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Chapter 1   Introduction 
 

Section 1   Overview 
This manual is a reference for GrafNav/GrafNet, GrafNav Lite, Inertial Explorer, and 
GrafNav/GrafNet with the moving baseline upgrade.  Contained in this manual are step-
by-step tutorials and in-depth information on each available option.  Logging software, 
utilities and GPS raw data converters are described here in addition to the processing 
software.  
 
The following components may be included with this package: 
GrafNav is a full-featured kinematic and static Windows 95, 98, 2000, XP and NT GPS 
post-processing package.  Using Waypoint’s proprietary GPS processing engine, 
GrafNav will support most single and dual frequency commercial and OEM receivers.  
GrafNav also processes GPS/GLONASS combined data.  When combined with a very 
easy to use Windows graphical interface, users can get centimetre accuracies almost 
instantaneously.  Now GrafNav will support multi-base (MB) processing. 
 
GrafNav will switch transparently from STATIC to KINEMATIC processing, as long as 
the static/kinematic flag is set properly in the GPB raw GPS data file.  A fixed static 
solution is available for static initialization on short or medium length baselines (30 - 50 
km).  A float static solution is available for long and/or noisy baselines.  Kinematic 
Ambiguity Resolution (KAR) allows the user to start in kinematic mode and/or fix 
otherwise unrecoverable cycle slips. For dual frequency users, ionospheric processing can 
improve accuracies as well.  All of these features are contained in the same program, and 
can all be used during the same project.  Chapter 2 is devoted to GrafNav. 
 
GrafNet is a multi-baseline static network-processing package.  It allows the user to 
combine days or weeks worth of static GPS baselines into a single network tying all 
points together.  The entire project can be processed in a single operation meaning the 
user can work on other tasks, but with Waypoint’s fast processor, processing can take 
minutes rather than hours.  When complete, GrafNet colour-codes the baselines 
depending on whether they passed internal tests.  Therefore, the user can concentrate his 
processing efforts on a few troublesome baselines rather than on the entire project.  
GrafNet allows four types of static baseline processing including the fixed static solution, 
the float solution and an ionospheric free solution.  See Chapter 3  Using GrafNet for 
more information. 
 
GrafNav Lite is a simplified version of GrafNav.  It contains all of the conversion and 
logging utilities, but will only process at 1 Hz or lower rates.  Only the float static 
initialization is included, and KAR is not supported.  Despite this, accuracies of 5-20 cm 
can be achieved with GrafNav Lite.  Use the GrafNav description given in Chapter 2 as a 
reference. 
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GrafNav Batch/GrafNav Lite Batch – This program module that comes with 
GrafNav/GrafNet, GrafNav Lite, and GrafNav/GrafNet with Moving Baseline upgrade, 
facilitates batch processing of static and kinematic baselines.  For GrafNav/GrafNet 
users, GrafNet is a more effective batch processing tool for static baselines.  For GrafNav 
Lite users, GrafNet is not available and this tool must be used.  The two main uses of 
GrafNav Batch are: 
 

a) One base station and many remote occupations.  The remote occupation can be 
observed by one or more GPS units.  Up to 128 baselines can be processed in this 
manner. 

 
b) One kinematic remote processed with respect to two or more bases.  The batch 

processor can be used to automatically process forward/reverse and combine these 
solutions into one optimal solution. A new feature in version 7.50 will allow the 
user to process multi-baselines in GrafNav Batch with two or more base stations.  
See Chapter 2  for more details.  

 
GrafNav can also be executed on individual bases, which may make working with an 
individual baseline easier.  Otherwise, GrafNav Batch has many of the features of 
GrafNav, including data plotting utilities. 
 
A GPS Data Logger is included to facilitate GPS data logging directly from a variety of 
GPS receivers under a Windows 95, 98, 2000 and NT environment.  Supported receivers 
include Thales (Ashtech), NovAtel, Canadian Marconi, Rockwell Jupiter, Trimble, 
Parthus, and Javad.  Features like tagging stations and satellite lock plots are included as 
well.  Logging is performed directly into Waypoint’s custom format.  Under Windows 95 
and 98, Waypoint’s own device drivers are used (i.e. WPCOMM.VXD), while the driver 
supplied by Microsoft’s is used for Windows 2000 and NT.  This program is described in 
Chapter 8. 
 
Also included is a Windows CE version of the data logger.  It has many of the same 
capabilities as the Windows version, and it is described in detail in Chapter 8  Section 2. 
 
Conversion utilities are included to convert the manufacturer specific raw GPS data files 
to Waypoint’s own format.  Supported formats are: 
 
• Allen Osborne Associates (AOA version only) 
• Conexant Jupiter/NAVCOR 
• CSI SLX/DGPS-MAX 
• Javad/Topcon 
• Leica SR/MX/System 500/System 1200 
• Magellan 
• Motorola Oncore 
• NavCom 
• NovAtel CMC All Star/Super Star 
• NovAtel OEM2/3/4/SoftSurv 
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• RINEX (v.2.0 and 2.1) 
• Rockwell PLGR/MPE12 (Rockwell version only) 
• Septentrio SBF 
• Sirf Binary 
• Thales Download (Ashtech) B-File Format/Real Time/DSNP 
• Trimble DAT/Real Time/TSIP/TIPY 
• U-Blox  
 
These decoders can be accessed external to GrafNav/GrafNet/GrafNav Lite/Inertial 
Explorer or from within the interface.   They are further described in Chapter 7. 
 
GPS raw data utilities are included that resample, splice and reduce the size of raw data 
files.  A raw GPS data viewer is also included.  This will allow you to view the data 
collected by the GPS receiver in order to detect any problems.  These utilities are 
described in Chapter 6. 
 
The following modes of processing are supported: 
Static processing involves the determination of a three dimensional baseline between two 
stations.  There are two types of static solutions supported by GrafNav:  a float solution 
and a fixed solution.  These two solutions are explained in more detail later in this 
section.  GrafNav Lite only supports the float solution. 
 
Kinematic processing is initialized either with a static survey, from a known point or 
using Kinematic Ambiguity Resolution (KAR).  Following initialization, the antenna 
mounted vehicle moves from station to station.  In some cases, it may be possible to 
remove the antenna and place it over the desired point.  However, in other cases such as 
an aircraft, positions can be interpolated. 
 
A fixed static solution is available when sufficient cycle slip-free data is available.  This 
algorithm starts with the float solution, and using this as a seed, it searches for the nearby 
integer combinations.  Then, it will calculate RMS fits for these integer intersections.  
The intersection list will be sorted about this value.  In single frequency, fixed static 
solution requires at least 10-15 minutes of continuous static data, and more on longer 
baselines.  Dual frequency receivers require about 1/2 - 2/3 of the time.  Fixed solutions 
are not reliable on baselines longer than 15 km for single frequency and 30 km for dual 
frequency.  For version 7.50, fixed solution is now solved for all static periods. 
 
The float solution does not solve for integer ambiguities, and can take much longer to 
converge to centimetre accuracies.  Since integers are not forced, the float solution tends 
to be less accurate than the fixed or KAR solutions.  For longer baselines (>10 km in 
single frequency and >30-40 km in dual frequency), integers are often not solvable.  In 
such cases, the float solution is often the best alternative.  For dual frequency, be sure to 
enable the ionospheric free correction mode from the Dual Frequency Options.  Solution 
plots can also be viewed from within the GrafNav environment using the plot functions 
under the Output Menu. 
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Figure 1.1 Example of GPS Processing Static Convergence (float solution) 

 
Kinematic Ambiguity Resolution (KAR) searches the ambiguities after a serious loss of 
lock and is useful for precise kinematic processing as it achieves centimetre accuracies.  
This is the so-called on-the-fly (OTF) algorithm.  This technique requires 5 or more 
satellites in view, and it is helped considerably by L2 (dual frequency) phase 
measurements.  KAR can be useful for single frequency receivers if open conditions are 
present.  KAR is generally engaged at the start or after periods of extremely poor 
geometry or loss of lock.  For dual frequency, it can be used for reliable initialization if 
baseline lengths are less than 30 km.  Single frequency can also be initialized in this 
manner, but static methods are more reliable. 
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Table 1.1 Product Comparison Chart 

Capabilities GrafNav/ 
GrafNet 

GrafNav
Static 

GrafNav 
Lite 

GrafMov Utilities  
Only 

Inertial  
Explorer

Float Static       
Float Kinematic       
Fixed Integer 
Static (Fixed 
Solution) 

      

Fixed Integer 
Kinematic (KAR) 

      

Dual Frequency       
Single Point       
Moving Baseline       
GPS Azimuth 
Determination 

      

IMU Processing       
Kinematic < 1sec 
Data Rates 

      

Mission Planner       
GPS Data 
Conversion 

      

Coordinate/Datum 
Conversion 

      

GPS Data Logger       
Download Service 
Data (FTP) 

      

 

Section 2   For People Who Do Not Read Manuals 
For users who generally do not read manuals, these are the sections that should still be 
considered for reading, in order of importance: 
 

1) Chapter 10  Section 1, Chapter 10  Section 2 and Chapter 10  Section 3 
contains tips on improving accuracies and additional information on multi-
base processing. 

2) Chapter 2  Section 3 is a reference section describing the processing 
settings. 

3) Chapter 7 contains some tips on converting data from each type of GPS 
receiver.  Conversion settings are also described here. 

4) Chapter 10  Section 5 is a useful Q & A style description of Datums, 
Geoids and Grids for users who are not well versed in these areas. 
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Section 3   Installing GrafNav/GrafNet or GrafNav Lite 

1.3.1   What You Need To Start 
The minimum software and hardware your computer system needs to run GrafNav for 
Windows are: 
 

• GrafNav/GrafNet for Windows is distributed on a compact disc. 
• A Waypoint Protection Key burned for the correct product and has a version 

number of at least 7.50.  The key can be read via Start | Programs | Software 
Package | Utilities | Hardware Upgrade Utility. 

• A computer running Windows 95, 98, 2000, XP or NT (Version 3.51 or 4.0). 
• At least 64 MB of RAM and 20 MB of space on your hard disk. 
• A 486 CPU is sufficient, but a Pentium is suggested.  Furthermore, Pentium II or 

higher CPUs will run significantly faster. 

1.3.2   Installation CD - GrafNav/GrafNet 

1.3.2.1   Common Problems with Upgrading GrafNav/GrafNet 
GrafNav/GrafNet is distributed with a Sentinel hardware lock.  Upgrading to a new 
version will require a new key code for the hardware lock, and expired demo codes will 
also need new codes for the software package to continue working.  Waypoint Consulting 
Inc. should be contacted for obtaining new key codes.  For contact information, see 
Section 5  of this chapter. 
 
Once the GrafNav/GrafNet software is installed, press the Start Menu button and click on 
Programs | Waypoint GPS | Utilities | Hardlock Upgrade Utility to start updating your 
hardware lock.  Click on the Read Key button and copy down the existing key code and 
save the code.  This will help prevent the loss of a full working GrafNav/GrafNet key 
code when the user is testing out a newer demo or beta version of the software.  To 
upgrade the key, enter the given key code in the following format ####-####-####-#### 
and press Upgrade. 
 
Note:  Versions 7.50 and greater of KeyUtil.exe are not compatible with previous 
versions.  The software will only function if they key has been upgraded with a newer 
version of KeyUtil (ie. 7.50 and greater).  The version number appears the title bar. 

1.3.2.2   Installing the Software 
GrafNav/GrafNet is distributed on CD media.  To install the software, insert the CD into 
the CDROM drive.  From the Windows Start button, select Run.  Type D:\Setup (where 
D: would be your CDROM drive), or navigate to the CD by selecting Browse.  Follow 
the instructions during installation. 
 
Your software should now be installed.  Sample GPS data is provided under the \Data 
directory of the CD.  Copy some data on to your hard disk and try processing it.  There is 
a Getting Started Section at the start of the GrafNav and GrafNet Chapters. 
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1.3.2.3   Hardware Lock Problems 
The hardlock is needed when GrafNav, GrafNav Lite and GrafNet process. For almost all 
users, the software will work without problems.  However, every now and then, some 
users have difficulties with the hardlock supplied with the software.   
 
Currently, this product only works with one type of hardware key, which are 
manufactured by Sentinel.  The Sentinel locks are beige colored and have memory.  
Encoded in the memory is the user's serial number, version number, software type (i.e. 
GrafNav/GrafNet, GrafMov, POSGPS, etc.).  The memory may also contain the 
demonstration status if applicable.  The information on the Sentinel lock's memory can be 
read using the Hardlock Upgrade Utility, which can be accessed from the software's 
program group in the Start Menu. 

1.3.2.4   Sentinel Hardlock Problems 
Currently, there are no known compatibility issues with this hardlock.  In Windows 
95/98, it will work without the drivers even being installed.  However, for Windows 2000 
and NT, it is important that the drivers are installed and the system is restarted. 
 
The most often cause of problems is due to drivers not being installed, especially by 
preliminary versions of version 6.00 and prior versions of GrafNav/GrafNet.  Such 
versions will also not work with the Sentinel key.  The error message for such an error is 
'FATAL ERR – Hardlock error! Unable to open Sentinel hardware lock driver – Install 
driver (error code 12)'. 
 
Another common cause of problems is an incompatible version number for the software 
type between the processor and key.  In this case, you will need to contact your dealer.  
This returns one of two error messages 'FATAL ERR – Hardlock error! Hardware key is 
intended for a software version older than what is being used – reinstall older version or 
upgrade key'.  Demo keys burned after the week roll-over (i.e. August 22, 1999) will only 
work with version 6.01 or greater.  If an error occurs, this message will be returned, 
'FATAL ERR – Hardlock error! Demo software is being used outside of demo usage 
period – Upgrade to working version or call to extend demo period'. 
 
In a few cases, failed or intermittent locks have been encountered.  These usually return 
an error labeled 'FATAL ERR – Hardlock error! Waypoint hardware key not found – 
Check printer port (error code 3)'.  Test procedures have improved, but if the problem 
occurs, the lock will need to be replaced.  Note that an RMA number is required before a 
shipment will be accepted.  Please contact you dealer for instructions. 
 
Otherwise, the error code number that is shown in the error message corresponds to the 
following: 
 
  0 - SUCCESS 
 
  1 - INVALID FUNCTION CODE was specified - See your language's include 
         file for valid API function codes.  Generally, this error should not 
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         occur if you are using a Rainbow-provided interface to communicate 
         with the driver. 
 
  2 - INVALID PACKET - A checksum error was detected in the command packet, 
         indicating an internal inconsistency.  The packet record structure may 
         have been tampered with.  Generally, this error should not occur if you 
         are using a Rainbow-provided interface to communicate with the driver. 
 
  3 - UNIT NOT FOUND - The specific unit could not be found.  Make sure you 
         are sending the correct information to find the unit.  This error is returned 
         by other functions if the unit has disappeared (that is, unplugged). 
 
  4 - ACCESS DENIED - You attempted to perform an illegal action on a word. 
         For example, you may have tried to read an algorithm/hidden word, 
         write to a locked word, or decrement a word that is not a data nor 
         counter word. 
 
  5 - INVALID MEMORY ADDRESS - You specified an invalid SentinelSuperPro 
         memory address.  Valid addresses are 0-63 decimal (0-3F hex). 
         Cells 0-7 are invalid for many operations.  Algorithm descriptors 
         must be referenced by the first (even) address. 
 
  6 - INVALID ACCESS CODE - You specified an invalid access code.  The 
         access code must be 0 (read/write date), 1 (read only data), 2 (counter), 
         or 3 (algorithm/hidden). 
 
  7 - PORT IS BUSY - The requested operation could not be completed because 
         the port is busy.  This can happen if there is considerable printer 
         activity, or if a unit on the port is performing a write operation 
         and is blocking the port.  Try the function again. 
 
  8 - WRITE NOT READY - The write or decrement could not be performed due to 
         a momentary lack of sufficient power.  Try the operation again. 
 
  9 - NO PORT FOUND - No parallel ports could be found on the workstation. 
 
 10 - ALREADY ZERO - You tried to decrement a counter or data word that 
         already contains the value 0.  If you are using the counter to 
         control demo program executions, this condition may occur after the 
         corresponding algorithm descriptor has been reactivated with its 
         activation password. 
 
 12 - DRIVER NOT INSTALLED - The system device driver was not installed 
         or detected.  Communication with the unit was not possible.  Please 
         verify that the device driver is properly loaded. 
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 13 - COMMUNICATIONS ERROR - The system device driver is having problems 
         communicating with the unit.  Please verify that the device driver 
         is properly installed. 
 
 18 - VERSION NOT SUPPORTED - The current system device driver is outdated. 
         Please update the system device driver. 
 
 19 - OS ENVIRONMENT NOT SUPPORTED - The Operating System or  
         Environment is currently not supported by the client library.  Please 
         contact Tech Support. 
 
 20 - QUERY TOO LONG - The maximum query string supported is 56 characters. 
         Send a shorter string. 
 
 30 - DRIVER IS BUSY - The system device driver is busy. Try the operation 
         again. 
 
 31 - PORT ALLOCATION FAILURE - Failed to allocate a parallel port through 
         the Operating System's parallel port contention handler. 
 
 32 - PORT RELEASE FAILURE - Failed to release a previously allocated 
         parallel port through the Operating System's parallel port 
         contention handler. 
 
 39 - ACQUIRE PORT TIMEOUT - Failed to acquire access to a parallel port 
         within the defined time-out. 
 
 42 - SIGNAL NOT SUPPORTED - The particular machine does not support a signal 
         line.  For example, an attempt was made to use the ACK line on a 
         NEC 9800 computer.  The NEC 9800 does not have an ACK line. 
         Therefore, this error is reported. 
 
 57 - INITIALIZE NOT CALLED - Failed to call the client library's initialize 
         API. This API must be called prior to the API that generated this 
         error. 
 
 58 - DRIVER TYPE NOT SUPPORTED - The type of driver access, either direct 
         I/O or system driver, is not supported for the defined Operating 
         System and client library. 
 
 59 - FAILURE ON DRIVER COMMUNICATION - The client library failed on 
         communicating with a Rainbow system driver. 
 
 60 - SERVER PROBABLY NOT UP – The server is not responding; the client has 
         timed out. 
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 61 - UNKNOWN HOST – The server host is unknown.  The server is not on the  
         network, or an invalid host name was specified. 
 
 62 - SEND TO FAILED – The client was unable to send a message to the server. 
 
 63 - SOCKET CREATION FAILED – The client was unable to open a network  
         socket.  Make sure the TCP/IP or IPX protocol is properly installed on the system. 
 
 64 - NO RESOURCES – Could not locate enough licensing requirements. 
         Insufficient resources (such as memory) are available to complete the 
         request, or an error occurred in attempting to allocate the needed memory. 
 
 65 – BROADCAST NOT SUPPORTED – The broadcast is not supported by the  
         network interface on the system. 
 
 66 – BAD SERVER MESSAGE – Could not understand a message received from 
         the server.  An error occurred in decrypting (or decoding) a server message at 
         the client end. 
 
 67 – NO SERVER RUNNING – Cannot communicate to the server.  Verify that 
         the server is running.  The server on the specified host may not be available  
         for processing the request. 
 
 68 – NO NETWORK – Unable to communicate with the specified host. Network  
         communication problems encountered. 
 
 69 – NO SERVER RESPONSE – No server responded to the client broadcast. 
         There is no server running in the subnet, or no server in the subnet has the 
         desired key connected. 
 
 70 – NO LICENSE AVAILABLE – All licenses are currently in use.  Server  
         has no more licenses available for this request. 
 
 71 – INVALID LICENSE – The license is no longer valid.  License expired due 
         to time-out. 
 
 72 – INVALID OPERATION – The specified operation cannot be performed. 
         Tried to set the contact server after obtaining a license, or tried to call 
         FindFirstUnit function on a packet that already has a license. 
 
 73 – BUFFER TOO SMALL – The size of the buffer is not sufficient to hold 
         the expected data. 
 
 74 - INTERNAL ERROR – An internal error, such as failure to encrypt or decrypt 
        a message being sent or received, has occurred. 
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 75 – PACKET ALREADY INITIALIZED – The packet being initialized was 
         already initialized. 
 
 255 – INVALID STATUS – An invalid status code was returned. 
 
The Alladin (black) hardlock is no longer supported by GrafNav/GrafNet.  Therefore, if 
you have such a key, then it must be exchanged for one of the Sentinel keys to run 
version 6.02 and later.  There may be an upgrade charge for this operation. 

1.3.2.5   What else is on the CD? 
There are a number of directories on the CD containing additional programs and data.  
These include the following: 
 
\Data 
This directory contains sample GPS data for GrafNav and GrafNet for various types of 
GPS receivers.  Browse through the subdirectories of \Data to see what data is available.  
To process, it is easiest to copy the contents of a directory (or all directories) to your hard 
disk since the CD will not allow file creation. 
 
\Hardlock 
This directory contains the drivers necessary for Windows 2000 and NT installation.  The 
Windows 95 VXD is also there. All hardlock drivers should be installed automatically 
during installation. 
 
\Geoid 
This directory contains geoid files for U.S. (Geoid96, Alaska96, Geoid99, Geoid03), 
Mexico97, Australia (AusGeoid93 and AusGeoid98) and the World (EGM96).  These 
files allow mean-sea-level (orthometric) heights to be computed using GrafNav and 
GrafNet.  Files are in the .WPG (Waypoint Geoid) format.  For Canada, files must be 
downloaded from the Geodetic Survey Division of Geomatics Canada.  This directory 
also contains Geoid99 for the continental US and Alaska.  Other regions of the world are 
also available.  Check the CD or Waypoint’s FTP site (call for information). 
 
\DosUtils 
This directory contains various DOS and Win32 console utilities that are not installed 
with the software.  Generally, these utilities are replaced by capabilities within the 
windows product. 
 
\Ctl3D 
This directory contains versions of CTL3D32.DLL for both Windows 95 and Windows 
NT.  See the readme.txt file.  Newer versions of the software may not need this DLL. 
 
\Devkit 
This directory contains a command-line program that can execute the Dynamic Link 
Library (DLL) that GrafNav, GrafNet and GrafNav Batch use for processing, which is 
useful for off-line batch processing.  This directory also contains sample ‘C’ source code 
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for linking to this DLL.  See the Application Note.doc file for further explanations.  This 
is the so-called 'Developers Kit'. 
 
\ManualPdf 
Contains this manual in Adobe Acrobat format. 
 

Section 4   New Features in GrafNav 
Existing GrafNav/GrafNet, GrafMov and GrafNav Lite customers can obtain the latest 
version if they have purchased or upgraded within the last year.  Users whose year will 
run out before the release date will not be able to receive the release copy of the software.  
In such a case, an upgrade should be ordered. 

1.4.1   What is new with version 7.50? 
Processing Engine: 

• True multi-base (MB) processing capabilities.  Users can now utilize all (or some) 
of the base stations simultaneously in the Kalman filter.  Accuracies are generally 
improved over older methodology (which is still supported). 

• KAR can attempt to fix from all base stations, but generally will use the closest 
base. 

• KAR can automatically engage when approaching a new base station (optional). 
• The fixed static solution can attempt to fix to all base stations (within distance and 

time tolerances).  It will pick the best passed solution for each static session. 
• Much improved satellite weighting.  Users can select from elevation based or 

C/N0 based schemes.  Carrier standard deviation is automatically adjusted for 
distance and other effects. 

• Bad data rejections/corrections are much simpler to control.  Parameters are more 
dynamic, and users need only select a “level” of rejection.  Software handles bad 
carrier data better than before. 

• User can control how easily filter reset will happen. 
• Much better control over omitting satellites and baselines.  For instance, baseline 

and/or satellite can be omitted just from KAR or from overall solution. 
• Better handling of satellite serial drop-outs. 
• For P-Y code data, users can process single frequency L2/P2 or utilize P1 instead 

of C/A for processing (new GPB format only). 
 
GrafNav Interface: 

• GrafNav performs full MB processing. GrafNav Batch only needs to be used if 
user wishes to perform older sequential style MB processing.   

• For MB processing, a number of new plots have been added that show individual 
graphs for each base station.  Plots include code/carrier/doppler RMS, 
code/carrier position separation, effective baseline weighting, distance to base, 
DOPs, number of satellites and number of baselines used. 

• GrafNav now tracks user name and process ID string for each “run”. 
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• GrafNav saves history of processing settings and coarse statistical data (e.g. 
forward/reverse separation), which can also be plotted.  This allows users to not 
only restore previous settings, but compare results from various “runs” as well. 

• Data gaps in master files can be automatically filled when master is added to 
project.  GrafNav can also show analysis of time gaps and other timing errors. 

• User can resample to higher data interval right within GrafNav.  Concatenate, 
slice and resample no longer need to be used. 

• Plot selection is now much easier.  Most commonly used plots are available for 
quick selection. 

• Users can copy a plot to clipboard for pasting into other applications. 
• Selection of x-axis and y-axis plot ranges is now much faster. 
• More compact storage of individual satellite and baseline residuals in “Binary 

Value” files. 
• Improved processing screen. 
• Menus are now reorganized to make them more intuitive. 
• Processing settings are reorganized and are more intuitive. 
• Combined solution automatically loaded on start-up.  A number of other user 

preferences can also be set (e.g. CMB file can be automatically created on 
fwd/rev combination). 

• Improved ability to remove processing files. 
• Base station map projection coordinates can now be entered in Metres, Feet or US 

Survey Feet. 
• .EPP and .STA files can be quickly viewed for each observation file. 
• Better remote antenna height handling with respect to static sessions. 

 
GrafNav Batch: 

• Both sequential (old-style) multi-base and new MB processing baselines can be 
loaded simultaneously making comparisons easy. 

• “Combined” baselines can now be combined, which helps in comparing 
trajectories. 

• GrafNav Batch can now import GrafNav .CFG files, meaning projects can be 
started in GrafNav and moved to GrafNav Batch. 

• All new GrafNav features implemented in GrafNav Batch. 
 
Utilities/Converters: 

• Addition of U-Blox converter 
• Addition of Thales DSNP decoder 
• Addition of Leica System 1200 decoder 
• Better reporting of version numbers 
• Improved NovAtel OEM-4 ephemeris decoding 
• GpbView can compute clock offset from C/A, P1 or P2 code.  Previously only 

C/A was possible. 
• Added stations in Download and Coordinate Favorites 
• Many of the built-in favorite coordinates account for continental drift  
• Better TCP support in WLOG 
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Bug fixes: 
• Static/Kinematic coverage plot now supports week rollover 
• Better time display in Object Viewer/Menu 
• Better Javad event mark handling 
• Projects no longer “auto-saved” on exit.  User prompted first 
• Fixed a number of issues with static sessions 

1.4.2   What was new with version 7.01? 
Late Version 7.00 bug fixes (included with Version 7.01) 

• Reversed fixed solution did not work with new format 
• Fixed Glonass+KAR processing bug 
• Trimble real-time converter fixed cycle slip and outputs new format 
• Concatenate, Slice and Resample has better directory handling 
• Trimble Decoder now supports data rates higher than 1 Hz 

 
Version 7.01 bug fixes 

• Plotting bug fixed where KAR always being selected 
• Time problem in batch processor fixed 
• Concatenate, Slice and Resample fixed bug with adding file names 
• Bug fixed in Ashtech B-File (HOSE) decoder where channel 12 was being 

rejected 
• Lambert conformal scale factor now properly being computed 
• Better support for UTM map display 
• Locktime base satellite slip now more properly being detected 
• Cycle slip on base satellite was sometimes not being properly handled (fixed in 

build 1/26/04 and later) 
• Javad/Topcon decoder now better handles data from newer Javad firmware 

versions.  Problem fixed where some epochs were being missed during decoding. 
• NovAtel OEM3 decoder now reads CLKB record. 
• GPB->RINEX now outputs a continuous week number for receivers that output 

the 10 bit value. 
• RINEX->GPB prompts for .NAV file if missing.  In addition, a .NAV file can be 

decoded on its own. 
• Trimble DAT decoder now properly decodes static/kinematic flags. 
• Antenna height could be mixed up in GrafNav during static mode.  Generally, it 

happens when the antenna height in the station file is different than that selected 
for processing and happens most easily from GrafNet->GrafNav.  In GrafNav, it 
is important to change the antenna height for the static session as opposed to the 
global value, and there is now a message to this regard.  The transition between 
GrafNet->GrafNav has been improved. 

  
Version 7.01 new features 

• New about box that includes key control and better version/date reporting 
• All manufact files can now be downloaded from Waypoint's FTP site 

14 



Chapter 1  Introduction 

• DEMs can be loaded, displayed and used for more accurate vertical scale factor 
computation 

• Allow more than one combined baseline to be added in GrafNav Batch 
• GpbView allows user to enter site specific meteorological parameters 
• GpbView displays processing messages and single point processor better 

compensates for extremely bad data. 
• Additional modes added for GrafMov azimuth determination. Azimuth 

computation possible for a variable baseline length 
• Septentrio GPS data decoder now included 
• Addition of Ashtech DG-16 real-time CT message  
• Trimble real-time decoder now support 40h message and better high data rate 

support 
• RINEX ephemeris files can be decoded separately 
• Four new networks and a number of stations were added to the Download 

program 
• Download can also download IONEX and precise clock files 
• IONEX model can be used for single frequency single point and differential 

processing 
• Solutions and settings can be imported from one project (and Batch baseline) to 

another 
 
Inertial Explorer bug fixes 

• Export wizard now better handles high data rates 
• Bug were events were lost during interpolation has been corrected. 
• Bug fixed where users can now better create their own IMU error models.  

Previously values would get lost 
 
Inertial Explorer new features 

• Users can plot IMU coverage in addition to Master and Remote GPS coverage.  
This plot will also show IMU data time gaps. 

• Error models have been added for DMARS-I and HG-1700 IMUs 
• User can now flexibly import IMU data into Inertial Explorer using the new 

‘Convert IMU’ utility.  It allows users to convert their own IMU data to 
Waypoint’s common format.  Users can set axes, scale factors, time systems and 
directions to handle most formats available 

• Inertial Explorer now supports a generic .IMR IMU raw data file that is common 
for all formats.  Existing formats are still currently supported, but future versions 
may only support IMR.  Users can either create this file themselves or use the 
flexible ‘Convert IMU’ utility 

• Users can now process data from IMUs that are not parallel to the body frame.  
That is, the IMU need not be level when the vehicle is level.  The user must know 
the angles of orientation 

• The IMU processing window now better integrated into GrafNav windows 
• IMU software now outputs a meaningful quality number 
• IMU processor now transfers GPS statistics after IMU processing 
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• Export wizard can now export ω, φ, κ angles oriented to map system. 
• Users can now select start/end IMU processing time from plots 

1.4.3   What was new with version 7.00? 
Processing Engine: 

• Totally re-designed processing engine employing a more robust Kalman filter 
• More realistic error modeling in float solution 
• Updated KAR algorithm which is more robust 
• New precise code-only single point processor 
• Improved antenna modeling (more antennas included and there is now more 

control over them).  Elevation based corrections also now applied. 
• New GPB data format implemented with more data variables (e.g. C/No and L2 

Locktimes are now present in the format). 
• Ability to solve for fixed static solution midstream in data (e.g. for every static 

session).  There is no limit to number of static fixes for stop and go data. 
• Totally new message log output with more meaningful warnings and errors.  

Cycle slip messages can now be disabled. 
• Totally new .fss/rss file output that also reflects input settings. 
• Better handling of individual satellite data gaps. 
• Improved static initialization accuracy from fixed solution and from known 

points. 
 
User Interface: 

• New Options profiles now available.  Users can save combinations of processing 
settings that work well.  The software will also come with pre-loaded profiles.  

• Auto-start allows selection of an Options Profile or Factory Defaults 
• Improved viewing capabilities for static sessions and KAR, while fixes and status 

are now displayed in the plots and on map window. 
• Users can now edit names and antenna height for static sessions. 
• Updated satellite lock plot display that also shows data gaps 
• Improved ability to interpolate for both distance and time in export wizard 
• New individual satellite plot that shows: carrier and C/A residuals, elevation 

values and C/N0 values. 
• Satellite residuals can now be plotted for forward and reverse direction. 
• Users can now reject user-selected periods in forward and reverse combination. 
• Better tracking and selection of previous projects 
• Improved orthometric height input 
• Batch processor now handles static sessions and features better 

 
Utilities and Converters: 

• Implementation of new GPB format in the most popular data converters and all 
utilities. 

• New utility added to more easily switch between static and kinematic 
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• New RINEX export and import converters developed.  Also now supports RINEX 
station markers. 

• Addition of CSI SLX GPS data converter 
• Support for NovAtel/Waypoint OEM4 ultra-compressed record.  Much improved 

handling of erroneous week numbers originating from OEM-4 ephemeris files 
• New raw data viewer that allows bi-directional movement. 
• Two new networks added to the download utility (networks in France and 

Japan).  There are now over 2400 stations available to the user.  
• Download program will now download SP3 files as well.  In addition, RINEX 

files are now optionally left in processing directory. 
• Improved point searching in the Favorites 
• Improvements to 'Concatenate, slice and resample' utility and new interpolator has 

been added.  Ability to interpolate one GPB file onto the times of another. 
• WLOG now supports NAVCOM and CSI-SLX receivers 
• WLOG supports high speed serial connections (230400 baud) for supported 

receivers (e.g. NovAtel OEM4) 
• WLOG better support for TCP connections 
• Added support of latest processor to WinCE Logger. 
• WinCE Logger can now time tag external line terminated data (e.g. 

magnetometer, sonar etc…) and store them as an event. 

1.4.4   What was new with version 6.03? 
• Our OTF algorithms have undergone a number of improvements to better handle 

long baselines.  This included distance dependent weighting and better controls to 
reject bad solutions.  Additional options have been added to facilitate faster 
resolution on short baselines (i.e. a few epochs). 

• The datum handling has been totally redeveloped.  We now support a 7 parameter 
transformation, a 10 parameter transformation (7-param + rotational velocity), 
and the NGS’s NADCON grid transformation format.  In addition, the software is 
not pre-loaded with most of the world’s datums, while adding your own 
transformations is simple.  It is also now possible to compute 3 or 7 parameter 
datum transformations from two coordinate files. 

• We have added a download utility that allows users to download the nearest 
CORS, IGS and AUSLIG GPS service data.  Users need only specify their 
location and the nearest stations will be located automatically.  This utility will 
download the data, convert to our format from RINEX and resample to the 
desired interval. 

• Our handling of master (and other station) coordinate favorites has been much 
improved.  Users can now group their favorites and load a list of coordinates from 
a file.  Ellipsoidal/orthometric height flags and datums are also retained for each 
favorite point.  The CORS and IGS station coordinates are also preloaded. 

• We have a newly developed WinCE data logger available.  We have added 
support for more GPS receivers and the functionality of the data logger is being 
much increased.  We are supporting as many screen sizes as possible, and the 
display is user configurable. 
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• The Windows Data logger now supports additional receivers such as Trimble 
4XXX, NovAtel OEM4 and Ashtech DBEN format. 

• An additional post-processing decoder has been added for Trimble Real-time 
while a numerous improvements have been made to existing decoders. 

• Feature handling has been much improved.  Users can now re-number 
features/camera marks.  Moreover, editing is much easier, and any changes are 
automatically saved.  Users can also apply time shifts. 

• For photogrammetry users, we have much improved the ability to import and 
export camera event marks.  New import formats are supported (e.g. RC-
30/ASCOT), while users can apply a 3-D offset to the aerial camera principal 
point. 

• Users can enter the master station coordinates in Grid in addition to geographic. 
We are also now keeping track of what height is entered (i.e. ellipsoidal or 
orthometric) which aids coordinate exporting. 

• The Export Wizard has a number of additions including the ability to 
transformation into another datum,  

• DXF output is also now available directly from GrafNav and GrafNet. 
• Data plotting has been improved considerably.  Loaded stations/camera marks are 

plotted on the graphs to show users if problem areas are significant.  Users can 
also locate times on the map or in the message log file by clicking on the graph.  
These new features make it much easier to analyze data. 

• We have also added two additional plots such as static/kinematic coverage + a bar 
graph for the number of satellites. 

• Users can search for epochs on the map.  The map can also now display grid 
coordinates. 

• Users can apply any combination of datum, coordinates and geoid height 
conversions to a coordinate file to create a new converted file. 

• GrafNet is seeing a number of improvements including better display of sessions 
and their quality statistics.  Now the session menu shows RMS, reliability, 
standard deviation, etc.. for each baseline. 

• In GrafNet, control points can now be horizontal, vertical or 3-D.  This is a great 
convenience from before, where users had to go through a number of steps to 
handle such points. 

• GrafNet now has built-in support for grid coordinates and control points with 
orthometric heights can be entered. 

• GrafNet has a few more processing controls 
• GrafNav Batch encompasses all the improvements of GrafNav.  In addition, it can 

now print, display the map window and import stations and camera event marks.  
Users can also now add user defined options within GrafNav Batch. 

1.4.5   What was new with version 6.02? 
Version 6.02 saw the following improvements: 
 

• Ionospheric L2 Noise Modeling was added to KAR.  This facilitates much farther 
KAR fix distances and has much improved reliabilities.  Even for shorter 
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distances, Waypoint’s KAR algorithm has been much improved for dual 
frequencies. 

•  In static, the fixed solution now has ionospheric modeling, which has vastly 
improved accuracies on baselines between 15 and 75 km. 

•  GrafNav and GrafNet bad data handling capabilities received a complete 
overhaul for Version 6.02, which now handles more combinations of data errors. 

•  GPS antenna modeling for GrafNav and GrafNet.  A number of manufacturer 
models are included, while users can add their own antennas as well.  This 
antenna modeling takes into account L1 and L2 phase centre offsets from the 
measuring mark and slant measurement corrections.  

•  GrafNav now has the ability to fix the position at any number of points or 
stations visited in a kinematic survey.  This includes the ability to snap to the 
nearest integer ambiguity. 

•  Mission Planning has been added to GrafNav.  This includes differential 
capabilities, useful on longer baselines. 

•  Multi-base station batch processor.  GrafNav Batch now has the ability to 
optimally combine data from up to 100 base stations (up to 8 can be plotted) 
making multi-base processing a much simpler task. 

• GrafNav and GrafNet can now process dual frequency GPS + GLONASS data 
(note: only GPS data is used for fixed integer determination).  Former versions 
could only process single frequency GPS+GLONASS data. 

• Better velocity accuracies are now available under extremely high dynamics. 
• GrafNav now has much improved plotting capabilities.  This includes additional 

graphs such as the fixed/float ambiguity status, while plots are now dynamically 
configurable. 

• KAR now processes approximately 50% faster. 
• Improved decoding for the Javad, NovAtel Glonass and Ashtech receivers.  Better 

detection of unhealthy satellites was added to most decoders. 
•  Command line baseline processing interface is now available.  Users can add 

processing capabilities to their own software or batch files. 
• Data logging software has a much improved startup interface.  In addition, the 

ability to output RTCM corrections to an additional serial port has been added. 
•  A beta version of the Windows CE data logger is now included.  Currently, 

Ashtech, CMC, NovAtel are supported, while support for more receivers are 
planned for the future.  A number of CE platforms have been tested. 

1.4.6   What was new with version 6.01? 
Version 6.01 saw the following improvements: 
 

•  Printing capabilities 
•  Export Wizard that allows the user to customize ASCII output using over 100 

data variables from GrafNav and GrafNet 
•  Data conversion utility that auto-detects the GPS receiver data type 
•  Kinematic batch processing.  Static batch processing can be performed by 

GrafNet 
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•  Processing Summary which shows overall statistics of a kinematic mission 
•  Distance and Azimuth Tool that computes the true azimuth and distance between 

two selected points 
• Updated Graphical interface including a new toolbar and tabbed options dialogue 

boxes 
• Added KAR options such as the ability to engage KAR at the user’s request 
• Improvements to windows data logger 
• Improved KAR message output to summary files 
• Better Fixed/Float ambiguity reporting 
• Extended DOP computations 
• Support for additional GPS receivers such as Garmin 25/35 and Leica System 500 
• Improved bad data handling such as in forest canopies 

 
 

Section 5   Customer Support 
If you purchased GrafNav/GrafNet, GrafNav Lite or GrafMov through a vendor, please 
contact them for support.  Otherwise, Waypoint can be contacted as follows: 
 
Waypoint Consulting Inc. 
Suite 210, Riverbend Atrium One 
200 Rivercrest Drive S.E 
Calgary, Alberta 
T2C 2X5 Canada 
 
Phone: (403) 720-3800 
Fax: (403) 720-3868 
Email: support@waypnt.com 
Web: www.waypnt.com 
 
Please indicate: 

• Key number 
• Program Name and Version (see Help/About) 
• Nature of problem 
• Type of GPS receivers used 
• Nature of the application
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Chapter 2   GrafNav 
 

Section 1   Getting Started with GrafNav 
GrafNav is a full-featured kinematic and static GPS post-processing package using 
Waypoint’s proprietary GPS processing engine.  It supports both single and multi-
baseline (MB) processing.  GrafNav will support most single and dual frequency 
commercial and OEM receivers (see Chapter 7  Convert for further information).  This 
section goes through the basics of GrafNav including how to process in a step-by-step 
tutorial for first time users.  This chapter also describes the features contained within 
GrafNav Lite.  When GrafNav is referred to, it can be assumed that GrafNav Lite is also 
implied.  Please refer to Table 1.1 Product Comparison Chart on page 5 for a list of 
differences between GrafNav lite and GrafNav. 

2.1.1   How to Start Processing Baseline(s) 
The following is a 10-step tutorial to help you start processing one or more baselines at 
once.  Each menu is defined in detail in the following chapters.  For first time users we 
suggest that you run the software and follow the steps below. 
 
Note:  This manual assumes that you are familiar with your Windows operating system 
and are familiar with using a mouse.  If not, please refer to Windows Help for assistance.  
It also assumes that you have master and remote GPS data files collected in a directory 
that you have created. 
 
Step 1: Start GrafNav 
Assuming that you have followed the installation instructions properly, you will have a 
program group called Waypoint GPS 7.50.  In this program group, there will be a 
program called GrafNav.  Highlight GrafNav to start the program. 
 
Step 2: Convert GPS Data 
If your data was collected using something other than one of the data logging programs 
supplied by Waypoint, then you must convert your files.  If the data was logged raw (i.e. 
as it comes from the GPS receiver), then you will have to convert it first. 
 
Use File | Convert | Raw GPS to GPB to access the converter.  Browse to the directory 
that contains the data.  Select ‘Auto Add All’ to auto-detect GPS formats.  You may wish 
to investigate the conversion options (select Options or Global Options) to convert your 
rover to kinematic.  The GPBView utility can also be used to switch between static and 
kinematic (see Chapter 6 Section 3 for more information on the GPB Viewer).  Chapter 7 
contains a complete description of the Convert utility. 
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Step 3: Download Service Data (optional) 
If no master stations were used, master GPS data can also be downloaded from the 
Internet.  In such a case, select Download Service Data from the Tools Menu.  A CORS 
or IGS station can be added directly from a list, or you can add the closest one to your 
project area.  The simplest is usually to use the Add Closest tab.  Type your approximate 
position in.  If it is not known, then the average position can be computed from the 
remote GPB file.  Select ‘Position from GPB’ and choose your converted GPB file.  On 
the main page, be sure to enter the proper time and date of your survey and the directory 
where the files are to be saved.  See Chapter 6  Section 9  Download Service Data for a 
more complete description of this utility. 
 
Step 4: Create New Project 
Select File from the Main Menu bar and choose New Project and File Name.  You can 
also use the Auto Start feature, which will automatically bring up all the necessary 
dialogue boxes.  For our purposes in this tutorial we will go through all the steps 
manually.  Note that if you have already processed a baseline, a .CFG file will be present.  
You can select Open Project and skip to Step 7. 
 
A dialogue box will appear asking you to enter the name of your new project. The default 
directory may be where GrafNav was installed.  You should switch to the directory that 
contains your raw GPS data.  Entering the name of a project that already exists will 
overwrite the file contents.  Type in the name of your new project and press enter or click 
OK using the left mouse button. 
 
Step 5: Load Master File(s) 
At this point, the screen will appear empty.  From the File Menu choose Add Master GPB 
File(s).  This adds the GPS data from each of the base stations.  Note that you need a 
minimum of 1 base station that overlaps the remote file in terms of data and time.  From 
the list of .GPB files, select the file(s) collected at the base station and select OK.  The 
program will load the .GPB file and then a dialogue box will appear prompting you to 
enter the appropriate master station coordinates.  The program will use the average 
coordinates by default.  It is important that you enter the proper coordinates if they 
known.  For multi-baselines this is especially important.  If your elevation value is 
orthometric then select the 'Enter MSL Height' button.  This will cause the mean-sea-
level (MSL) height to be converted to ellipsoidal.  Note that the difference between 
ellipsoidal and orthometric heights can be as large as 100 m. 
 
This is also a good time to select the processing datum.  Click the ‘Datum Options’ 
button.  Select the Datum from the list in the Processing Datum box.  In addition, be sure 
that the radio button labeled ‘Use processing datum by setting processing datum to local 
datum’ is selected.  See Chapter 10.5.2  for more information on Datums.  If the datum 
has changed, GrafNav will warn the user. 
 
Step 6: Load Remote File 
Once again, the screen will appear blank.  From the File menu choose Add Remote GPS 
File.  From the list of .GPB files, choose the file collected at the remote station and press 
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enter or click OK.  The program will then prompt you to enter the remote station antenna 
height.  Enter the height of the antenna or range pole (height of phase centre above 
ground!) and press enter. NOTE: This antenna height applies primarily to kinematic 
trajectories.  It will be overridden by features (stations/events) and static sessions.  
For changing the antenna height on static sessions, select Output | View Objects | 
Static/Kar, then select 'Edit' for each static session, see Section 2.6.7    If the antenna 
height is changing, then features must be used to define the antenna height at various 
points (see Section 2.6.6  View/Edit Features (Feature Editor)). 
 
Step 7: Select Processing Settings (Type of Data) 
From Options | Load Settings | <profile name>, select a profile that represents your data 
type, or select Factory Defaults.  <program defaults> is a default profile that can be 
created by the user. 
 
Step 8: Process 
From the Process Menu choose Process Differential.  A dialogue box will appear 
prompting you for more information.  For this tutorial, we will accept the defaults that are 
automatic.  For the static initialization mode select Float for kinematic initialization or 
Fixed Static if you have a sufficiently long static period at the start. Refer to Chapter 2  
Section 3  Processing Options for more information.  For long baseline processing (i.e. 
airborne) and dual frequency data, select ‘Use L2 for ionospheric processing’ from the 
Dual Frequency Options. 
 
Upon selecting Process, the program will begin post-processing your GPS data.  Note 
that it is a good idea to become familiar with the different modes of GPS processing, as 
you may have to use them for problem data sets. 
 
While the program is processing, “keep an eye” on the quality bar.  It should ideally settle 
down to a level of 1 or 2 and stay there if the GPS data is reasonably good.  The meaning 
of the quality number is given in Section 2.9.3  Processing Window.  If this bar spikes, it 
will probably coincide with a loss of lock or large phase and pseudorange RMS values, 
and possibly unstable ambiguity numbers and corresponding solutions.  For slower 
computers it may be possible to view the values during processing.  However, for newer 
faster units, epochs fly by at such a high speed that visual inspection is impossible.  This 
should not cause concern since all statistics are available from the Plot GPS Data function 
under the Output Menu. 
 
Step 9: Plotting and Quality Control 
Under the Output Menu, choose Plot GPS Data.  From the list of options you can show 
the following plots: 

Combined Separation If both forward and reverse processing was enabled, 
then this plot will show the difference.  Ideally, they 
should agree very well. 

RMS-C/A Code This shows how well the pseudorange measurements fit 
in the Kalman Filter.  Larger values (i.e. >5 m) are an 
indication of poor signal quality or multipath. 
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RMS-L1 Phase This shows the fit of the carrier phase.  If ionospheric 
processing was enabled, then this value includes L2.  
Values larger than 2 cm indicate noisy data.  On longer 
baselines, RMS values of 1-4 cm are typical. 

Float/Fixed Amb. Status Shows if the ambiguities are ‘floating’ or ‘fixed’.  Fixed 
indicates that the integer solution is solved for and a 
higher accuracy has been attained.  Single frequency 
and GrafNav Lite users will normally not see a fixed 
integer solution for kinematic data if the default settings 
are used. 

DOP-PDOP… This shows an indicator of satellite geometry.  Smaller 
numbers indicate a better geometry.  Values over 3.5 
are generally considered “poor”. 

Number of Satellites This shows a bar graph of the number of satellites used 
in the solution.  4 are always necessary, while 6 or more 
are considered “good”. 

Quality Number This is the same value displayed during processing.  
Lower is better.  See Section 2.9.3  for a description of 
the meaning of this indicator. 

 
Section 2.6.1 further describes the plotting feature. 
 
Step 10: Export Final Coordinates 
From the Output Menu, select Export Wizard.  Select the source for the solution.  Epochs 
will output the trajectory, while features will export any loaded features.  For 
photogrammetry users wishing to export interpolated camera positions, event marks must 
first be loaded (see Section 2.2.10  Loading Camera Event Marks).  After selecting the 
source, a profile must be selected.  Users can choose from a number of default profiles.  
Select Next.  For the Datum screen, just use the processing datum.  Users may also be 
prompted for the geoid undulation file.  The distribution CD contains a number of Geoids 
in the Geoids directory. 
 
See Section 7 for more information. 
 
This was a brief overview on how to load a file and process the data.  The following 
sections deal with each menu and the options that are offered in detail. 
 

Section 2   File Menu Options 

2.2.1   Starting a New Project 
File | New Project | File Name/Auto Start 
To process a baseline for the first time, you must start a New Project.  Choosing New 
Project from the File Menu prompts you to choose between “File Name” and “Auto 
Start”.  
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The “File Name” option allows you to choose a new name for your project.  Once a new 
name has been chosen, you must then go through all of the necessary steps manually.  
Auto Start automatically prompts you for all the information required to process a data 
set.  The following steps will guide you through the auto-start process. 
 
Create a new GrafNav project 
1.  Enter the new name of your project. 

 

 
Figure 2.1 Auto Start 

 
If you choose a name of an existing project, the project information will be overwritten.  
Auto Start works best, if the desired path is entered in this step. 
 
2.  Choose the master station file(s) (.GPB).   
 
This is the file collected at the base station.  Raw GPS data files must first be converted 
to Waypoint’s common format (i.e. .GPB).  See Chapter 7  for more information on 
converting data.  Waypoint’s data logging software can create .GPB files directly, which 
saves you from having to perform this step. 
 
3.  Choose the remote file (.GPB).   
 
Note: the base and remote station files MUST be collected at the same time.  For users 
that are not sure, click the ‘Plot coverage’ button to display the static/kinematic coverage 
plot. 
 
4.  Choose a setting and press OK. 
 
There are five preset settings, Factory Defaults, GrafNav Defaults, Airborne, Ground 
Vehicle, and Tree Cover.  Choose the settings those best fits, when in doubt just choose 
either the Factory Defaults or GrafNav Defaults. 
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5.  Enter the exact master station coordinates for each base station loaded. 
 
Entering the proper base station coordinates is essential for obtaining high accuracies.  
The values that appear are averaged from the GPB file, and may have errors of 10 or 
more meters.  For IGS and CORS stations, ARP (antenna reference point) coordinates are 
pre-loaded in the Favorites Manager (see Section 8   Favourites Manager for more 
information).  As always, datums are very important, and it should be noted that CORS 
sites are stored in NAD83 and IGS sites in WGS84.  WGS84 coordinates are different 
from NAD83 coordinates by ~2 m, so care should be taken when using these coordinates.  
Be sure to set the ellipsoidal/orthometric height flag correctly.  See Section 2.2.4  for 
more information. 
 
6.  Enter the remote station antenna height. 
 
You should enter the remote station antenna height at this point.  If you do not enter the 
antenna height, the ending height coordinates will include the antenna height, which will 
cause a vertical shift.  If you are only interested in the height of the antenna (above 
ellipsoid or sea level), then enter zero. NOTE: This antenna height applies primarily 
to kinematic trajectories.  It will be overridden by features (stations/events) and 
static sessions.  For changing the antenna height on static sessions, select Output | 
View Objects | Static/Kar, then select 'Edit' for each static session, see Section 2.6.7   
 
7.  Processing your GPS Data 
 
See Chapter 2  Section 3  Processing Options for more information on processing. 

2.2.2   Opening an Existing Project 
File | Open Project 
To open an existing project: 
 
1. Choose Open Project from the File Menu. 
2. A dialogue box will appear asking you to select the name of an existing project (.CFG 

file).  Choose the name of the project and press enter or click OK. 
 
The Auto Start feature can also be used to open an existing project.  The auto start option 
is under File Menu | New Project or under the Process Menu | Auto Start. 

2.2.3   Saving your Project File 
File | Save Project 
The program will automatically save your project file prior to processing.  Any changes 
made to features (i.e. name, time, antenna height, etc.) are also saved. 
 
Use the Save As command under the file menu to create a new project that has identical 
processing options as the current project.  This will allow you to change the options in the 
new project and process the data without losing the solution computed by the original 

26 



Chapter 2  GrafNav 

configuration.  This can also be done by viewing the processing history, see Section 
2.4.11 for details. 

2.2.4   Add Master File(s) 
File | Add Master File(s) 
When starting a new project, the program needs the master station information.  Binary 
measurement data is stored in our custom .GPB format.  This format is receiver 
independent and only stores necessary information to minimize disk space requirements.  
This format contains a position record, and the number of measurement records for each 
epoch.  GPBVIEW is a useful utility to inspect and modify this file (see Chapter 6  
Section 3). 
 
1. Choose Master GPS File(s) from the file menu after you have given your new project 

a name.   
2. From the list of available .GPB files select the files which contain the data collected 

at the base station(s).   
3. The program will then prompt you to enter the master station coordinates. 
4. Enter the coordinates of the base station in latitude, longitude and height.  Make sure 

the datum matches the one selected in the general options.  Selecting the elevation 
type (e.g. orthometric or ellipsoidal) will tell the Export Wizard whether nor not to 
apply a relative correction for orthometric height computations.  Note that this is the 
height used for computation.  Thus, if baselines are long (i.e. 300+km), users will get 
better results if they enter an ellipsoidal height directly here. 

5. Select either the simple or advanced antenna height model to use for your master 
station and press OK (see below). 
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Figure 2.2 Coordinate Options 

 
Coordinates 
Note:  The program calculates the average coordinates, but you should use the exact base 
station coordinates to improve accuracy.   This is especially important for multi-base 
projects, see Section 10.2.2  for an explanation why. Version 7.50 has coordinates for 
CORS, IGS, AUSLIG, IGN, ASI, BKGI, CDDIS, OLG and GSI stations pre-loaded in 
the Station Favorites (see Section 8  of this chapter for more information on the 
favourites manager).  Watch out for the datum that the coordinates are expressed in, as 
mismatching datums can add many meters of error (e.g. NAD83 and WGS84 are 
different by ~2 m). 
 
Users can also now enter the horizontal coordinates in Grid (e.g. UTM).  This is 
performed by pressing the ‘Enter Grid Coordinates’ button.  Setting the grid type and 
zone beforehand (Options->Grid) will make the initial values much closer to the real 
values. 
 
Datums 
If the coordinates are in a datum other than WGS84, make sure to select the proper datum 
in the general options.  For instance, NAD83 is different from WGS84 by approximately 
two meters. ITRF94+ is co-located with WGS84.  Users can still process in WGS84 but 
enter the base coordinates in similar datums such as NAD83.  The final result will be the 
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same.  However, selecting the proper datum is always suggested. There are two reasons 
for doing this: 

• Output files will contain the proper datum name, which avoid later confusion. 
• If favorites are selected from datums other than the processing datum, a 

warning will appear.  This is important since the IGS coordinates are in ITRF 
and not NAD83! 

• Accuracies on very long static baselines will be improved. 
See Section 2.3.11 for more information on datum options or Section 10.5.2 for a 
discussion on datums. 
 
Antenna Models 
The simple model and Generic profile for the advanced model are identical and assume 
that there are no horizontal, L1 phase, or L2 phase offsets from the antenna height 
measurement.  For each antenna height profile, the information can be obtained, added, 
edited, and removed.  Information from the dialogue box includes the antenna 
manufacturer, the name of the antenna, the horizontal distance from the phase centre to 
the edge of the ground plane, the L1 phase offset from the origin, the L2 phase offset 
from the origin, and the location of the origin on the antenna.  See Section 3.3.3   for a 
diagram.  The origin is set to one of five following settings and antenna heights are 
measured from unknown, the antenna base, the top of the ground plane, the bottom of the 
ground plane, or the measuring mark.  Users can also use a slant distance from the 
measuring mark/origin to measure to the ground plane instead of an antenna height.  
GrafNav uses Pythagorean Theorem to find the antenna height using the user defined 
slant distance and the horizontal distance in the antenna profile. 
 
Note: The antenna models are from the NGS.  They may not be using the measuring 
mark on the antenna as the origin.  This can add an error of several centimeters to the 
antenna height. Users should check each antenna model before using them.  Users should 
always ensure that the final overall vertical antenna height is from the monument to the 
L1 phase centre.  The greyed vertical antenna height box will show this value. 

2.2.5   Loading the Remote .GPB File 
File | Add Remote GPB File 
When starting a new project, the program needs the remote station information.  Binary 
measurement data is stored in our custom .GPB format.  This format is receiver 
independent and only stores necessary information to minimize disk space requirements.  
This format contains a position record and the number of measurement records for each 
epoch.  GPBVIEW is a useful utility to inspect and modify this file. 
 
1. Choose the Remote GPS File option from the file menu after you have given your 

new project a name and you have chosen the appropriate master .GPB file.   
2. From the list of available .GPB files choose the file collected at the Remote Station.   
3. The program will then prompt you to enter the remote station antenna height. 
4. Enter the antenna height and press enter.  For more details on antenna height models, 
please refer to Section 2.2.4. NOTE: This antenna height applies primarily to 
kinematic trajectories.  It will be overriden by features (stations/events) and static 
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sessions.  For changing the antenna height on static sessions, select Output | View 
Objects | Static/Kar, then select 'Edit' for each static session, see Section 2.6.7. 
 
Note:  If you do not enter the appropriate antenna height, the program will assume that 
the height was zero and calculate the Height based on this information.  If a .STA file 
exists and a station mark is present in that file, the last antenna height will show up by 
default. 

2.2.6   Choosing an Alternate Ephemeris or Adding IONEX 
and Satellite Clock Files 
File | Alternate Ephemeris Files 
 
Broadcast Ephemeris 
The ephemeris file contains trajectory information used to reconstruct the orbit of each 
satellite.  This data is necessary for any kind of GPS positioning.  Generally, the GPS 
receiver includes ephemeris data with its raw data files.  Either the decoder or the logging 
software will take care of converting these files to the .EPP format. However, the user 
should still sometimes monitor data logging and ensure that enough ephemerides are 
being saved.  Generally, new ephemerides are produced every 1-2 hours.  Receivers will 
also output ephemerides at startup or when satellites rise.   
 
Under normal circumstances, the combined base and remote ephemeris files contain 
enough ephemerides.  However, in some cases, one or both of these files have been 
corrupted, missed or does not contain all of the ephemerides needed.  In this case, another 
file such as that from the remote can be loaded.  This is done as follows: 
 
1. From the File Menu, choose ‘Alternate Ephemeris Files’. 
2. The program will display a list of ephemeris files (.epp), precise ephemeris files 
(.sp3), IONEX files (.yyI), or clock files (.clk).  Click Add to add .epp files to the project.   
3. Click OK. 
 
Ephemerides from different stations or precise ephemerides that span over a day can all 
be added to the list to be included with the processing.  Ephemeris files can be obtained 
by using the Download Service Data utility (Tools Menu).  Download the IGS file for the 
nearest station.  For precise ephemeris, select the options tab and enable precise 
ephemeris download. 
 
Precise Ephemeris 
The precise ephemerides are post-mission computed trajectories, which are more accurate 
than the broadcast ephemerides.  Since S/A is disabled, the differences between broadcast 
and precise ephemeris are minimal and the broadcast ephemeris should suffice for most 
applications.  Differences in final coordinates will only be observed on extremely long 
static baselines.  The use of precise ephemeris is highly suggested for single point 
positioning.  Geodetic services such as the NGS in the United States, the Geodetic 
Survey of Canada and some European agencies compute these orbits on a continual basis 
using a global network of tracking stations.  In most cases, this data is available a few 
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days after the actual mission took place.  The easiest way to download .SP3 (and other 
precise files) files is via Waypoint’s download program (see Section 6.9.2). 
 
GrafNav only supports precise orbits stored in the .SP3 format, which was originally 
created by the NGS.  Luckily, most agencies use this format.  Orbits, which have been 
optimized for the USA, are available free of charge from the NGS at the following 
Internet location: http://www.ngs.noaa.gov. 
 
To load a precise ephemeris file in the .SP3 format, follow these steps: 
 
1. From the File Menu, choose ‘Alternate Ephemeris Files’ 
2. The program will display a list of ephemeris files (.epp), precise ephemeris files 
(.sp3), IONEX files (.yyI), or clock files (.clk).  Click Add to add .sp3 files to the project.   
3. Click OK. 
 
It should be noted that GrafNav’s precise orbit implementation requires that a broadcast 
orbit also be available.  This file can be selected using the steps described in the 
broadcast ephemeris section.  Therefore, the precise ephemeris feature cannot be used to 
circumvent missed broadcast orbit information. 
 
IONEX and Satellite Clock Files 
IONEX (IONosphere Map EXchange) files contain information of the Total Electron 
Count (TEC) in a two dimensional grid.  For single frequency long range differential or 
single point processing, the information in an IONEX file can add corrections (helpful to 
the L1 frequency).  These are available for download using the download utility; see 
Section 6.9.2  for a list of producers available. 
 
Satellite clock files contain a list of biases that can be used to assist single point 
positioning, as the clock bias is differenced out in differential positioning.  The clock files 
can also be downloaded using the download utility, see Section 6.9.2  . 
 
To load IONEX files in the .yyI (yy being the year) format, or Satellite clock files 
(.clk), follow these steps: 
 
1. From the File Menu, choose ‘Alternate Ephemeris Files’ 
2. The program will display a list of ephemeris files (.epp), precise ephemeris files 
(.sp3), IONEX files (.yyI), or clock files (.clk).  Click Add to add .yyI or .clk files to the 
project.   
3. Click OK. 

2.2.7   Showing Master File(s) Information 
File | Show Master Files 
This command brings up the Object Menu for the base stations only. 
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The following features (buttons) are available: 
View This will bring up the Object Info message box for the selected 

object.   
View/Edit GPS This will display a list of actions that the user can view or change 

to the master file(s).  The user can do the following: 
- Show Station Info: Displays information about the station (name, coords, 

antenna height etc.) 
- Show GPB Info: Displays information about the GPB file (length, 

start/end times, interval etc.) 
- Show Time Gaps: Displays information about any time gaps in the data. 
- View Raw GPS Data: Opens the master file in GPB Viewer, see Chapter 6  

Section 3  for more information on GPB Viewer. 
- View Ephemeris File: Opens the .EPP file in the internal viewer. 
- View Station File: Opens the .STA file in the internal viewer.  The station 

file contains the following: 
a) Copy of RINEX header, which contains antenna type/name, data 

interval, marker information etc. See Figure 2.3 as an example of a 
RINEX header. 

b) Fixed Station name, antenna height, and position. 
c) Station Features 
d) Event Markers 

- Insert Static/Kinematic Markers: Opens up the menu to insert 
static/kinematic markers in the file.  See Chapter 6  Section 6  for more 
details on this feature. 

- Edit: This will allow you to edit the name, coordinates and antenna height 
for the selected base station. 

- Resample Fill Gaps:  Users have the following resampling options: 
 i) Resample to master interval – this will fill any data gaps. 

ii) Resample to processing interval – this will fill gaps and allow 
the user to either lower or increase the data rate.  To alter this rate, 
change the data interval from the General Options (see Section 
2.3.2). 
iii) Resample to Remote epochs – this will prodice a .GPB file 
with matching epoch times to the remote GPB file.  A data gap 
present in the remote will also be present in the master (after 
resampling, that is) as well.  This method serves two purposes: A) 
Removes unneeded data present before and after remote 
observation time period.  B) Allows resampling to remote GPB 
files that do not sample on a constant rate.  (e.g. SIRF, GSU I/II 
etc.) 
NOTE: Resampling can cause additional error. For original data 
intervals of 5.0 seconds or less, the error is negligible for kinematic 
processing.  However, for 30 second data, this error is 1-2 cm, and 
can hamper integer ambiguity resolution.  The original interval for 
RINEX files can be determined by viewing the corresponding 
.STA file.  Look for the ‘Interval’ header, see Figure 2.3.  Under 
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no circumstances should resampling be performed for static 
processing. 
 

 
Figure 2.3 RINEX .sta file header 

 
- Disable: This will disable the selected master station from processing and 

can be enabled later on. 
- Remove: Remove the master file completely from the project. 
- Plot L1 Locktime: Plots the L1 locktime plot. See Section 2.6.1  for 

details 
- Plot L2 Locktime: Plots the L2 locktime plot. See Section 2.6.1  for 

details 
Edit This will allow editing of the the name, coordinates and antenna 

height for the selected base station. 
Add to Favorites This will add the object with solution to the list of Favorites (see 

Section 8  of this chapter for more details). 

2.2.8   Loading a Station File (.STA) 
File | Load | Station File 
The program automatically loads the ASCII station file with the same name as your 
remote .GPB file.  If your station file has a different name than the .GPB file, then you 
will have to load the file separately.  Our data logging software and most of the decoders 
produce station files.  GrafNav now supports a new station format as well.  After loading 
a station file, they are saved to the project .NST file. 
 
1. Under the File Menu, select ‘Load’ then ‘Station File’. 
2. A dialogue box will ask you to choose a .STA file from the list. 
3. Choose the alternate station file and press enter. 
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2.2.9   Loading an Existing Solution 
File | Load | Existing Solution 
Opening an existing project that you have already processed does not automatically load 
the processed solution.  The .FWD, .REV or .CMB files contain all the information 
computed for each GPS epoch by GrafNav.  This feature allows you to load the solution 
from another project.  For instance, a .CMB file produced by the multi-base station 
combining process can be loaded this way. 
 
1. Under the File Menu, select ‘Load’ then ‘Station File’.   
2. Select a .FWD, .REV or a .CMB file.  The program will then read in the processed 

results. 

2.2.10   Loading Camera Event Marks 
File | Load | Camera Event Marks 
This feature can be used to load external time tagged events from an ASCII file.  The 
events must be referenced to GPS time (not UTC).  The source of the events may come 
from an aerial camera, sounding equipment or other real-time device, and the GPS 
receiver must support a mark or pulse input for this feature to work.  See photogrammetry 
options (Section 2.5.4  Photogrammetry Options) for a discussion on how GrafNav 
interpolates event positions. 

2.2.10.1   Where can I find Camera Event Marks? 
1. LOGGPS logging NovAtel data.  These are stored in the .STA file and should get 

automatically loaded with the remote file.  If they do not exist, then there may be a 
problem with the marks or they are located in another file.  Use the File-Load-Station 
File menu option to load them.  Numbering is performed by LOGGPS. 

2. Many new converters save the camera event marks directly to the station file.  In this 
case, there is no need to go through the process of this chapter.  To load events in this 
format, use the File | Load | Station File feature. 

3. *NovAtel raw binary data in the form of the MKPB or MKTB record. The NovAtel 
Converter (NOV2GPB) writes these marks to an external .MRK file.  Load using the 
NovAtel option.  Numbering is performed by NOV2GPB. 

4. Ashtech receiver with internal memory.  The HOSE or corresponding utility that 
downloads the receiver data should create a file called PHOTO.DAT.  Newer variants 
start with an M????.###.  This file contains the event marks and can be loaded by 
GrafNav using the Ashtech option.  The GMT date of the first event mark must be 
entered.  Numbering is performed automatically starting at 1. 

5. *Trimble 4000 series receiver.  The camera marks are located in the .DAT file and 
are automatically extracted by the Trimble Converter (TRIM2GPB) to the .STA file.  
This file has the same prefix as the remote .DAT and .GPB files.  The Trimble 
receiver performs numbering.  Older versions of GrafNav extract the events to a 
.SUM file. 

6. Leica .EV0 and .TDU files.  These are the event marks produced by the Leica 
software.  This can be imported using the Leica option.  This file may contain time in 
the local time zone.  If not, enter the time zone offset as zero.  The time zone 
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correction as well as the GMT date of the first mark must be entered.  Numbering is 
performed automatically starting at 1.  

7. LH Systems ASCOT (RC-30) has a format very similar to .EV0, except that it also 
has the relative angles of the camera mount.  This can later be used to apply a 3-D 
offset for the antenna/camera difference. 

8. *Leica SR series receivers store camera marks in a .EVT file.  During decoding, this 
file is converted to a .MRK file, which contains the event number and GPS time 
(seconds of the week).  This file can be loaded by selecting the .MRK. 

9. A number of User formats are also provided.  These allow users to import the time 
and name of each event mark.  Optional variables include line number, which comes 
across as the description.  In addition, attitude information can also be loaded (see 
below).  The time format may be seconds of the GPS week, GMT HH:MM:SS.SSS 
and local HH:MM:SS.SSS. 

* Pre-Version 7.00 files only 

2.2.10.2   How Do I Load Camera Event Marks? 
From the File Menu, select Load, then Camera Event Marks.  The following screen will 
appear. 

 
Figure 2.4 Load Camera/Event Marks screen 

 
1. File format - Described above. 
2. Pulse file name - Use the browse button to select the file of interest.  The file name 
depends on the receiver format and is explained above.  Normally, Ashtech is 
PHOTO.DAT, NovAtel is .MRK, Trimble is .SUM, and Leica is .EVO, etc… 
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3. User time format - This selects time format of the User1 to User5 formats.  They may 
either be GPS seconds of the week (0-604800), GMT hours (referenced to GPS time), 
minutes and seconds (HH:MM:SS.SSSS) or Local hours, minutes and seconds 
(HH:MM:SS.SSSS).  UTC time cannot be loaded and the correction must be applied 
externally. 
4. Local time correction - This is necessary for both Leica and user defined formats 
using local hours minutes seconds.  This is the number of hours offset from GMT.  For 
the Eastern Standard Time Zone, this number is 5.  For the Pacific Standard Time Zone, 
this number is 8.  During daylight savings time, these numbers are reduced by one.  An 
incorrect entry will cause the camera marks to not be displayed or to be displayed in the 
wrong place. 
5. GMT date of first record - This is necessary for Leica, Ashtech and user defined 
formats implementing hours minutes seconds.  It is the date (month/day/year) of the first 
exposure record.  It is not the date in local time, which may differ towards the end of the 
day.  An invalid date will cause the marks to not be displayed at all. 
6. Attitude Information – For user formats that include attitude information, a 
definition of attitude is required (how are the angles defined).  Currently, the following 
attitude formats are supported: 

i) Photogrammetric (w-p-k) – These angles are defined as omega primary, 
phi secondary and kappa tertiary (ground-to-air) 

ii) Camera (roll, pitch, drift) – These angles are the relative angles between 
the camera and aircraft’s frame 

iii) There are other formats listed, but their exact definition has not been 
defined yet. 

2.2.10.3   How do I know my marks have been loaded? 
Generally, if your raw GPS receiver data has positions, you should see the event marks as 
small cyan (bright blue) circles.  This is also the case if the data has been successfully 
processed.  In such a case, if no dots are present, then the times are usually wrong or no 
event marks have been loaded.  The Feature Editor is a very useful way of determining 
what has been loaded (select View/Edit Features from the Output Menu). 

2.2.10.4   How do I extract the coordinates? 
In order to obtain the coordinates from the camera marks, you must use the Write 
Coordinates option or the Export Wizard.  The Export Wizard is preferable because it has 
more datum options and it can apply a 3-D offset.  You must process before any 
coordinates can be exported. 

2.2.11   Importing TTP Names From Leica SR Into GrafNav 
Time tagged points  (TTP) created with Leica 5 data collector are named stations with 
position, time and antenna height information also available.  However, firmware 
versions 3.0 and greater do not store the station names within the .TTP file.  Rather, these 
names are stored within the database structure (control.db).  Unfortunately, Waypoint 
cannot access this file directly, and the point information contained within the database 
must be converted to ASCII, which is the IDEX file.  This feature can be ignored for 
Leica System 500 files. 
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The IDEX file can be created by Leica's Ski software.  Versions 2.2 and later allow the 
user to access this feature without a Ski hardware key, and Leica customers can obtain 
this software from their local dealer.  There should be no charge without the key. 
 
An IDEX file can be created, after downloading from the data collector.  Use the 
following steps: 
 

• Unplug your Waypoint hardware lock.  However, Ski lock is not required. 
• Run Ski 2.2 or higher.  This may take a while as it searches for a hardware lock. 
• Select Project 
• Select Manager, New 
• Select a path that is empty or open an existing project via Manager Open 
• Close the window by clicking on the "close file" icon 
• Select Import 
• Select measurement, back up/PCMCIA 
• Move to the Rover directory containing DS and .db files 
• Select jobs that you wish to include in IDEX file 
• Press the "Insert" button.  (This may take some time) 
• Press the "OK" button  
• Close the "Import" window by pressing the "close" icon 
• Select View/Edit 
• Select utilities, export to IDEX 
• Type in a meaningful name 
• Deselect variance/covariance information (optional) 
• Select "Measured" 
• Press the "Save" button.  (This may take some time) 
• Close the window by pressing the "close" icon 

 
Once an IDEX file has been created, it can be loaded into GrafNav.  This is done as 
follows: 
 

• Create or open a GrafNav project containing the correct Leica data 
• After processing, at least one direction, the TTP points should be visible and 

numbered 1,2,3…  These would have been loaded from the .STA file 
• From the file menu, select Load, and Leica IDEX file 
• Move to the directory containing the IDEX file created via Ski 
• You should see a message showing how many IDEX points were matched to TTP 

points.  Points are matched via their times.  Often there will be fewer matched 
points than the original number of TTP points due to several reasons such as:  
points deleted in the field, and/or static session marks being added 
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2.2.12   Loading Stations with Known Coordinates 
File | Load | Stations with Known Lat/Long 
This option allows users to load and display a file that contains the known station 
coordinates.  The known coordinates are displayed with pink triangles and pink lines, 
while the stations computed by the program have yellow triangles.  To join the stations 
and generate a pink line, include a + sign before each station ID in your file. 
 
File Name: 
Choose the file that contains your station information.  The default file extension is *.lat.  
If your file has an alternate extension, choose ALL FILES from Files of Type.  Any file 
can be chosen here as long as the coordinates are in one of the formats described below. 
 
Lat/Long Format: 
Your coordinates must be in one of the following formats: 
 
Degrees Minutes Seconds i.e.  51 03 28.3214 
Degrees Decimal Minutes i.e.  51 03.4720 
Decimal Degrees  i.e.  51.0579 
 
ID String Handling: 
This tells the program how to handle the file.  The first column is usually the station ID’s.  
The following will tell the program how to separate the ID from the Coordinates. 
 
Use First Continuous Word (no spaces: Use this if spaces separate your ID and 
Coordinates. 
 
Comma Separation: Use this if commas separate your ID and Coordinates. 
 
Use First ‘n’ columns: If you know where your coordinates start, you can enter the 
number for the program to begin at.  Each character is a column. 

2.2.13   Digital Elevation Models 
File | Load | Digital Elevation Model 
Please see Chapter 10  Section 4  for more information on DEMs. 

2.2.14   Viewing an ASCII File 
View | ASCII File(s) 
The View ASCII file command allows you to view any of the files generated by the 
program in ASCII format.  The ASCII files include Epochs Solution (.FWD or .REV), 
Message Logs (.FML or .RML), Static Summary (.FSS or .RSS), Station Files (.STA), 
Ephemeris File (.EPP), Output Files (.LAT, .UTM, .ST, .XYZ, .LAM, .LOC), and 
Configuration Files (.CFG). 
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1. From the View Menu, choose ASCII file(s) 
 
2. Change the list of file types option to show the extension of the file type that you 
would like to see or choose *.* to see all files in the current directory. 
 
3. Highlight the file that you would like to view and press enter. 
 
Right-click with the mouse to view additional features.  Such features include the ability 
to change the font.  Selected regions can also be copied for pasting in other applications. 

2.2.15   Viewing Raw Binary GPS Data 
File | GPB Utilities |View Raw GPS Data 
This option is also available under the process menu, under the View Master and View 
Remote options, or as a separate utility called GPB VIEWER.  This option allows the 
user to view and edit the binary GPS data in the .GPB format.   
 
Please refer to Chapter 6  Section 3 for information. 

2.2.16   Viewing Current CFG File 
View | Current CFG File 
This option allows the user to view the Configuration Files (.CFG) of the current project.  
The CFG file is just an ASCII file.  Also known as the project file, it contains all of the 
settings and options. 

2.2.17   Viewing Features 
View | Features 
Please refer to Section 2.6.6  View/Edit Features (Feature Editor) 

2.2.18   Viewing Objects 
View | Objects 
Please refer to Section 2.6.7  View Objects 

2.2.19   Removing Processing Files 
File | Removing Processing Files 
This option removes all the files associated to the current project or any projects in the 
directory.  These files include fml, fwd, fss, rml, rev, and rss files.  If the All Files is 
chosen, then all files with the above extension will be deleted.  If Current Project is 
chosen, only the files with the project name and the above extension with will be deleted. 

2.2.20   GPB Utilities 
File | GPB Utilities 
Concatenate, Slice and Resample – Please refer to Chapter 6  Section 4 for information. 
View Raw GPS Data – Please refer to Chapter 6  Section 3  for information. 
Convert GPB to RINEX – Please refer to Chapter 6  Section 5 for information. 
Insert Static/Kinematic Markers – Please refer to Chapter 6  Section 6. 
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2.2.21   Converting GPS Data 
File | Convert 
If you collected data using a program other than our logging software, then you must 
convert your files in order to use the GrafNav software.  Waypoint supplies several 
conversion utilities, which can be invoked from within GrafNav. 
 
Refer to Chapter 7 for more information on the Conversion Utility. 
 
Convert GPB to RINEX – Please refer to Chapter 6  Section 5 for information. 
 

Section 3   Processing Options 
Process Direction 
Forward  Process your data set forward (i.e. same time direction as it was collected). 
 
Reverse Process your data set reverse. This will start at the end in time and stop at 

the beginning. 
 
Both Process both forward and reverse.  After completion, the two solutions are 

combined, if the preference option is turned on, (see Section 2.5.2).  This 
method is most effective for kinematic processing.  For static processing, 
use either forward or reverse.  GrafNav has the ability to better combine 
static forward and reverse solution. 

 
Process Data Type  
Automatic: Tries to detect a dual frequency, single frequency or code only receiver data.  
This is the preferred process data type.  If two types of data are detected, the lesser of 
the two will be used.  For instance, if one dual frequency is combined with a single 
frequency, only single frequency processing will be utilized.  If L2 tracking is very poor 
(i.e. very few satellites are tracking L2), then a dual frequency GPS receiver may be 
detected as single frequency. 
 
Single Frequency: Process with C/A code, L1 carrier phase and L1 Doppler data in a 
combined Kalman filter.  Each of these data variables must be available.  Integer 
ambiguities can also be fixed using KAR or the fixed static solution (see below).  Single 
frequency is usually less reliable than dual frequency and has the disadvantage of not 
being able to correct for the ionosphere.  Single frequency is normally always more 
accurate than C/A code only.   
 
Dual Frequency: For GPS receivers that track L2 carrier phase, processing dual 
frequency has two benefits.  Integer ambiguity resolution (e.g. KAR and fixed solution) 
are much more reliable.  Resolution is much faster as well.  For instance, KAR can 
resolve in a few minutes what could take 10-20 minutes in single frequency.  Secondly, 
ionospheric correction can be enabled (see Dual Frequency Options).  This greatly 
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improves accuracies on baselines longer than 10 km.  Please note that processing dual 
frequency on single frequency data has no benefit, and may have adverse effects. 
 
C/A Code only: This will process in an advanced differential correction mode.  In 
kinematic mode, the accuracy will be the same as real-time differential (i.e. RTCM 
corrections).  In static mode, the accuracy will be higher due to the averaging effect.  
Normally, C/A only processing is only performed for data with no (or incomplete) carrier 
phase information. 
 
Occupation mode: This is a special mode of operation designed for use in high tree 
cover areas.  In this mode, the user should stay stationary over each point for 2-5 minutes.  
Carrier phase lock need not be maintained during travel between points.  Since the carrier 
phase is used in static mode (not kinematic) sub-metre accuracies can be achievable in 
such terrain.  GLONASS processing is also suggested to add additional satellites. 
 
Static Initialization 
Float Solution: The float solution does not solve for integer ambiguities.  This setting is 
also necessary for kinematic initialization.  Since integers are not solved for, the float 
solution tends to be less accurate than the Fixed Static solution.  For longer baselines 
(>10 km in single frequency and >30-40 km in dual frequency) integers are often not 
solvable.  In such cases, the float solution is the best alternative.  For dual frequency, be 
sure to enable the ionospheric free correction mode from the Dual Frequency Options. 
 
Fixed Solution: This setting processes the carrier phase in order to obtain a static fixed 
integer solution.  If the integers are correctly determined, this mode is the most accurate.  
For longer static baselines, an ionospheric correction is applied to the fixed solution.  See 
Fixed Static Options in Section 2.3.7.  For single frequency, a minimum of 10 minutes is 
required and 15 minutes is suggested. For dual frequency, only a few minutes will work, 
but users often choose to stay longer to lessen the likelihood that a point be re-observed. 
Note that time should be increased with baseline lengths for both single and dual 
frequencies. 
 
Kinematic Ambiguity Resolution 
Kinematic Ambiguity Resolution (KAR) is the process of solving for fixed integers on a 
moving antenna.  KAR will also engage in static mode if the ‘Engage KAR in STATIC 
mode’ setting is enabled in the KAR Options.  KAR is very useful to regain integer (high 
accuracy) positions at onset or after a loss of lock. 
 
Automatic KAR is enabled for dual frequency and disabled for single.  KAR 

is not applicable for C/A only processing. 
On Forces KAR to be enabled for single and dual frequencies.  Single 

frequency KAR can take 8-25 minutes to resolve.  In such a case, it 
should only be used with high quality receivers and open 
conditions. 

Off Forces KAR to never be engaged. 
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Manual Only KAR is only engaged at user selected times.  These times can be 
defined from the Advanced KAR Options. 

2.3.1   Processing Settings 
Process | Process Differential 
For differential processing, normally the Process button (or menu option) is selected.  See 
also Chapter 10  Section 1  Tips on Maximizing Accuracies for modifying these settings 
to optimize your solution. 
 
Main Processing Settings 
GrafNav provides several processing features allowing you to choose the options best 
suited to your application.  
 

 
Figure 2.5 Processing Options 

 
Process Direction 
Forward  
Process your data set forward (i.e. same time direction as it was collected). 
Reverse 
Process your data set reverse. This will start at the end in time and stop at the beginning. 
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Both 
Process both forward and reverse.  After completion, the two solutions are combined.  
This method is most effective for kinematic processing.  For static processing, use either 
forward or reverse.  GrafNav has the ability to better combine static forward and reverse 
solution. 
 
Process Data Type 
Automatic    
The feature automatically searches the data for dual frequency, single frequency or C/A 
code only.  If the master and remote files are of a different type, then the less of the two 
will be used.  The order is C/A only, single frequency then dual frequency. 
 
Single Frequency 
This will process with C/A code, L1 carrier phase and L1 Doppler data in a combined 
Kalman filter.  Each of these data variables must be available.  Integer ambiguities can 
also be fixed using KAR or the fixed static solution (see below).  Single frequency is 
usually less reliable than dual frequency and has the disadvantage of not being able to 
correct for the ionosphere.  Single frequency is normally always more accurate than C/A 
code only. 
 
Dual Frequency 
For GPS receivers that track L2 carrier phase, processing dual frequency has two 
benefits.  Integer ambiguity resolution (e.g. KAR and fixed solution) is much more 
reliable, and the resolution time is much faster.  For instance, KAR using dual frequency 
data can resolve in a few minutes what could take 10-20 minutes in single frequency.  
Secondly, ionospheric correction can be enabled with dual frequency data.  This greatly 
improves accuracies on baselines longer than 10 km.  Please note that processing dual 
frequency on single frequency data will have no benefit, and may have adverse effects. 
 
C/A Code only 
This will process in an advanced differential correction mode.  In kinematic mode, the 
accuracy will be the same as real-time differential (i.e. RTCM corrections).  In static 
mode, the accuracy will be higher due to averaging effect.  Normally, C/A only 
processing is only performed for data with no (or incomplete) carrier phase information. 
 
Occupation mode 
This is a special mode of operation designed for use in high tree cover areas.  In this 
mode, the user should stay stationary over each point for 2-5 minutes.  Carrier phase lock 
need not be maintained during travel between points.  Since the carrier phase is used in 
static mode (not kinematic) sub-metre accuracies can be achievable in such terrain.  
GLONASS processing is also suggested to add additional satellites. 
 
Static Initialization 
Float Solution 
The float solution does not solve for integer ambiguities.  This setting is also necessary 
for kinematic initialization.  Since integers are not solved for, the float solution tends to 
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be less accurate than the fixed static solutions.  For longer baselines (>10 km in single 
frequency and >30-40 km in dual frequency) integers are often not solvable.  In such 
cases, the float solution is often the best alternative.  For dual frequency, be sure to 
enable the ionospheric free correction mode from the Dual Frequency Options. 
 
Fixed Solution 
Process carrier phase in order to obtain a static fixed integer solution.  If the integers are 
correctly determined, this mode is the most accurate.  For longer baselines, an 
ionospheric correction is applied to the fixed solution.  For single frequency, a minimum 
of 10 minutes is required and 15 minutes is suggested. For dual frequency, only a few 
minutes will work.  However, users often choose to stay longer to lessen the likelihood 
that a point be re-observed. Note that time should be increased with baseline lengths for 
both single and dual frequencies.  Enabling this will solve fixed integers on all static 
sessions (see Section 2.3.7  Fixed Static Options).  Note that short time or long distance 
baselines may be disabled during processing.  See Section 2.3.3  Advanced Options 1. 
 
Kinematic Ambiguity Resolution 
Kinematic Ambiguity Resolution (KAR) is the process of solving  fixed integers on a 
moving antenna.  KAR will also engage in static mode if the ‘Engage KAR in STATIC 
mode’ setting is enabled in the KAR Options.  KAR is very useful to regain integer (high 
accuracy) positions at onset or after a loss of lock.  KAR requires 5 or more satellites and 
6 satellites are suggested. 
 
Automatic KAR is enabled for dual frequency and disabled for single.  KAR is not 

applicable for C/A only processing. 
On Forces KAR to be enabled for single and dual frequencies.  Single 

frequency KAR can take 8-25 minutes to resolve, and it should only be 
used with high quality receivers and open conditions. 

Off Forces KAR to never be engaged. 
Manual Only Only engage KAR at times specified in the Advanced KAR options.  KAR 

will not be engaged if there is a loss of lock 
 
GPS+GLONASS Processing 
Normally, GrafNav will automatically detect if there is GLONASS data.  However, if this 
detection fails or if the GLONASS data is causing problems, then satellite system type 
may need to be selected (i.e. GPS Only or GPS+GLONASS). 
 
Process Information 
The description information can be entered by the user of the processing run.  By default 
the program will use Run (1) and increment after each processing run.  The initials can be 
entered by the user to indicate who processed the data.  This information is stored in the 
processing history, see Section 2.4.11  for details. 
 
 
 

44 



Chapter 2  GrafNav 

2.3.2   General Options 
Settings | Individual | General 
Most commonly used settings: 

• Elevation Mask 
• Data Interval 
• Time Range 
• Datum 

 

 
Figure 2.6 General Processing Options 

 
Elevation Mask  
The default elevation cut-off for satellite processing is 10 degrees.  You may wish to raise 
this to 15 degrees, but we do not suggest that you lower it.  If the default is set too high, 
you may miss satellites that are important to the geometry of the position.  Lowering the 
number can cause noisy satellites to degrade the solution, 13 degrees works well for 
many airborne data sets. 
 
Data Interval 
The program automatically lines up both the master and remote data sets at the data 
collection rate.  If this is not desired, you may specify the interval at which you wish to 
process the data.  For the fixed solution, the Fixed Static interval will be use rather than 
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the Normal interval.  Processing with data in static mode with intervals shorter than 15 s 
is not beneficial.  In fact, it can result in overly optimistic accuracy estimates.  This is due 
to the high time correlation of carrier phase data over periods less than 15 seconds.  A 
smaller value (i.e. more data usage) will not improve accuracies.  If zero is entered for the 
interval, all epoch will be processed. 
 
Time Range  
Normally, GrafNav will process the entire data set.  This means starting at the first epoch 
the master and remote has in common and ending at the last.  Users may, however, wish 
to limit the scope of processing to avoid problematic time periods.  Such time periods are 
usually isolated from the data plots.  The beginning and end times are entered here.  
These times are for forward processing (i.e. begin time is before end time).  For reverse 
processing, GrafNav starts at the end time and stops at the begin time. The default time 
system is GPS seconds of the week (0-604800), but times can also be entered in hours, 
minutes and seconds.  These are in the GMT time zone (i.e. GPS time). 
 
Processing Datum   
Normally, the processing datum is the same as that where your base station coordinates 
are referenced to.  In this case, select the processing datum from the list.  Alternately, 
processing can be in a global datum such as WGS84, and coordinates can be entered in 
the local datum.  The second approach is more complex and should only be used by users 
who thoroughly understand datums.  Select ‘More Datum Options…’ to enable/disable 
datums and to enable coordinate input in a different datum than the processing datum.  
See 10.5.2  Datums for more information on datums. 
 
Omit Satellites 
This can be used to reject the following: 

a) One, or all satellites; 
b) For one or all baselines; 
c) On a specified time range or for all epochs 
d) From processing totally or just from integer processing (i.e. KAR 

and Fixed Static). 
 
An omission record consists of the preceeding information and numerous omissions can 
be added. 
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2.3.3   Advanced Options 1 
Settings | Individual | Advanced 
Most commonly used settings: 

• Carrier Locktime Cut-off 
• Write epochs containing bad data 
• Write cycle slips to message log 
 

 
Figure 2.7 Advanced 1 Processing Options 

 
Satellite Settings 
Base Satellite 
This is the satellite initially used as the base for the differenced observations.  For most 
cases, automatic selection is much preferred. 
 
L1 Carrier Locktime Cut-off 
The number of seconds of carrier phase lock before data for that channel is deemed 
usable.  This allows users to reject data for the first ‘n’ seconds since loss of lock.  The 
default value is 4, but higher numbers (8-12 s) can be very beneficial to some GPS 
receivers—especially low-cost ones. 
 
Velocity/Doppler 
Use Doppler Measurement 
Option to use Doppler measurement for Phase processing or Code-only processing.  For 
Phase processing is the default setting.  The Doppler is mainly used for velocity 
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determination.  One may wish to disable it if numerous Doppler error warnings are 
present in the message log. 
 
Dynamic Model 
This setting controls whether the constant velocity vehicle dynamic constraint is to be 
utilized.  The main purpose of this setting is to much improve velocity determination if 
the Doppler measurement usage is disabled (e.g. code-only processing). 
 
Generally this setting is best left at automatic, which is as follows: 

• Dynamic constrain Off if Doppler usage enabled 
• Dynamic constrain High if Doppler usage disabled 

 
Otherwise the user may select one of the following: 
 High – Vehicle dynamics (100 m position error due to velocity change) 
 Med – Vehicle dynamics (10 m position error due to velocity change) 
 Low – Vehicle dynamics (1 m position error due to velocity change) 
 Off – No constraint 
 
Output Filtering 
This group box has two options that allow you to customize the way GrafNav deals with 
bad data. 
 
Write epochs containing bad data 
This command forces GrafNav to print out all positions that it computes, regardless of 
whether it has deemed the data to be good or bad.  By default, GrafNav will not print 
positions for epochs for which the Kalman filter has detect large measurement errors.  
This option should only be used if you need a position for as many epochs as possible, 
and if you are not concerned about some low quality positions. 
 
Do not write epochs with poor statistics 
This option allows you to remove epochs from a solution that have quality numbers, or 
standard deviations greater than some threshold.  This option can be used to attempt to 
filter out bad positions from the output. 
 
Output Settings 
Trajectory output level 
This option allows you to select the format of the epoch output files. The Normal format 
is the format that GrafNav uses by default.  The ‘Extended’ format is identical to the 
‘Normal’ format, except it has additional fields for the relative vector information, 
position and velocity covariances and the ambiguity values.  You should use this format 
if you require the additional information.  The GrafNet format is suited specifically for 
GrafNet in order to minimize disk file usage.   
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Print input settings to static/KAR summary 
With this checkbox enabled, the processing settings will be printed at the start of the 
FSS/RSS file.  This can be useful for tracking which options were used for a same 
solution file. 
 
Write MB Binary values/satellite residuals  
When enabled, carrier code and residuals will be written to .fbv and .rbv files.  For MB 
processing, this setting will always be enabled.  See Section 9.1.4  on details of .fbv and 
.rbv files. 
 
Write cycle slips to message log 
With this checkbox enabled, satellite cycle slips and rising/falling messages will be 
printed to the FML/RML file.  This messages, although numerous, can be helpful in 
locating a problem satellite.  Disabling will create a much more concise message log. 

2.3.4   Advanced Options 2 
Settings | Individual | Advanced 
Most commonly used settings: 

• Fixed static tolerances 
• Save ambiguities on satellite drop-outs 

 

 
Figure 2.8 Advanced 2 Processing Options 
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Static Session Settings 
These parameters govern how GrafNav processes static baseline. 
 
Split if time gap greater than 
With this enabled, the processing software will treat time gaps greater than the tolerance 
as an indication of a new station occupation.  Enabling this setting is useful for two 
reasons: 

i. Raw GPS data has no kinematic epochs between static sessions. 
ii. Blockages are so severe that the receiver outputs no records between static 

sessions. 
 
Fixed solution usage 
GrafNav can compute a fixed static solution for any number of static sessions.  To 
prevent unreliable static fixes on very long baselines or short time periods, this page 
allows the user to specify maximum distance and minimum time tolerances.  There are 
separate controls for single frequency and dual frequency, as dual frequency can span a 
longer distance and requires less data.  In addition, the fixed static solution on individual 
static sessions can be enabled or disabled by right-clicking on a particular static session 
(select Edit).  Note that for these to take effect, Fixed Static must be enabled on the main 
processing screen. 
 
Cycle Slip Detection 
These parameters govern how GrafNav detects L1 phase cycle slips.  In general, GrafNav 
relies on a procedure of using the locktime read or computed in the decoders combined 
with a Doppler check.   
 
Static cycle slip tolerance 
This is the tolerance used to detect cycle slips in static mode.  Generally, there is no need 
to change this unless the user is processing extremely noisy carrier data, where this value 
may need to be raised.  In static mode, the fine static check is turned on. This allows 
GrafNav to detect very small cycle slips and is now by default ON. For the fixed solution, 
this is automatically used and cycle slips are also corrected.  To disable the cycle slip 
correction for the fixed solution add the user command (FIX_CORRECT_SLIP = OFF). 
 
Locktime counter 
In kinematic mode, the locktime cycle slip check uses flags generated by the GPS 
receiver.  This should normally always be enabled. 
 
Save ambiguities on satellite drop-outs 
Some receivers can be susceptible to periodically dropping satellites (with no loss of 
lock).  These are due mostly to serial data errors.  Without this setting enabled, these 
dropouts will be treated as a cycle slip.  Enabling this setting is especially beneficial for 
Ashtech receivers.  In some cases, it is better to interpret this loss of lock as a cycle slip.  
A good indicator that this checkbox should be disabled is if a filter reset message ($$$) 
follows the message ‘Prn # dropped out for #.#s on b/l ??? -- will try to save ambiguity’. 
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2.3.5   Measurement Options 
Settings | Individual | Measurements 
Most commonly used settings: 

• Measurement standard deviation (code and carrier) 
• Outlier detection/rejection level 
• Distance effects 

 

 
Figure 2.9 Processing Options 

 
Satellite Weighting Mode 
Elevation Based Satellites are weighted inversely according to the elevation 

angle (wf = 1 / sinε).  Using this mode is suggested. 
 
C/N0 Based L1 C/N0 can be used for weighting as well  

(f = V + 10CN0/10).  L2 C/N0 will be used for ionospheric 
processing (if available).  If L1 C/N0 is not available on all 
master/remote raw data files, weighting will revert to 
elevation based.  Before using this weighting mode, plot 
the C/N0 values for all files to verify: 
 a) That the data is available. 
 b) Values are in proper 30-50 dB range. 
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Some receivers output SNR or “signal counts” instead of 
C/N0.  Such recever data should not be used. 

 
Standard Uses a constant weight value for all satellites.  Using this 

mode is not suggested as baseline distance effects are 
disabled. 

 
Note that GrafNav’s weighting is relative rather than absolute.  The magnitude of the 
nominal elevation (45 deg) or nominal C/N0 (50 dB) is controlled via the measurement 
standard deviation values.  Scientific and advanced users can use the user command 
STD_REF for more controls (see Appendix A).  Also note that using the C/N0 base 
weighting should theoretically produce “best” weight.  However, scientific testing has not 
shown this to be the case.  In addition, C/N0 values vary from receiver to receiver and 
may have a time lag associated with them.  Many do not output C/N0 at all.  Therefore, 
using C/N0 based weighting can actually be hazardous. 
 
Measurement Standard Deviations 
Code SD Controls the standard deviation at reference elevation or C/N0 for 

C/A, P1, and P2 codes. 
 
Carrier SD Controls the standard deviation at reference elevation or C/N0 for 

L1 carrier.  Adjust for iono will adjust the carrier standard 
deviation for additional error resulting in L1/L2 combination. This 
should be on. 

 
Doppler SD Controls the standard deviation at reference elevation or C/N0 for 

the Doppler.  Automatic causes 0.25 or 1.0 m/s to be used 
depending if the receiver type measures Doppler. 

 
These values are normally set for all baselines.  However, individual baseline settings can 
be altered.  In such a case, the baseline name will have a ‘*’ appear next to it. 
 
Outlier Detection/Rejection 
These settings control how the processing engine rejects bad satellite measurements using 
the residuals.  Basically, it rejects based on “sigma tolerances”, which are the number of 
standard deviations needed to flag an outlier.  There are two levels of outliers: 
 

a) Rejection – An attempt is made to reject satellites, measurements or 
baselines.  If too many continuous rejections are encountered, a reset is 
issued. 

b) Reset – For very large errors, cycle slips are issued to all satellites (which 
is called a reset). 

 
The easiest way to control the “amount of rejection” is to select one of the levels.  
Possible levels include: Normal, strict phase, strict code, strict both (code+phase) loose 
phase, loose code, loose both (code+phase) or manual.  In the manual mode, users can 

52 



Chapter 2  GrafNav 

enter the exact rejection and reset values for each measurement.  In general, users may 
wish to use a stricter phase tolerance in reduce the number of visible spikes in the carrier 
RMS plot—especially for the carrier phase. 
 
Advanced Reset Settings 
None of these values would be commonly changed by the user.  However, power users 
do have access to them (see Figure 2.10).  

 

 
Figure 2.10 Advanced Reset Settings 

 
Maximum continuous rejections before reset is engages – This is the number of seconds 
of continuous rejections before a reset is engaged.  Some high data rate kinematic 
applications may find it appropriate to lower this value. 
 
Epochs to skip before reset induced on code error – On occurrence of a code error, the 
processing engine can attempt to reject an epoch’s data.  This may prevent a reset, but at 
the expense of a position drop-out.  Users may wish to lower this value to permit fewer 
missed epochs. 
 
Epochs to skip before reset induced on phase error – This is similar to that above, except 
for the carrier phase.  In general, one or two epochs distinguish between a one epoch 
carrier spike (which disappears) and a missed cycle slip (which acts as a step function on 
the carrier residuals).  Only the former can be handled by skipping an epoch. 
 
Reliability tolerance for rejecting satellites or baselines – This is the ratio between the 
second best residual and the best residual necessary to detect an successful satellite or 
baseline removal.  Generally, this value is left at 4.0, but it can be lowered (if a correction 
is missed) or increased (if incorrect corrections are occurring). 
 
Distance Effects (PPM Error) 
To properly account for distance dependent error sources, a parts-per-million (PPM) 
value is added to code and carrier phase measurement standard deviations.  A PPM is 
added for the horizontal (spatial) distance and the vertical (height) distance between each 
master and the remote.  The easiest way is to select the “error amount” which can be: 
Small, Medium or Large.  Large would be used during a heavy ionospheric disturbance.   
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In addition, Large would cause a stronger weighting on the nearest base station.  The 
actual PPM values used for each of these levels is determined by the processing engine 
and is dependent on the type of processing.  To view the PPM values used, bring up the 
Static/KAR Summary file after processing.  For example: 

; Measurement Weighting Options: 
;   Weighting Mode : Elevation Based 
;   Main SD Values :  
;     Code SD      : 4.00 m 
;     Phase SD     : 0.0200 m, (adjusting for iono. correction) 
;     Doppler SD   : 0.250 m/s 
;   Baseline Values:  
;     2530         : Using Main SD Values 
;     cosa         : Using Main SD Values 
;   Reject. Level  : NORMAL 
;   Max Rej Sec    : 15.0 (s) 
;   Skip Code Rej  : 5 nEpochs 
;   Skip Phase Rej : 1 nEpochs 
;   Reliability Tol: 4.00 , (for rejecting bad satellites) 
;   Dist. Effects  : Medium, (HzPPM: 0.6, VertPPM: 5.5) 

 
Manual distance effects can be entered as well.  In this case, the user would enter the 
horizontal and vertical values directly.  Finally, this effect can be disabled, but this is 
NOT suggested—especially for multi-base processing. 

2.3.6   L2/Ionosphere Options 
Settings | Individual | L2/Ionosphere 
GrafNav supports full dual frequency processing.  For this feature to work, both the 
master and remote receiver must be dual frequency GPS receivers. 
 
Most commonly used settings: 

• Use L2 for dual frequency ionospheric processing 
• Correct C/A for ionospheric using dual frequency data (500+ km only) 
 

Advantages 
By making measurements on both L1 and L2, the ionosphere error can be resolved.  The 
effect of the ionosphere under normal conditions and in the absence of ionospheric 
storms is a small effect at 0.5 - 2 PPM (5-20 cm per 100 km).  Because L1 and L2 carrier 
phase need to be combined to remove the ionosphere, the measurement noise will 
increase from sub 1 cm to 1-3 cm.  A further problem occurs because L2 is more prone to 
cycle slips.  For the ionospheric-free model, a cycle slip on L2 will induce a total cycle 
slip for that satellite. For the relative ionospheric model, this is not the case making it less 
sensitive to L2 slips.  However, this adds additional noise to the solution, which can 
sometimes cause the relative model to be less accurate.  Generally, ionospheric correction 
becomes beneficial on baselines greater than 10 km. 
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Another good reason for employing dual frequency is to improve the reliability of integer 
ambiguity search techniques.  By combining the L1 and L2 carrier phase the so-called 
widelane is formed.  These techniques are employed for Fixed Static and Kinematic 
Ambiguity Resolution (KAR).  The result is that these techniques will work much more 
reliably, solve on longer distances and require less observation time. 
 

 
Figure 2.11 Dual Frequency (L2/Ionosphere) Processing Options 

 
Ionospheric Correction 
Use L2 carrier for dual frequency Ionospheric Processing 
Once selecting this option, either the relative ionospheric or the ionospheric free type 
must be selected. 
 
Ionospheric Free Model 
This can be used for static or kinematic.  The Iono-free solution will do a better job of 
resolving the ionospheric error at the expense of being more susceptible to cycle slips.  
Static baseline should only use this method. 
 
For choosing between Iono-Free and Relative Iono Models there are several rules of 
thumb: 

• If the L2 data is very clean with minimal losses of lock, then the iono-free 
model often works better. 

• If the L2 data is continually losing lock, then the Relative model can be better. 

55 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

• The relative likes to start close, but it is not necessary.  In many cases both 
models will give similar results. 

• It is also often a good idea to try both models.  Sometimes one will work quite 
a bit better than the other. 

• Iono-free should be used in static.  It will aid the fixed static solution if the 
iono noise model is used. 

Generally, for most GPS receivers, iono-free is superior to the relative model. 
 
Relative Ionospheric Model 
This is normally used when static initialization occurs when the base and remote are close 
and the ionospheric error at that base-remote separation can be assumed to be zero.  
Using the relative transfer algorithm, the ionospheric error is accumulated as the base and 
remote get farther apart.  The distance from the base station when the relative transfer 
starts can be set using the Engage Distance.  If loss of lock occurs, then this ionospheric 
transfer cannot continue.  After this point, this solution becomes very similar to the 
ionospheric free model.  Because of this last feature, the relative model can be used even 
if the starting point is far from the base.  Since the relative model is less sensitive to L2 
cycle slips, choosing this model might work better on data with frequent L2 cycle slips. 
 
Engage Distance for Relative Ionosphere 
This parameter is combined with relative ionospheric processing and it sets the radius 
from the base station before the relative ionospheric correction starts.  This is an 
advanced parameter and changing it will cause little difference in the final solution.  
Users may wish to lower this value during periods of high ionosphere activity. The 
default value is 4.0 km. 
 
Correct C/A code for Ionosphere 
By combining the C/A code and the P2-code, the ionospheric effect can be removed from 
the pseudorange measurement.  However, this adds additional noise on the order of a few 
meters.  Thus, baselines need to be very long before the effect of the ionospheric is larger 
than the additional noise induced.  Generally, baselines need to be 500 km or more in 
length. 
 
Correct Single Frequency using IONEX or broadcast model which must exist 
IONEX files contain information relating to the ionosphere on a given day.  It can be 
used with single frequency processing to assist in the ionospheric modeling process. They 
can be downloaded using the download utility, see section 6.9.2  for more information on 
IONEX files and downloading them.  To add them to the project, see Section 2.2.6  in 
adding precise ephemeris, satellite clock, and IONEX files. 
 
L2/P2 Measurement Usage 
Process Single Frequency L2 instead of L1 (Special Applications) 
This mode utilizes L2 for carrier and P2 for code, and is most appropriate for special 
applications, such as: 

a) GPS simulator testing 
b) P-Y code receiver testing 
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c) Operation during Jamming using a P-Y code receiver 
For civilian receivers, there is no benefit to using this mode of processing. 
 
Use P1 instead of C/A Code in the Kalman Filter 
By default, the processing engine uses C/A for processing in the Kalman filter.  Some 
receivers can deliver better performance if the P1 code is used instead.  Note that this 
requires the NEW GPB format.  In addition, P1 code data must be present (see View | 
GPS Observations | Station | View Raw GPS Data). 
 
Use P2-Code in Kalman Filter  
Under normal circumstances P2-code measurements are not employed.  This is because 
most dual frequency receivers use narrow correlators (or similar technology) for their 
C/A code measurements and these tend to be more robust and reliable than the P2-code.  
Enabling this feature will add this measurement to the Kalman Filter thereby possibly 
improving convergence. 
 
L2 Cycle Slip Detection 
L2 Small Cycle Slip Tolerance 
Both KAR and relative ionospheric processing check for small cycle slips on L2 by 
comparing it against the L1 phase.  Raising this value too high will increase the chance of 
a half cycle slip being detected.  Lowering this value may cause false cycle slips to be 
induced by noise.  Changing this value requires analysis of the results and should only be 
done by advanced users. 
 
Utilize L2 Locktime Variable if available 
In general, the default method of L2 cycle slip detection which compares L2 against L1 is 
superior and generally results in less false detection.  However, the user has the option of 
using the L2 locktime variable which utilizes the cycle slip detection of the GPS receiver.  
Watch out if too many cycle slips are being detected.  If this is the case, you will see 
many more warning in the message log if Static Slip warnings are enabled from the 
Advanced 1 Settings.  In addition, the forward or reverse position estimated accuracy 
may be higher (if ionospheric processing is used). 

2.3.7   Fixed Static Options 
Settings | Individual | Fixed Solution 
The search region size can be controlled along with the L2 noise model (see Advanced 
KAR). 
 
Most commonly used settings: 

• Refine L1/L2 integer solutions 
• Stricter RMS tolerance 
• Stricter reliability tolerance 
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Figure 2.12 Fixed Static Processing Options 

 
Search Area Options 

Normal This is the default search area, which is a constant search region 
size. 

Auto-reduce  An auto-reducing search area is helpful for situations where the 
fixed solution is failing the reliability tests.  Normally, this would 
be the case on short baselines, possibly with single frequency 
measurements. 

User A user defined search area is not often used.  However, if the float 
solution is known to converge very close to the correction solution, 
then enter zero here. 

 
Ionospheric Noise Modeling 
The Ionospheric noise model controls how the L2 measurements are treated in the fixed 
solution.  Due to anti-spoofing, L2 can be noisier than L1.  Therefore, on shorter 
baselines, a noise model placing more weight on L1 (i.e. Normal L2 Noise) can deliver 
better results. 
 

Normal This is similar to the High noise model for KAR. 
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Iono This noise model corrects for the ionosphere in its computation.  
This can improve accuracies, but noise might be higher on short 
baselines. 

Automatic This noise model chooses between Normal and Iono based upon 
the distance tolerance given. 

 
General Options 
For more detail about the following options, please refer to Section 2.3.8. 

Refine L1/L2 integer solutions This setting can be helpful in obtaining more 
accurate integer fixes.  However, it can also 
result in poorer results.  Generally, it helps 
more than it hurts.   

Stricter RMS tolerance This option applies lower tolerance to the 
RMS value of the best intersection. 

Stricter reliability tolerance The reliability is the ratio of the carrier RMS 
values between the second best and best 
intersections.  Enabling this checkbox will 
apply a more stringent tolerance. 

2.3.8   KAR 1 Options 
Settings | Individual | KAR 
Kinematic Ambiguity Resolution (KAR) is a technique that allows the user to compute 
an integer fixed solution (i.e. 2 cm) while the remote antenna is in motion.  Typical 
applications would be kinematic initialization and initialization after loss of lock. 
 
A KAR solution that uses dual frequency data is considerably more reliable than if only 
single frequency data is available.  This is due to the additional measurements present 
with the L2 phase.  However, KAR can deliver accurate results with single frequency, it 
just takes longer.  Secondly, both single and dual frequency KAR requires at least 5 
satellites.  If KAR fails after a given length of time, then it starts searching over again. 
 
KAR may skip some data after loss of lock, but it will try to go backwards as far as 
possible.  The .FSS or .RSS file (Static/KAR summary) will show when KAR was 
engaged and when it was restored.  Additional KAR statistics will also be shown here. 
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Figure 2.13 KAR 1 Processing Options 

 
Minimum Time 
Single Frequency 
This is the minimum amount of time before KAR is invoked for single frequency.  The 
default value is 8 minutes.  This value should not be set to lower than 5 minutes unless 
azimuth determination is enabled in GrafMov. 
 
Dual Frequency 
This is the minimum amount of time before KAR is invoked in dual frequency mode.  
The default value is 1.0 minute.  Users may wish to lower this value for urban data sets 
where fast ambiguity determination is very helpful.  Longer baseline airborne users may 
wish to increase this number to minimize the effect of the ionosphere. 
 
The value to the right is added to the time for every 10 km that the remote is from the 
base.  For instance, if a dual frequency receiver is used, and the base-remote separation is 
20 km, then the overall minimum time will be 1.0 min + 1.5 min*20/10 = 4 minutes. 
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Search Region Size 
Single Frequency 
This is the size of the search area for single frequency KAR.  Because the single 
frequency KAR is invoked after 8 minutes or so, this value can be quite small.  The 
default value is 1.0 m.  Valid values range from 80 cm to 1.2 m. 
 
Dual Frequency 
For dual frequency KAR, there are two ways to determine the search area: 

a) Use a fixed search range (e.g. 4.0 m by default).  This value is often 
lowered to 2-3 m to speed up KAR resolution time (used by fast KAR). 

b) Auto-reduce, which means that the covariance information is used for 
search area estimation.  To ensure that the entire search area is 
encompassed, the ambiguity standard deviation is multiplied by a factor 
(e.g. 3).  If a user feels that the standard deviations are overly optimistic, 
then raising this factor can be helpful.  This mode is suggested. 

 
Maximum Distance 
Maximum distance for single/dual frequency 
KAR will not engage if the remote is too far from the base.  This improves reliabilities.  
The distance tolerance for engaging KAR in both single and dual frequency is defined 
here.  Normally, the maximum allowable distance for single frequency is 7.5 km, while 
for dual frequency it is 30 km.  These values are designed for a period where the 
ionospheric activity is high (i.e. year 2000).  In subsequent years, these tolerances can be 
lengthened.  This option (i.e. ‘Maximum engage distance’) only controls when KAR is 
started.   
 
Options for Engaging KAR 
Engage KAR while in STATIC mode 
Normally, KAR will not engage in static mode.  This is to allow static processing 
methods to take precedence.  However, for users that wish to engage KAR in static, the 
option ‘Engage KAR while in STATIC mode’ should be enabled.  Be cautious when 
combining this with the fixed static solution, as KAR’s solution may supersede that of the 
fixed solution in certain circumstances. 
 
Engage if distance < (tol1), reset if > (tol2) 
This method of engaging can be very useful for airborne multi-base processing 
applications where the aircraft flies over various base stations.  It will engage the first 
time that the distance is closer than tol1.  If the distance becomes greater than tol2, then a 
flag is reset and tol1 will be tested again.  Note that all distances are in kilometres. 
 
Engage KAR Continuously 
This will engage KAR at a specified interval, and is most often used in monitoring 
applications.  This value is usually set around 5-20 minutes.  As this mode makes no 
attempt to check either baseline distance or data quality, it should be the least desirable 
mode for engaging KAR in airborne data.  Consider using ‘Engage on distance’, engage 
on DOP or or Manual engage instead. 
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Engage on Poor DOP 
The number of cycle slip free satellites to maintain lock is four.  In some cases this 
minimum is maintained, but the geometry of these satellites is very poor.  This can be 
seen as a spike in the DD_DOP plot.  If the DD_DOP is extremely poor, the plot will not 
show the large DD_DOP as GrafNav skips past these epochs as their accuracy can be 
suspect.  This will cause a gap in the data.  The default DD_DOP tolerance is 100, but 
this can be changed using the DOP_TOL command. 
 
Setting this checkbox will engage KAR after the DOP recovers from being very poor.  
The default tolerance is 25, but users may wish to increase or decrease this to control how 
KAR reacts at a poor DD_DOP.  Note that KAR automatically engages if the DD_DOP 
is greater than DOP_TOL (i.e. 100) regardless of this setting.  For DOPs above the 
DOP_TOL (i.e. 100), the solution is not available so users will need to view the .FML 
and .RML files for occurrences. 

2.3.9   KAR 2 Options 
Settings | Individual | KAR 
Most commonly used settings: 

• Stricter reliability tolerance 
• Stricter RMS tolerance 
• Use fast KAR 
• Refine L1/L2 KAR search 
• L2 Noise Model 
• Manual KAR Engage 
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Figure 2.14 KAR 2 Processing Options 

 
Control Settings 
Stricter Reliability Tolerance 
The reliability is the ratio of the carrier RMS values between the second best and best 
intersections.  Larger values indicate increased reliability.  The tolerance for accepting a 
reliability number is dynamic within GrafNav.  Enabling this checkbox will apply a more 
stringent tolerance.  Basically, a bias is added to the existing dynamic tolerance to make 
the tolerance stricter.  This setting would be used to reduce the occurrence of incorrect 
KAR intersections.  The reason that users may not wish to use this all the time is that it 
can cause to KAR to take longer to resolve or sometimes not resolve at all. 
 
Stricter RMS Tolerance 
This option is similar to the above except that it applies a lower tolerance to the RMS 
value of the best intersection.  The tolerance, normally 0.065 cycles, is lowered to 0.05 
cycles.  The tolerance can also be altered using the KAR_RMS_TOL command.  If this 
command is used, then this option will further lower the tolerance by 0.015 cycles.  Like 
before, setting this will reduce incorrect KAR intersections.  In fact, of the two, this 
feature is usually more effective.  Some users may wish also to use both. 
 
Use Fast KAR 
Check this box to enable fast kinematic ambiguity resolution. Upon its selection, the user 
has the option of further specifying if they wish to also engage fast KAR even if only five 
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satellites (the minimum required for KAR computations) are present. Note that solutions 
computed using five satellites tend to be less reliable. 
 
Fast Kinematic ambiguity determination, while not necessary in most GPS work done 
today, can be of large benefit to certain applications. Some examples of these 
applications include race car or rocket trajectory determination, some types of road 
surveys, and other surveys under generally open conditions with scattered obstructions of 
the sky. It can also be used to independently verify a KAR solution if different KAR fixes 
are obtained in forward and reverse processing. 
 
By default, GrafNav will compute a float solution for 1 minute + 1.50 minutes/km (dual 
frequency) or 8 minutes + 1.50 minutes/km (single frequency) upon a kinematic 
initialization or following a simultaneous loss of lock on a sufficient number of satellites. 
This typically provides enough data to reliably resolve satellite ambiguities under 
reasonable GPS conditions. 
 
As long as KAR successfully resolves, GrafNav will restore the ambiguities in the data 
from the moment it engaged so that centimetre accuracies are only unavailable for the 
actual period of signal obstruction. Hence, as long as no additional complete signal 
obstructions are encountered following the initial loss of lock, KAR will generally 
successfully resolve given good quality phase measurements and low multipath. 
 
There is a problem with this methodology if your GPS survey is performed in an 
environment littered with signal obstructions. In this case, KAR may not resolve as it 
could have less data between successive losses of lock than the minimum time specified 
in the KAR options. Therefore engaging the fast KAR option will make several internal 
changes to the processing options. These changes include: 
 

• Reducing the minimum KAR time to 0 minutes + 0 minutes/km 
• Reducing the maximum time before KAR is started over to 8 minutes 
• Increasing the amount of data KAR uses in its computations 

 
The first change has the effect of telling GrafNav to resolve the ambiguities as quickly as 
possible. The second change forces KAR to be recomputed more often, and the third 
change helps reduce the amount of time KAR requires to resolve by increasing the 
amount of data it uses. 
 
The following options are recommended only for dual frequency GPS users, as fast single 
frequency ambiguity determination is inherently unreliable. As well, before users should 
consider using fast kinematic ambiguity resolution, they should be aware of its 
limitations. Fast KAR is generally only reliable under the following conditions: 
 

• Relatively close master-remote separations (< 7 km) 
• Many (7 or more) satellites in view above a 10-degree elevation mask 
• Dual frequency measurements are available 
• Low multipath environment 
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• Clean carrier phase measurements 
 
Even so, we recommend using Fast KAR only if needed. 
 
Use Fast KAR even for 5 SV's 
Five satellites is the minimum required for KAR computations. It is therefore risky to use 
fast kinematic ambiguity resolution in this situation. However, given otherwise 
favourable conditions (low multipath, clean phase measurements and a close master 
remote separation), it can be used successfully. 
 
For more information regarding fast kinematic ambiguity determination, it's applications, 
limitations and accuracy, we refer you to the report titled "Fast Kinematic Ambiguity 
Determination in GrafNav v.6.03" located in the technical report section of our website 
(www.waypnt.com). 
 
Refine L1/L2 KAR Search 
When this option is checked a more intelligent methodology is used to correctly compute 
intersections. Sometimes ionospheric noise or carrier multipath can make it difficult to 
determine the carrier L1/L2 ambiguities. With this setting on, an additional search is 
performed. This can lead to faster and more correct ambiguity resolution. This setting 
also works well in combination with the stricter reliability / RMS tolerance setting – 
especially when accuracy improvement is the goal. 
 
Distance Settings 
Search only for closest base (or < 8 km) 
This checkbox only applies for multi-base processing, and it causes KAR to utilize the 
closest base station (or those which are closer than 8 km).  Disabling causes all base 
stations to be used and is normally not desirable.  If a certain base station causes suspect 
fixes due to poor quality data, then consider disabling it (View | GPS Observation | 
Master ___ | Disable) or omitting it from KAR usage (see General Option, omit settings). 
 
Maximize Long Baseline Data Useage 
With this setting disabled, KAR stops using data as soon as the remote is significantly 
longer than the maximum distance.  This can result in minimal data being used; thereby 
causing lower reliability.  Will this setting enabled, all usable data less than maximum 
distance is utilized by KAR. 
 
Use Distance Weighting 
KAR has the ability to weight by the inverse of the base-remote distance (baselines 
shorther than 6 km will not be affected).  This is helpful for airborne data as the effect of 
the ionosphere is distance dependent. 
 
Advanced 
Maximum Allowed DOP 
KAR will not search if the DD_DOP is greater than this tolerance.  This is to preserve the 
reliability of the solution.  KAR solutions with high DOPs can be unreliable.  However, 
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raising this value allows KAR to search where otherwise the software would skip past 
this data.  The default value is 9.0. 
 
Restart Search After 
This is the time length before KAR will start searching over again.  Lowering this value 
can cause fixed integer gaps to be lower.  However, KAR will be prevented from using 
more data than indicated.  This is more practical for dual than single frequency because 
single frequency KAR often needs 15 or more minutes to resolve.  The default value is 30 
minutes and this value is normally left ‘as is’. 
 
Search on data interval 
This defines how many seconds between epochs that KAR will use for processing. 
Generally, if carrier phase errors are random (i.e. white noise), then using a lower interval 
will improve results at the expense of memory usage and computational time.  If errors 
are systematic (i.e. colored/ionospheric noise), lowering this value will help little. 
 
Exact interval (for interpolating data) 
GPS data can be interpolated with the ‘Concatenate, Slice and Resample’ utility or using 
the ‘Download Service Data’ feature.  In either case, additional errors of 1-2 cm can be 
added to measurements, which is sufficient to cause KAR not to work.  However, if the 
‘Exact Interval’ check box is enabled and the data interval ‘Use on interval’ has been set 
to the original source data interval (e.g. 30 s), then KAR will not be affected.  Users may 
also wish to lengthen the minimum KAR time (KAR Options) to use more data, as one 
point every 30 seconds is quite sparse. 
 
L2 Noise Model for KAR 
KAR supports a number of L2 noise models, which model how GrafNav handles L2 data 
in dual frequency KAR.  Due to anti-spoofing, L2 can be significantly noisier than L1 
and this difference must be taken into account.  The following noise models are available 
for L2: 
 

High This is different than the Version 6.01 (and previous) high noise 
model.  It is more robust and is less susceptible to ionospheric 
noise. 

Iono This noise model corrects for the ionosphere, and seeds the 
ionospheric correction algorithms forming a more accurate KAR 
fix. 

Medium This is the old high noise model.  There should be few cases where 
it performs better than the new high noise model. 

Low The low noise model places more weight on L2.  It normally does 
not perform as well as the previous noise models, but for short 
baselines it may be helpful. 

Automatic The automatic noise model is the default, and it chooses between 
the High and the Iono noise model depending on the current 
distance.  The distance tolerance is specified in the dialogue box. 
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Manual KAR Engage 
Users can manually engage KAR at times that they feel it is necessary.  For instance, 
there may be a perfect time when an airborne platform is very close to the base.  In such a 
case, also consider lowering the minimum KAR time.  The user must specify the time of 
engagement as well as the process direction.  This feature works well combined with the 
process KAR (Manual Only) setting in the Process Settings.  This will allow KAR to only 
be engaged when selected by the user. 

2.3.10   GLONASS Options 
Settings | Individual | Glonass 
The GLONASS options govern the way GrafNav will use GLONASS measurements 
when computing a solution. 
 
Solve for GPS-GLONASS Time Difference as Kalman Filter State 
This option forces the time difference between the GPS and GLONASS time systems to 
be computed in the Kalman Filter.  The difference between the two time systems is never 
more than a few meters (3-5m).  Corrections to the GLONASS pseudo-ranges will be 
made using this time difference, but the phase measurements will not be corrected since 
they vary only by the change in this difference over time, which is extremely small.  
Computed ambiguities will account for the remaining error. 
 
The initial value for the time difference filter state can be set if you know what it is.  The 
initial standard deviation describes the confidence that you have in the initial value that 
you have set.  The standard deviation should be between a few centimeters to a few 
meters. If you do not know what the initial value is, and you still want to compute it, 
enter zero and set the standard deviation of the state to about 2m or more.  
 
The spectral density is noise that you purposefully add to the computation of the time 
difference state.  Since both the GPS and GLONASS time systems are very stable, this 
number is always small, from about 0.001mm2/s to 0.01mm2/s.  If the spectral density is 
set too high, then the time difference computed will fluctuate erratically and never 
stabilize. 

2.3.11   Datum Options 
Settings | Datum 
This screen is invoked by selecting Datum from the Options Menu.  Users selecting 
‘More Datum Options…” from the General Processing Options will also see this screen.  
Figure 2.15 shows the property sheet that is displayed.  Subsequent pages are the same as 
those for the Datum Manager, which can be accessed from the Tools Menu.  The Datum 
Manager has one additional feature.  It can convert geographic coordinates from one 
datum to another.  See Section 10.5.2  Datums for more information. 
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Figure 2.15 Datum Options 

 
Project Options 
Processing Datum 
This is the datum in which the data is processed.  The way GrafNav/GrafNet works is 
that it will convert the satellite coordinates into this datum.  By far the easiest procedure 
is to select the local datum from the list of datums.  If it does not exist, then select the 
Datum tab and enable the datum.  If the desired datum does not exist, then a datum and 
conversion will need to be added.  See Section 10.5.2  Datums for more information. 
 
The ‘WGS84->Processing datum conversion’ is the set of transformation parameters used 
to convert between datums.  Selecting the ‘Automatic’ checkbox will choose the default 
datum conversion.  Another datum conversion can be made default by selecting the 
‘Datum Conversions’ tab.  Otherwise, deselecting the ‘Automatic’ checkbox will allow 
users to select a datum conversion more appropriate for a given area.  The accuracy of the 
datum conversion becomes more important with increasing baseline length. 
 
Coordinate Input Datum 
In some cases, users will want to process in a more global datum such as WGS84, but 
enter the base coordinates in the local datum (e.g. NAD27).  There are two reasons a user 
would do this: 

• A grid style (e.g. NADCON) conversion is used to transform between datums.  
Such transformation will not convert satellites as they are often outside of the 
boundaries (see Section 10.5.2  Datums). 
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• The datum conversion is heavily localized.  This means that it may have very 
large rotation values and its transformation is only valid over a small area (e.g. 
a city or state).  Similar to NADCON, a user would not want to convert 
satellite coordinates using this transformation. 

 
To enter coordinates in a different datum than the processing datum, ensure that the radio 
button labeled ‘Convert input coordinates to processing datum’ is selected.  In such a 
case, the datum conversion becomes very important.  Even more important is that the 
same conversion be used to later transform the output back to that datum.  Otherwise, a 
datum error of several meters may be induced on the final coordinates.  Currently, only 
the Export Wizard supports datum transformations.  Thus, if this feature is used, do not 
use ‘write coordinates’!!!  See Section 10.5.2  Datums for more information.  In any 
event, be cautious with datum conversions, as their accuracy can always be suspect. 
 
Datums 
This page allows you to enable/disable datums.  For instance, there are 110+ datums in 
the list.  Only a few of these are shown in many of the datum selection lists.  This is to 
make it easier to find a datum.  Users will want to disable unnecessary datums and 
enables the ones that are required.  New datums can also be added here.  If a new datum 
is added, be sure to add a conversion as well (see Section 10.5.2  Datums). 
 
Datum Conversions 
This page allows users to inspect, edit and add new conversions between datums.  
Normally, conversions are from/toWGS84.  However, conversions between any two 
datums can be added.  This page can also be used to make a particular conversion the 
default conversion for a given datum pair.  See Section 10.5.2  Datums for more 
information. 
 
Ellipsoids 
This page allows users to inspect the A and B or A and 1/F values for a particular 
ellipsoid.  Users can also add new ellipsoids.  Most of the world’s ellipsoids should 
already be added. 

2.3.12   Process Single Point Options 
Process | Process Single Point 
This dialogue box appears when the user selects code-only single point processing from 
the process menu.  This feature allows users to process the raw measurements within a 
GPB file without using the base station.  Generally, accuracies are poorer than 
differential (even on longer baselines), but this feature can be useful if the nearest base is 
very distant.  Quality control and clock issues can also be addressed with this feature.  
The top of the dialogue box shows the GPB file name, ephemeris file (precise or 
broadcast) and the method of ionospheric correction that will be applied. 
 
Accuracies can be improved via the usage of the precise ephemeris, IONEX files, and 
satellite clock files (which can be defined via File | Alternate Ephemeris Files).  
Downloading these files is very easy with the new Download Service Data program (see 
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Tools | Download Service Data followed by selecting the Options tab).  With the 
'Download SP3 files' checkbox enabled, the most accurate precise ephemeris file will be 
downloaded from the IGS FTP site.  IONEX and satellite clock files can also be obtained 
using the download program, see Section 6.9.2   for more details.  Click ‘Change Precise 
Files’ to add them to the project. 
 

 
Figure 2.16 Process Single Point 

 
General Options 
Process Mode: 

Automatic Chooses between single or dual frequency depending on whether 
the GPB file has L1 only or L1/L2 measurements. 

Single Freq. Forces C/A only processing.  Currently, the only means of 
removing ionospheric errors in single frequency is to utilize the 
broadcast (ICD-200) ionospheric model (Alpha and Beta values in 
GpsIon {} record within .EPP file). 

Dual Freq. Enables dual frequency ionospheric correction, which is computed 
from both the C/A or P1 and P2 signals.  If L1 and L2 carrier are 
available, this correction is further refined. 

 
Elev. Mask Satellites below this elevation value will be rejected. 
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Interval Only process epochs that fall on this data interval (which is 
specified in seconds).  Use a value of 0.0 to process all epochs. 

 
Accumulate static periods Enable this checkbox to compute a weighted average for 

static periods thus improving accuracies. 
 
Advanced 
Use broadcast iono model for SF Enable this to use the ICD-200 broadcast or 

IONEX ionospheric mode for single 
frequency correction (if it is available in the 
.EPP file). 

Use P1 instead of C/A For some receivers, interchannel biases 
between C/A and P2 result in a less accurate 
ionospheric correction being computed.  If 
these receivers also have a P1 signal (see 
GPB Viewer to find out if they do), then P1 
can be used to compute a more accurate 
correction.  P1 will also be used in the single 
point least-squares computation. 

Output epochs with high residuals The single point processor normally rejects 
epochs with high residuals that cannot be 
fixed.  Enable this checkbox to always 
output solution data regardless of quality. 

Correct time with solved clock shift Normally, the single point process uses the 
raw receiver measurement time stored in the 
GPB format.  However, if the corrected time 
in the GPB file is deemed more accurate, 
then enabling this setting will not use the 
computed clock correction to compute a new 
corrected time.  This can be helpful for 
processing some data sets with times 
problems--especially in the OLD GPB 
format. 

 
Standard Deviation 
C/A code standard deviation This is the estimated accuracy of the C/A 

code measurement.  An accurate number 
here will result in better accuracy estimates, 
but will not affect the trajectory. 

C/A code rejection tolerance This setting is useful for defining the 
tolerance above which measurements will be 
detected an erroneous.  First the software 
will attempt to fix such errors (by removing 
the satellite), or it will reject the entire epoch 
is a bad satellite cannot be located. 
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Account for atmos. and orbital errors Adjust final accuracy estimate using 
nominal orbit, tropospheric, ionospheric and 
receiver clock errors.  Like the C/A code 
standard deviation, this will not affect the 
actual trajectory. 

 
Processing Datum 
See 10.5.2  Datums for more information on datums. 
 

Section 4   Additional Features (Before and After 
Processing) 

2.4.1   Master Station Coordinates 
Settings | Coordinate | Master Tab 
This option allows you to change the master station coordinates.  When starting a new 
project, the program prompts the user for the master station coordinates.  If you did not 
enter the exact coordinates at that time, you can go to this option to enter them after the 
project has already started.  See Section 2.2.4  for more information. 
 
Note: If the coordinates are in a datum other than WGS84, make sure to select the proper 
datum from the Datum Options button. 

2.4.2   Remote Initialization 
Settings |Coordinate | Initialization Tab 
With this feature, users can “fix” the remote position at any number of times or locations 
within the survey.  This feature works best with shorter baseline lengths, and it is 
intended primarily for surveyors.  However, on long baselines combined with dual 
frequency receivers, baselines can also be fixed to some degree. 
 
The procedure is normally as follows: 

• Determine when (or where) the antenna was over the known point.  This is a 
point of known latitude, longitude and height.  It could be a station name (as it 
appears on the GrafNav screen), or it could be a specific time. 

• Define if a fix is to take place in the forward, reverse, or both processing. 
• ‘Snap to integer’ works well on shorter baselines and can result in improved 

accuracies.  It moves the point to the closest carrier phase integer ambiguity 
intersection.  It can be spotty on noisier data as only one epoch is used. 

• Make sure to enter the proper antenna height. 
• The time window defines how close a time can be and still perform a fix. 
• Finally, enter the position of the fix coordinates.  This is the monument 

position. 
• The Ambiguity fix works best on longer baselines such as airborne data. 
• Automatic selects a method best suited. 
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Figure 2.17 Remote Initialization 

 
When? 
Here is where the user selects or enters the times where the initialization took place.  For 
kinematic trajectories, selection of a time is preferable to the start/end method because 
the software may not start processing on the very first epoch.  Be sure to set a sufficiently 
small time window below.  For stations or static sessions, be sure that the antenna height 
is correct. 
 
General Options 
Direction 

Fwd Forward direction. 
Rev Reverse direction. 
Both Both forward and reverse direction. 

 
Method for fixing position 

Automatic The selects one of the modes below based upon baseline length, 
base/remote height difference and estimated accuracy of the 
current epoch. 

 
Ambiguity Fix This tends be the most robust method overal and does the best job 

of keeping the position selected (which includes any errors that 
may be present).  Airborne applications should only use this 
method. 
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Snap to Integer Practical for short baseline applications (such as surveying).  It 
selects the nearest integer position, which means that input position 
must be accurate to at least 1/2 cycle (10 cm for L1 and 40 cm for 
L1L2). 

 
Position Fix This works when the position's accuracy is suspect.  In general, the 

user can try to speed up convergence but this does not always show 
that much of an improvement over not using a seed at all. 

 
Advanced Options 
Valid time window In the When? section, user has selected at which point the fix 

should be applied.  This setting defines how close the an epoch 
should be before it should be used.  For kinematic trajectories, this 
value should be 1/2 the processing data rate. 

 
Antenna height Height of the antenna position above the marker position supplied 

below. 
 
Standard deviation Estimated accuracy of the position supplied below.  This will be 

most important for the position fix mode or in the automatic setting 
(which uses it to decide which method of fix to use). 

 
Position 
This is the marker position to be utilized for all of the above modes of position fix.  This 
height plus the antenna height is the location to be used for the antenna position.  See 
Section 2.2.4  for more details. 

2.4.3   Combining Forward and Reverse Solutions 
Process | Combine Solutions | Forward and Reverse 
This is the process of taking GrafNav solution files processed both in forward and reverse 
mode to form an optimal solution.  Newer versions of GrafNav no longer allow users to 
select the mode for combining, as variance weighting will always be used. 
 
What are the benefits? 
The overall accuracy is improved because in many cases the forward solution is more 
accurate than the reverse or vice versa for a given epoch.  This accuracy difference may 
change during the mission.  In turn, the weighting function (see Section 2.6.1  Plot GPS 
Data) should reflect these accuracy differences. 
 
By combining the two solutions a difference can be computed and plotted (2.6.1  Plot 
GPS Data).  This difference graph gives an indication of solution accuracy and problem 
areas.  However, it should be noted that the actual accuracy would often be better as the 
combining process places more weight on the solution with greater estimated accuracy.  
 
Before this process can be invoked, there must be a forward (project.FWD) and reverse 
(project.REV) solution file present.   
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How does the process work? 
A weight between 0 and 100 is assigned to both the forward and reverse solution.  The 
sum of both will equal 100.  All three axes (latitude, longitude and height) are assigned 
the same weighting value.  The weight is computed by 1 / variance.  Fixed integer 
positions will be weighted much stronger than float solutions. 
 
The combined solution is intended for kinematic processing.  The combined solution will 
average static epochs, but it will not average static sessions. 
 
Where do I find the coordinates from the combined solution? 
The combined solution does not create a separate output file.  To view the coordinates, 
you must write the coordinates or use the Export Wizard (the Export Wizard is 
suggested).  This can be done by writing epochs or features (i.e. stations).  To create a 
“combined” file with the same format as the forward or reverse solutions, use Export 
.CMB File from the Output Menu.  There is also a command line utility available to do 
this combination. 

2.4.4   Combine Any Two Solutions 
Process | Combine Solutions | Any two solutions 
This feature is similar to the Combine Forward and Reverse option, but any two solutions 
can be combined.  Either forward, reverse or combined solutions can be combined.   
Users may wish to combine files from different processing settings of the same master 
and remote. It can be very helpful for examining the effect of making changes to the 
options, or users can compare a fixed to a float solution to try and detect a bad ambiguity 
resolution. 
 
Combining combined solutions is also possible.  Using GrafNav Batch is preferable, 
however, users may also wish to use this feature.  In order to make this possible, the 
combined solutions must first be exported.  From the Output Menu, select ‘Write 
Combined (.CMB) File’ from each GrafNav project.  Then in the current GrafNav project 
(which may be one of the two), use the ‘Combine Any Two Solutions’ feature. 
 
IMPORTANT:  These solutions must be collected at the same time using the same 
antenna and the same receiver. 

2.4.5   Combine Settings 
Process | Combine Solutions | Combine Settings 
This feature is similar to the Combine Forward and Reverse option.  It allows the user to 
reject certain time intervals of the Forward or Reverse solution.  This way, areas where 
there are bad results will not be included into the combined solution. 
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Figure 2.18 Combine Settings 

Click on the Add button to enter the times where the forward or reverse solution is to be 
excluded from the combined solution. 

2.4.6   GPS Observations 
View | GPS Observations 
Here the user can check on information relating to the master(s) and remote files.  These 
include viewing station data, raw GPS data, resampling options, editing, plotting 
locktime plots etc.  See Section 2.2.7  for more details on these options. 

2.4.7   Epoch Output 
View | Forward/Reverse Solution | Trajectory 
This file provides a detailed record of the output at each epoch.  It is principally useful for 
keeping a record of the data computed for kinematic processing.  Refer to Section 9.1.3  
.FWD or .REV for a description of both the old and new output formats.  By enlarge, the 
plotting feature will plot most of the statistical information contained in these files.  
However, some users may wish to look at the actual raw numbers. 
 
Users would view this file for the following reasons: 

• Compare the exact numerical values between epochs or solutions. 
• View the statistical and epoch information for an exact point in time.  Press F3 

to search for a time. 
• View specific satellites or what the base satellite is.  The plotting functions on 

indicate how many satellites are used. 
• If the command VERBOSE=ON is used, then additional KAR information is 

printed to this file. 
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2.4.8   Message Log 
View | Forward/Reversed Solution | Message Log 
This file simply echoes all warning messages sent to the message window during 
processing.  See Section 9.1.1  for more details. 
 
Some of the messages sent are as follows: 

• Status messages on the progress of KAR and fixed solution. 
• When KAR is engaged and why (i.e. due to loss of lock, poor geometry, 

etc…) (***). 
• Ephemeris messages such as satellites whose ephemeris is missing. 
• Epochs of less than 4 satellites. 
• Notifications of extremely poor DOP (i.e. DD_DOP>100).  These epochs are 

skipped, the DOP at these epochs will not be plotted from the Plot GPS Data 
option.  This is the only way to see these locations. 

• Cycle slip warnings -- These are very important as they give you a time and 
record of the occurrence of these slips.  In some cases, cycle slips or many 
slips will indicate problems (especially in kinematic mode).  Only shown if 
‘Write cycle slip warnings to message log’ is enabled through Advance 1 
options. 

• Warnings of data errors such as filter resets, rejected satellites and invalid 
measurements ($$$). 

• When entering static and kinematic modes. 
• Changes in the satellite constellation.  These include changes in the base 

satellite, satellites rising or below elevation mask, etc. 
• Notification of position fixes (###). 
• Notification of data omission. 

2.4.9   Static Session/KAR Summary  
View | Forward/Reverse Solutions | Static/KAR Summary 
This file shows initial processing settings, final static solution, KAR fixes, and program 
completion status.  See Chapter 9  File Formats for a complete description of the format. 
 
Some reasons for looking at this file are: 

• View the final solution for a static period. 
• Locate when KAR engaged and what the statistics were.  This can be useful 

for evaluating if, when and where KAR engaged incorrectly. 
• Check the master station coordinates, datum or other start-up settings. 
• View the periods when and how long satellites are tracked for the static fixed 

solution. 
• See which satellites were rejected during the static fixed solution. 
• See the solution type used for a static solution (e.g. L1-Float, L1L2-

NewFixed, …). 
• See the slope distance, horizontal distance and ellipsoidal (corrected) distance 

for a static period. 
• Program completion information. 
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2.4.10   View the Reverse Solution Output Files 
Same as Forward. 

2.4.11   View Processing History 
View | Processing History 
 

 
Figure 2.19 Processing History 

This displays the processing history in a time ordered list.  It contains the date, time, size 
of the history, the description of the run, processing directions, the user’s initials and the 
return status.  Clicking on ‘Settings’ will bring up the processing settings used for that 
run.  Clicking on ‘Details’ will bring up a window that dispays more information about 
the processing run, including the configuration file.  See Figure 2.20. 
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Figure 2.20 Processing Details 

 
If the user wishes to save these processing settings into a new configuration file, click 
‘Save CFG As’ and a new dialogue box will prompt the user for a new name.  This is an 
effective way to start a new project using a previous configuration. 
 
The Process History saves certain statistics every 10 seconds.  This is useful for 
comparing processes.  The user can plot these values by clicking ‘Plot’.  The user can 
plot the forward/reverse separation, estimated position accuracy, float/fixed ambiguity 
status, and the quality factor.  Note that not all plots may be available if both directions 
were not processed or if processing was interrupted (e.g. user stopped processing). 
 
Clicking ‘Load into project’ will load the settings from a particular run into the current 
settings.  The user will be prompted if they wish to make a backup of the current project 
settings.  Selecting ‘Yes’ will save the current configuration into a .bak file before 
overwriting with the previous configuration.  
 
By pressing ‘Clear’ the processing history will be entirely deleted.  Select ‘Yes’ to 
confirm. 
 
If two process history selections are made, the ‘compare’ button can be pressed to 
compare CFG files.  This can be helpful in determining what settings are different.  See 
Appendix A Summary of Commandsfor the meaning of these commands. 
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2.4.12   View Processing Summary 
View | Processing Summary 
This summary screen provides statistics about the current forward, reverse, or combined 
solution that is loaded in GrafNav.  It is mainly intended for kinematic processing, 
however it can be used for static despite being less meaningful.  The Processing 
Summary includes details such as solution type, baseline distances, total number of 
epochs (i.e. in the remote .GPB file), epochs not processed, and epochs with bad C/A 
code and L1 phase measurements.  Bad C/A code and L1 phase measurements are 
deemed as unacceptable based on the standard deviation rejection tolerances + Distance 
PPM error specified in the Standard Deviation processing options. 
 
Statistics such as RMS values of the C/A code, L1 phase, L1 Doppler measurements, 
quality number percentages, estimated position standard deviations calculated from the 
Kalman filtering, and percentages of epochs having double difference DOPs over 10, 
provide a quick, convenient method of assessing processed solutions.  The 
forward/reverse separation RMS values for E,N, and H are listed, and a new addition is 
the forward/reverse separation RMS values of E,N, and H for 25%-75% weighting. 
 
The latter RMS values take into account the weighting of the forward/reverse combined 
solution only in the region of 25%-75% where the float solution has had time to converge 
to a lower value of error since the larger error values occur at the beginning of the 
processing direction.  The same can be said for a KAR fixed solution as well.  The RMS 
values for the 25%-75% weighting of the combined solution are generally lower than the 
RMS values from the forward/reverse separation because if one solution has high error 
values, most of the weighting will go to the other processing direction. 
 
Note that this screen can be added to the end of the output text file created with the 
Export Wizard (see Header/Footer settings). 

2.4.13   View Return Status 
View | Return Status 
This option will display the last processing status.  This feature allows you to see whether 
the processing was successful or, if not, why.  It shows the contents of the finish{} record 
in the fss/rss file. 

2.4.14   View the GPS Raw Binary Data 
View | Raw GPS Data 
Binary measurement data is stored in our custom .GPB format.  This format is receiver 
independent and only stores necessary information to minimize disk space requirements.  
This format contains a position record and the number of measurement records for each 
epoch.  See Chapter 6  Section 3  for more information on this feature. 
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2.4.15   View the Current .CFG file 
View | Current CFG file 
This will open the configuration file with the internal viewer.  Processing options and 
user comannds are stored in this file so that the project can be opened at a different time 
with the same configurations.  The definitions of the commands are located in Appendix 
A of this manual. 
 

Section 5   Settings Menu 

2.5.1   Grid Options 
Settings | Grid 
GrafNav projects now store grid information.  Users may wish to setup a grid for the 
following reasons: 

• Master coordinates can also be entered in grid directly.  This can be very 
convenient if source sheets do not have geographic coordinates 

• The map screen can plot in grid coordinates 
• DXF output will use these Grid Settings. 
• Export Wizard can use a defined grid using the Selectable Grid field. 

 
New grid definitions can be added by clicking ‘Define Grid’ in the Grid Options or via 
Tools Menu | Grid/Map Projections | Define.  Such grid definitions can be used here and 
the Export Wizard (use Selectable Grid variable). Note that the write coordinates feature 
cannot use selectable Grids. 

2.5.2   Preferences 
Settings | Preferences…  
 
Display Preferences 
This option allows you to edit the main screen display and other preferences.  The default 
for the zoom increment is 3.  The user can change this to any integer number greater than 
zero.   
 
‘Use H:M:S m/d/y for default time system’ encourages GrafNav to display this time 
format instead of seconds of the GPS week. 
 
‘Show direction arrows’ shows arrows in the direction of travel on the map screen. 
 
Coordinates for Display 
‘Geographic’ displays the latitude and longitude on the screen.  The orientation is such 
that the positive y-axis is true-north. 
 
‘Local level’ shows the vector difference between the master and remote.  It is most 
useful for GrafMov where users can see the relative separation rather than the absolute 
position, which is less meaningful. 
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‘Grid’ coordinates can also now be displayed.  To set the Grid system, choose Grid from 
the Options Menu.  Note that the UTM zone has not been set.  In such a case, the display 
may be severely rotated.  Use the Grid Options to set the zone correctly.  See Section 
2.5.1  for Grid Options. 
 
Zoom Level Specific 
The next set of options is based on each zoom level.  Level 0 is the main screen without 
being zoomed.  Each level has its own set of default display options that can be changed 
to meet with individual preferences.  The zoom level options include Font Size and 
Symbol Size.  The Show Text option allows the text to be seen on the screen such as the 
word MASTER at the base station. 
 
Multibase Static Session Plotting Options 
The user can choose whether to plot the static session lines to all base stations, to the nearest 
base station, or not to draw any lines at all. 
 
Solution Preferences 
Under the ‘Solution’ tab, the user can set their preferences in GrafNav.  Enabling ‘Load 
solution on project start’ will load the .fwd and .rev files into the project once a .cfg file is 
opened, if they exist.  Enabling ‘Combine forward/reverse after successful processing’ 
will automatically load the combined solution into the project after processing forward or 
reverse direction.  A combined solution is always loaded after processing both directions.  
Enabling ‘Automatically write .CMB file after processing’ will write a .cmb file after 
processing.  Note that this will slow down the CPU response after processing if a large 
project has been processed.   If the option ‘Prompt user when finished processing’ is 
turned on it will display a message at the center of the screen once processing is 
complete.  If it is turned off the user should hear a beep after processing (unless an error 
occurs). 

2.5.3   DEM Plotting Options 
Settings | DEM Plotting 
 
Using the DEM display plotting Options can help speed issues with using large DEMs in 
GrafNav, see Figure 2.21 below. 
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Figure 2.21 DEM Display Options 

Drawing contours in mapping window will show up along with the trajectory to show a 
topographic representation of the GPS survey.  Zooming in may be required to view the 
elevation of each contour. Drawing the DEM triangles will display the TIN model of the 
network formed.  Turning these options off can reduce any sluggish response from the 
program when viewing the map window. 
 
Plotting the ground elevation in the height profile plot allows the user to check the 
ground height compared to the height of their trajectory.  Sometimes the ground height 
can slow down the plotting of the height profile.  Turing this off allows the user to only 
view the height of their trajectory. 
 
The user can also control the interval of the contour elevations by entering the thick and 
thin line intervals.  Note that the thick interval must be a multiple of the thin.  The 
contour resolution can also be controlled.  Selecting a higher resolution will show more 
smoothness in the contour lines, although this gives more details and may slow down 
CPU response and use more RAM.  Having a lower contour resolution can speed up the 
response from GrafNav. 

2.5.4   Photogrammetry Options 
Settings | Photogrammetry 
The options described here are useful for using GrafNav for the purposes of GPS assisted 
aerotriangulation.  This includes a control over how interpolation is implemented, and it 
includes a special processing mode useful in conjunction with Bundle adjustment drift 
parameters. 
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Figure 2.22 Photogrammetry Options 

 
Camera Pulse Interpolation 
These options determine how the camera marks are interpolated.  More information on 
loading camera marks can be found in Section 2.2.10.  Since each photograph is seldom 
taken on the even epoch, it must be interpolated to compute a proper position.  There are 
two methods of interpolation supported by GrafNav: Linear interpolation and a 2nd order 
polynomial.  The polynomial interpolation will give the best accuracies, but it can 
sometimes induce larger errors if epochs are missed or dynamics are very high.  This can 
be detected by viewing the RMS value computed for each camera pulse, which can be 
viewed by clicking on the station or writing the coordinates, selecting features and doing 
no geoid correction.  In such cases, the linear interpolation model will deliver better 
results.  The size of the window for which the polynomial is fitted can also be controlled.  
Ideally, this number should be kept at 4, but it can be increased for more averaging.  This 
can sometimes be dangerous unless very high data rates are available.  The linear 
interpolation model is much simpler and gives no RMS statistics.  It merely fits a line 
between the two nearest epochs and places the camera mark on it.  It is simple but 
effective. 

2.5.5   User Defined Options 
Settings| Individual | User Defined 
The User Defined Options dialogue box can be used to change any command that is 
passed to GrafNav (Refer to Appendix A for a list of commands).  It can be used to 
modify commands that are set by the other dialogue boxes, or set commands that are not 
normally used (those commands not handled by the other dialogue boxes). 
 
When a configuration file is loaded, all commands that are not handled by the other 
options dialogue boxes will appear in the User Defined Options dialogue box.  This 
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includes commands that do not exist in the version of GrafNav that you are using.  
Commands that do not exist can easily be deleted here. 

2.5.6   Load Settings From 
Settings | Load Settings From 
This feature permits users to load configuration settings from one of the following: 

• Factory Defaults – Built-in default settings (cannot be altered by user). 
• <Program> Defaults – Startup settings that can alter by user.  Otherwise, same as 

Factory Defaults. 
• Pre-loaded Profiles (e.g. Airborne, Low Cost, Tree Cover, etc.) – These are 

settings that come preloaded with the software. 
• User created profiles – These are profiles that can be created by the user. 

2.5.7   Manage Settings 
Settings| Manage Profiles 
 

 
Figure 2.23 Manage Settings 

 
Create from Project Create new CFG profile uses the current project's settings. 
Load into Project Same as 'Load Settings From' menu selection.  Basically 

this loads the options from this profile into the current 
project. 

Update from Profile Updates the CFG profile with the current project settings. 
Rename Allows profile to be renamed. 
Edit Brings up processing setting dialogue, which allows the 

selected CFG profile to be modified.  Note: Modifications 
to pre-loaded settings will be lost if software is reinstalled. 
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Delete Deletes the selected profile. 
Copy From Creates a copy of the currently selected profile. 
 

Section 6   Output Menu 

2.6.1   Plot GPS Data 
Output | Plot GPS Data 
This feature is very useful for analyzing GPS data and processed results.  The plots are 
divided into eight groups: Most common, Accuracy, Measurement, Separation, Quality 
Control, Coordinate Values, Miscellaneous, and All plots.  The ‘Build Custom List’ 
button allows users to form their own list of plots that will show up under the ‘custom 
group’.  See Figure 2.24. 
 

 
Figure 2.24 List of plotting categories 

 
Along with selecting the plot type, users can define X-Axis and Y-Axis information.  
Changes made to these pages will be retained for future plots.  For instance, if a time 
range is entered in the X-Axis, this same time range will be used for future plots in this 
project.  This can be very useful to inspect a narrow time slice.  Users can still make 
changes to axes information after the plot has been displayed by right-clicking on the 
plot. 
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If features are loaded (e.g. stations or camera marks), then plots will show these as 
vertical red bars at the top of the plot.  For most but not all of the graphs, clicking on the 
feature will show solution status information. 
 
Plot features available via the mouse right-click are: 

• Edit Axes – Users can change the ranges on the x and y axes.  In addition, 
users can switch between seconds of the week and hours minutes seconds time 
display. 

• Edit Titles – Users can modify the plot, x-axis and y-axes titles. 
• Set Y-Axis Range – Previous settings of the time range are stored here 
• Set X-Axis Range – Previous settings of the Y-Axis are stored here 
• Auto-scale (X-Axis) – This feature will show the entire time range of the data. 
• Auto-scale (Y-Axis) – This feature will show the entire value range of the 

data. 
• Set Start Plot Time – This will make the current time the x-axis minimum. 
• Set End Plot Time – This will make the current time the x-axis maximum. 
• Set Maximum Plot Value – This will make the current value the y-axis 

maximum. 
• Set Minimum Plot Value – This will make the current value the y-axis 

minimum. 
• Copy – This will copy the plot onto the clipboard as a bitmap (.bmp file) and 

users can paste the image in another application such as MS Word or Paint. 
• Copy (without title) – This will copy the plot onto the clipboard as a bitmap 

(.bmp file) without the title of the plot. 
• Go to Time in Forward Message Log – This will search the forward message 

log for a time closest to the time clicked on.  Note that KAR may rewind the 
file to some degree.  Users may need to search below the found location to 
find the rewound epoch. 

• Go to Time in Reverse Message Log – Same as above but for the reverse 
message log. 

• Go to Time on Map – This will show the epoch on the map pertaining to the 
time clicked on.  This is a handy feature to geographically locate problem 
areas. 

• Set Start Processing Time (GPS/IMU) – This will make the current selected 
time the begin time in the General Options for GPS processing or IMU 
processing.  Note that not all plots have this feature enabled. 

• Set End Processing Time – Same as above, but it sets the end processing time. 
• Engage KAR at Time – This will engage KAR the current selected time. 

 
List of Available Plots 
 
Acceleration Profile Advanced 
This plot shows the approximate acceleration computed by the baseline processor.  To 
permit this plot to be shown, users must also enable Extended output from the Advanced 
options (see 'Epoch Output' in the bottom right corner). 
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Ambiguity Drift  Advanced 
This value indicates solution stability—especially for a float solution.  Under ideal 
conditions, the ambiguities should be driftless, thereby having a drift of 0 cycles / sec.  
Normally this number will be 0-0.03 cycles for very stable solutions, and 0.03-0.05 for 
quality 2 stability, and otherwise Q3 and up.  Most users rely on the quality number 
instead of the Ambiguity Drift.  The quality number is partially derived from this 
parameter. 
 
Combined Separation Novice 
Requires forward and reverse solutions to be combined.  Basically, this is the difference 
between the two combined solutions.  For multi-baseline combination in GrafNav Batch, 
this is the maximum minus minimum difference between baselines for each epoch, and the 
number will always be positive. 
 
Combined RMS Intermediate 
This plot is only applicable for multi-base processing.  Instead of showing maximum 
minus minimum like the Combined Separation plot does, it shows the weighted RMS of 
the baseline.  Thus, if one baseline does not fit well, but it is given a very low weighting, 
it will not affect this plot as much.  It is a good idea to view both just to be sure, as this 
plot can be optimistic. 
 
Combined Weighting  Intermediate 
This requires that two solutions be combined.  It is the weighting factor (0-100) given to 
both the forward and reverse solution.  Note that this is not the weighting of different 
baselines in a multi-baseline project.  See the ‘Effective Baseline Weighting Plot’ in 
Multi-base plotting (see Section 2.6.2). 
 
Combined Number of Solutions  Intermediate 
This plot shows the number of baselines that are used to form a combined baseline.  This 
can be useful for multi-base processing.  
 
Distance Separation Novice 
This plot shows the difference between the 1st master and remote in kilometers.  It can be 
useful to identify where the master and remote are either far apart or close in kinematic 
data.  Under the advanced plotting, it can be shown in meters.  For multi-base distance 
separation, see ‘Distance to base stations plot’ (see Section 2.6.2). 
 
DOP – DD_DOP  Intermediate 
Indicates satellite geometry relating to position.  Small values indicate better geometry.  
This value is the double difference DOP and is approximately PDOP^2.  Although, it can 
be somewhat lowered due to the differential modeling.  The DD_DOP is used for all 
internal checks and DOP related options in the software.  Epochs with extremely poor 
DD_DOP (>100) are skipped and will not be plotted.  Use the DOP_TOL command to 
change the default DD_DOP tolerance of 100. 
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DOP –PDOP, HDOP, VDOP Novice 
Indicates satellite geometry relating to position.  Small values indicate better geometry.  
Lines are displayed for position DOP (PDOP), horizontal position DOP (HDOP) and 
vertical position DOP (VDOP).  These values should be similar to other PDOP 
computations, but differences can be visible due to the double differencing (i.e. different 
base satellite selection). 
 
Estimated Clock Accuracy Advanced 
This plot shows the estimated standard deviation computed by the least-squares single 
point processor.  In general, it will match position accuracies. 
 
Estimated Position Accuracy Novice 
This option plots the standard deviations of the east, north and up directions versus time 
for your solution.  A fourth channel, the total standard deviation with a distance 
dependent component is also plotted.  Viewing this plot for individual forward or reverse 
solutions will show losses of lock very nicely. 
 
Estimated Velocity Accuracy Intermediate 
Velocity is the local level component (easting, northing, up) computed by the Kalman 
filter.  These are mostly derived from the Doppler measurements.  Plotting the Doppler 
RMS is a good means to check the actual accuracy base on real data.  Plotting the 
estimated standard deviation shows the theoretical accuracy base on the Kalman filter 
error estimates. 
 
Float/Fixed Ambiguity Status Novice 
This plot shows whether an epoch has a fixed or float ambiguity status.  Fixed integer 
ambiguities generally have better accuracies, and they are preferable for obtaining <20 
cm accuracies.  This plot will also show if there are zero, one or more fixed ambiguities 
used to determine a combined solution. 
 
GPS/GLONASS Time Offset  Advanced 
The time offset shown here is the computed difference between the GPS system time and 
the GLONASS system time.  Also, part of the time-offset value is due to small inter-
channel biases between the GLONASS channels with respect to one another and with 
respect to the GPS channels. 
 
Height Profile Novice 
Height over the processing time period.  This can be a very good quality control measure 
in areas where the height is very stable. 
 
Individual Satellite Statistics  Intermediate 
Shows satellite code residuals, phase residuals, elevation angles and C/NO values for 
individual PRNs. 
 
 
 

89 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

Local Level Vector  Advanced 
This is the vector between base and remote centered about the main base station.  It is 
useful for moving baseline processing.  For absolute positioning applications, the 
distance separation combined with the height profile is usually a better diagnostic tool. 
 
Number of Satellites (BAR) Novice 
Number of satellites for epochs with at least 4.  Note that epochs with less than 4 
satellites will not be displayed as these epochs are skipped. This plot gives a nice 
overview of how many satellites there are.  Data sets with large numbers of epochs may 
wish to use the line graph, as this plot better shows every time the number of satellites 
drops to a minimum. 
 
Number of Satellites (LINE) Advanced 
This plot shows the number of GPS, GLONASS and total satellites.  Note that epochs 
with less than 4 satellites will not be displayed as these epochs are skipped.  The plot is 
not as nice to look at as the bar graph, but it actually contains more information. 
 
Quality Factor  Novice 
Increasing quality factors indicate a worse solution.  Quality 1 and 2 are the best, and 
indicate a converged static solution or continuous in kinematic mode.  For precise 
kinematic processing, a quality number of 1 should be maintained since it indicates a 
fixed integer carrier phase solution.  A quality factor of 2, normally indicates a converged 
float solution or a nosier fixed integer.  Quality 3 and 4 indicate converging float or very 
noisy fixed integer.  Quality 5 to 6 usually are epochs with DGPS accuracies.  For code-
only processing, quality factors of 3 or higher are to be expected. 
 
Receiver Clock Offset Advanced 
The single point processor computes a clock correction on an epoch-by-epoch basis.  This 
value is the difference between the receiver's clock and the GPS time system.  For some 
applications, users may wish to plot and moniter this value. 
 
RMS – C/A Code Novice 
This is a good indicator of receiver code measurement accuracy.  It is also a good 
indicator of multi-path for carrier phase processing.  Large jumps can be induced by 
missed carrier phase cycle slips. 
 
RMS – Carrier Phase  Novice 
This is a good indicator of carrier phase measurement accuracy.  If the signal is affected 
by the ionosphere and other error sources, the RMS will be greater than the few 
centimetre range and can be as large as 10 cm or more for single frequency.  Because the 
code and carrier phase are combined, some noise from the C/A code can seep into the 
carrier phase. 
 
RMS – L1 Doppler  Advanced 
The Doppler is predominantly used for velocity determination.  User’s using GrafNav in 
conjunction with inertial (INS) integration should pay close attention to this plot.  It will 
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give a good indication of what standard deviation to give velocity data in the inertial 
Kalman filter. 
 
Non-inertial users can view this plot to get a good indication of velocity accuracies.  
However, pay close attention to the Doppler weighting in GrafNav’s Kalman Filter (see 
Section 2.3.5  for more information).  Large Doppler errors can also sometimes result in 
the L1 carrier phase RMS to rise.  In this case, the L1 Doppler standard deviation should 
be raised or Doppler usage should be disabled (see Section 2.3.3  Advanced Options). 
 
RMS – P Code  Advanced 
If the option ‘Use P-Code in Kalman Filter’ is turned on in the Dual Frequency options, 
then this feature can be used to plot the P-Code RMS. 
 
Satellite Lock – Cycle Slips Intermediate 
This plot is used to view the general quality of the data contained in a .GPB file.  The plot 
shows four data characteristics.   The first is the cycle slips in the data for each satellite.  
This information can be very useful because it is possible to detect poor tracking.  Cycle 
slips are shown as vertical lines in the bars.  The second data characteristic is the times 
that data is available for each satellite contained in the .GPB file.  Data availability is 
shown by any colour of bar.  To compare coverage of multiple .GPB files, use the 
Static/Kinematic Coverage plot.  The third characteristic that is shown is the elevation 
angle for each of the satellites.  The different bar colours represent different elevation 
ranges.  The last data characteristic shown is data that cannot be used in the processing as 
the options stand.  This data is shown in red.  There are two reasons for data to be flagged 
as red:  
 

• If the C/A range, or the phase data (L1 or L2) are invalid. 
• If the locktime of the satellite is less than the locktime cutoff. 
• Black indicates that there is an ephemeris missing.  GLONASS satellites will 

also be plotted in black. 
 
Static Session Convergence  Intermediate 
This plot assumes that the last epoch in the static session is exact.  A float solution 
convergence plot is then formed.  This gives an indicator of how well a static solution is 
stabilizing. 
 
Static/Kinematic + Coverage Novice 
This plot is new for Version 6.03.  It has three purposes.  Firstly, it shows if and when 
GPB files are static and kinematic.  Secondly, it can be used to overlay multiple GPB 
files to see when they overlap in time.  Finally, it tries to indicate weak periods of the 
data that may result in a loss of lock.  Since it does not examine processed data, it is not 
as reliable as other indicators (e.g. Position Standard Deviation).  Inertial Explorer users 
can also plot IMU coverage in addition to Master and Remote GPS coverage. This plot 
will also show IMU data time gaps.  
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User Selected File – Plot data from  Advanced 
This feature can be used to plot data from a comma or space separated file.  This spares 
the user from having to use a program such as Microsoft Excel or MatLab to plot the 
data.  It can also be used to plot the results of the Compare utility (see Chapter 6  Section 
1). 
 
Velocity Profile Intermediate 
Plot shows north, east and up velocities over the processing time period.  This can be 
used to determine when the antenna is moving. 
 
Azimuth/Heading data (GrafMov Only)  Intermediate 
Shows the azimuth in heading determination mode. 
 
Azimuth/Heading standard deviation (GrafMov Only)  Intermediate 
Shows the standard deviation of the azimuth computation for heading determination 
mode.  Users should also examine the fixed/float ambiguity status flag. 
 
Antenna Distance Error (GrafMov Only)  Advanced 
Shows the difference between the computed antenna distance and that given by the user.  
This is a good quality control check. 
 
Attitude (Roll and Pitch) (Inertial Explorer Only)  Novice 
Plots the Roll and Pitch values from GPS/INS processing. 
 
Attitude (Azimuth/Heading) (Inertial Explorer Only)  Novice 
Plots the heading and GPS COG (Course-over-Ground) that was computed from the 
GPS/INS processing. 
 
Attitude Separation (Inertial Explorer Only)  Novice 
This plot requires forward and reverse IMU solutions to be combined.  To combine 
forward and reverse IMU solutions, select the Process Menu | Combine Solutions | IMU 
Forward and Reverse.  Basically, this plot shows the difference between the combined 
solutions in terms of Roll, Pitch, and Heading. 
 
Estimated Attitude Accuracy (Inertial Explorer Only)  Novice 
This plot shows the estimated accuracy (standard deviation) computed in the GPS/INS 
Kalman filter in terms of Roll, Pitch, and Heading. 
 
Estimated Gyro Drift Accuracy (Inertial Explorer Only)  Intermediate 
This plot shows the estimated standard deviation of the gyro drift rate.  This plot 
generally decreases with time.  It is plotted in terms of the X (right direction), Y (forward 
direction), and Z (up direction) of the INS body. 
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Estimated Accelerometer Bias Accuracy (Inertial Explorer Only)  Intermediate 
This shows the estimated standard deviation of the accelerometer bias.  It is plotted in 
terms of the X (right direction), Y (forward direction), and Z (up direction) of the INS 
body. 
 
IMU Accelerometer Bias (Inertial Explorer Only)  Intermediate 
This is the apparent output in acceleration when there is no input acceleration present.  It 
is computed by the GPS/INS Kalman filter and the effects may be sinusoidal or random. 
It is plotted in terms of the X (right direction), Y (forward direction), and Z (up direction) 
of the INS body. 
 
IMU Angular Rates (Inertial Explorer Only)  Advanced 
This plot shows the gyroscope rate of change of attitude in the X, Y, and Z axes of the 
IMU body with the drift removed.  This plot is used to check the gyros. 
 
IMU GPS Position Misclosure (Inertial Explorer Only)  Intermediate 
This plot shows the difference between the GPS solution and the mechanized INS 
positions obtained from the GPS/INS processing.  This is a good analysis tool used to 
check the GPS/INS solution as well as checking INS stability.  Large jumps or spikes 
may indicate a bad INS solution. 
 
IMU GPS Velocity Misclosure (Inertial Explorer Only)  Intermediate 
This plot shows the difference between the GPS calculated velocity and the mechanized 
INS velocity obtained from the GPS/INS processing.  Another good analysis tool used to 
check INS stability. 
 
IMU Gyro Drift Rate (Inertial Explorer Only)  Intermediate 
This is the apparent change in angular rate over a period of time.  It is computed by the 
GPS/INS Kalman filter and the effects are usually random. It is plotted in terms of the X 
(right direction), Y (forward direction), and Z (up direction) of the INS body. 
 
IMU Heading COG difference (Inertial Explorer Only)  Advanced 
This plot is the difference between the IMU heading and the GPS Course-over-Ground 
values.  The absolute IMU heading/GPS COG can be seen in the Attitude 
(Azimuth/Heading) Plot. 

2.6.2   Multi-Baseline Plotting 
Output | Plot Multi-Base 
If a user processes more than one baseline, there are additional plotting tools available to 
display measurements and separations of multi-baselines.  This tool plots values present 
in the .fbv and .rbv files (see Section 9.1.4).  Figure 2.25 displays the multi-base plotting 
window. 
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Figure 2.25 Multi-Base Plotting 

The user can select from the measurement, individual carrier and code separations 
(baseline check), DOPs, or other miscellaneous plots.  The user can also specify the 
direction of plotting as forward, reverse, or both directions.   
 
C/A Code (MB Only) Measurement Residual RMS and Weighting 
This plot shows root mean square (RMS) of C/A code residuals for each baseline.  In 
addition, the measurement standard deviations are plotted on the same (or separate plot).  
This plot can be useful for identifying a one base station has better or worse code 
residuals than another. 
 
Carrier Phase (MB Only) Measurement Residual RMS and Weighting 
Similar to that of the code, this shows the carrier RMS for each baseline.  Viewing this 
separated value is preferable to the combine value shown from ‘Plot GPS Data’.  This 
plot most effectively shows if a base station’s coordinates are incorrect (see Section 
10.2.2  for an example). 
 
Doppler (MB Only) Measurement Residual RMS and Weighting 
Use this plot to identify problematic Doppler data originating from one of the base 
stations.  This only needs to be of concern for users requiring accurate velocity. 
 
Carrier Separation (MB Only)    Individual Baseline Position 
This shows the difference between the Kalman filter (KF) position (using all base 
stations) and a least-squares based solution using the code and carrier (using carrier 
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ambiguities solved in the KF).  It can be useful for determining which base’s data is 
causing larger errors.  It is not a good accuracy assessment tool. 
 
Code Separation (MB Only)    Individual Baseline Position 
This is a less helpful plot because any differences between the bases are normally 
shrouded in the code noise.  However, large base station position errors can be observed 
here.  In addition, this is an effective way of spotting poor quality code measurements 
stemming from one of the bases.  In such a case, consider using larger standard 
deviations for this problematic base. 
 
DD_DOP (MB Only)         DOPs 
Indicates satellite geometry relating to position for each baseline.  Small values indicate 
better geometry.  This value is the double difference DOP and is approximately PDOP^2.  
Although, it can be somewhat lowered due to the differential modeling.  The DD_DOP is 
used for all internal checks and DOP related options in the software.  Epochs with 
extremely poor DD_DOP (>100) are skipped and will not be plotted.  Use the DOP_TOL 
command to change the default DD_DOP tolerance of 100. 
 
PDOP, HDOP, VDOP (MB Only)       DOPs 
Indicates satellite geometry relating to position for each baseline.  Small values indicate 
better geometry.  Lines are displayed for position DOP (PDOP), horizontal position DOP 
(HDOP) and vertical position DOP (VDOP).  These values should be similar to other 
PDOP computations, but differences can be visible due to the double differencing (i.e. 
different base satellite selection). 
 
Number of Satellites (MB Only)       Other 
This displays a line graph of the number of satellites for each baseline.  Note that epochs 
with less than 4 satellites will not be displayed as these epochs are skipped. This plot 
gives a nice overview of how many satellites there are visibile from each baseline.  
 
Effective Baseline Weighting (MB Only)      Other 
This indicates the approximate percentage weighting that could be assigned to each 
baseline if a linear combination were used.  Although this value is not used for 
processing, it can be a helpful indicator to the user. 
 
Distance to Base Stations (MB Only)      Other 
This plot shows the difference between the masters and remote in kilometers.  It can be 
useful to identify where the master and remote are far apart or close in kinematic data. 
 
Number of Baselines         Other 
This shows the number of base stations uses for processing each epoch.  It is an important 
means of assessing if certain bases are rejecting (or not lined up during processing). 
 
Ambiguity Drift (MB Only)        Other 
This would be the individual ambiguity drift for each baseline.  See ‘Ambiguity Drift’ 
under Plot GPS Data for more information. 
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2.6.3   Write Coordinates 
Output | Write Coordinates 
This allows you to write coordinates in various coordinate frames.  Select this item in 
order to transform computed latitudes and longitudes to Transverse Mercator or Lambert 
Projections.  The main reason for using Write Coordinates is to export specialized 
formats such as Waypoint .CMB, azimuth output, etc… 
 
Note: Write Coordinates is the old way GrafNav used to export coordinates, it is 
retained for backward compatibility.  Users are urged to use the Export Wizard 
since it has more Grid, Datum and transformation options. 
 
What follows are the options available when using the Write Coordinates feature. 
 
File Name 
Type in a filename in which to store your coordinates and station names.  This file will 
contain much of the output significant to your survey.  The output format will be 
approximately): 
 
Station  X Y Z      Quality  StdDev 
 
Information: 
The output file given by the filename above will contain all or only part of the 
information processed by the processing component and saved in the .FWD & .REV in 
GrafNav or .OUT file in GrafNet. 
 
Time Format 
The Time Format button brings up the Epoch Output Time Format dialogue box, which 
allows you to change the time format in the coordinate file.  The dialogue box allows 
three major operations: setting the time format, correcting the time, and interpolation of 
missing data. 
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Figure 2.26 Write Coordinates Time Format 

 
1. Time Format 
This section allows you to change the format that the time will take.  Four time formats 
are available: GPS seconds of the week, GPS seconds of the day, GMT (UTC) HMS, or 
local HMS.  The last format requires that a time zone correction.  The best output format 
to use depends what you intend to do with the coordinates. 
 
2. Correction Values 
There are two time corrections that you can apply.  The first correction is to apply the 
receiver clock bias to the GPS time.  This corrects the time to the actual time that the 
receiver made the measurement.  This correction can be as high as 1 millisecond.  This 
can be very significant in applications that require time synchronization between various 
instruments and devices.  For example in many inertial applications, attitude is very 
important.  Depending on the dynamics of the application, attitude can change very 
quickly, and small-timing errors can become significant. 
 
The second correction that can be done must be made when GPS times are converted to 
UTC times.  GPS time is a linear time scale.  This means that there is never a second that 
is missed, or counted twice.  UTC time, on the other hand is not linear.  UTC time is held 
fixed with relationship to the stars.  There are many global effects that change this 
relationship very slightly, so corrections to the UTC time are made in the form of leap-
seconds.  These corrections can be made as often as every six months, but usually only 
happen every twelve or eighteen months.  To determine what the UTC correction is for 
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the time your data was collected, please consult the web site  
http://tycho.usno.navy.mil/leapsec.html  
 
3. Missing Epochs 
The last section of the Epoch Output Time Format dialogue box allows you to interpolate 
position for missing epochs based on existing epochs.  The option uses a simple linear 
interpolator.  Simply check the check box, and set the interval that you would like the 
interpolation to occur at.  This option is very useful for application like GIS where 
accuracy may not be as important as simply having a continuous trajectory of positions. 
 
Source 
1. Epochs: The output file will contain X,Y,Z from every epoch gathered by the GPS 

receiver. 
 
2. Features: The output file will only contain information at STATIONS marked by the 

data logging program LOGGPS.EXE.   
 
3. Static Sessions:  The final solution of each individual static occupation separated by 

kinematic occupation.   
 
4. Single Point Solution: Solutions computed by the GPS receiver in real-time.  For a 

single receiver (i.e. no radio link), accuracies will be 5-10 m.  For a real-time DGPS 
configuration, accuracies will be 1-5 m. 

 
5.  Station File RTK Results: 
 
Coordinate Type:   
1. Geographic (Lat/Long/Ht) & UTM: 
Follow the current dialogue box using Degrees/Minutes/Seconds as the horizontal 
coordinate units and meters or feet for the elevation coordinate unit. 
 
The program will calculate the UTM zone for you unless you have chosen User Entered 
under Information. 
 
2. 3TM or Transverse Mercator map projections 
Follow the current dialogue box using meters or feet for both horizontal and elevation 
coordinate units.  
 
A new dialogue box will appear prompting the user to enter the Central Meridian and the 
scale factor for that meridian. 
 
 i.e. 114 00 00  
   .9999 
 
False easting on the central meridian and false northing, for example 10,000,000 from the 
equator if you are in the southern hemisphere.  See State Plane if in U.S. 
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3.  Lambert Conformal - Map Projections 
Follow current dialogue box using meters and feet for both coordinate units.  At this 
point, a new dialogue box will appear prompting you for more information such as the 
Origin Parallel and the lower standard parallel.  See State Plane if in U.S. 
 
4.  XYZ-ECEF - Earth Centered Coordinate Frame (x, y, z) 
Follow the dialogue box using meters or feet as the coordinate units for both horizontal 
and elevation. 
 
5.  State Plane 
To convert coordinates for specific state planes, follow the dialogue box using meters or 
feet for both the horizontal coordinate unit and the elevation coordinate unit. 
 

 
Figure 2.27 Write Coordinates Dialogue Box 

 
The next dialogue box will ask you for the state plane that you would like the coordinates 
converted in.  Once you have selected the state plane the program will ask you for the 
coordinates.  When changing the datum, be careful to re-process before writing 
coordinates.  To view the result, select Output from the Main Menu and then View 
Coordinates. 
 
6. Local Level 
Local level coordinates have horizontal and vertical coordinates in units of meters or feet.  
Coordinates have three components: north, east and height.  The origin of the coordinate 
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system is at the base station.  The north and east axis form a plane.  The height axis is 
always perpendicular to the ellipsoid, or in other words follows the curve of the ellipsoid.  
This means that this coordinate system is not Cartesian. 
 
7. Gauss – Kruger 
This is a TM coordinate system used primarily in Europe.  The zones are the same as the 
UTM zones.  The difference between this projection and the UTM projects is that the 
scale factor is 1.0 for Gauss – Kruger. 
 
8. Local XY Plane 
See 2.7.3  Wizard Option Screens under Local Plane Options. 
 
Output Format:   
The data will be written in one of the formats given here. 
 
ASCII  
Data simply delimited by spaces.   
 
ASCII (s.f. and convergence) 
As above with additional columns for the scale factor and meridian convergence of the 
projection. 
 
ASCII (ENH Std. Deviations) 
An ASCII format with additional columns reserved for east, north, and height standard 
deviations in the position.  The complete standard deviation for the position with the 
distance dependant component is also given. 
 
CSV (for EXCEL) 
Data delimited by commas. 
 
Waypoint OutRec (.CMB) 
Prints a standard forward solution file.  This is good for storing the forward reverse 
combination results.  This can be exported directly from the Output Menu. 
 
INS/GPS Integrator 
This output format produces a file with all data that would be useful in the integration of 
GPS with INS. 
 
Also available are: Itres Research data format 
 
Epoch Statistics (.dat file) 
The epoch statistics generates a comma separated .dat file, which contains the following 
information: 
Time, Quality Factor, L1 Phase RMS (m), CA Code RMS (m), Ambiguity Drift 
(cycles/sec), Covariance/Standard Deviation (m), Number of Satellites. 
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Combination Information 
This data is separated by commas and includes the following information: 
Time is the time in GPS seconds of the week.   
 
DNorth (m) is the difference in northing between the forward and reverse solution. 
 
DEast (m) is the difference in easting between the forward and reverse solution. 
 
DHeight (m) is the difference in Height between the forward and reverse solution. 
 
Fwd Weight (%) is the percentage of the forward solution used in the combination. 
 
Rev Weight (%) is the percentage of the reverse solution used in the combination. 
 
Local Level Vector 
This coordinate system has the origin at the master station.  The positive y-axis is 
pointing true north at the master station, and the positive x-axis is point true east.  The z-
axis is defined vertically and is the difference between the ellipsoidal heights of the 
remote and master stations.  These axes may not be aligned to true north at the remote 
station.  This effect is known as convergence of the meridians, and the difference 
between coordinate y-axis and true north is expressed as follows:  
 
dα = (λremote - λmaster) * sin(ϕremote) (1) 
 
Where, dα is the azimuth difference (radians), λ is longitude (radians) and ϕ is latitude 
(radians).  The local level vector can be written directly from the Write Coordinates item 
from the Output menu. Select Local Level Vector under Output Format. 
 
Horizontal Coordinate Unit 
Horizontal coordinate data will be written in degrees, minutes, and seconds for 
lat/long/ht, meters or feet for UTM.  Refer to the Coordinate Type for a description on 
which unit to use for each coordinate.  
 
Elevation Coordinate Units 
Elevations may be written in meters or feet. 
 
Apply Geoid height correction 
See 2.7.3  Wizard Option Screens under Geoid Correction Options. 
 
Apply map scale factor 
See 2.7.3  Wizard Option Screens under Vertical Scale Factor Options. 
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2.6.4   View Coordinates 
Output | View Coordinates 
This allows you to view the coordinate files created by the Write Coordinates or Export 
Wizard Features.  Users can print files using this methodology (from the File Menu, 
select Print). 

2.6.5   Export to DXF 
Output | Export to DXF 
DXF is a file format that can be read by various CAD packages.  The ‘Export to DXF’ 
utility lets you output your GrafNav/GrafNet project into DXF format. 
 

 
Figure 2.28 Export DXF Options 

 
The above figure shows the ‘Export to DXF’ dialogue box, which is the same for 
GrafNav and GrafNet.  However, certain options are disabled if you are using 
GrafNav/GrafNet.  For example, Error Ellipse output is only available in GrafNet.  The 
options relevant to GrafNav are explained here.  Refer to Section 3.6.1   Export to DXF 
for information on the GrafNet specific options.   
The output file name is the name and path of the DXF file that is to be created.  The 
Station/Features output component will output all the stations and features to the DXF 
file.  The size of the stations and features is governed by the symbol size.  
Baselines/Static Sessions output component will output baselines between all the static 
sessions.  The colour of the baseline will be the same as it was in GrafNav.  That is, 
quality 1 is green and quality 6 is red.  The colour for Epoch and Join Epoch output is 
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also dependent on the quality number.  The Epoch control outputs each epoch, which is 
only useful for kinematic surveys.  The size is again dependent on the symbol size option.  
Join Epochs simply joins a line between epochs, which is also only useful for kinematic 
data.  Symbol size defines the size of the symbols in the DXF file.  It is recommended 
that you use ‘Automatic’ on your first run.  If the symbol size turns out too small or large 
you can try the user defined size.  This may take a couple tries to get the correct size.  
The Datum options let you choose if you want to use the processing datum or input 
datum.  To change any of the grid options select the ‘Select Grid System’ tab.  If you are 
using UTM, State Plane or any other zone dependent grid check that zone entered is 
correct.  Do not assume the default is correct. 

2.6.6   View/Edit Features (Feature Editor) 
View | Features 
 
Users will want to use the Feature Editor for the following reasons: 

• Examine which features are loaded. 
• Examine the quality/accuracy of features after processing. 
• Examine the time difference, azimuth and distance between successive marks 

to identify timing and numbering errors. 
• Edit feature names, description and remarks.  For camera marks, the line 

number can be inserted into Desc/Info field. 
• Re-number stations and camera event marks. 
• Features can be disabled so that they will be neither displayed nor exported. 
• Edit the crab/drift angle for applying 3-D offsets to camera event marks. 

 
Note that changes made to stations are now saved automatically to a project.nst file.  To 
revert back to the original station information, use File | Load | Station File or File | Load 
| Camera Event Marks. 
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Figure 2.29 Feature Editor 

 
The following columns are displayed: 

Name This is the name of the feature.  The symbol next to the name indicates the 
type of point (e.g. Station, Camera Mark or GIS Mark).  The symbol will 
be grayed if the feature is disabled. 

Time This is the time that the feature was captured.  This is GPS time and not 
UTC.  To show the time in HH:MM:SS, select the ‘Show HMS’ 
checkbox. 

Q Quality Number.  1=best, 6=worst.  1=fixed integer, 2=stable float, 
3+4=converging float, 5+6=DGPS 

Std(m) Combined north, east + height standard deviation which includes additive 
PPM based error. 

Fix Y=Fixed ineger, N=float solution 
Azimuth Azimuth in degrees-minutes-seconds from previous point to current point 
Dist(m) Distance from previous point to current point in meters 
Dt(s) Time difference between current and previous point (seconds) 
Height Height of feature in meters.  Normally, this would be an ellipsoidal height.  

However, if the master station height was entered as orthometric, than this 
height will be closer to orthometric.  Use Export Wizard to get the exact 
orthometric height.  For stations with antenna heights (e.g. STA and GIS 
marks) then this height will be of the monument and not of the antenna. 

Name Repeat of the point name 
AntHgt Height of the antenna above the monument.  Note that the camera marks 

do not have an antenna height and N/A is displayed.  If a remote antenna 
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height is used in addition ot this value, the remote antenna height is added 
before this value is subtracted. 

Desc/Info Description of the point or line info for camera mark 
Remarks Remarks field 
 

The following features (buttons) are available: 
Add Station This allows the user to manually add a station.  Stations can also be 

added by right-clicking on epochs in the map window.  Users may 
wish to add stations to static sessions that have none.  This serves 
two purposes: 1) static sessions cannot handle a varying antenna 
height 2) The move-to-static feature only works on static sessions 
with features (see below). 

Remove Removes the selected stations.  Multiple stations can be selected.  
Users may wish to consider disabling a feature as opposed to 
deleting it permanently. 

Edit Edits the station name, description and remarks for the current 
selection.  Only the first selection in the list will be edited.  For 
editing multiple feature selections, use the Global Edit button. 

View Info Shows processing information about the current selected feature.  
If a station has just been added, then information cannot be 
displayed. 

Global Edit If multiple features have been selected, then this button can be 
used to make changes to the entire selection. Modifications can be 
made to the antenna height, description, camera line information, 
remarks, enable/disable flag and drift/crab angle.  See the Loading 
Camera Event Marks section for a definition of the sign of the 
angle. 

Re-Number This button allows users to re-number a selection of stations. 
Numbering can start at the bottom or the top.  In addition, users 
can specify the starting number and the increment value.  To 
decrement numbering use a negative number. 

Move-to-Static This feature is useful for seismic and other surveys where users are 
over a point for a very short amount of time. This process will 
move stations within static sessions to the end-points.  Basically, 
each static session that has a station will see the station replaced 
with one at the start and one at the end. The remarks field is 
modified to be BEGIN_STATIC or END_STATIC, which notifies 
the Export Wizard to combine the two solutions upon output.  
Upon combination, features where the begin solution and end 
solution do not match will be flagged to aid quality control. 

 
Note: Global Edit, Re-Number and Move-to-Static work with multiple feature selections.  
To select a continuous block, hold down the shift key while clicking on features.  To 
select individual features, use the ctrl key instead of the shift key. 
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2.6.7   View Objects 
View | Objects | All 
The command brings up the Object Menu for all of the epochs, Static/KAR, 
features/stations, and RTK Data in the project.  The Object Menu can also be brought up 
by right-clicking on an epoch of interest of the Map window.  In that case, only the 
features and epochs in the neighborhood of the click will be displayed. 
 

 
Figure 2.30 Object Menu 

 
The following features (buttons) are available: 

View This will bring up the Object Info message box for the selected 
object.   

Edit Edits the station name, description and remarks for the current 
selection.  If a master station is selected, this will allow you to edit 
the coordinate and antenna height. 

View/Edit GPS Various functions available.  See Section 2.2.7  for a description of 
these functions. 

Add as Station This allows the user to manually add a station.  The time will be 
automatically set as the selected object. 

Initialize Remote This allows the user to “fix” the remote position at time of the 
selected object.  This will only work on objects with valid 
solutions.  

Engage KAR KAR will be engage at the selected object's time. 
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Add to Favorites This will add the object with solution to the list of Favorites (see 
Section 8  of this chapter for more details). 

Find on Map This will show the epoch on the map of the selected object. 
Go to FML This will search the forward message log for a time closest to the 

time of the selected object. 
Go to RML Same as above but for the reverse message log. 

 
The Set Start Time and Set End Time buttons will use the select object as the start or end 
time for the processing (see Section 2.3.2). 
 
For static baseline, the 'Edit' button will display the following Static Session dialogue 
box.  It allows users to change station naming, antenna height and fixed static options (if 
desired). 
 

 
Figure 2.31 Static Session 

Time Range 
Start This displays start time and date of the data set.  It displays the GPS 

second, week number, GMT time zone, and date (mm/dd/yyyy) 
respectively. 

End This is the same as 'Start' but for the end time. 
Length This is the duration of the data set.  This is simply just the end time 

subtract the start time. 
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Point Name and Antenna Height 
Automatic Determination The will extract the antenna height and point names from 

the nearest station.  If no station exists that is close enough, 
then it will use the global remote antenna height and a 
station name of STATIC_???. 

 
Override with these values  

Point Name  This is the name of the station.  User may change the name if they 
wish. 

Antenna Height This is the antenna height of the station.  User should enter the 
antenna height if this value is known, espeicailly if a static 
session is being processed from GrafNav. 

 
Fixed Static Settings 
Fixed solution usage 

Never  Always use the float solution for each static session 
Always  Utilize the fixed integer solution for each session 
Only if distance and time OK  Check the distance and time to ensure that: 

a) The distance is not too long 
b) The time span is long enough 
The tolerances are set under the General Processing 
Options (see Static Session Settings) 

 
Use global fixed static options 

Edit Fixed Options   See Section 2.3.7. 
 
In some cases, the user may know a position of an epoch or point from some other 
means.  This could be via a previous survey, or from another base station.  It can be very 
helpful to seed or even fix the current trajectory using this other position.  There are 
several means to to this which are explained below.  Fixing a position can also be easily 
performed by "right-clicking" on an object (e.g. epoch, feature or static session) 
containing a processed position. 
 

Section 7   Export Coordinates Wizard 
The Export Wizard allows the user to customize the output text format to suit their needs.  
In addition, it has more features for controlling offsets, datums and corrections than the 
Write Coordinates method for exporting coordinates.  Users can select from some 150+ 
data variables to either try to re-produce an existing format or create their own with 
exactly the information that they need.  Please contact customer support if you need help 
with this capability. 

2.7.1   Creating Files and Profiles with Export Wizard 
Output | Export Wizard 
The new export wizard integrates the features of write coordinates with the flexibility of a 
user friendly graphical user interface that allows the user to create different output format 
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profiles.  Export profiles can be moved from one machine to another by copying the .PRF 
files to the directory containing the GrafNav/GrafNet software.  This means that profiles 
need only be created once.  
 

 
Figure 2.32 Export Wizard 

 
Creating a Profile 
1. To define a profile, click the New button and type in a unique name for your profile. 
2. From the Define Profile window, start creating your profile by adding variables you 

need into the export variables list by highlighting the chosen variable and either click 
Add (will add to bottom of list), Insert (will add variable above highlighted variable 
in list), or double-click the variable.  Listed below are options that can be changed to 
personalize each profile and also a variable reference list. 

3. Once the user is finished adding all the necessary components of the profile, click OK 
to save the profile.  The process of creating profiles is discussed further on in this 
chapter. 

 
Creating an Output File 
1. Type in a file name for your output file in the dialogue bar in the Export Coordinates 

Wizard window or accept the default name for the file (based on <project name>.txt) 
2. After a profile has been defined, click Next in the above window to start creating your 

output file. 
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3. Fill in the Export Wizard Option Dialogue Boxes in accordance with the settings 
needed (descriptions of the wizard dialogue boxes and their options are listed below 
in an individual section). 

4. Click Preview to view your file before saving it to the file path name specified. 
5. Click Finish to save your output file. 
 
Tips 
1. If the user wants to create a profile that does not have spaces between variable entries 

since the record is based on column width, the user can change this option by going to 
the define profile <name> window.  Click the Field Separator button and select the 
‘none’ option for separation character to remove any field separators in the entire file.  
The same procedure can be used to change the file to be space or comma delimited as 
well. 

 
2. When the user wants to change the file by adding a header/footer of a specific format, 

the Header/Footer option in the Define Profile Window allows the user to add 
headers/footers from a predefined text file.  If specific characters are needed to 
designate the start and end of a text file, strings of characters can also be added to the 
beginning and end of the file. 

 
3. For formats that require no decimal points to be shown in the file (ie.SEGP1, Blue 

Book), the decimal points can be removed by going into the chosen variable and 
under the Format option (or double click on the variable in the Export Variables List) 
in the Define Profile window, and selecting the ‘Do not print decimal point’ box. 

 
4. For profiles that require some delimiting with characters at places and no spaces 

between some values follow these steps.  If you want to create a format that is like 
this: 

 
StationName    hhmmssss ddmmsssssssN 

 
with a fixed width of 15 for the station name, fixed width 2 for hours, fixed width 2 
for minutes, fixed width 4 for seconds with 2 decimal places and no decimal point, 
space delimiter, 2 fixed places for degrees, fixed width of 2 for arc minutes, and a 
fixed width of 7 for arc seconds with 5 decimal places, an alphanumerical character 
representing north or south for latitude. 

 
• From the Station Names/Info menu in the define profile window, add the 
Station Name variable and choose a fixed width of 15, and left-justify for 
format. 

• From the Time/Date menu, select the GPS time variable and change the 
format to Hours with fixed width 2 and pad field with zeros.  Repeat this step 
for GPS Time (Minutes).  For GPS Time (Seconds), select a fixed width of 4, 
2 decimal places, pad field with zeros, and Do not print decimal place. 

• Under the Miscellaneous menu, select the Field Separator variable and 
choose space as the separator character 
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• In the Geographic Coordinates menu, choose Latitude and change the 
format to Degrees (unsigned) with a fixed width of 2 and pad the variable 
field with zeros.  Repeat this process for Latitude (Minutes).  For Latitude 
(Decimal Seconds), change the fixed width to 7, the number of decimal places 
to 5, pad field with zeros, and select Do not print decimal places. 

• Select the Latitude variable again and change the format to N, S, E, W 
character with a fixed width of 1. 

 
If the user needs a text string label to designate the type of record being printed/read (i.e. 
$--GLL, *81*), open up the Miscellaneous menu and add the User Text String variable.  
Change the format of the string by entering the text needed for the label and select the 
fixed width option if the format is dependent on column width. 

5. Check out the Header/Footer button.  Users can put in their own header file, they can 
show datum/projections information, column descriptions and titles.  A special 
character can also be inserted at the start of each header line.  This makes it easier for 
other software to skip past the header.  At the bottom of the file users can add 
errors/warnings of any problems that were encountered.  In addition, processing 
summary information can also be added. 

 

 
Figure 2.33 Creating a Profile 

 
Options  
Source Variables This pull down menu and backwards and 

forwards buttons lets the user toggle 
between variable categories for choosing 
variables 

111 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

Export Variables A list of variables in a scroll down menu 
that will appear in the output file in the 
path name set in Export File  

Add Adds a new variable to the end of the 
Export Variables list 

Insert Inserts a new variable above the 
highlighted variable in the Export 
Variables list 

Info Gives a brief description of the variable 
and provides information from which 
source the variable can be used 

Remove Removes the highlighted variable from the 
scroll down list 

Format Allows the user to change options such as 
fixed width, number of decimal places, 
padding values with zeroes, left-justify, 
exponential output, and string text content; 
also changes format the variable is 
displayed in (i.e. GPS Time: seconds of the 
week, HH:MM:SS.SS 

Up/Down Moves the highlighted variable up/down 
the list of variables 

 

 
Figure 2.34 Line Termination 

 
Line Termination Allows the user to choose how to modify 

the line termination of each record written 
to the file 
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Figure 2.35 Field Separation Character 

 
Field Separator Lets the user choose the character used to 

separate each variable in a record in the 
output file 

 

 
Figure 2.36 Header Footer Options 

 
Header 
File Allows the user to select a file by path 

name or browse button that will be inserted 
at the top of the output file as a header 

113 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

Datum, Geoid, and Projection Information Inserts details about the datums, geoid, and 
projections used on the variables printed 
out (i.e. if UTM eastings and northings 
were selected, the UTM zone would be 
included in this portion of text); also lists 
the coordinates of the master station 

Column Variable Contents and Description This will insert an information record for 
each variable selected.  It will show the 
column header (i.e. variable name, units 
and a description). 

String Adds a string of user defined text 
underneath Datum, Geoid, and Projection 
Information 

Variable/Field Titles & Variable/Field 
Units 

Allows the export wizard to adjust the titles 
and units in field width and the ability to 
add special characters to the titles 

 
Footer 
String Inserts a user defined string immediately 

after the data output 
Errors and warnings encountered Adds error and warning messages to the 

end of the data output to alert the user of 
any problems 

Processing Summary Information Shows the same summary screen as the 
View Processing Summary from the 
Process Options 

File Lets the user choose a file (by path name or 
browse button) for the footer that will be 
added to the very end of the output file 

 

 
Figure 2.37 Export Wizard Preview 
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Preview Displays what the output data will look like 
once it is written to a file 

2.7.2   Variable Reference 
The following list briefly describes the numerous variables that users can define in their 
profiles for output format.  Note that not all variables are available for use with each 
source. 
 
Variable 
 

Description 
 

Absolute ECEF-XYZ XYZ coordinates in the Earth Centred Earth Fixed 
Frame which is a Cartesian frame centred at the 
ellipsoid origin 
 

Ambiguity Drift Drift on ambiguities over time; low ambiguities 
indicate stable solution 
 

Antenna Height Height of the pole or tripod above the station marker 
 

Azimuth (1->2) Angle between true north and the baseline made from 
between FROM and TO stations 
 

Azimuth (2->1) Angle between true north and the baseline made from 
between TO and FROM stations 
 

British-East, North East and North coordinates in the British State Plane 
projection 
 

C/A RMS Root mean square of C/A code signal 
 

Checksum (8-bit) The absolute value calculated by using XOR, ADD, or 
NMEA methodology on the 8 data bits of each 
character in the sentence; decimal and hexadecimal 
formats may be selected (user will be prompted for 
these options after the profile is created) 
 

Combined Scale Factor Scale factor used by surveyors.  It applies the map 
scale factor combined with the ellipsoidal height 
correction, which can be used to scale distances on the 
ellipsoid to the earth’s surface. 
 

Combined Standard Deviation Combines east, north, up position standard deviations 
into one value.  Same value is written by Write 
Coordinates. 
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Convergence Meridian convergence for the current location in the 
current map projection 
 

Corrected GPS Time GPS time corrected for receiver clock bias 
 

Course Over Ground Direction of travel indicated by velocity vector. 
 

Date Date of the epoch or feature 
 

Description Description of the station or feature from the .STA file 
 

Double Difference DOP Double Difference DOP which is approximately 
equivalent to PDOP2 
 

East, North, Height Fwd/Rev 
Separations 

Separations between the forward and reverse solution 
in the east, north, and height axes 
 

East, North, Height Fwd/Rev 
RMS 

Root mean square of the separations between the 
forward and reverse solution in the east, north, and 
height axes 
 

East, North, Up Standard 
Deviations 

Estimated east, north up position standard deviations 
in the local level frame 
 

East, North, Up Velocities East, North, Up velocity components in the local level 
frame 
 

East, North, Up Velocity 
Standard Deviations 

Estimated east, north up velocity standard deviations 
in the local level frame 
 

East, North, Up Offset Applied When a 3-D offset is applied to camera event marks, 
this field can be used to verify that the proper offset is 
applied.  This offset is oriented to local level (i.e. true-
north). 
 

ECEF Covariance Matrix Estimated ECEF position covariance matrix; needs 
extended output in GrafNav 
 

ECEF Vector XYZ XYZ components of the vector between base and 
remote in the ECEF frame 
 

ECEF Velocity Covariance 
Matrix 

Estimated ECEF velocity covariance matrix; needs 
extended output in GrafNav 
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ECEF XYZ Standard Deviations Estimated ECEF position standard deviations in the 
XYZ axes; needs extended output in GrafNav 
 

ECEF XYZ velocities XYZ velocity components in the ECEF frame 
 

ECEF XYZ Velocity Standard 
Deviations 

Estimated ECEF velocity standard deviations in the 
XYZ axes; needs extended output in GrafNav 
 

Ellipsoidal Height Height above current ellipsoid; based on datum 
selected during processing 
 

Ellipsoidal Height Scale Factor 
 

Used to scale distances on the ellipsoid to the earth’s 
surface. 
 

End Time End time of the static session 
 

Error Ellipse Orientation Orientation of the error ellipse (theta) 
 

Error Ellipse Semi-Major Estimated error along the semi-major axis of the error 
ellipse (a) 
 

Error Ellipse Semi-Minor Estimated error along the semi-minor axis of the error 
ellipse (b) 
 

Extended Ambiguity Status Indicates if KAR fixed the ambiguities. 
 

Field Separator User can select what character separates each variable 
in a record 
 

Fixed Reliability Reliability number for fixed static solutions 
 

Float/Fixed Ambiguity Status Indicates if KAR fixed the ambiguities.  Also available 
in GrafNet. 
 

Gauss Kruger-East, North East and North coordinates in the Gauss Kruger 
projection 
 

Geoidal Undulation Height of the ellipsoid above or below the geoid (user 
will be prompted with options after profile creation) 
 

GLONASS/GPS Time Offset Time difference between GPS and GLONASS 
expressed in meters 
 

GLONASS/GPS Time Offset 
Stdev. 

Standard deviation of the time difference between 
GPS and GLONASS expressed in meters 
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GPS Corrected Time Exact time of measurement in the GPS time frame.  
 

GPS Course-over-ground(track) Direction of travel computed from trajectory (velocity) 
 

GPS Time/Date Time of the epoch or feature; time format may be 
changed to user’s preference 
 

GPS Week Number Week number for GPS data starting from January 4, 
1980; Depending in the format, this week number may 
or may not reset after 1023 
 

Heading Angle Negative yaw (see IMU angle definition). 
 

Height Difference Vertical height difference between stations 
 

Height Error Estimate Estimated error along the vertical axis (dh) 
 

Horizontal Distance Horizontal distance on the ellipsoid between stations 
(geodesic) 
 

Horizontal Standard Deviation Estimated position standard deviation in the east and 
north axes of a local level frame 
 

Irish-East, North East and North coordinates in the Irish State Plane 
projection 
 

L1 Doppler RMS Root mean square of L1 Doppler signal; useful for 
INS integration 
 

L1 RMS L1, or Iono-free root mean square 
 

Lambert-East, North East and North coordinates in the Lambert Conformal 
projection 
 

Latitude North/South geographic coordinate 
 

Local Level Covariance Matrix Estimated local level position covariance matrix; 
needs extended output in GrafNav 
 

Local Level Velocity 
Covariance Matrix 

Estimated local level velocity covariance matrix; 
needs extended output in GrafNav 
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Local Level XYZ Local level left hand side frame where the x axis is 
pointing east, the y axis is pointing north and the z 
axis is pointing up; the frame is centred at the master 
station 
 

Local plane XYZ XYZ axes of a coordinate frame defined by two or 
more points (see local plane options) 
 

Local Time/Date GPS time and date with time-zone offset applied 
 

Longitude East/West geographic coordinate 
 

Map Scale Factor Map projection scale computed for a location 
 

Master File Name Name of Master GPB file 
 

Num Fwd+Rev or Comb 
Baselines 

Number of baselines used in the combine the solution. 
 
 

Num GLONASS satellites Number of GLONASS satellites 
 

Num GPS satellites Number of GPS satellites 
 

Number of Satellites Total number of GPS and GLONASS satellites 
 

Orthometric Height Height above the geoid (mean sea level height)(user 
will be prompted with options after profile creation) 
 

PDOP, HDOP, VDOP Position dilution of precision, horizontal position 
dilution of precision and vertical DOP.  May be 
slightly different than values from other sources due to 
the differential computation  
 

Pitch Angle IMU pitch angle  (see IMU angle definition) 
 

Project Name Name of current project.  Useful to separate multiple 
baselines in GrafNav Batch. 

P2 RMS Root mean square of P2 code signal 
 

Quality Number Quality factor from GrafNav; 1 (best) to 6 (worst) 
 

Relative Azimuth 
 

Azimuth between current and previous feature or 
epoch. 
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Relative Height Difference Relative height difference between current and 
previous epochs or features 
 

Relative Horizontal Distance Uncorrected horizontal distance on the ellipsoid 
between the current and previous epochs.  Multiply by 
Combined Scale Factor to bring to mapping plane and 
surface  
 

Relative Slope Distance Free-air distance between neighboring epochs or 
features.  Distance between current and previous. 
 

Remarks Remarks of the station or feature from the .STA file 
 

Remote File Name Name of Remote GPB file 
 

Roll Angle IMU roll angle (see IMU angle definition). 
 

Roll, Pitch, Heading Separation The difference between the combined solutions in 
terms of Roll, Pitch, and Heading. 
 

Roll, Pitch, Heading StdDev Estimated attitude accuracy. 
 

Scale Factor Horizontal distance ratio between the globe and the 
map distance for the current point in the current map 
projection 
 

Selectable Grid Allows user to enter a north and east value for a user 
defined grid.  Grids can be modified and added using 
the Grid Manager (see Tools Menu). 
 

Sequence Number Allows the user to number epochs in the data with a 
user defined start and end sequence number, as well 
as, an incremental value 

Slope Distance Free air distance between stations 
 

Solution Type Type of solution used.  In GrafNav, possible solution 
types include SF-Carrier, DF-Carrier, IonoFree, 
RelIono, CaOnly, SingPoint.  In GrafNet, FixedSoln, 
FloatSoln. 

Standard Dev. (NO PPM) Trace of the covariance matrix expressed as a standard 
deviation; no distance dependent errors included 
 

Start Time Start time of the static session 
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State Plane-East, North East and North coordinates in the  US State Plane 
projection 
 

Static/Kinematic Status Indicates if an epoch is static or kinematic 
 

Station Name Name describing the station, feature or camera mark 
 

Surface Distance Horizontal distance between the two stations on the 
surface (corrected geodesic) 
 

Time Length Time length of the static session 
 

Time Transfer … Time transfer variables computed if the 
COMPUTE_CLOCK command is used 
 

TM-East, North East and North coordinates in the Transverse Mercator 
projection 
 

Total Slope Distance Spatial distance between two points 
 

Total Horizontal Distance The shortest path between two points on the surface of 
a sphere (e.g. Great circle) 

User Text String String of text defined by user 
 

UTC Corrected Time Same as UTC Time, but a correction for the receiver 
clock bias is applied.  This is the most precise time.  
Only applicable for epochs. 

UTC Date Date in UTC time.  
 

UTC Time Time which is available in various format.  This is the 
epochs or feature time offset from GPS seconds by the 
GPS-UTC time offset (see http://maia.usno.navy.mil/).  
This time is uncorrected for the receiver clock bias 
 

UTM-East, North East and North coordinates in the Universal 
Transverse Mercator projection 
 

VSF. Ellipsoidal Height Ellipsoidal height corrected by the map scale factor 
(see VSF options below) 
 

VSF. Orthometric Height Orthometric height corrected by the map scale factor 
(see VSF options). Used in photogrammetry 
applications to create an elevation that is more 
compatible with measured ground coordinates 
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XYZ Accelerometer Bias This is the apparent output in acceleration when there 
is no input acceleration present.  It is computed by the 
GPS/INS Kalman filter and the effects may be 
sinusoidal or random.  
 

XYZ Gyro Drift This is the apparent change in angular rate over a 
period of time.  It is computed by the GPS/INS 
Kalman filter and the effects are usually random. 
 

2.7.3   Wizard Option Screens 
Epoch Sampling Options 
 

 
Figure 2.38 Export Wizard Sampling Options 

 
Export every epoch Prints out the variables for every 

epoch in the .fwd/.rev file 
Reduce to lower sampling rate Prints out the variables for every x 

number of seconds at a lower 
sampling rate(i.e. every 10th epoch) 

Interpolate to higher sampling 
rate 

Prints out the variables for every x 
number of seconds at a higher 
sampling rate(i.e. every ½  epoch); 
this option can also be used to fill in 
missing epochs where a linear 
interpolation is used 

122 



Chapter 2  GrafNav 

Use distance dependent 
sampling 

Only exports an epoch every ‘n’ 
meters 

 
Datum Options 
 

 
Figure 2.39 Output Datum Options 

 
This page allows users to select the datum final coordinates will be output in.  Caution 
should be taken when any datum other than the processing datum is used (see Chapter 10  
Section 3).  The Input Datum allows users to convert back into the datum that coordinates 
were entered in.  This is only applicable if this datum is different from the processing 
datum. 
 
Finally, ‘Use Other Datum’ allows users to convert to a datum separate.  Again, extreme 
caution should be taken.  Many meters of additional error can be added this way.  
Be sure to select the closest appropriate conversion.  The conversion selected by 
‘Automatic’ may not be best. 
 
‘Do not convert elevation values’ is applicable if the Geoid model is meant for the 
processing datum (e.g. NAD83), but final horizontal coordinate output is in another 
datum (e.g. NAD27). 
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UTC/Local Time Options 
This correction for UTC time must be used when GPS times are converted to UTC times.  
GPS uses a linear time scale and never misses or counts a second twice, however, UTC 
time is not linear.  UTC time holds a fixed relationship to the stars and there are many 
global effects that can change this relationship slightly.  These corrections can be made as 
often as every six months but are usually only necessary every twelve or eighteen 
months.  To determine what the UTC correction should be at the time the data was 
collected, please consult the following website: http://tycho.usno.navy.mil/leapsec.html 
 
This page also allows users to set the time zone offset for local time output.  This is the 
number of hours offset from GMT. 
 
Apply 3-D Offset 
 

 
Figure 2.40 Apply 3-D Offset Page 

 
This page will appear if camera event marks are being exported.  It allows users to apply 
a 3-dimensional offset from the antenna to the measurement device (e.g. entry nodal 
point on aerial camera).  The offset is defined in the local body system of the aircraft, and 
not the camera.  The right handed coordinate system is defined as follows: 
 x-axis positive axis through the front nose of the aircraft 
 y-axis positive axis through the left wing 
 z-axis positive axis through the roof 
Note that this vector is from camera to antenna (i.e. z-axis value is normally positive). 
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In order to transform this body frame vector to local level, aircraft attitude is required.  
This can be supplied when the camera event marks are imported.  If no attitude is present, 
then the heading is assumed to be the course-over-ground (direction of travel).  This can 
have errors of many degrees due to the aircraft’s crab angle.  User’s can also supply a 
crab/drift angle (if known) in the Feature Editor (see Section 2.6.6  View/Edit Features 
(Feature Editor)) using the Global Edit button.  Note that the export wizard has variables 
for the offsets after they have been rotated to local level.  It is suggested that these be 
exported to check offset vector. 
 
Combine Features 
 

 
Figure 2.41 Combine Features 

 
For data sets with numerous static sessions separated by kinematic, coordinates can be 
produced in a more optimum fashion.  This is done by forming a combined solution using 
the solutions from the start and end of each static period.  It is also important to process 
both forward and reverse, and a combined solution should be loaded. This methodology 
works well because in applications such as high tree cover, the first and last epochs of a 
given static session can be significantly different.  This feature flags such points and puts 
more weight on the solution with the best estimated standard deviation.   
 
In order for features to be combined, features/stations must be selected as the Source 
from the main Export Wizard screen.  In addition, each static session must have a station 
at the start and end.  The remarks field for such stations should be “BEGIN_STATIC” at 
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the start and “END_STATIC” at the end.  The Ashtech Download decoder will 
automatically insert these fields if the ‘Extract station information from Ashtech D-File’ 
setting is used along with the Seismark data collector software.  The new WinCE data 
logger will also create such files if the appropriate station selection is used.  Otherwise, 
features can be moved to static session start and end using the Feature Editor (i.e. Move 
to Static button). 
  
When ‘Combine Features’ is used, a .log file can be created that shows statistics about 
each combination.  In addition, the remarks field will be replaced with a status message.  
The KinSurveyStations export profile is well suited for use with this methodology. 
 
Tolerance between start/end position: 
This is the minimum difference between start/end values necessary to generate an error 
message.  For the above Figure 2.41, if the horizontal or vertical difference is less than 1 
m, then the combination is deemed to be OK. 
 
Log messages to File.log 
This checkbox allows messages to be logged to a separate file.  This is a good quality 
control feature.  The ‘Stdev. warning tolerance’ is used to flag points with very poor 
estimated standard deviations. 
 
Select Grid System and Settings 
If the selectable grid north and/or east variable is used, then this page is displayed.  It is 
the same page if the Grid Options are selected from the Options Menu.  Basically, users 
will select the Grid model to use.  For some grids such as UTM, the zone number must 
also be entered.  For State Plane, the state plane zone (STATE + REGION) must be 
selected. 
 
UTM Options 
 

Zone Number The UTM zone of the desired output; Note that 
UTM zones are separated by 6° and start 
numbering from west to east starting at 180° W 
with the central meridian at 177°W 

 
Gauss-Kruger Options 
 

Zone Number Defines Gauss-Kruger zone, that output should be 
in (see UTM) 

 
Transverse Mercator Options 
 

Central Meridian Defines the central meridian of the Transverse 
Mercator projection 

Central Meridian 
Scale Factor 

Specifies the scale factor along the central 
meridian 
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False 
Easting/Northing 

If the coordinates in the TM projection are 
negative values, the false eastings and northings 
force the coordinates to all positive values 

 
If a latitude origin is specified in your Transverse Mercator coordinate system, then use 
the Grid Manager along with the Selectable Grid export variables, as this supports this 
parameter. 
 
State Plane Options 

 
Select region Allows the user to define which state plane 

region the points are in 
Datum The datum is set for NAD83 for all state plane 

coordinates; NAD27 will be selected if 
processing is in that datum.  The user may not 
change the datum.  This must be done through 
the datum or processing options. 

 

 

 

 

Central Meridian and Central Parallel: Defines the central meridian and parallel for the 
Lambert Conformal projection (dms). 
 
 

Lambert Conformal Options 

Figure 2.42 Lambert Conformal Options 

Origin 
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Standard Parallels 
Lower and Upper Standard Parallels: Specifies which lower and upper parallels are 
standard (i.e. constant scale factor) (dms). 
 
Central meridian scale factor 
Initializes the scale factor along the central meridian (usually 1.0). 
 
False Easting, False Northing 
If the coordinates in the Lambert Conformal projection are negative values, the false 
easting and northing force the coordinates to all positive values. 

Vertical Scale Factor Options 

 
Figure 2.43 Vertical Scale Factor 

This correction is normally only used by photogrammetric users.  When performing 
photogrammetric aerial triangulations, these algorithms known as block adjustments 
often assume the scale factor for the horizontal and vertical coordinates.  The block 
adjustment can either be a bundle adjustment (e.g. GPSBund, PAT-B, ALBANY, etc…) 
or an independent model adjustment (e.g. SPACE-M, PAT-M).  When map projection 
coordinates (e.g. UTM, Gauss-Kruger, State Plane, Lambert, etc…) are used in the 
adjustment, then the horizontal coordinates are scaled by the map projection scale factor, 
while vertical coordinates if uncorrected will have a scale factor of one.  Adjustments like 
PC-GIANT that work in a geocentric frame are unaffected but such adjustments are not 
very compatible with soft-copy systems. 
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To counter-act this problem, GrafNav can apply a correction to the vertical component 
that corrects for much of the scale error.  Currently, GrafNav assumes a constant terrain 
height, and this correction will be most accurate in flat areas.  It will be less accurate in 
areas with high relief as the constant height model no longer holds true.  Aircraft height 
variations are taken into account.  GrafNav will prompt the user for the average height of 
the ground.  If the user outputs height in feet, then this height should also be in feet. 
 

This feature enables you to rotate and scale processed feature or epoch output coordinates 
into a local coordinate frame.  Note that the Z coordinate will be a differential ellipsoidal 
height, and not a Cartesian coordinate.  There are three types of local transformations 
supported in GrafNav and GrafNet: a 4-parameter 2D transformation, a 6-parameter 2D 
transformation, and a 7-parameter 3D transformation.  The parameters that are solved by 
each transformation are shown in the table below: 
 

 
The local frame that you will transform the processed output coordinates into is defined 
by a number of previously surveyed points.  The minimum number of such points needed 
for the transformation depends on the number of parameters that need to be solved for.  
In general, the minimum number of individual coordinates (i.e. X, Y, and Z) that need to 
be defined for any specific transformation is equal to the number of parameters being 
solved for. Each coordinate must be given in either meters or feet. 

So, for the 4-parameter 2D transformation, the northings and eastings of at least two 
points will be required.  Similarly, for the 6-parameter 2D transformation, the northings 
and eastings of three points will be required.  Performing a 7-parameter 3D 
transformation requires seven known coordinates.  Six of these coordinates must define 
two points completely (i.e. X, Y, and Z).  Either a height for a third point must be 
entered, or another horizontal pair of coordinates must be entered to solve for the final 
parameter. 
 

Local Plane Options 

Transformation: Parameters: 
4-parameter 2D 2 translations, 1 rotation, 1 scale 
6-parameter 2D 2 translations, 1 rotation, 2 scales, 1 skew angle 
7-parameter 3D 3 translations, 3 rotations, 1 scale 

 

Using the 6-parameter 2D transformation or the 7-parameter 3D transformation can be 
very dangerous.  The horizontal axes (i.e. X, and Y) will probably no longer be 
perpendicular to one another when using the 6-parameter 2D since the transformation 
allows for a skew between these axes.  Coordinates transformed using the 7-parameter 
3D transformation are not necessarily in a local-level frame any more, which can cause 
severe problems in many applications. 
 
To indicate which type of transformation you would like to perform, and which points 
you would like to use as known points, GrafNav provides the Local Coordinate 
Transformation dialogue box shown on the following page. 
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Figure 2.44 Local Coordinate Transformation Dialogue Box 

 

 

 

Use the Add, Remove, and Edit buttons to define the reference points in the 
transformation.  The Local Station Information dialogue box below is used to add and 
edit points.  The name given to a known point must be the same as the name of the station 
it corresponds to.  Pressing the search button will provide a list of the points that GrafNav 
or GrafNet has GPS coordinates or master coordinate for, and a list of the points with 
known coordinates that have previously loaded.  These lists are displayed in the Search 
for Station dialogue box.  

Figure 2.45 Adding a station 
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The Favorite Points that are referred to in the first two dialogue boxes are points that you 
may want to use as known points in many different projects.  GrafNav saves the coordinates 
of these points to a file called ‘local.fav’ in the program files directory so that they can be 
used at any time without having to be re-entered.  To use one of these points in the 
transformation, its name must be the same as its corresponding point in GrafNav. 
 

Figure 2.46 List of Favourites 
 

 

131 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

Geoid Correction Options 
 

Figure 2.47 Geoid Correction Options 
 

GPS works in the ellipsoidal height system.  However, many maps and vertical datums 
are defined in the orthometric system (height above mean sea level).  GrafNav can make 
use of the .BIN/.SLV and .GEO GEOID files produced by the Canadian and American 
governments.  GrafNav also supports various geoids in the .WPG (Waypoint Geoid 
Format).  This includes files for US Geoid99 and Geoid96, Australia AusGeoid93, and 
EGM96 for the World.  These files are located on the distribution CD in the \Geoid 
directory.  Using these files, GrafNav can produce orthometric heights as output.   
 
The user will be asked where the GEOID files reside and whether the base station height 
is orthometric or ellipsoidal.  Selecting “Orthometric” will apply a relative geoid 
correction, while using “Ellipsoidal” will apply an absolute correction.  The automatic 
setting (‘automatically select using input master height type’) will use the 
ellipsoidal/orthometric flag selected in the master station input. 
 
Note that the Geoid Correction option requires geoid95.bin and geoid95.slv or 
geoid91.bin and geoid91.slv from the Geodetic Survey of Canada, geoid##.geo from 
NGS in the United States or the appropriate .WPG file.  For Canada, these files must be 
obtained from GSC since they are NOT PROVIDED. 
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Geoid    
 Geoid File Name Allows the user to select the proper file 

containing information on the geoid 
and its format 

Master Station Height 
 Automatically select using 

input master height type 
Uses the ellipsoidal/orthometric height 
flag that can be selected when the 
master station coordinates are entered.  
When selected, the grayed radio button 
below will indicate which selection was 
made. 

 Ellipsoidal  Height entered for the master station 
coordinates is an ellipsoidal height 

 Orthometric (mean sea level) Height entered for the master station is 
an orthometric (mean sea level) height 

2.7.4   Export Wizard Tutorials - Creating Your Own Format 
To familiarize the user with Export Wizard, several tutorials on how to use the wizard are 
included in the following section to give the user a background on the process of creating 
a custom output format.  Several frequently data formats have been created as profiles to 
help the user. 
 
$GPGGA – NMEA format Example 
GGA – Global Positioning System Fix Data 
Time, position and fix related data for a GPS receiver. 
 
$GPGGA,hhmmss.ss,llll.ll,a,yyyyy.yy,a,x,xx,x.x,x.x,M,x.x,M,xxxx*hh<CR><LF> 
 
Description Format Comments 

 
UTC of 
position 

hhmmss.ss hoursminutes.decimal, where there are 2 fixed digits for 
hours, 2 for minutes, and variable number of decimal 
places for decimal minutes fraction (however, user must 
specify this manually to the number of decimal places in 
the export wizard); leading zeros are needed for hhmmss.ss 
 

Latitude  llll.ll degreesminutes.decimal;2 fixed digits for degrees, 2 fixed 
digits for minutes, and a variable number of decimal places 
for decimal minutes fraction; pad with leading zeros 
 

Latitude – 
N/S 

A Alphanumerical character for N or S 

Longitude  yyyyy.yy degreesminutes.decimal;2 fixed digits for degrees, 2 fixed 
digits for minutes, and a variable number of decimal places 
for decimal minutes fraction; pad with leading zeros 
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Longitude – 
E/W 

A Alphanumerical character for E or W 

GPS Quality 
indicator 

X Numerical character; 0-8; refer to NMEA 0183: Standard 
For Interfacing Marine Electronic Devices Version 2.30 for 
GPS Quality indicator codes 
 

Number of 
satellites in 
use 
 

Xx 00-12; numerical field; pad with leading zeros 

Horizontal 
Dilution of 
Precision 
 

x.x Variable field width 

Altitude re: 
mean sea 
level (geoid), 
meters 
 

x.x,M Variable field width for altitude; alphanumerical character 
M for meters 

Geoidal 
separation 
(undulation), 
meters 
 

x.x,M Variable field width for geoidal separation; alphanumerical 
character M for meters 

Age of 
differential 
GPS data 
 

x.x Variable field width; time in seconds since last SC104 
Type 1 or 9 update, null field (,,) when DGPS is not used 

Differential 
reference 
station ID 

Xxxx 0000-1023; numerical field; pad with leading zeros 

 
To use the Export Wizard step by step to create a custom format, follow these 
instructions: 
 
Steps: 
1. Open a project in GrafNav and load a forward or reverse solution. 
2. Open the export wizard by pressing the Export Wizard button on the tool bar or 

access it from the menu Output | Export Wizard. 
3. Type in the file path name or press the Browse button if you want to select a file other 

than the default file name. 
4. Press the New button to create a new profile and enter the profile name in the space. 
5. A Define Profile window will appear after OK is pressed, variables can be added to 

the Export Variables list from the Source Variables window beside it. 
6. Click on Header/Footer and remove all checked boxes in the options dialogue box 
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7. Press the Line Terminator button, and make sure the line terminator characters are 
CR+LF 

12. Add another comma field separator from the ‘Miscellaneous’ menu. 

17. Repeat steps 12-15 under the Geographic Coordinates menu for Longitude. 

22. The HDOP is not a valid variable at this time (June 10, 1999), but the Double-
Difference DOP is available.  Add the DDOP from the Statistics menu. 

8. For the field separator, press the Field Separator button and click the None option 
since not all variables need to be separated by commas.  Field separators can be 
manually added into the Export Variables list if needed. 

9. To begin the data format sentence with $GPGGA, select Miscellaneous from the 
scroll down menu of Source Variables and highlight User Text String.  Double-click 
on User Text String and type in $GPGGA into the bar, click on the fixed width box 
and fill in a width of 6 in the box. 

10. In the same ‘Miscellaneous’ menu, double click on the Field Separator variable and 
select the comma radio button. 

11. Go to the Time/Date menu and select UTC Time and add it to the list.  First change 
the UTC Time format to Hours under the Format/Units menu and next make sure the 
fixed width and the pad field with zeros options are selected.  Repeat the same 
procedure for minutes and seconds. 

13. Go to the Geographic Coordinates menu and add the Latitude variable.  Change the 
format to Degrees (unsigned) and then add Latitude again under the format of 
Decimal Minutes.  Enable the fixed width and pad field with zeros options. 

14. Add a comma field separator. 
15. From the Geographic Coordinates menu, add Latitude again using the format N, S, E, 

W Character option. 
16. Add a comma field separator. 

18. For GPS Quality indicator, use the User Text String variable in the ‘Miscellaneous’ 
menu to add a string of 1 character long.  Be sure to fix the width to 1. 

19. Add a comma field separator. 
20. From the Statistics menu, add the number of satellites variable and fix the field width 

to 2 and select the pad field with zeros option. 
21. Add a comma field separator. 

23. Add a comma field separator. 
24. Under the Height/Elevation menu, select and add Orthometric Height to the list and 

make sure the units are in meters. 
25. Add a comma field separator. 
26. From the ‘Miscellaneous’ menu, add a User Text String of one character (fixed 

width) of the letter M. 
27. Add a comma field separator. 
28. From the Height/Elevation menu, add Geoidal Undulation to the list and check to see 

if the units are in meters. 
29. Add a comma field separator. 
30. From the ‘Miscellaneous’ menu, add a User Text String of one character (fixed 

width) of the letter M. 
31. Add a comma field separator. 
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32. If you are not using DGPS, the age of differential GPS data option can be ignored by 
adding a null character (i.e.’’).  Therefore, add a comma field separator. 

33. Go to the Station Names/Info menu and add the Sequence Number variable to take 
the place of the Differential reference station ID (0000-1023).  The user will be 
prompted later after profile creation for the range of the station ID numbers and the 
increment value. 

34. Add the checksum delimiter by using Field Separator under Miscellaneous and select 
the Character radio button and type the * symbol in the box. 

35. From the ‘Miscellaneous’ menu, choose the Checksum (8-bit) variable and change 
the format to NMEA-methodology enabled and hexadecimal format for $GPGGA. 

36. Press OK and then Next to start choosing the final options before outputting your file. 
37. Select the geoid file name by typing in the path name or use the Browse button.  

Select either ellipsoidal or orthometric height based on which one was used for the 
master station. 

38. Under the Sampling Mode dialogue box, choose the sampling rate for the number of 
epochs to be printed out.  Press Next. 

39. Select the Output UTC time instead of GPS option and either keep the nominal UTC 
time offset or type in your own.  Press Next. 

40. For the Sequence Number options, start the count at 0 and restart counting sequence 
when the count exceeds 1023, increment the sequence value by 1 and check the 
option of continuing the count for epochs not written.  Press Next. 

41. Press Preview if you would like to take a look at your file before saving it.  Press 
Finish to save the file. 

 
 NGS Blue Book *80* ,*86* Example 
The following example goes through the procedure of making a basic *80*, and a *86* 
data code record for the NGS Blue Book format.  Since the format requires that there are 
no decimal points in the data record, slight modifications to the units and field width will 
have to be made to accommodate for this profile. 
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Steps: 
1. Open a project in GrafNav and load a forward or reverse solution. 
2. Open the export wizard by pressing the Export Wizard button on the tool bar or 

access it from the menu Output | Export Wizard. 
3. Type in the file path name or press the Browse button if you want to select a file other 

than the default file name. 
4. Press the New button to create a new profile and enter the profile name in the space. 
5. A Define Profile window will appear after OK is pressed, and variables can be added 

to the Export Variables list from the Source Variables window beside it. 
6. Click on Header/Footer and remove all checked boxes in the options dialogue box 
7. Press the Line Terminator button, and make sure the line terminator characters are 

CR+LF 
8. For the field separator, press the Field Separator button and click the None option 

since not all variables need to be separated by commas.  Field separators can be 
manually added into the Export Variables list if needed. 

9. Go into the Station Names/Info menu and add the Sequence Number variable of fixed 
width 6 and select the pad field with zeros option.  After the profile is created, the 
options for start and end time, as well as, the incrementing value will be prompted 
from the user. 

10. Using the User Text String, add a fixed width 4 for the string containing the data code 
*80* 

11. Add a User Text String from the ‘Miscellaneous’ menu of fixed width 4 for SSN. 
12. From the Station Names/Info menu, add the variable Station Name to the Export 

Variables list, and change the fixed width to 30 and unclick the Left-Justify box. 
13. Go to the geographic Coordinates menu and add the Latitude variable.  Change the 

format to Degrees (unsigned) with a fixed width of 2, padded with leading zeros, and 
then add Latitude again, but now change the format to Minutes with fixed width 2 and 
padded with leading zeros as well.  Make sure that both degrees and minutes do not 
have decimal places.  Add Latitude once again and change the format to Decimal 
Seconds with fixed width 7 and the padded with leading zeros option and do not 
display decimal point options selected. 

14. From the Geographic Coordinates menu, add Latitude again using the format N, S, E, 
W Character option. 

15. Repeat steps 12-13 for Longitude; however change the fixed width of Longitude 
(Degrees) to 3 instead of 2. 
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16.  From the Height/Elevation menu, add Ellipsoidal Height, fix the width to 6 and 
change the units to meters and make sure the pad with leading zeros and do not show 
decimal point options are selected. 

17. Using User Text String from the ‘Miscellaneous’ menu, create fixed width strings of 
1, 2, 1, and 1 space width for each of the following: Elevation Code, State Code, 
Station Order, and Station Type. 

18. From the ‘Miscellaneous’ menu, select the Field Separator and add CR+LF to the list. 
19. Go into the Station Names/Info menu and add the Sequence Number variable of fixed 

width 6 and select the pad field with zeros option.  After the profile is created, the 
options for start and end time, as well as, the incrementing value will be prompted 
from the user. 

20. Using the User Text String, add a fixed width 4 for the string containing the data code 
*86* 

21. Add a User Text String from the ‘Miscellaneous’ menu of fixed width 4 for SSN. 
22. Add a fixed width 2 User Text String for a blank to the variables list from the 

‘Miscellaneous’ menu. 
23.  From the Height/Elevation menu, add Orthometric Height, fix the width to 7 and 

change the units to meters and make sure the pad with leading zeros and do not show 
decimal point options are selected. 

24. From User Text String in ‘Miscellaneous’, make strings of widths 1, 1, 1, 1, 2, and 6 
for OHT code, OHT order, OHT class, OHT NGISDB indicator, OHT datum, and 
Organization. 

25.  From the Height/Elevation menu, add Geoidal Undulation, fix the width to 7 and 
change the units to meters and make sure the pad with leading zeros and do not show 
decimal point options are selected. 

26. Add 2 User text Strings of fixed widths 1 and 2 for the variables GHT code and 
blank. 

27.  From the Height/Elevation menu, add Ellipsoidal Height, fix the width to 7 and 
change the units to meters and make sure the pad with leading zeros and do not show 
decimal point options are selected. 

28. Create User Text Strings from the ‘Miscellaneous’ menu for EHT code, EHT order, 
EHT class, EHT Datum, and Comment for fixed widths of 1, 1, 1, 1, and 24 and click 
OK when finished. 

29. Click Next, and now select the file path name or press the Browse button to select the 
geoid file from the directory tree structure.  Select either ellipsoidal height or 
orthometric height based on the type of height that was measured at the master 
station.  Press Next. 

30. Depending on how many epochs the user wants printed to a text file, select one of the 
options: Export every epoch, Reduce to lower sampling rate, Interpolate sampling 
rate, Use distance dependent sampling.  If there is a large amount of data or if there 
are missing epochs, the latter options are suggested.  Press Next. 

31. Select 0 for the start value of the Sequence Number, increment the sequence number 
by 10 for Blue Book records, and select a reset value after the Sequence Number 
exceeds 99999.  Make sure the continue incrementing even when epochs/features are 
not written option is chosen.  Press Next. 

32. Press Preview to view the file being created.  Press Finish to save the file. 
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Section 8   Favourites Manager 

2.8.1   Getting Started 
 

 
Figure 2.48 Favourites Manager 

 
Use this feature to avoid unnecessarily retyping coordinates that are used often.  It is 
accessed from GrafNav, GrafNet, and GrafNav Batch from the Tools menu. 
 
Upon loading the Favourites Manager, a list of favourite groups appears.  If this feature 
has never been used before, eight or possibly nine groups should appear: 
 

• ASI 
• BKGI 
• CDDIS 
• CORS 
• GSI 
• IGN 
• IGS 
• OLG 
• Previous_Fav (may not appear) 

 
The groups ASI, BKGI, CDDIS, CORS, GSI, IGN, IGS and OLG contain a list of control 
points that continuously collect GPS data that can be downloaded free of charge from the 
download program (Tools | Download Service Data).  Previous_Fav will only exist if you 
have favorites from the previous installation. 
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In the installation of version 7.50, you are prompted to locate the directory where your 
previous version of GrafNav/GrafNet is installed.  This will automatically copy all of 
your user files (including your previously stored favourites) into version 7.50.  You may 
follow these steps to manually copy your favourites into version 7.50: 
 
Conversion from 6.02 to 7.50: 

1. Copy the file Master.fav from your 6.02 (or earlier) directory (the same directory 
that contains the 6.02 version of wgrafnav.exe) 

2. Paste into the new 7.50 directory (the same directory with the 7.50 version of 
wgrafnav.exe) 

3. Load the Favourites Manager in version 7.50 
4. Upon loading the favourites manager, a message will appear warning the old 

favourites are being read in the WGS84 datum and height coordinates as 
ellipsoidal.  If this is not the correct coordinate format, you must change them 
individually by using the Edit button, which is described later. 

 
Conversion from 6.03 to 7.50: 

1. Copy the file User.fvt from your 6.03 directory (the same directory that contains 
the 6.03 version of wgrafnav.exe) 

2. Paste into the new 7.50 directory (the same directory with the 7.50 version of 
wgrafnav.exe) 

3. Load the Favourites Manager in version 7.50 
4. Upon loading the favourites manager, version 6.03 favourites will now be loaded 

into the vesion 7.50. 
 

2.8.2   Working with the favourites manager 
What follows is a brief discussion of the buttons on the favourite manager interface. 
 
Add Site, Add Group, and Remove 
Often new groups are created when starting a new project to facilitate easy removal after 
project completion. 
 
Info 
If clicked on an entire group, returns the total number of sites contained in the folder. 
If clicked on an individual station, returns position, height type and datum type. 
 
Edit 
Rename the entire group or edit the coordinates of individual stations using this function. 
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Add from File 
 

 
Figure 2.49 Load From Favourites File 

 
Lists of coordinates can be directly read in from a file using this feature.  Simply browse 
to the file, specify the input height type and Lat/Lon format of the file, and Load. 
 
Rejected Sites 
If only a few sites were rejected it could simply mean that the lines in the header were 
rejected (the program has no way of knowing what header information is, it will simply 
reject lines that do not conform to the expected input format).  However, if no points 
were accepted, this is an indication of problems in the input file. 
 
The input coordinates must be signed to indicate hemisphere, and must not have N/S or 
E/W preceding or following the coordinates.  Another major cause of failure is the way 
the station name is read in, which is controlled by the ID string handling option. 
 
The station name should precede the latitude, longitude, and height in the input file.  If 
the station name is FRED1, the default option (Use first continuous word (no spaces)) 
should work, as there are no spaces in the name.  If, however, you wish to specify the 
name as FRED 1, there must either be a comma after FRED 1 and the file read in as 
.CSV format, or you could choose to read in the first 6 columns for the ID string.  If you 
chose the latter option, all the station names must also be fixed at six characters or less.  
Note all other fields should simply be separated by a space. 
 
Examples of input file formats and how the ID strings cam be handled: 
 
Use first continuous word (no spaces) 

141 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

POINTONE 34 26 09.98731 -114 26 09.98731 12.01 
POINT2 36 12 56.12154 -114 12 56.12154 14.23 
POINTTHREE 52 12 00.00000 -56 00 23.01213 1112.45  
 
Comma separation (csv format) 
POINT ONE,34,26,09.98731,-114,26,09.98731,12.01 
POINT 2,36,12,56.12154,-114,12,56.12154,14.23 
POINTTHREE,52,12,00.00000,-56,00,23.01213,1112.45  
 
Use first n Columns (in this case n = 7) 
POINT 1 34 26 09.98731 -114 26 09.98731 12.01 
POINT 2 36 12 56.12154 -114 12 56.12154 14.23 
POINT 3 52 12 00.00000 -56 00 23.01213 1112.45 
 

Section 9   Interactive Windows 

2.9.1   Mapping Window 
 

 
Figure 2.50 Mapping Window 

 
This screen is a graphical representation of the project area.  It shows the master station, 
the location of the remote station at each epoch, and station or event marks.  The master 
station is represented by a solid green triangle.  The event marks are shown as blue 
circles, and the station marks are shown as yellow triangles.  The remote locations are 
shown as small crosses.  The colour of the cross depends on the quality of the solution.  
The colours displayed are listed below: 
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Quality Number Description 
 

Quality Colour Meaning Accuracy (m) 
1 Green Fixed Integer 0.00 – 0.15 
2 Cyan Converged Float 

or Noisy Fixed Integer 
0.05 – 0.40 

3 Blue Converging Float 0.20 – 1.00 
4 Purple Converging Float 0.50 – 2.00 
5 Magenta DGPS 1.00 – 5.00 
6 Red DGPS 2.00 – 10.00 

Unprocessed Grey Has not been processed N/A 
 
Note: The accuracies given above are only guidelines.  The actual accuracies may be 
very different, and in fact, much worse.  The user should also check the standard 
deviation values, which are also a guideline. 

2.9.2   Mouse Usage in Mapping Window 
Positioning the cursor on a station or epoch mark and clicking with the left mouse button 
will bring up either the Station Information, or Epoch Information message boxes. 
Clicking the right mouse button instead of the left mouse button, the Object Menu will 
come up (see Section 2.5.5  User Defined Options). 

2.9.3   Processing Window 
This window appears during processing and it will show position, status, satellite and 
message information originating from the processing engine.  Such various types of 
information are contained on different pages, which can be accessed by pressing the 
appropriate radio button, near the top of the processing window. 
 
Also displayed on this window is a graphical quality bar.  It ranges from 1 to 6, where 1 
is best, and 6 is worst.  The quality number is dependent on a number of factors but it is 
most sensitive to solution stability.  If this bar jumps from 1 to 6, either a serious loss of 
lock has occurred or, unfixable bad measurements have incurred a Kalman filter reset in 
kinematic mode.  At this point KAR will be engaged if enabled.  Stable solutions are 
usually 1 or 2 for carrier phase processing.  For code-only processing, the quality will 
range from 3 to 6. 
 
This dialogue box has two checkboxes: 

Split windows This shows a two-window display.  Users can select either 
window, except that when KAR engages, it will utilize the 
right page. 

Show message log   This displays the status messages written to the message log 
file.  It updates in real-time.  Enabling this can significantly 
slow processing down!!! 
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Figure 2.51 Processing Window 

 
The status bar at the bottom of the processing window shows whether the current epoch 
is static, kinematic or if KAR is engaged.  This status bar also indicates if the current 
process is using the forward or reverse direction.  The static processing mode selected is 
also displayed.  Lastly, the number of epochs that have been processed is shown.  This 
screen is not updated every epoch rather, it is updated every N milliseconds.  This update 
interval can be changed from the display options in both GrafNav and GrafNet, and the 
default is 500 milliseconds. 
 
The meanings of the various parameters are given below: 
 
Parameter Description  Page 
GPS Time Epoch time given in seconds of the week, GMT 

hours, minutes, seconds time is also given. 
Info/coordinate 
& Status 

DD DOP Instantaneous dilution of precision using double 
difference model.  Large values indicate poor 
satellite geometry, which may cause position 
accuracy degradation.  PDOP is approximately the 
square root of this value. 

Info/coordinate 
& Status 

Quality Number Qualitative indicator ranging from 1 to 6 where 1 is 
best and 6 is worst. 

Info/coordinate 
& Status 

Latitude, 
Longitude, Height 

Geographic position of remote at current processing 
epoch. 

Info/coordinate 

Speed Vehicle instantaneous velocity vector in m/s.  This 
value may be inaccurate for code-only processing. 

Info/coordinate 
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L1 RMS RMS fit of L1 carrier phase data should normally be 
<0.03m.  However, larger values are acceptable for 
very long baseline processing. 

Info/coordinate 
& Status 

CA RMS RMS fit of C/A code.  This value is a good indicator 
of multipath.  However, various receiver types will 
have different values.  For example, precise 
correlation receivers should have values <3m, while 
some standard correlation receivers can have values 
>5m. 

Info/coordinate 
& Status 

Num Cycle Slips Number of detected cycle slips.  However, due to 
the lock time cut off, normally set to 8 seconds.  
This value may stay near zero. 

Status 

Num <4 Sats Number of epochs less than 4 satellites Status 
Separation Distance separation between base and remote 

stations expressed in km. 
Status 

PRN Satellite vehicle number (1-31) Satellite 
Elev Satellite Elevation (degrees) Satellite 
Az Satellite Azimuth (degrees) Satellite 
DD Amts Last few digits of double difference L1 carrier phase 

ambiguity.  For accurate short baseline processing 
these values should be near integer. 

Satellite 

 
KAR display: 
During processing, the message page will contain status of the last KAR solution.  The 
following variables are displayed: 

Time since engage This is the number of seconds or minutes since KAR 
was engaged.  KAR can be engaged for a number of 
reasons including loss of lock, poor geometry, data 
errors etc… 

Time skipped This is the time that KAR was unable to restore.  Once 
KAR has a successful solution, it tries to go backwards 
as far as possible.  This is the difference between the 
restore time and the original cycle slip time. 

Search distance This is the distance when the ambiguity search was 
performed.  This is not the distance when KAR was 
restored. 

Avg. num sats This the average number of satellites used to compute 
KAR statistics.  It will always be greater than or equal 
to 5 

Noise model This is the model that KAR used to model L2 during 
processing.  See Advanced KAR Options. 

RMS: This is the RMS fit of the KAR search and statistical 
testing of previous data.  This number is in cycles.  
Values better than 0.04 usually indicate a correct 

Minutes used This is the time that KAR used for a solution.  It is not 
the time since engagement. 
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solution.  However, this number can be larger and still 
be correct.  The tolerance for passing is 0.065 cycles. 

Reliability This is the ratio between the second best RMS and the 
best RMS.  Ratios above 3-4 are usually a pass for dual 
frequency.  The tolerance is variable depending on the 
float-fixed separation. 

 
Fixed solution display: 
During processing, the message page will contain status of the last KAR solution.  The 
following variables are displayed: 

RMS(m) RMS value computed by fixed solution (should be less than 0.02) 

Frequency SINGLE or DUAL.  Dual frequency receivers will try a single 
frequency solution if they fail on shorter baselines. 

Time Number of Hours:Minutes:Seconds used in the solution 
Type Fixed static solution type used.  Continuous is the pre-version 6.00 

type.  It uses the best continuous block of data.  NewFixed (multi-
sat) uses all of the data.  It may reject some satellite arcs (see 
Static/KAR summary file). 

 

2.10.1   Help Topics 
Here the user can find online help topics similar to the ones published in this manual. 

2.10.2   www.waypnt.com 

Float/fixed separation This is the distance between the solved fixed integer 
solution and the float solution at time of search.  Low 
numbers indicate a good correspondence between the 
two solutions.  

Reliability This is the ratio between the second best RMS and the best RMS.  
Ratios above 3-4 are usually always a pass for dual frequency.  
The tolerance is 1.5. For single frequency, ratios are lower, but 2 or 
greater is usually correct.  The tolerance for single frequency is 
1.35. 

Section 10   Help Menu 

Click this to open a web browser to Waypoint’s homepage.  Details on latest versions, 
patches, information on GPS/INS, and tech reports can be found on our webpage. 
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2.10.3   About GrafNav 

 
Figure 2.52 About Box 

 
By clicking ‘Download latest manufacturer files’ the user will automatically connect to 
Waypoint’s download FTP site (internet connection required) and download the 
following manufact files: 

 

 
This window displays information about the software version, build dates, copyright 
information, hardware lock key information, and dll information.  User’s can access the 
hardware key utility from this window by clicking ‘Key Util (Upgrade)’ if they need to 
upgrade their hardware lock.  The dependent files window displays a list of executables 
and dlls associated with GrafNav.  The date and time of the files are shown as well as a 
quick description of the file.  Other programs (such as the convert utility, download 
service data, and GrafNet) have this feature as well. 

 
manufact.adf – List of antenna profiles.  See Section 10.3.2  for more details. 
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manufact.dn1 – List of base stations available for the download utility.  This is usually 
updated monthly.  This file can also be updated within the download utility, see Chapter 
6  Section 9  for more details. 
manufact.dtm – A list of datums, ellipsoids, and transformations between datums.  See  
Chapter 10  Section 5  for details. 

manufact.grd – A list that contains available grids such as UTM, US State Plane, Gauss 
Kruger etc.   See Section 2.5.1  for more details. 
manufact.svi – A file that associates a PRN number with a satellite type (Block II, Block 
IIA etc.) for purposes of determining the center of mass of the satellite.  It assists in 
single point processing.  This file should not be modified. 
manufact.imu – Inertial Explorer Only.  Contains a list of IMU error models tested and 
built into Inertial Explorer.  See Section 5.4.5  for details on error modeling. 

 
Most of these manufact files have an associated user file (e.g. user.fvt) where the user 
enters their own information to be saved.  These files will not be modified when a user 
downloads the latest manufacturer files.  It is important, for this reason, that users do not 
directly modify the manufact files as they will be overwritten if they choose to download 
the latest manufacturer files. 

manufact.fvt – A list of favorites and the groups they are contained in.  These only 
contain coordintes for stations available with the download utility.  See Section Chapter 2  
Section 8  for details. 

manufact.cim – Inertial Explorer Only.  Contains a list of IMU profiles for the IMU 
convert utility.  See Section 5.7.4  for details. 
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Chapter 3   Using GrafNet 

Section 1   What is GrafNet? 
GrafNet is a program developed by Waypoint Consulting Inc. that allows for quick 
processing of multiple static baselines.  This is accomplished in a batch processing 
methodology.  The user has only to load the observation (.gpb) files, define the 
coordinates of a reference (control) point, and start processing.  GrafNet only processes 
static data and users wishing to perform kinematic processing should use GrafNav. 

 

3.1.1   Common Definitions 
Observation: A raw measurement file collected from a receiver set up over a stationary 
point.  GrafNet only accepts .gpb files and other formats must be converted first.  The 
acceptable formats are Allen Osborne Associates (Turbo Binary), Ashtech, Leica, 
NovAtel, Trimble, RINEX, CMC, and Motorola.  This is accomplished using the Convert 
option from the File Menu.  GrafNet also requires at least single frequency carrier phase 
data, but it will accept dual frequency if available.  Users wishing to perform code-only 
processing should use GrafNav. 
 
Station: A point where the GPS receiver was setup over and there might be multiple 
observation files for a single station.  However, one set of position values will be 
produced for each station as a final product of GrafNet.  There are several types of 
stations: 
 
Ground Control Point (GCP): A reference station with known latitude, longitude and 
height coordinates.  The user may also assign horizontal and vertical standard deviation 
for these values.  There must always be at least one control point per project. 
 
Check Point: A Station with known coordinates, but these coordinates are only used as a 
check against GrafNet’s computed coordinates. 
 

 
Traverse Station: This is a point with no tie or control information.  It might have two 
stations connected to it, but one is pointing to and one is pointing from. 
 

Tie Point: Such a point may also be called a loop tie closure, and it is formed when two 
or more sessions "point" to it.  Thus, there is a redundant determination at this point. 

Session: Concurrent period of time between two observation files at two different 
stations.  One of the two stations will be remote and one the master.  The arrow on the 
screen will be pointing from the master to the remote.  The direction is determined by 
GrafNav in order to form loop closures as well as to minimize the number of legs from a 
control point.  Each session will be processed individually and combined in either a 
network adjustment or traverse solution.  A session can have different statuses and 
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colours depending on whether the tests passed or failed (see Section 3.7.1  Mapping 
Window). 
 
Baseline: Connection between two stations with one or more sessions.  Normally, a 
session and a baseline can be considered the same.  However, in some cases there may be 
more than one session per baseline.  This is called a duplicate session baseline, and it is 
plotted yellow on the screen. 
 
Control Point: see station, ground control point. 

GrafNet can be used to batch process any combination of static sessions.  However there 
are two common types of networks employed.   

Closed Loop Network 

Note: Antenna height measuring errors will often cancel with this method and should 
therefore be double-checked.  Methods involving more than two receivers become quite 
complex, and are past the scope of this chapter. 
 

The previous method, though reliable, can be tedious as it involves moving receivers 
around.  Regardless, other applications such as GIS do not need this high degree of 
reliability and productivity is more important.  For these situations, open loop networks 
might be used.  Figure 3.2 (base) shows an example of such a network.  With this 
method, one receiver is left stationary over a reference (control) point.  One of more 
remote GPS receivers are moved from point to point being surveyed. 
 

3.1.2   What types of networks can be loaded into GrafNet? 

 

This style of network is shown in Figure 3.1, and surveyors often use it because of 
increased reliability.  Due to the closing of the loops, any baseline determination errors 
will show up as tie point error.  Such closure values can be seen from the View Traverse 
Solutions option in the Process Menu.  If just two GPS receivers are employed, then a 
method called leap frogging can be used to collect the data.  In this procedure, starting 
from a known point, the lead receiver is placed on the first point to be surveyed.  After 
the first session is complete, the trailing receiver is moved ahead of the lead receiver so 
that it now becomes the lead.  The next baseline is observed and this procedure is 
repeated until small (4-6) loops are closed. 
 

Single Base Station or Open Loop Network 
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GPS Baseline

station

 
Figure 3.1 Close Loop Network 

 

GPS Baseline
Base

Station

 
Figure 3.2 Open loop Network 

3.1.3   How does GrafNet work? 
GrafNet automatically determines concurrent sessions by examining the start and end 
times of the observation files.  Using these sessions, stations and their connections will be 
formed.  GrafNet will try and form sessions, using an extended time scale, which will 
resolve any ambiguities with different weeks.  However, this requires that a valid 
ephemeris file (.epp) be present for each observation file (.gpb) with the same file prefix 
for both .epp and .gpb files.  When such ephemeris files are present, the week numbering 
ambiguities will be resolved.  For users with more than two receivers simultaneously 
collecting data, unwanted session connections can be ignored from within the Session 
Menu.  Clicking with the right mouse button on the desired GPS baseline accesses the 
Session menu.  The vector for each session is resolved independently.  However, there 
are five modes of static processing: 
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Fixed Solution – This process uses single or dual frequency data, but assumes integer 
ambiguities.  Therefore, this mode delivers the best accuracies and is also the default 
static processing mode.  As a general rule, single frequency fixed solutions are best for 0-
20 km baselines, while dual frequency will work up to 60 km.  However, longer baselines 
will require longer observation times. 

Float Solution – This method does not solve for integer ambiguities, and therefore, has 
no baseline length restrictions.  Regardless, long single frequency baselines will have 
much poorer accuracies than their dual frequency iono-free counterparts.  Normally, the 
float solution is only used when either the quick or fixed static solutions cannot be made 
to pass or for long single frequency baselines (20+km). 

Iono-free – This is a float solution with the ionospheric effect largely removed from the 
carrier phase.  This option requires dual frequency data at both stations.  Iono-free should 
normally only be used on 50+km baseline lengths since the combined L1/L2 carrier 
phase noise is higher than L1 only, and will result in decreased accuracies if used on 
short baselines. 
 
Automatic – chooses between the four processing modes by examining baseline length 
and the type of measurements available (single or dual frequency). 

After processing, baselines will either show up green, if they passed, or red, if they failed.  
If an error occurred and only an approximate 1-5 metre solution was extracted, the 
baseline will show up as purple.  Also, if the baseline shows up as blue, a serious error 
has occurred.  Clicking the Session Info/Results button from within the Session Menu 
will display any return error messages.  What to do if a baseline fails will be discussed 
later in this chapter (see Section 8  of this chapter). 

After processing each session, GrafNet will transfer coordinates from the control points 
to successive stations in order to compute absolute coordinates.  It is important that at 
least purple, red, or green sessions are computed for baselines on networks covering very 
large areas, otherwise distortions may arise. 

Once the processing is complete, there are two methods to produce coordinate at the 
stations.  First, the traverse solution is automatically computed and will start from known 
stations and transfer positions to neighboring stations one baseline at a time.  A tie or 
closure will be computed for stations that already have coordinates transferred.  Another 
way to produce station coordinates is by using a network adjustment.  This takes all of 
the baselines into account into a single weighted least-squares adjustment.  It will spread 
the errors out over the entire network and takes advantage of redundant baselines using 
covariance weighting to produce more accurate station coordinates.  The network 
adjustment will flag erroneous measurements in that the residuals (calculated baseline 
vector minus observed value) will be unacceptably high to the user.  This is most 
obviously displayed by the PPM (parts per million) value. 
 

 

 

 

 

3.1.4   How are coordinates computed for the stations? 
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Section 2   Getting Started 

3.2.1   How to start using GrafNet 
 
Using the following procedure, a static network can be quickly processed with GrafNet.  
Further details of the individual menu items will be discussed in later sections. 
 
1. Give the Project a Name 

• Select "New Project" from the File Menu or click the  button. 
• Go to the directory where the project files are to be located.  Using a new 

directory can simplify matters as GrafNet creates a number of files during 
processing. 

• Give the project a meaningful name. 
• Click "Save". 

 

• If any of Waypoint's logging utilities were used (e.g. LOGGPS, LPCS) then this 
step can be skipped. 

2. Convert receiver dependent files to .gpb 
 

• From the File Menu, select Convert | Raw GPS to GPB (instructions for Convert 
are available in Chapter 7) 

• Select the desired GPS receiver and convert the data file. 
 
3. Add observation files 

• Select "Add/Remove Observations" from the File Menu or click on the  icon. 
• Select the directory containing the .gpb and .epp files.  Note that you only need to 

select the .gpb files.  The .epp files are assumed to have identical prefix names. 
• Files can be added one at a time by clicking "Add" or all files in the directory can 

be added using "Add All".  A dialogue box will appear requesting verification of 
the station ID and antenna height.  With some receivers this information will be 
filled in automatically.  Otherwise, GrafNet will extract the first four characters of 
the file and use the antenna height of 1.50m.  The user should always ensure that 
the ID and antenna heights are correct. 

 

 
• Repeat these steps for each directory containing .gpb and .epp files that are to be 

added. 
• Click on the OK button. 

Important!  If a station is observed more than once, the station ID should be the same for 
each observation.  Otherwise, two separate stations will be formed. 

• Save Project from the File Menu. 
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4. Add at least one ground control point 

• Press the "Add" button. 
• Enter the ID corresponding to the control point to be added.  This ID can be 

selected from the list. 
• Enter the latitude, longitude, and ellipsoidal height for that station.  Important!  

These coordinates should be in the same datum as the selected one in the Datum 
Option under the Option Menu.  The default datum is WGS84/NAD83. 

5. Select "Static Processing Mode" and "Datum" 
 

• Select the desired static process mode.  These modes are described in Section 
3.5.1  Global Processing Options. 

• Select the desired processing datum. 
 

• Select "Re-Process All Sessions" from the Process Menu or click the  button. 
• Error ellipses should appear on each of the single session baselines after they have 

been processed.  The processing window will also appear. 
 

 
Passed baselines will be plotted in green, failed baselines in red, purple, or blue (see 
Section 3.7.1  Mapping Window).  Duplicate (yellow) baselines do not show the pass/fail 
via colouring.  Baseline statuses should be verified by clicking the right mouse button. 
 

• Press the " Info” or “Results" button to find out what the problem is.  Section 8   
Fixing Bad Baselines of this chapter explains in detail how to "fix" these sessions. 

• If the user feels that the solution is correct despite failing GrafNet’s statistical 
tests (appears a colour other than green), the statistics can also be overridden by 
pressing "Status" from within the Session Menu.  However, such a change should 
only be performed for closed loop networks. 

Note: The traverse will transfer coordinates using failed baselines, while the network 
adjustment will not. 

8. Run Network Adjustment 
 

• From the Process Menu, select "Network Adjustment". 

• Select "Add/Remove Control Point "from the File Menu or click the  button. 

• Press "OK". 
 

• If fixed solutions and WGS84/NAD83 are desired, this step can be skipped.  
Otherwise: 

6. Process All Sessions 

7. Verify that all baselines have passed. 

• Click on each failed baseline with the right mouse button. 

 

• Press "Process" 

154 



Chapter 3  Using GrafNet 

• Select "OK" to view error ellipses or View Solution to view the ASCII output of 
the adjustment. 

• You should see error ellipses on each of the stations. 
 

 
• From the Output Menu, select "Write Coordinates". 
• Enter an output file name. 

• Select a projection, format, and units (see Section 2.6.3  Write Coordinates) 
• Press "OK". 

 

 
• The user may wish to remove some of the intermediate processing files by 

selecting File | Remove Processing Files | All but Static Summaries. 

3.2.2   Tips on Maximizing Accuracies 

9. Export Station Coordinates 

• Select the source for the coordinates (usually network). 

10. Clean up processing files (optional) 

Chapter 10  Section 1 contains a valuable list of tips that can be helpful improving 
accuracies. 
 

Section 3   File Menu 

3.3.1   New, Open, Save, Save As Project 
File | New Project/ Open Project/ Save Project/ Save As 
These menu items allow the user to control .gnt projects.  Their usage is very similar to 
other Windows applications.  The Save and Save As operations saves the .gnt (project), 
.rep (session report), and .trv (traverse solution). 

3.3.2   Print 
File | Print 
The user can print the current window or the map window.  The orientation of the output 
can also be controlled and the colour scheme as well.  Click ‘Set Margins’ to change the 
top, bottom, left, and right margins.  By default they are 1 inch. 
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3.3.3   Add/Remove Observations 

 

 
Figure 3.3 Observations Dialogue Box 

This menu item is necessary to add observation files to GrafNet.  Observation files must 
first be converted to .gpb/.epp files using the Convert utility from the File Menu.  These 
files may have also been created directly by using Waypoint's data logging software. 
 
If available, GrafNet will automatically extract the station name and antenna height 
values from the .sta file, which may have been created during the conversion process.  
For such a case, and if the user is confident that these values are correct, the check box 
titled "Prompt for Station Name and Antenna Height" may be unselected.  This will cause 
observations to be added without user input.  However, the user should still double check 
station names and antenna heights in the Observations Added List.  The format in the list 
is File Name, StaName, and Ant Height.  If there are any errors, they can be corrected by 
pressing the "Edit" button. 

GrafNet allows users to select an Antenna Profile.  When using profiles other than 
‘Generic’, users should be cautions to match up the antenna height measurement to the 
expected measuring mark on the antenna (see figure below--Origin).  This is because 
additional offsets to the L1 and L2 phase centres are added.  In addition, if a slant 
measurement is selected, then a correction is applied based upon the size of the antenna 
ground plane.  Again, be sure that the origin (i.e. measuring mark) is defined correctly. 

File | Add/remove Observations 
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L2 Phase Cntr
L1 Phase Cntr

L2 Phase Cntr
L1 Phase Cntr

Origin(a) Origin (b)

L2 Offset L2 Offset

L1 Offset L1 Offset

Vertical
antenna
height
measurment

Slant
antenna
height
measurment

Ground plane
radius

(A) Vertical Antenna Height (B) Slant Antenna Height  

 
Adding observations will normally break-up observation files into multiple periods if a 
gap of 3 minutes more is detected.  Whether or not this is done is controlled from the 
checkbox ‘Break-up multiple occupations into periods’.  Some RINEX files have gaps 
but are observed over the same point for the entire observation period.  For such files, this 
checkbox should be disabled.  For cases where the time gap is very short because the 
station to station movement is very fast, the minimum time gap for breaking up periods 
can be controlled from the Global Options ‘Solution and Session’ (see ‘Minimum time 
span for breaking up observations into periods’). 
 

3.3.4   Add/Remove Control Points 
File | Add/remove Control Points 
At least one 3D ground control point must be added before processing can begin, and 
sessions will not be processed unless they are directly or indirectly connected to a 3D 
control point.  Three types of control points can be entered, 3D, horizontal and vertical 
control.   

After selecting "Add/Remove Control Points" from the File Menu, press "Add" to enter a 
new control point.  The station ID should match that of the corresponding station. 

Figure 3.4 Antenna Profile Definitions 

IMPORTANT:  Station ID's must match those of all observations for a given same 
station and those of matching ground control points.  Sessions associated with an 
observation should be reprocessed if the antenna height has been changed.  This is 
performed by clicking on the station for that observation with the right mouse button.  
Select "Remove Processing Files", the select "Process All" from the Process Menu. 

 

 
IMPORTANT:  The latitude and longitude coordinates should be in the same datum as 
the selected datum.  The height can be entered as meters above the ellipsoid or above 
mean sea level.  If height above mean sea level is used you will have to select a geoid 
file.  If the geoid height corrections are desired, they can be implemented using "Write 
Coordinates" from the Output Menu.  If a mean sea level or orthometric height is entered 
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here, then only an approximate geoid correction is applied.  As stations become more 
distant from the control point, orthometric height errors will increase.  If more than one 
control point is present, and orthometric (mean sea level) heights are entered, the height 
ties may be poorer as well. 
 
Standard deviations can be entered at this stage.  The default values are 5mm for 
horizontal and 5mm for vertical.  The user may wish to change them to more realistic 
values.  The standard deviations are only taken into account in the network adjustment.  
However, they can be very useful for combining high and low accuracy control points. 

3.3.5   Add/Remove Check Points 

Check points are useful for gauging how well the network fits the existing control fabric.  
They are added in the same manner as control points, except that standard deviations 
cannot be defined.  As with control points, it is important that the processing datum 
matches the coordinates' datum. 

File | Add/remove Ephemerides 
This option can be used to add additional precise or broadcast ephemeris files (.sp3 and 
.epp files).  To load an ephemeris file, press the "Add" button.  Move to the directory that 
contains the proper file.  Select the file.  Press "Open". 
 
It is important that a precise ephemeris file covers the entire time span for each session.  
Although more than one .sp3 file can be loaded, only one can be used for processing each 
session and GrafNav will pick the proper file.  However, if a session spans more than one 
.sp3 file, the .sp3 files must be concatenated together.  Using MS-DOS copy command 
will work i.e.  copy file.sp3 +file2.sp3 all.sp3.  Be sure that the files are sequential and in 
chronological order.  If a session is not fully covered by one .sp3 file, a message will 
appear providing the percentage covered by the precise ephemeris.  Unless the percentage 
is in the high 90's, this baseline should be processed with start/end times.  This can be 
accomplished by utilizing the GrafNav option from within the Session Menu (see Section 
3.7.5  Session Menu). 

File | View | Raw GPS Data 
See Section 2.2.15  Viewing Raw Binary GPS Data. 

3.3.8   Convert 

See GrafNav Section 2.2.21  Converting GPS Data and Chapter 7  Convert. 

File | Add/remove Check Points 

3.3.6   Add/Remove Ephemeris 

3.3.7   View Raw GPS Data 

File | Convert 
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3.3.9   Remove Processing Files 
File | Remover Processing Files | All Files / All but Static Summaries 
This menu item can be used to "clean up" a directory by removing the session dependent 
files.  Solutions for static sessions are stored in the .fss for forward and .rss for reverse 
processed files.  The .fwd/.rev and .fml/.rml are unnecessary and can be removed using 
the "All But Static Summaries" option.  Selecting "All Files" will remove all files 
including the solution files.  The user must reprocess for further analysis. 

3.3.10   GPB Utilities 
File | GPB Utilities 
This menu item gives you access to a couple of utilities, provided with the software 
package, directly from GrafNet.  The utilities (ViewGPB, GPB to RINEX Converter, and 
Concatenate, Slice, and Resample) and their locations are described in Chapter 6  
Utilities. 
 

Section 4   Process Menu 
Generally, this menu is used to process all sessions and view solutions. 

3.4.1   Process Unsuccessful Sessions 
Process | Process Unsuccessful Sessions 
Selecting this option will process sessions that do not have a good status (i.e. not green).  
Processing will start nearest to the control points and move outward.  For processing 
problem sessions, it may be better to process from the Session Menu using GrafNav. 

3.4.2   Re-Process All Sessions 

This option will re-process all solutions regardless of status.  It is a good idea to re-
process all sessions after changing the global options  

3.4.3   Rescan Solution Files 
Process | Rescan Solution Files  

Process | Re-Process All Sessions 

This option merely rescans the .fss (forward static solution) or .rss (reverse static 
solution) files.  When deciding whether to use the forward or reverse, it uses the one with 
the newest date/time.  Under normal circumstances, solution scanning is automatic, but in 
a few instances, such as when using GrafNav in conjunction with GrafNet, the user may 
want to rescan manually. 
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3.4.4   Ignore Trivial Sessions 
Process | Ignore Trivial Sessions 
GrafNet defines trivial baselines as those that are unnecessary resulting from multiple 
receivers simultaneously running.  The problem is that the baseline solutions computed 
by GrafNet are not independent and are correlated.  Therefore, trivial baseline removal 
reduces these dependencies, while still maintaining a closed loop.  Removing trivial 
baselines will also create a network where the standard deviations reflect the actual errors 
more accurately. 
 
Consider the network in the figure below.  The six points are surveyed with four 
receivers, during two one-hour sessions.  During the first session, the points A, B, C, and 
D are observed.  During the second session, the points C, D, E, and F are observed. 
 

A

B

D

C

E

F  
Figure 3.5 Trivial Baselines 

 
This network can be divided in two sub-networks, namely the sub-networks formed by 
the first and second time periods respectively.  Before the trivial baseline removal, every 
baseline in these two sub-networks is dependent on the other baselines.  Such 
dependencies can cause the loop ties to be unnaturally low. 
 
With four receivers or more collecting data at the same time, a sub-network is very over-
determined.  Using three GPS receivers, the network is still over-determined, but all 
baselines need to be included to form a closed loop.  GrafNet attempts to remove these 
dependent or trivial baselines by creating a single loop that will connect all of the points 
in the sub-network.  Form the example above, we can see that it is easy to remove such 
baselines.  With four receivers, there are two dependent baselines in each sub-network.  
GrafNet will remove these trivial baselines for each sub-network individually.  The 
diagram below shows two possibilities of what GrafNet might do with the first sub-
network. 
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GrafNet removes the trivial baseline by setting their session status to IGNORE.  It is 
possible to un-ignore any session by simply changing its status back to UNPROCESSED 
from the Session Menu (see Section 3.7.5  Session Menu).  GrafNet tries to keep the 
sessions that are of best quality.  The criteria it looks at are: 

• The frequencies used in the surveying of the session. 
• The length of the baseline. 
• The number of connecting baselines to the two end-points. 

A

B

D

C

E

F  
Figure 3.7 Network with Trivial Baselines Removed 

3.4.5   Unignore All Sessions 
Process | Unignore All Sessions 
Unignore All Sessions changes the status of all ignored sessions from ignored to the 
status they had before they were ignored. 

Process | View Traverse Solution 
GrafNet computes a traverse solution automatically after processing each session.  This 
option can be used to view traverse solution files (.trv). 

Figure 3.6 Removal of Trivial Baselines 
 

 
• The amount of time the baseline was surveyed. 

 

 
As you can see, GrafNet automatically excluded AC, BD, CE, and DF.  It then formed a 
single loop for each of the time periods.  DC is a baseline with a duplicate session. 

3.4.6   View Traverse Solution 

 
Section 3.9.1  contains a detailed description or the Traverse Solution. 
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3.4.7   Network Adjustment 
Process | Network Adjustment 

Figure 3.8 Network Adjustment Options  
 
Executing this option allows the user to invoke the network adjustment contained within 
GrafNet.  External network adjustments such as GeoLab also supports GrafNet's output 
format. 

 

 

 
Before running the network adjustment, all baselines must have already been processed 
and only good (green) baselines will be used. 
 
The Output Options let you control what is output in the network solution.  The input 
stations and vectors are all the control and check points and their vectors.  You can output 
the coordinates in three different forms.  These forms include Geographic, Grid and 
ECEF.  The option for orthometric height also exists.  To use orthometric height you 
have to provide the geoid file. This geoid file can be selected by using Browse Geoid.  
Other output options include outputting the estimated standard deviations and converting 
the output coordinates into the input datum.  The input datum is selected in Tools | Datum 
Manager. 
 
To process the network adjustment, press the "Process" button.  This step must be 
performed each time a project is re-loaded.  To view the ASCII solution output, press 
"View Solution", otherwise press "OK". 

Error ellipses should appear on the stations.  The ellipses will be scaled by the Scale 
Factor.  The level of confidence of the error ellipse can also be adjusted. 
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Section 3.9.2  contains a detailed description of the Network Adjustment including a 
description of scale factor and confidence level. 

3.4.8   View Processing Report 

This option displays the .rep file.  This file displays information about the stations, 
sessions, baselines, and observations and gives a summary for each session processed. 

3.4.9   View All Sessions 
Process | View All Sessions 

3.4.10   View All Observations 
Process | View All Observations  
This option gives the information about each observation.  The user can click on the 
"View" box, which will bring up a message box showing: file name, station name, 
antenna height, time range (in seconds and status information).  Also, pressing the "View 
.gpb" button will access the .gpb file viewer. 

Section 5   Options Menu 
This section describes the items under the Options Menu. 

3.5.1   Global Processing Options 

This dialogue box gives the user access to the global processing options.  Global Options 
for all baselines can be accessed from the Options Menu.  Otherwise, this menu can be 
accessed for individual sessions using the session menu. 

Process | View Processing Report 

The Session Menu, which is described in Section 3.7.5  , can be accessed for all baselines 
by selecting this menu item.  It can also be invoked for individual sessions by clicking on 
a baseline with the right mouse button.  This is a useful way of ensuring all sessions have 
a good status. 

 

Options | Processing (Global)  
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Static Process Mode 
A simple table is given below to summarize usage, observation time lengths, and 
expected accuracies. 

Figure 3.9 Processing Options 
 

 
Mode Frequency Minimum 

Observation 
time (min) 

Maximum 
Distance 
(km) 

Approximate 
Accuracy 

Fixed Solution SF 15 15 5mm+1ppm 
 DF 5 50 5mm+1ppm 
Float SF --2 --3 10mm+2ppm 
Iono-free DF --2 --3 10mm+0.5ppm 
Automatic Chooses between the fixed solution and the float (for SF) and iono-free 

float (for DF) depending on the baseline distance.  The distance 
tolerance can be defined in the Solution and Session options. 

 
Notes: 

1. Observation times should increase for longer baselines.  For single frequency, a 
good rule of thumb is 10 min + 1 min/km.  For dual frequency, these times can be 
halved.  Observation times should also be increased during poor satellite geometries 
(i.e. high PDOP). 
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2. No minimum time is given, but accuracy improves with observed time.  A few 
minutes of observation will only achieve sub-metre accuracies under very good 
operating conditions. 

3. For dual frequency receivers, use fixed quick, or float solutions for baselines less 
than 50 km, and Iono-free for more than 50 km. 

4. Accuracies are given for average occupation time.  Accuracies will increase for 
longer times, and degrade with poor geometry or bad measurement quality. 

 
Elevation Mask – Satellites below this mask angle will be ignored.  The default value for 
GrafNet is 15°.  Setting this to a lower value will allow more satellites to be used, 
perhaps improving a solution with poor geometry. 

 
Process Mode (Frequency type) 
Single Frequency – forces single frequency (L1 only) processing. 

5. Use precise ephemeris for baselines longer then 150 km. 

 
Process Direction – This option can be set to forward, reverse, or both.  GrafNet will use 
the solution file created last (i.e. file with latest date).  Under normal circumstances the 
forward and reverse solution should provide roughly the same solution.  However, in 
some circumstances, a reverse solution will pass when a forward has failed, or, solutions 
may differ because of different base satellite selections.  If both directions are selected, 
the combination of the two solutions will be used.  (See Section 2.4.3  Combining 
Forward and Reverse Solutions for more details). 

Dual Frequency – forces dual frequency processing.  This can be used if the auto 
detection is failing.  However L1/L2 data must be present in all observation files. 
Auto-frequency detect – auto-detect single or dual frequency processing for each 
baseline.  This is the default process mode, and it should be used under most 
circumstances. 
 
Interval –This option lets you choose the processing interval.  The default interval is the 
interval the data was logged.  If the logged data rate is high (e.g. 1 Hz), it is suggested 
that this interval be overrided with 15 seconds. 
 
Time Range- This option is only available for individual baselines.  The processing 
options for an individual baseline are accessed through the session menu.   

Options | Processing (Global) | Fixed Static Tab 
See Section 2.3.7  Fixed Static Options. 

3.5.3   Solution and Session Options 

Forward/reverse Process Direction Handling – This dialogue box allows the user to 
change the way forward and reverse solutions are chosen for use in the network.  By 
default, GrafNet will load the latest solution (most recently processed).  If however you 
wish to use a combined solution, you must check the combined solutions radio button.  If 

3.5.2   Fixed Static Options 

Options | Processing (Global) | Solution and Session Tab 
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in the General Options dialogue box, you indicated that you want both directions to be 
processed, GrafNet will prompt you to change to the combined solution option. 
 
Session Forming Options – Minimum observation time for forming a session controls 
the minimum number of seconds necessary to declare concurrent observation files as a 
session.  The default value is 180 seconds or 3 minutes.  For dual frequency data, it may 
be desired that this time is reduced, and for single frequency, this value may have to be 
lengthened to avoid short/low accuracy baselines.  The ignore feature from the Session 
Menu “Change Status" can also be used to manually ignore short baselines.  The 
minimum time span for breaking up observations into periods controls the time required 
between sessions for them to be recognized as two different sessions.  The default is 3 
minutes.  

Time span for breaking up periods – This combined with the checkbox labeled ‘Break-
up multiple occupations into periods’ in the Add Observations dialogue box controls how 
long of a gap in the data in needed to signify a new period.  The default is 3 minutes (i.e. 
180 seconds). 
 
Distance tolerance for using fixed over float – This tolerance is used in combination 
with the Automatic Static Process Mode.  If the baseline distance is longer then the 
tolerance, then a float solution will be used for single frequency, while an iono-free 
solution will be used in dual frequency mode.  Otherwise, the fixed static solution is used. 

 

3.5.4   Datum Options 
Options | Processing (Global) | Datum Tab 
Refer to Section 10.5.2  Datums for a discussion on datums. 

3.5.5   User Defined Options 
Options | User Defined 
This command works identically to the one found in GrafNav.  Please refer to Section 
2.5.5 and Appendix A for a list of commands. 

3.5.6   Grid Options 
Options | Grid 
See Section 2.5.1  Grid Options. 

3.5.7   Display Options 

Zoom Increment – changes amount of zooming between each (+) and (-).  For the first 
three zoom levels, the following option can be set.  Zero refers to the smallest scale with 
all objects plotted on one screen.  Further zooming past two will use the values from two.  
Pressing the "Set Defaults" button will return values to their original state. 
 
Text point size – size of station name text (points). 

Options | Display 

Symbol size – size of station triangles on the screen. 
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Ellipse scale – This is an important option as it changes the size of the error ellipses.  
Projects covering large areas may have unpleasantly large ellipses.  This being the case, 
decreasing the values for all three zoom scales (0, 1, and 2) will make the ellipses 
smaller. 

Map status information – This setting defines what is displayed at the bottom status bar 
of the mapping window.  The session ID may not be implemented on early versions, but 
it gives the session name when the left button is clicked. 

Error ellipse display – This controls if relative or absolute error ellipses are displayed.  
First, error ellipses can be displayed for session solutions.  Second, ellipses can be 
displayed for the stations after a network adjustment is run.  The crosses on the ellipse 
option merely shows the axes of the error ellipses. 

Processing updates – this is an important display option because it can increase or 
decrease processing speeds.  It defines how often the solution is updated to the 
Processing Window.  Values of at least 250ms are suggested, and the default value is 
500ms.  Entering zero will force every epoch to be written to the screen. 

 
Figure 3.10 Display Options 
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Section 6   Output Menu 
See GrafNav Sections 2.6.3  Write Coordinates, 2.6.4  View Coordinates and Section 7  
Export Coordinates Wizard of Chapter 2  Section 7  . 

3.6.1   Export to DXF 

The following figure shows the main dialogue box for Export to DXF.  Most of the 
options for this dialogue box are described in Section 2.6.5  Export to DXF.  Only the 
GrafNet specific options are described here.  These options include station error ellipses, 
baseline error ellipses and the error ellipse scale factor.  Station error ellipses are only 
available if a network adjustment has been done.  The station error ellipse shows the error 
ellipse around each of the stations.  To use baseline error ellipses only the baseline needs 
to be processed.  The ellipse scale factor simply scales the ellipse so it will be visible.  In 
most cases if you use a small scale factor the error ellipses will not be visible.  If you 
want error ellipse and do not see any in the DXF file try increasing the ellipse scale 
factor. 

 

 

Options | Export DXF 

 

Figure 3.11 Export to DXF 
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Section 7   Interactive Menus and Screens 

3.7.1   Mapping Window 
 

 

This section describes the Mapping Window, Processing Window, Station Menu, and 
Session Menu. 

Figure 3.12 GrafNet Mapping Window 
 
This mapping window screen is a graphical representation of the project area.  It shows 
the stations and connecting baselines. 
 
Baselines are plotted using the following colours. 
 
Colour Description 
Blue This is normally an unprocessed baseline.  In some cases when 

processing quits prematurely, the colour may remain blue.  The return 
error message can be viewed from the Session Menu by pressing the 
Session Info/Result button 

Grey Session is to be ignored 
Yellow This baseline has more than one session and it is called a duplicate 

baseline.  This line is plotted with two colours: yellow, and the colour 
of the best solution type among all the sessions for the duplicate 
baseline. 
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Purple An error has occurred during the processing and only an approximate 
(1-5m) solution was extracted.  This solution is only useful for 
transferring an approximate position from base to remote and this 
session should either be reprocessed or ignored. 

Red Processing on this baseline has failed one or more tests, and it is 
considered bad.  Press the "Session Info/Results" button under the 
Session Menu to determine the problem.  If the user is confident that 
the solution is okay, the status can be changed from the Session Menu 
as well. 

Green This session has passed all tests or the user has set it to green. 
 
Station triangles can be represented with the following colours that signify: 

3.7.2   Mouse Usage in Mapping Window 

3.7.3   Processing Window 
See Section 2.9.3  Processing Window. 

3.7.4   Station Menu 

 

 
Colour Description 
Cyan (light 
blue) 

Tie point.  Two or more sessions are connected as remotes to this 
station via the traverse solution.  The .trv file will show traverse ties. 

Dark purple Check point.  This station has known coordinates available, but they 
will only be used as a check.  Comparisons are found in the .trv file as 
well.  The network adjustment output file (.net) will also show 
checkpoint errors. 

Yellow (hollow) Regular traverse point.  No tie information can be computed for 
traverse solution. 

By positioning the cursor on stations and clicking with right mouse button or double 
clicking with the left mouse button, the Station Menu will be invoked.  Performing the 
same procedure on baselines will bring up the Session Menu.  Using the display options 
to perform the same procedure on the baselines will also bring up the Session Menu.  Use 
the display options to also show the latitude and longitude position on the bottom station 
bar of the Mapping Window. 

Positioning the cursor on a station marker and clicking with the right mouse button or 
double clicking with the left mouse button can access the Station Menu.  This menu 
allows the user access to coordinates computed by traverse or network adjustment 
solutions.  However, it can also be used to view sessions and observations associated with 
this station.  For the purposes of reprocessing only a portion of a project, files associated 
with a certain station may be deleted as well. 
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Right-clicking on a station marker and selecting the View Solution (processing datum) 
will bring up the following message box. 
 

Figure 3.13 Station Solution 

This message box shows the latitude, longitude, and height for that station for both the 
traverse and network adjustment solutions.  For the network adjustment, error ellipse 
parameters are also given. 

This dialogue box is often used as it gives access to session specific features.  Such 
features include display of baseline processing results, editing of session specific options, 
changing of session result status (e.g. from bad to good), reprocessing directly or by 
invoking GrafNav, viewing of processing files and displaying of observation file info.  
Clicking with the right mouse button on a specific baseline easily accesses the Session 
Menu.  All sessions within a range of a few pixels will be loaded and will show up in the 
"Select Session" window.  Select the session that is of interest.  Session names are 
defined as follows:  FromID to ToID (#).  From ID is the master station name, while 
ToID is the name of the remote.  The # refers to the duplicate session index and will be 1 
for baselines with only one session. 
 

 

 

3.7.5   Session Menu 
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Figure 3.14 Station Session Menu 

 
Results/Fwd/Rev Buttons – Displays information about the solution used by GrafNet, 
the forward solution, and the reverse solution respectively.  The following information is 
displayed: 
 
Parameter Meaning 
Result/Status Good/Bad/Ignore/Approximate/Unprocessed 
Soln Type Defines whether a fixed, quick, or float solution is found 

in the static solution file.  An Iono-free solution will show 
up as a float solution. 

Direction Forward, Reverse, or Combined solution used. 
ECEF Vector Earth centre earth fixed vector between base and remote. 
Rel Err Ellipse Relative semi-major (a), semi-minor (b), and height error 

values for baseline solutions.  All values in millimeters. 
Reliability Result of the ratio test computed by dividing the RMS of 

the second best integer intersection by the best RMS. 
Err Code Return status from the GPS Engine used by GrafNet and 

GrafNav.  Can be SUCCESS, FATAL ERROR, NON 
FATAL, ERROR, USER QUIT. 

Err String Message returned by the processing engine.  Some of 
these messages are defined in the appendix. 

Solution String Message generated by GrafNet indicating if static solution 
tests have passed or failed. 

 

172 



Chapter 3  Using GrafNet 

Info button – Displays information about the data used in the session.  The following 
information is displayed: 
 
Parameter Meaning 
Master Obs/Remote Obs Observation file names for From and To stations. 
Start and End Start and end of concurrent session between observation 

files. 
Length Session time length in seconds. 
Result/Status Good/Bad/Ignore/Approximate/Unprocessed 
Err Code Return status from the GPS Engine used by GrafNet and 

GrafNav.  Can be SUCCESS, FATAL ERROR, NON 
FATAL, ERROR, USER QUIT. 

Err String Message returned by the processing engine.  Some of 
these messages are defined in the appendix. 

SolutionString Return solution type.  Can be Fixed or Float. 
 
Options button – see Section 3.5.1  Global Processing Options and 2.3.2  General 
Options. 
 
Status button – This is an important option with three uses: 

Change session status to Good in the event that a session has failed tests, but the user is 
confident that the solution is in fact correct.  Such a change should only be performed for 
closed loop networks. 
Change the status back to Unprocessed so that "Process All" will reprocess it.  Removing 
the solution files can also perform this. 
 

 
GrafNav button – All of GrafNav's features are made available to GrafNet by invoking 
GrafNav.  This includes graphical plotting and extensive control over all options.  For 
example, when controlling such parameters as the start /end times, GrafNav must be 
used.  For details on using GrafNav, consult Chapter 2  . 
 

Allows the user to ignore redundant or troublesome baselines. 

Process button – Reprocess this session using new options.  Due to the limited number 
of items within general options, GrafNav may have to be used for more troublesome 
baselines. 

Azimuth + Distance – Displays the Azimuth (from→to/to→from) and Distance 
(Ellipsoidal/Surface/Spatial). 
 
Delete Fwd/Rev button – Removes the Forward or Reverse solution of the selected 
baseline. 
 
View Master/Remote Obs. – View Master or Remote GPB summary and Raw GPS 
data. 
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Note: Solutions will be re-loaded into GrafNet when the Session Menu is closed.  If the 
Session Menu is closed before GrafNav is finished processing, the solution files must be 
rescanned manually, which can be performed from the Process Menu.  The forward or 
reverse solution with the latest date will always be used.  Therefore, be careful to 
reprocess a forward solution if an undesirable result is achieved on the reverse solution.  
The same is true for vice-versa. 
 

Section 8   Fixing Bad Baselines 
See also Chapter 10  Processing Techniques for more hints for fixing baselines. 

A difficulty that may arise is that some baselines may appear red when running GrafNet.  
For the case of a duplicated baseline, it will stay yellow.  However, when examining the 
baseline sessions from within the Session Menu, one or more sessions will have BAD 
indicators.  This means that one or more tests have failed in the static solution.  If a 
baseline is flagged as APPROXIMATE.  Then it has also failed tests.  In fact, the 
baseline was only able to achieve an approximate (1-5 m) solution.  Such a baseline can 
also be considered BAD. 

The purpose of this section is to assist the user in how to re-process this baseline in order 
to achieve better results.  Unfortunately, there are many causes of a failed baseline, and 
not every solution is given.  In some cases, not much can be done.  In other cases, the 
correct solution has been found, but the statistics just fail.  This indicates that GrafNet 
cannot label this baseline as correct for certain.  However if there are loops that are 
closed, and the closure is very good, then the user may wish to change the status from 
bad to good using Change Status from within the Session Menu. 

A few changes can be made within GrafNet to improve a baseline.  These options can be 
accessed for an individual session from within the Session Menu.  Otherwise, it can be 
accessed globally for all sessions from within the Global Options in the Options Menu.  
The Advanced Options have not yet been implemented and GrafNav must be accessed 
for these.  The user defined options found in options can also be used to avoid going into 
GrafNav.  Refer to Section 2.5.5  User Defined Options and Appendix A Summary of 
Commands for more information on user defined options. 

3.8.2.1   Fixed Static Solutions 

3.8.2.2   Forward / Reverse Processing 
Another easy change that can be made within GrafNet is to switch from Forward to 
Reverse.  Since the reverse solution may pick a different base satellite than the forward 

3.8.1   Fixing Bad GrafNet Baselines 

 

3.8.2   Using GrafNet to Fix a Baseline 

If fixed solution fails, then you might have to switch to a float solution.  However, float 
solutions are not very good at achieving centimetre accuracies unless you have many 
hours of data. 
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solution, this solution can be different and may in fact pass.  GrafNet will pick the 
forward or reverse solution with the latest date.  Therefore, be sure to reprocess the 
forward solution if the reverse is unacceptable. 

GrafNav by default uses a 15° elevation mask.  This is because tropospheric and 
ionospheric errors increase significantly on low satellites.  However, lowering the mask 
to 10° will allow more satellites into the solution, which will strengthen the geometry.  
The improvement in geometry may offset the increased atmospheric errors. 
 

3.8.3   Using GrafNav to Fix a Baseline 
GrafNet has limited access to processing options.  However, GrafNav can be used to 
change a number of various settings.  Therefore, GrafNav is a valuable tool in fixing a 
failed data set and can be invoked from within the Session Menu. 

3.8.2.3   Changing the Elevation Mask 

For long baseline dual frequency processing, the iono-free solution combined with a 
precise ephemeris can be a tremendous benefit.  However, some shorter baselines are 
better off using a fixed solution.  Therefore, it may be advantageous to re-process shorter 
baselines separately. 

 
From within GrafNav, the most common options to change from a static baseline are as 
follows: 
 

• The start/end times can be modified from within the General Options.  Sometimes 
a data set can have parts that are unusable.  A good indicator is the L1 Phase RMS 
Plot from within GrafNav.  Entering the start and end times can eliminate these 
parts by selecting the appropriate times.  Another way to find good sections of 
data is to view the .fss or .rss files.  There is a section at the start showing 
numerous periods of cycle slip free data for various satellites, and it also shows 
which period was used.  You might try entering the start/end times from another 
period exclusive to the one used. 

 
• For a float solution, only a coarse cycle slip detection scheme is used, and it uses 

another means to detect small cycle slips.  However, you may try engaging the 
fine static cycle slip detection from within Advanced Options.  This will help to 
find small cycle slips. 

 
• Bad Doppler data can sometimes make data process poorly.  This can be detected 

by plotting the L1 Doppler RMS.  If there are any large spikes (5 or more times 
the size of the Doppler standard deviation), then this data may have problems.  
Try shutting the Doppler OFF for carrier phase processing from within the 
Advanced Options. 

 
• A particular bad satellite will have many bad data warnings in the message log 

file (.fml or .rml).  This satellite can be omitted from within the Advanced 
Options. 
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• For a float or iono-free solution, changing the standard deviations for both the L1 

carrier phase and the C/A code can improve a solution.  Suitable standard 
deviations can be obtained by viewing the plots for both the C/A code RMS and 
the L1 Phase RMS.  A good standard deviation value to choose is generally one 
which about 90% of the RMS falls below.  Realistic values allow the Kalman 
filter to perform better. 

3.8.4   Unfixable Data 
Sometimes bad data is just bad, and changing the options within either GrafNav or 
GrafNet cannot help.  In this section, some of the possible causes of such data are given, 
and for some cases, advice for improving the solution is still offered. 
 
An antenna that is not still will cause havoc with static processing.  This can be caused by 
an operator not holding the antenna still, heavy winds, or a vehicle this is rocking.  
Theoretically, this data should be processed as kinematic and the position solutions 
averaged.  However, GrafNet does not currently support this mode of processing.  
Therefore, such types of data should be avoided.  If it needs to be processed, a float 
solution will perform best. 
 
Heavy ionospheric activity can cause large carrier phase noise.  A single frequency 
receiver cannot do much to alleviate the problem.  However, dual frequency data will 
most likely process better with an iono-free solution rather than some of the fixed integer 
techniques, such as the fixed solution. 
 
High multi-path mostly affects the C/A code.  However, the carrier phase can also be 
affected and may cause a fixed solution to fail.  Antennae placed near large metal 
structures are most easily affected.  Moreover, locations on rooftops can also cause data 
to be much poorer.  Such locations should be avoided.  There is not much that can be 
done at processing time.  The only suggestion is to reduce the size of the C/A code 
standard deviation from within the Standard Deviation Options. 
 
Sometimes a GPS receiver just collects bad data.  Low power or a poor antenna 
connection can cause this.  If the problem is consistent with a particular GPS receiver 
unit, the manufacturer should check the GPS receiver. 
 

Section 9   Traverse and Network Solution 

3.9.1   Traverse Solution 
After all of the baselines have been successfully processed, i.e. they will show up green.  
At this point the user will wish to produce coordinates for each of the stations.  This is 
accomplished by using the traverse technique from known station to unknown stations.  
Using the Add GCP command under the File Menu, additional known (fixed) control 
points may be specified (Note that at least one GCP is needed per project before GrafNet 
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will process any data, but others can be added later).  These known control stations are 
used to transfer coordinates to unknown stations in the network.  In some ways, this is 
very similar to a conventional traverse survey.  However, instead of instrument, backsight 
and foresight stations, this traverse technique only has an instrument and foresight 
station.  Starting from the known stations, coordinates are transferred to the nearest 
stations.  Then, the next nearest stations receive coordinates.  This procedure is repeated 
until all connected stations have coordinates transferred.  The arrow marker on the 
baseline shows which direction this transfer takes place. 
 
The coordinates for a given station will be transferred from the minimum number of legs.  
The lengths of the legs are not taken into account which, in some cases, may result in an 
unfavorable transfer of position.  In this case, the network adjustment will produce more 
accurate coordinates. 
 
For stations that have more than two baselines connecting, a loop tie can be computed.  
This means that there is more than one possible transfer of coordinates to this point.  The 
first transfer is used for coordinate generation.  Subsequent transfers are used to compute 
loop ties.  The loop ties are good for locating erroneous baselines.  However, it should be 
noted that the loop ties are an accumulated error of many baselines to that point meaning 
that the last baseline in that traverse leg may not be the erroneous one.  These ties also 
give a good indication of the accuracy of the network, but the magnitude of the errors 
will be larger than the network adjustment residuals.  This is not saying that the network 
adjustment is that much more accurate than the traverse, rather, the traverse errors 
(closures) are accumulated while the network adjustment spreads these errors across the 
whole network. 

3.9.2   Network Adjustment 

3.9.2.1   What is the Network Adjustment? 
The network adjustment is only available within GrafNet, and it is a means to more 
accurately compute each station’s coordinates given the solution vectors computed for 
each session/baseline.  Such an adjustment not only uses the X, Y and Z vector 
components, but it also utilizes the 3x3 covariance matrix (i.e. standard deviation values 
+ coordinate to coordinate correlation).  Using least squares, the errors are distributed 
based on a session’s estimated accuracy.  More weight will be placed on sessions with 
lower standard deviations. 

3.9.2.2   Why use it? 
In the traverse solution, each station’s coordinates are determined using one session from 
one previous station.  For networks with redundant measurements (usually the case), this 
can lead to a sub-optimal or even erroneous determination of a station’s coordinates.  The 
network adjustment does a much better job of distributing errors than the traverse 
solution.  This makes it less sensitive to errors as long as a session’s estimated accuracy 
is representative of actual errors.  Thus, the network adjustment generally produces more 
accurate station coordinates. 
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Another advantage of the network adjustment over the traverse solution is that it assigns a 
standard deviation to each point.  Estimated standard deviations should be used with 
caution, but they are a good tool for locating outliers.  See ‘What is the variance factor 
and how does it relate to the scale factor’ for more information on scaling standard 
deviations to match the data accuracy. 

3.9.2.3   How do I run the network adjustment? 
After processing all of the baselines within GrafNet, and you are happy with the solutions 
(i.e. sessions are green), then the network adjustment can be accessed from the Process 
Menu.  Select Network Adjustment.  It should be noted that the network adjustment will 
only accept session data flagged as GOOD (i.e. green sessions).  IGNORE, BAD or 
APPROX baselines will be ignored. 
 
For the initial few runs of the network adjustment, the Scale Factor should be set to 1.0.  
This will not scale the final standard deviations to match observed session vector 
residuals (see ‘What is the variance factor and how does it relate to the scale factor’). 
 
Select ‘Process’ to compute a network adjustment solution.  This will display any errors 
encountered.  If there are any “hanging stations”, which are stations that are not attached 
to the network or are attached by a BAD baseline, the adjustment will fail.  It is possible 
to change the status of the baseline to good from the session menu.  Once complete, an 
ASCII .NET file will be created, which can viewed by selecting ‘View Solution’.  
 
Please note that the network adjustment must be re-run if you have reprocessed sessions 
or changed the station configuration. 

3.9.2.4   Procedure for employing more than one control point 
When multiple control points are present, it is important to initially use just use one.  This 
will prevent errors in the existing control from causing otherwise correct session vectors 
not to fit.  Therefore, large tie errors in the traverse solution or large residuals in the 
network adjustment can be attributed to GPS errors (see ‘Interpreting the network 
adjustment output’ below).  Once you are happy with the quality of the GPS data and the 
fit of the session vectors, then additional control points may be added.  This can be done 
from the File Menu by selecting Add or Remove Control Points.  Control points can also 
be added by right-clicking on a station and selecting Add as Control Point. 
 
Since the network adjustment is a least-squares adjustment, it will attempt to move 
control point coordinates to make the network fit better.  This can be an undesirable 
effect for many applications.  To avoid such movement, control points should be given 
very low standard deviations.  The default value is 5 mm, which may need to be lowered 
if the network fit is poor.  Lowering the standard deviation to 0.0001 m should force the 
control point to “stay put”.  A standard deviation of zero is not allowed.  The standard 
deviation for control points can be changed from the File Menu in GrafNet (see File | Add 
and Remove Control Points).  Select the desired control point and select Edit. 
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3.9.2.5   How do I use horizontal and vertical control? 
GrafNet supports horizontal and vertical control points in addition to full 3-D control.  To 
utilize such control, users must have available 1-10 m accurate coordinates for the 
unknown axes (i.e. Z for horizontal points and Latitude and Longitude for vertical 
points).  These coordinates can be obtained either from the single point solution (in the 
absence of SA) or from an initial network adjustment run using just one 3-D control 
point.  The latter method is normally used. 
 
When the vertical and horizontal control points are added (using File | Add and Remove 
Control Points), it is important to de-weight the unknown axes.  For vertical control 
points, the horizontal standard deviation is set to 100+ m.  For horizontal control points, 
the vertical standard deviation is set to 100+ m. 

3.9.2.6   How do I obtain orthometric (mean sea level) heights? 
Orthometric heights are not available in the network adjustment output.  To obtain these 
heights, you will need to use the Export Wizard or Write Coordinates feature from the 
Output Menu in GrafNet.  This must be done after running the network adjustment.  
Important!  Control point elevations must be entered as ellipsoidal heights. 

3.9.2.7   The variance factor and the input scale 
The variance factor can be found at the very bottom of the network adjustment output.  It 
is the ratio between the observed residuals errors and the estimated session (baseline) 
accuracies.  Ideally, the variance factor should be 1.0.  This indicates that the estimated 
errors correspond well to observed errors.  A variance factor less than 1.0 indicates that 
the estimated errors are larger than the observed errors (i.e. session standard deviations 
are pessimistic).  A value greater than 1.0 denotes that observed errors are larger than 
estimated accuracies (i.e. session standard deviations are optimistic).  The latter case 
most often exists unless the GPS data is very clean.  Thus, low variance factors are 
normally desired.  Very large variance factors 100+ normally indicate abnormally large 
session errors (i.e. a very poor network fit), and a user should try and investigate the 
source of the problem before using the coordinates produced. 
 
The variance factor can also be used to scale the station standard deviations to more 
realistic values.  The network adjustment is initially run with a unity Scale Factor.  The 
resulting variance factor can then be inserted in the Scale Factor field from the first 
screen.  After running the network adjustment with this new Scale Factor, you will notice 
larger or smaller standard deviations and that the new variance factor should now be 
~1.0. 

3.9.2.8   What is the confidence level and do I need to use it? 
The confidence level (in percent) can be set from the first network adjustment screen.  
This uses a statistical 2-D normal distribution.  Changing this value will not alter the final 
coordinates; rather it will scale the final standard deviations and covariance values.  For 
example, 95% results in a standard deviation scale factor of 2.44. 
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3.9.2.9   Interpreting the network adjustment output 
The network adjustment output is an ASCII file, which can be printed from GrafNet or 
another program like Notepad.  This section describes each of the information blocks: 
 
INPUT STATIONS 
This is a list of each of the stations whose coordinates are being solved for.  The TYPE is 
UNK if the coordinates are to be determined and (GCP) for ground control points.  The 
Earth Centred Earth Fixed (ECEF) X, Y and Z coordinates are shown for control points 
only.  SX, SY and SZ refer to the ECEF standard deviations. 
 
INPUT VECTORS 
This is the ECEF vector components for each of the sessions that have a GOOD status.  
The lower triangular of the ECEF covariance matrix is shown next to the vector 
components.  The value in brackets is the standard deviation of the ECEF X, Y or Z axis 
in meters.  The covariance values are not scaled by the Scale Factor entered at the start. 
 
OUTPUT VECTOR RESIDUALS (most important!) 
This is the most important section of the network adjustment output.  It indicates how 
well the session vectors fit in the network.  The residual values are shown in local level, 
where RE is the east axis residual, RN is the north axis residual and RH is the Z axis 
residual.  These values are expressed in meters and ideally should be a few centimeters or 
less.  Larger values may be acceptable for larger networks.   
 
In addition to the residual values, a parts-per-million (PPM) value is shown.  This 
indicates the size of the residuals as a function of distance.  1 PPM corresponds to a 1 cm 
error at a distance of 10 km.  The baseline length is also shown in kilometers.  Short 
baselines (i.e. < 1 km) can have large PPM values.  This is because other errors such as 
antenna centering become an influencing issue.  This may not indicate an erroneous 
session solution.  The last value is the combined (east, north and up) standard deviation 
(STD).  This will indicate sessions that have a float solution and/or poor satellite 
geometry (i.e. high PDOP) and/or short occupations. 
 
CHECK POINT RESIDUALS 
If check points have been added, this section will show how well the known coordinates 
compare to those computed by the network adjustment. 
 
CONTROL POINT RESIDUALS 
This section shows the adjustment made to control point residuals.  When just one control 
point is used, then the adjustment will always be zero.  With two or more points, the 
adjustment depends on the input control point standard deviation and the session vector 
standard deviations.  See “What procedure should I use for employing more than one 
control point”. 
 
OUTPUT STATION COORDINATES 
This shows the computed coordinates for each of the stations both in geographic and 
ECEF coordinate systems.  The output datum will be that indicated by the DATUM 
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parameter at the top of this file.  Note that the geographic height should be ellipsoidal.  
However, this is only true if the user entered an ellipsoidal height for the control point 
elevation. 
 
OUTPUT VARIANCE/COVARIANCE 
This section shows the local level (SE, SN and SZ) standard deviations along with ECEF 
covariance values.  These standard deviation and covariance values will be scaled by both 
the input Scale Factor and the statistical (confidence) scale factor.  If error ellipse 
parameters are desired, then the Write Coordinates feature should be used. 
 
VARIANCE FACTOR 
See “What is the variance factor and how does it relate to the scale factor?” discussed on 
the previous page. 
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Chapter 4   GrafNav Batch 
 

Section 1   What is GrafNav Batch? 
GrafNav Batch is a program that accompanies the GrafNav/GrafNet or GrafNav Lite 
version 7.50 software packages.  This program allows the user to batch process both 
kinematic and static baselines using float-only, fixed static, KAR solutions, and other 
GrafNav processing options.  Static-only baselines/networks are best processed using 
GrafNet.  Users can easily load observation files (.gpb), process multiple baselines, 
process multi-base baselines, and export the output of numerous sessions into separate or 
concatenated files. 
 

 
Figure 4.1 GrafNav Batch Processor 

4.1.1   Getting Started 
By following the procedure below, a user can quickly get accustomed to using GrafNav 
Batch, which can process multiple baselines with few operator steps. 
 
1. Select a name for your project 

• Select New Project from the File Menu or click on the  button on the tool bar. 
• Change the directory to the one where the observation files are located.  It is 

important that you save your project in the same directory as the observation files 
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because otherwise you will be prompted to locate each GPB file that is not in the 
same directory as your project when your project is reopened. 

• Give the project a unique name. 
• Save. 

 
2. Convert receiver dependent raw GPS data to Waypoint .gpb format. 
 

• If the data logger WLOG (or another one of Waypoint's utilities i.e. LOGGPS) 
was used to log the observation files, this step may be omitted. 

• The Convert utility can be accessed under the File Menu, or by clicking the  
button.  For more information on the Convert utility see Chapter 7  . 

 
3. Add Many Baselines 

• Choose Add Many Baselines from the File Menu or click the  button. 
• Select the appropriate directory containing the observation (.gpb) and ephemeris 

(.epp) files.  Ephemeris (.epp) files should have the same prefix as the .gpb files.  
If not, then a corresponding .epp file will need to be specified for each individual 
baseline (use Edit Baseline). 

• Select the option 'One base many remotes' or 'One remote many bases' depending 
on whether the same base or remote was used repeatedly for each baseline. 

• Highlight one or more observation files containing GPS data for the master 
station(s) and click Add Base(s) in the dialogue box.  Another dialogue will 
prompt the user for the geographic coordinates and antenna height of the base. 

• If you wish to specify remote antenna heights, ensure that the box with the option 
'Prompt for remote antenna height' is selected. 

• Highlight all the remote station observation files and click the Add Remote(s) 
button. 

• Click OK. 
 
4. Add Multi-base baselines 

• Choose Add Multi-Base Baselines from the File Menu or click the  button. 
• Add the master files by clicking ‘Add’.  The remote file can be added by clicking 

‘Browse’.  Locate the path of the .GPB files.  Click ‘Plot Coverage’ to display the 
Static/Kinematic Coverage plot of the files added.  Be sure that there is sufficient 
coverage available. 

• A dialogue box will appear prompting the user for geographic coordinates and 
antenna height of the bases.  Another dialogue box will prompt the user for the 
remote antenna height. 

• Click OK 
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5. Set Processing Options 
 
Global Options 
If you do not wish to specify individual processing options for each baseline, select 
‘Process All Baselines’ from the file menu.  You will be warned that using this option 
will process all the baselines with the same options, thus overwriting any previously user 
specified options for any individual baselines (such as processing time interval or user 
defined C/A or L1 phase standard deviations). 
 
Another way to specify global options is to select ‘Global Options’ under the Options 
menu.  Ensure that the processing datum corresponds to your project one.  For more 
information on datums, see Section 10.5.2  Datums. 
 
Individual Baseline Options 
Some baselines may require processing options that differ from others to obtain 
satisfactory results.  This can be for reasons as simple as some of the baselines in your 
project are short and some are long.  Specifying individual processing options for 
baselines is accomplished by selecting the baseline(s) that you wish to change the 

processing options and click the  button.  Then, with all of your baselines selected 
(those with and without special processing options), chose ‘Process Selected’ from the 

file menu, or click the  button.  This will process all of your baselines, while 
preserving processing options for each individual baseline. 
 
6. Combined baseline solution 
 
In the case where you have many base stations and one remote, or multi-base baselines, 
you may wish to create a combined file that uses weighted observations from all of your 
baselines.  See Section 7   for information regarding combining baselines. 
 
7. Export data output into files 
 
To export coordinates and other information from processed baseline sessions to ASCII 

text files, select Export All from the Tools Menu or click on the  button. 
Select the source for your output (epochs, features/stations, static sessions) and select a 
predefined profile that comes with GrafNav (i.e. $GPGGA, Geographic, UTM, State 
Plane, etc.) or select a user defined profile. 
Click the Next button and choose the Break-up batch sessions into separate files only if 
you want the output for each baseline in separate ASCII files.  The user can also specify 
how the output files are named and what file extension is used. 
Click Next again to continue with the rest of the Export Wizard option menus. 
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8. Save Project 

To save your configuration, select Save Project in the File Menu or click on the  
button.  If processing one remote and many base stations, then refer to Chapter 4  Section 
7  for information on combining multiple baselines into one solution. 

Section 2   File Menu 

4.2.1   New, Open, Save, and Save Project 
These menu items help manage the GrafNav Batch/ GrafNav Lite Batch projects (i.e. 
.BNV files), and they are very similar to standard Windows applications. 

4.2.2   Add Baselines 
File | Add Baselines 
Use this option to add independent single baselines to your project.  Under the 'File 
Name' window tab, select which GPB files you want to add as master and remote.  The 
user needs to select whether these separate baselines have ‘One base many remotes’ or 
‘One remote many bases’. 
 

 
Figure 4.2 Add Baselines Dialogue 

 
After pressing OK, the user will be prompted to enter the base station coordinates.  Once 
a position for the base station has been entered, the coordinates may be added to the 
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favourites list to reduce the amount of retyping.  Both the base station and remote station 
window tabs require an antenna height to be entered.  A simple vertical antenna height is 
generally used; however an advanced antenna height model using an antenna profile is 
also available.  The advanced antenna height profile is only used if horizontal distance 
from the antenna centre to the ground plane edge and vertical distances from the L1 and 
L2 phase centers are needed.  For more information on advanced antenna profiles, please 
see Section 2.2.4  . 
 

 
Figure 4.3 Base Station Information 

 
The ‘Remote Antenna’ dialogue box lets you change the antenna height and the antenna 
height model.  Refer to Section 2.2.5  for more information on remote antenna options.  

4.2.3   Add Multi-Base Baselines 
File | Add Multi-Base Baselines 
This option allows the user to add multi-base baselines, where the base stations will be 
processed together with the remote rather than independent single baseline processing. 
 

187 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

 
Figure 4.4 Add Multi-Base Baseline Dialogue Box 

 
Add the master files by clicking ‘Add’.  The remote file can be added by clicking 
‘Browse’.  Locate the path of the .GPB files.  Click ‘Plot Coverage’ to display the 
Static/Kinematic Coverage plot of the files added. 
 
Tip: This is best called after single base baselines are added. 

4.2.4   Add Combined Baseline 
This will add another ‘combined’ baseline to the list of baselines.  A user may wish to 
combine more than one pair of baselines in one project.  This option will allow the user to 
do so.  New to version 7.50, the user can now combine ‘combined’ files and multi-base 
baselines as well.  Highlight 2 or more baselines in the list of baselines to be combined, 
then select Process | Combine Selected Multi-Base.  The dialogue box that opens contains 
information about the combine process and the user can select the ‘combine’ baseline 
from the pull down menu, see Section 7 for more details. 

4.2.5   Edit Selected Baseline Settings 
File | Edit Selected Baseline Settings 
This option gives the user the ability to edit the path and file names that GrafNav Batch 
should be looking for, base station names, change the master station coordinates, or 
change the antenna heights or antenna height model being employed.  If more than one 
baseline is selected, then any shared information can be changed.  This could be the 
master position and antenna height, remote antenna height, or baseline options.  Refer to 
Section 4.2.2 for more information on the edit options. 

4.2.6   Remove Selected Baselines 
File | Remove Selected Baselines 
Remove Selected Baselines will remove highlighted baselines in the List of Baselines 
window and from the project file (.bnv).  However, if the project is not saved afterwards, 
the project will still retain the deleted baseline.  Configuration and processing files will 
be left over unless they are manually removed. 
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4.2.7   View ASCII file 
File | View | ASCII File 
See Section 2.2.14  Viewing an ASCII File. 

4.2.8   View Raw GPS Data 
File | View | Raw GPS Data 
See Section 2.2.15  Viewing Raw Binary GPS Data. 

4.2.9   Convert Raw GPS to GPB 
File | Convert | Raw GPS to GPB 
See Section 2.2.21  Converting GPS Data and Chapter 7  Convert. 

4.2.10   Convert GPB to RINEX 
File | Convert | GPB to RINEX 
See Chapter 6  Section 5  GPB to RINEX (Windows). 

4.2.11   Remove All/Selected Processing Files 
File | Remove Processing Files | All/Selected 
Use caution when choosing to remove all processing files, as all processing files in your 
working directory will be deleted, including those from other projects.  If you wish to 
remove the processing files from only certain baselines, select these baselines then chose 
to remove only the selected baseline solutions. 

4.2.12   GPB Utilities 
File | GPB Utilities 
See Chapter 6  Utilities. 
 

Section 3   Process Menu 

4.3.1   Process All/Selected 
Process | Process All Baselines / Process Selected 
These two options will process either all or only the selected baselines in GrafNav Batch.  
If Process All is selected, the individual processing options will be overwritten with the 
global processing options for all baselines. However, the user may wish to specify 
individual options for troublesome baselines.  Do this by selecting the desired baseline 

and pressing the  button.  After changing individual processing options, select all the 
baselines with the mouse (while holding the shift or control key for multiple selections), 

and press the  button or go File | Process Selected.  The processing window and 
dialogue box for options are the same as GrafNav.  Users should refer to Chapter 2  
Section 3  Processing Options for more information. 
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4.3.2   GrafNav on Selected 
Process | GrafNav on Selected 
If the user needs additional options, tools, plotting and printing capabilities or the 
baseline solution needs improvement, GrafNav can be opened and used for processing 
the highlighted baseline using the GrafNav on Selected option. 

4.3.3   View Selected Processing Summary 
Process | View Selected Processing Summary 
See Section 2.4.12  View Processing Summary. 

4.3.4   Load All/Selected Solutions 
Process | Load All / Selected Solutions 
These two options will load all or selected solutions into GrafNav Batch, thus allowing 
the user to load existing solutions for plotting and exporting into output files. 
 

Section 4   Settings Menu 

4.4.1   Global/Selected Processing Options 
Settings | Global Options/Selected Options | Processing Options 
If global processing options are selected, the options will be copied to every single 
baseline and overwrite any individual options that have been set.  Baselines that require 
individual options should be selected and then ‘Selected Options’ should be chosen from 
the Options menu.  Users should refer to Chapter 2  Section 3  for more information on 
Processing Options. 

4.4.2   Global Datum/Grid Options 
Settings | Datum/Grid Settings 
These options will affect all baselines.  See Section 2.3.11  for datum options and Section 
2.5.1  for grid options. 

4.4.3   Alternate Ephemeris files 
Settings | Global | Alternate Epehemeris Files 
See Section 2.2.6  for details on adding precise ephemerides or IONEX files. 

4.4.4   Edit Selected Baseline 
Settings | Selected | Processing/Baseline Settings 
See Section 4.2.5  and Chapter 2  Section 3  for processing/baseline settings. 

4.4.5   Copy Processing Options 
Settings | Copy Processing Options 
Copy processing options lets the user copy the processing options from one baseline to 
another baseline.  The baseline with the new processing options will have to be 
reprocessed for the processing options to take effect. 
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4.4.6   Manage Settings 
Settings | Manage… 
See Section 2.5.7  for loading pre-defined settings into a baseline. 

4.4.7   Display Options 
Settings | Preferences 
See Section 2.5.2  for a list of the options available in GrafNav Batch.  
 

Section 5   Output Menu 

4.5.1   Plot Selected GPS Data 
Output | Plot Selected GPS Data 
This feature allows users to plot GPS data from a selected baseline.  See Section 2.6.1  
for more information on the types of plots available for GrafNav, GrafNet, and GrafNav 
Batch. 

4.5.2   View Selected GPS Map 
Output | View Selected Map 
This feature allows the user to view a trajectory (in the case of kinematic data) or a static 
representation of the GPS data for any individual baseline.  Note that only one map for 
one baseline can be viewed at a time. 

4.5.3   Export All / Selected 
Output | Export All / Export Selected 
By using Export All and Export Selected, the user can export custom output files using 
the Export Wizard.  Export Selected and Export All will export the selected data into one 
concatenated file if more than one baseline is selected and if the ‘Break up batch sessions 
into separate files’ option is not selected.  If this latter option is selected, the user will be 
prompted to assign the method for naming the output files. Further information regarding 
the use of the Export Coordinates Wizard and its options can be found in Chapter 2  
Section 7  . 

4.5.4   View Export File 
Output | View Export File 
This option opens the ASCII viewer in GrafNav Batch for the user to view the last output 
file that was written using the Export Wizard.  If the Export Wizard has the option ‘Break 
up batch sessions into separate files’ selected, View Export File will not work properly 
since it looks for the file name <project name>.txt in the current working directory.  In 
this situation, try using the View ASCII file option in the File Menu or on the toolbar.  
See Section 2.2.14  Viewing an ASCII File. 
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Section 6   Tools Menu 

4.6.1   Map Tools 
Tools | Zoom In / Zoom Out / Zoom Reset / Distance & Azimuth Tool 
These tools, also found in GrafNav and GrafNet, are provided to be used in the mapping 
window.  In GrafNav Batch, this window is activated by selecting the desired baseline 
and selecting the ‘View Selected Map’ option from the Output menu.  The 
distance/azimuth tool works by left clicking once on your “from” point, then right-
clicking on your “to” point. 

4.6.2   Find Epoch 
Tools | Find Epoch Time 
This tool is also used only in the mapping window, and is useful for kinematic data sets.  
When selected, the user is prompted to enter a time in GPS seconds of the week.  
GrafNav Batch will then highlight the chosen epoch by drawing a red circle around it.  
This can be useful in determining where in the survey bad epochs were recorded. 

4.6.3   Datum Manager 
Tools | Datum Manager 
Use this tool to convert coordinates between datums.  This is useful for converting base 
station coordinates before processing in the desired datum.  See Section 10.5.2  Datums 
for more information. 

4.6.4   Geoid 
Tools | Geoid 
If orthometric heights are of interest, use this option to change geoid models.  Geoid 
heights can also be computed here.  See Section 10.5.4  for information on Geoids. 

4.6.5   Grid/Map Projection 
Tools | Grid/Map Projection 
Available grid systems include Gauss Kruger, US State Plane, and UTM.  This option 
allows users to define their own grid system as well.  Use this option to convert grid 
coordinates to geographic coordinates.  See Section 10.5.3  Map Projections/Grids for 
more information. 

4.6.6   Favourites Manager 
Tools | Favourites Manager 
Use this feature to avoid unnecessarily retyping coordinates that are used often.  See 
Chapter 2  Section 8  Favourites Manager for more information. 
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4.6.7   Time Conversion 
Tools | Time Conversion 
This tool allows the user to convert both from GPS time to HMS and back.  Note that this 
tool returns GPS week numbers from 0-1023.  In some applications (such as downloading 
precise orbits) it is necessary to add 1024 to the week number returned by this tool. 

4.6.8   Mission Planner 
Tools | Mission Planner 
To best prepare for a GPS survey, take advantage of this tool that indicates hourly 
conditions (number of satellites, DOP values) for your area of interest.  See GrafNav 
Chapter 6  Section 8  Mission Planner for more information. 

4.6.9   Download Service Data 
Tools | Download Service Data 
This is a convenient tool that will download GPS data from the IGS, CORS, AUSLIG, 
IGN, and GSI networks.  These stations, if near enough to your project area to satisfy 
desired accuracies, can be used as base stations, or additional base stations if you already 
have one of your own.  This can improve accuracies, and in some cases save a survey 
altogether.  They can also be used to check the validity of base station coordinates.  See 
Chapter 6  Section 9  Download Service Data for more information. 
 

Section 7   Combining Multiple Baselines 
This section covers the process of using GrafNav Batch to process between multiple 
bases, multi-base baselines, and a single remote.  For instance, a typical scenario would 
be an aircraft covering a large area.  In order to maintain accuracies, multiple base 
stations are required.  As of version 7.50, users can now combine multi-base baselines 
and combined baselines as well.  To add an additional combined baseline, see Section 
4.2.4  . 
 
The following procedure would be used: 
1. To get started, follow steps 1 to 5 in Section 2  File Menu of this chapter. 
2. Process each of the baselines to your satisfaction.  This can be done either from 

within GrafNav Batch or GrafNav. 
3. Add an additional baseline to the same remote (it does not mater which base station is 

used because this baseline will not be used for processing).  The user may wish to 
change the name on this baseline, which is performed by right-clicking on it and 
selecting the Rename menu option.  Change the name to something appropriate like: 
Multi-Base Combination. 

4. You may wish to reject epochs that have poor statistics, specify remote initializations, 
or specify the solution to load (forward / reverse / combined).  All of these options are 
found in the ‘Multi-base’ tab after selecting ‘Edit Selected Baselines’ from the File 
menu.  From this dialogue box, epochs can be rejected for a number of reasons.  In 
addition, an additive PPM and weighting value can be used to change the weighting 
with distance. 
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5. With all of the baselines still selected, select ‘Combine Selected Multi-base’ from the 
Process Menu.  This will combine these baselines into a single solution.  Outliers can 
be rejected based on two parameters: 
• Error Tolerance – this is the minimum error before an outlier will be detected.  

Setting this correctly is important to prevent false errors from being detected. 
• Sigma Tolerance – This is the number of standard deviations (of the computed 

position standard deviation) before an error is “deemed an error”.  You may wish 
to use 3-sigma to reduce the number of errors detected.  The default is 2-sigma. 

6. The additional baseline added will be used as a “holding place” for the combined 
solution.  This is performed by enabling ‘Send output to baseline (i.e. BED file)’.  
Select the baseline added (possibly renamed) e.g. Multi-Base Combination. 

 

 
Figure 4.5 Combining Data from Multiple Base Stations 

 
7. If camera event positions are desired, then select the next option labeled ‘Send 

output to ASCII .CMB file’ as well.  This will allow you to load this solution into 
GrafNav, which supports the interpolation of camera event marks. 

8. Press OK 
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When complete, the following screen will appear: 
 

 
Figure 4.6 Combine Multi-Base Summary 

 
This gives the user an indication of how many epochs were rejected. 
 
To export the camera event pulses, load one of the baselines in GrafNav.  From the File 
Menu, select Load | Existing Solution.  Select the .CMB file created.  You may also need 
to load the camera event pulses.  Use either Write Coordinates or the Export Wizard to 
output the camera position. 
 
<Important>:  The user should monitor how many epochs were rejected – especially as 
outliers. 
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Section 1   Introduction 
Inertial Explorer (GPSIMU) post-processing 
software suite is aimed at user’s who wish to 
integrate rate data from six degrees of f
IMU sensor arrays with GPS informati
processed via GrafNav which is included.  
Inertial Explorer is designed to utilize 
strapdown accelerometer (∆ν) and angular
rate (∆θ) information to produce high rate 
coordinate and attitude information from a 
wide variety of IMU’s including high 
accuracy navigation grade to inexpensive 
MEMS (Micro Electro-Mechanical Systems) 
sensor types.   

reedom 
on 

 

 
The initial version of the GPS/IMU processor implements a loose coupling of the GPS 
and inertial data.  Users must collect and process GPS data in a separate stream from the 
raw IMU ∆ν and ∆θ measurements.  It is the user’s responsibility to time tag each set of 
inertial measurements to the GPS time frame during the data collection process.  The 
GrafNav component of Inertial Explorer must be run first in order to process and store an 
optimal set of GPS coordinates, velocity and quality information in the standard GrafNav 
fwd/rev/cmb output files.  Following this, the IMU component of Inertial Explorer can be 
invoked to perform alignment, mechanization of the rates and filtering.  GPS coordinate 
and velocity updates are implemented by time matching and interpolating the inertial rate 
data with the closest GPS measurement epoch.  Sensor bias calibration is also performed 
during the filtering process. 
 
With this software package we hope to provide GPS / inertial processing for users who 
are not able to utilize available commercial GPS/IMU systems in their particular 
application for reasons of cost, package size or other parameters relative to specialized 
mission requirements.  The IMU algorithms have been originally developed at the 
University of Calgary for their KINGSPAD program and have been proven in many 
applications.  Waypoint is engaged in on-going IMU research activities with our partners 
at the University.  The aim of this partnership is to help bring relevant and significant 
improvements to the Inertial Explorer package as time goes on. 
 

Section 2   About Inertial Systems 
To a significant extent, inertial navigation is about coordinate frames.  Inertial sensors 
measure rate information relative to an inertial frame of reference.  An inertial coordinate 
frame does not rotate or accelerate with respect a space-fixed system of reference.  
Accelerometers measure change of velocity with respect to an inertial frame.  Gyroscopes 
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measure change of rotation with respect to inertial space.  In other words, they are inertial 
sensors.  If one can relate measurements made in this inertial frame to some chosen 
navigation frame, then inertial sensors can be used to realize both 3-dimensional 
coordinates (X, Y, Z) and 3-dimensional attitude (roll, pitch and yaw) in a world that 
makes sense to navigators. 
 
Inertial Reference Frame (I-Frame) 
A practical implementation of an inertial coordinate frame is to define the centre of mass 
of the earth as an origin.  The z-axis of this system goes through the poles and is co-
incident with the spin axis of the earth.  The x-axis is tied to star systems and points at the 
equinoctial colure or the meridian where the sun apparently crosses the equator at the 
spring equinox.  The y-axis completes a right hand triad.  We assume that a system tied to 
the stars does not move for the duration of a typical survey. 
 
 

 
Figure 5.1 Coordinates Frames Utilized in Inertial Explorer 

 
Figure 5.1 above1 portrays the relationship of our practical inertial frame with a 
convenient ECEF computation frame (Xe Ye Ze) and a popular local level navigation 
frame (Xe Ye Ze). 
 
 
 
 
                                                 
1 Re-printed with permission of Dr El-Shiemy of the University of Calgary 
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Earth-Centred Earth-Fixed Frame (ECEF) or e-frame 
The computation frame - Inertial Explorer performs its principle calculations for both 
GPS and inertial computations in the ECEF frame.  The origin of this system is at the 
centre of mass of the earth – well-defined by observing the orbits of satellites together 
with gravity measurements.  The z-axis is co-incident with the spin axis of the earth and 
co-incident with the z-axis of the I-frame defined previously.  The x-axis of the ECEF 
system points through the Greenwich Meridian, while the y-axis completes a right hand 
orthogonal frame. 
 
It can be assumed that the ECEF frame differs from an inertial earth-centred frame only 
by the amount the earth rotates. 
 
Local Level Frame (LL-frame) 
The navigation frame, included for the purposes of visualizing the navigation of a vehicle 
the Local Level frame, is an appropriate reference system to output coordinate and 
attitude information. Local Level enables coordinate output in north, east, up or latitude, 
longitude, height as well as attitude output in terms of roll, pitch and yaw (heading).  The 
origin of this system is the centre of the sensor array.  The z-axis is orthogonal to the 
reference ellipsoid at the sensor array, the y-axis points north, while the x-axis points 
east.  When making computations in the local level frame, instabilities can develop near 
the poles due to convergence of the meridians.  This is not a problem for Inertial Explorer 
because it uses the e-frame.  However, other systems utilize the so-called Wander 
Azimuth system to compensate.  This system maintains a so called grid north. 
 
Body Frame (B-frame) 
This sensor axis frame is aligned to the vehicles body.  In the following discussion, we 
will assume that the accelerometer and gyro measurements are made in the body frame of 
the vehicle.  This is the so-called “strapdown” approach to inertial navigation.  The 
orientation of a vehicle’s body frame is completely arbitrary from one epoch to the next.  
One of the principal challenges in any inertial survey is to properly compute the 
orientation of the B-frame with respect to your chosen computation frame at each and 
every measurement epoch.  For instance, body to l-frame angles are roll, pitch and yaw. 
 
The B-frame chosen for Inertial Explorer is depicted below.  Note that the body frame 
definition for the user's inertial measurement unit may very likely be different from that 
shown below.  A simple reflection of your body axes into the body axes given by Inertial 
Explorer will typically be all that is required to process data.   
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Z 

Yaw 

Roll 

Pitch 

 
Figure 5.2 Body Frame Definition 

 
The y-axis of the body frame is co-incident with the longitudinal axis of the vehicle.  Its 
positive direction points out the nose of the vehicle.  The y-axis may also be said to 
define the roll axis of the vehicle with positive roll being counter-clockwise in a right 
hand system.  The positive x-axis of the B-frame points out the right side of the vehicle, 
when facing the rear.  It will contain the vehicle pitch rate.  The z-axis of the body frame 
points positive up.  A counter-clockwise yaw rate is positive about the z-axis of the given 
b-frame. 
 
Inertial Processing 
To process measurements made in an inertial frame, the body frame needs to be re-
oriented in such a way as to make it co-incident with the computation frame or eventually 
the navigation frame (if they are different).  In other words, body frame measurements 
should be sensed directly in the desired computation frame.  Furthermore, only those 
components, which are due to motion of the vehicle, are of interest.  Hence, gravity earth 
rotation and the curved shape of the earth as sensed by the gyros (and accelerometers) 
must be eliminated.  Any sensed accelerations can now come only from vehicle 
dynamics.  For example in the e-frame, if accelerations along the north-pointing axis are 
integrated twice, there is a direct difference in northing from some known starting 
location.  Similarly, differences in easting and height can be obtained by integrating twice 
along the other 2 accelerometer axes – provided these are properly oriented.  If the initial 
coordinates at the centre of the sensor array are known at the start of a mission, our 
coordinate differences can be used to compute and output latitude, longitude, and height 
at each time epoch in the trajectory. 
 
The problem is that sensor biases, measurement noise, errors in initial conditions and 
gravity modeling errors are integrated along with measurements.  In attitude, the single 
integration results in the platform becoming misaligned to the computational system.  In 
position, this misalignment causes the gravity vector to enter horizontal axes, while the 
double integration of these errors leads to an additional quadratic error.  The end result is 
that significant errors can quickly be realized. 
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The rotation matrix required to take body sensed measurements and place them in the 
computation frame at any given epoch will be referred to here as the attitude matrix.  
The gyro triad is utilized to sense the change in vehicle rotation from one body frame 
orientation at one epoch to the subsequent body frame orientation at the next epoch.  The 
direction cosine matrix which is defined in Inertial Explorer to go from body to 
navigation frame is a function of 3 consecutive rotations in yaw, pitch and then roll.  
Computation frame is ECEF, so the attitude matrix must be further rotated as function of 
latitude and longitude.    
 
Changes in orientation (i.e. angular rates) must be integrated once in order to obtain 
angles.  This implies 2 things.  First of all, it is a requirement to solve for 3 initial 
constants for the integration process to be complete.  Secondly, as with the 
accelerometers, errors are integrated as well as measurements.  The integration process 
can then quickly build up errors from the gyros – as well as signal.   
 
Error Models are more important for inertial processing than GPS processing.  Some 
details on error models are provided in the section concerning our Error Model Dialogue 
Box (see Section 5.4.5  but it may be useful to make some mention of the topic here.  
First of all, by “error model” in the context of Inertial Explorer, it looks at the initial 
variances and a priori spectral noise densities required by the IMU Kalman filter.  These 
are values which may be input through the Error Model dialogue box interface or User 
Commands.  The dialogue box interface provides a number of “canned” error models 
appropriate to certain classes of IMU’s.  It also allows the user to build custom error 
models suitable to particular inertial measurement units or applications.  
 
Unlike GPS, inertial computations are very sensitive to the input a priori stochastic 
information that is available for each inertial system.  As a rule of thumb, the more 
expensive the IMU, the less likely you are to achieve poor results from a non-optimal 
choice of input statistical quantities.  A poor choice of noise densities for a navigation 
grade inertial system may simply provide the user with a sub-optimal set of outputs, say 
for attitude.  An inappropriate choice of noise densities for a MEMS array with a drift of 
300 degrees/hour may mean that you obtain nonsense for attitude information!  The 
process of choosing an appropriate variance and spectral densities for a particular system 
is called “tuning”.  Unfortunately, tuning can be something of an arbitrary process.  The 
user may have to simply guess at the approximate magnitude of the noise densities which 
help describe the behavior of an inexpensive inertial system. This can be a tedious and 
unrewarding process.  Definition of error models for various classes of IMU’s will be an 
on-going program at Waypoint and with our partners at the University of Calgary.  These 
will be included in a file called USER.IMU which can be found under your Program 
Files\WaypointGPS software directory.  Waypoint will be attempting to update this file 
on a regular basis as we learn more about the different sensors coming on the market, 
especially in the MEMS category. 
 

Alignment is the process of computing the initial values of roll, pitch, and yaw.  Proper 
alignment is very important to IMU performance and processing because errors result in 
a direct attitude error and can take some time to correct by the Kalman filter.  Alignment 
can either be static or kinematic.   
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Static alignment generally takes place in 2 stages; coarse alignment followed by fine 
alignment.  Coarse alignment is a requirement for static alignment.  Fine alignment is 
optional. If the user has GPS data immediately available for updates, the static fine 
alignment process can often be ignored.   
 
Coarse alignment generally requires 1 to 2 minutes of static data.  The default time for 
coarse alignment is Inertial Explorer is 120 seconds.  The software will monitor the data 
and warn you if the data is kinematic.  During coarse alignment the basic signal from a 
set of static accelerometers is the gravity vector.  In this B-frame definition, roll is a 
function of acceleration measured in the x body axis.  Pitch is a function of sensed 
acceleration in the y body axis.  The approximate roll and pitch values computed from 
these measurements can then be used to define an approximate level plane.  Initial 
heading still needs to be computed and this is where inexpensive IMU sensors tend to 
disappoint.  Gravity is a strong signal and it can be sensed adequately by even MEMS 
grade accelerometers.  Heading or yaw (which simply has the opposite sign to heading) 
must be computed by examining the output of the gyros for earth rate.  For instance in an 
ideal stable platform system, the assumption was that one horizontal axis points due east.  
A gyroscope aligned along this axis will be in a no torque situation relative to the earth 
rotation. There will be no output.  On the other hand, the north-pointing axis will sense 
the entire earth rate at that latitude.  Consider the magnitude of the earth rotation rate at 
about 15 degrees per hour.  MEMS rotation sensors can have drifts in the order of 100 to 
300 degrees per hour and the user can see that computation of heading during coarse 
alignment with such sensors is impossible.  In fact, any output from such a gyro during 
static alignment can be simply considered as bias noise. Systems at about 1 deg/hr should 
be able to gyrocompass to some degree of accuracy.  Systems above this may require 
external aiding for azimuth determination.   
 
Fine alignment is the process of using static data in the Kalman filter process to fine tune 
the initial roll, pitch and yaw computations.  If GPS updates are immediately available 
following coarse alignment, many applications can choose to fine tune the attitude 
information from the GPS information available during navigation.  For instance, an 
airplane taxiing down a runway may have sufficient time and update information to 
adequately perform a dynamic fine alignment.  By the time the aircraft reaches the area 
where the mission will take place, the attitude matrix and associated sensor biases may 
very well be optimized as well as possible without static fine alignment.  Note that for 
low grade IMU’s, the GPS update process can also provide some approximation of 
heading during navigation.  This works best in minimal crab environments.  
 
In principle, it is also possible to transfer initial roll, pitch and yaw from another sensor 
while kinematic.  Moving coarse alignments are even possible just from GPS update 
information.  Users should be aware that the process of alignment is similar to the 
convergence process which must be undertaken for computation of GPS phase 
ambiguities.  Unless the user has a very expensive IMU do not expect to obtain optimal 
values for attitude until some static and kinematic data collection has taken place.  This 
will be in the order of minutes, not seconds.  Analogous to GPS, kinematic IMU 
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alignments take longer than static alignments.  Ideally, the first 5 to 10 minutes of the 
mission should be concerned with alignment (static and kinematic). 
 
Data Formats 
Inertial Explorer expects raw binary IMU data to have the following structure: 
 
Word Size 

(bytes) 
Type Description 

Gpstime 8 real time of the current IMU rate measurement in GPS seconds 
of the week. 

GyroX 4 int scaled x-body axis gyro measurement as an angular 
increment or angular rate 

GyroY 4 int scaled y-body axis gyro measurement as an angular 
increment or angular rate 

GyroZ 4 int scaled z-body axis gyro measurement as an angular 
increment or angular rate 

AccelX 4 int scaled x-body axis accel measurement as a velocity 
increment or acceleration 

AccelY 4 int scaled y-body axis accel measurement as a velocity 
increment or acceleration 

AccelZ 4 int scaled z-body axis accel measurement as a velocity 
increment or acceleration 

Table 5.1 IMU Data Formats 
 
Inertial Explorer directly decodes raw IMU binary measurements from a number of 
systems.  These are listed below:   
LTN90 
LASERREF3 
LN200 
HG1700 (NovAtel BDS) 
AG1700 
GENERIC_IMU 
 
These data formats are decoded if selected in the dialogue box shown in Inertial Explorer. 
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Figure 5.3 Data Formats Decoded in Inertial Explorer 

 
Users can define their raw strapdown output in our Generic Format which has the same 
structure as shown in Table 5.1 above, where 
 
Time is GPS seconds of the week, 
 
Gyro output is in angular rate of 1/100 of an arc second per second, in other words, 
degrees per second scaled by 360000, and 
 
Accelerometer output is in acceleration units of micro-metres per second2 or metres per 
second2 scaled by 1000000.  Also see Section 5.7.3  Generic Binary Input Structure that 
provides the format for different generic binary input files.  See Section 5.7.4  for 
converting raw IMU data into Waypoint’s generic format (*.imr file). 
 
Note that GPS time can either be the internal GPS receiver measurement time or it can be 
the so-called corrected measurement time.  The difference between the two is the receiver 
clock bias.  Users should be aware that GPS receivers which do not steer their clocks can 
have clock biases which are many milliseconds.  It is up to the user to make sure that 
their IMU measurements are tagged with a meaningful time in GPS seconds of the week.  
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GrafNav outputs both the corrected time and nominal receive time.  Inertial Explorer has 
a User Defined command which allows some accounting for this: 
 
INS_GPS_TIME_FRAME = GPS_TIME_FRAME / RCVR_TIME_FRAME 
 
The default is GPS_TIME_FRAME i.e. we are assuming that the IMU measurements 
have been time tagged with the corrected measurement time. 
 
Kalman Filtering / GPS Updates 
The IMU Kalman filter consists of 3 misalignment states, 3 position states, 3 velocity 
states, 3 gyro bias states, and 3 accelerometer bias states.  The first 9 states are in the 
ECEF computation frame.  They represent estimated errors in the realization of an ECEF 
computation frame from measurements made in the arbitrary vehicle body frame.  The 
sensor biases are lumped states accounting for constant and time-dependent gyro and 
accelerometer measurement errors.  This filter runs in conjunction with equations which 
“mechanize” the IMU rate data, that is propagate the attitude matrix and integrate 
coordinate differences between GPS updates. 
 
The GPS data must be processed first.  This produces ASCII .fwd and .rev files, as well 
as a .cmb file which represents the weight mean of the forward and reverse GPS 
processes.  Inertial Explorer reads the .cmb file by default and stores the coordinate, 
velocity and associated covariance information in a binary image in memory.  At IMU 
measurement time tags, and GPS epochs are generally not aligned.  Therefore, Inertial 
Explorer interpolates the inertial records either side of the GrafNav time tag to line up a 
derived inertial measurement with the corresponding GPS time.  At this derived point the 
mechanized inertial coordinates and velocities are differenced from the GPS computed 
quantities to obtain the error in the inertial information.  These estimated errors are used 
as update information to the IMU Kalman filter.  The covariance information from the 
GrafNav file is used as weighting in the update procedure. 
 
Note that Inertial Explorer has a GPS Updates Dialogue Box (see Section 5.4.3), which 
allows the user to reject GrafNav information which is deemed unacceptable for updating 
purposes.  Rejection tolerances can be based on ambiguity determination, standard 
deviation, or quality number.  Tolerances will be based on the stand-alone navigation 
capabilities of your inertial system.  Covariance can also be scaled. 
 

Section 3   Getting Started with Inertial Explorer 
Inertial Explorer contains full-featured static and kinematic GPS and inertial post-
processing package using Waypoint’s proprietary GPS processing engine, together with 
KINGSPAD IMU engine developed at the University of Calgary.  Waypoint’s GrafNav 
GPS-IMU is a single baseline processor that processes GPS data first, followed by 
processing IMU data using GPS updates to obtain a trajectory.  This section goes over the 
basics of GrafNav GPS-IMU including a how to process inertial data in a step-by-step 
tutorial for first time users. 
 

205 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

Step 1: Start Inertial Explorer 
Assuming that you have followed the installation instructions properly, you will have a 
program group called Waypoint Inertial Explorer 7.50.  In this group, there will be a 
program called GrafNav GPS-IMU.  Highlight and click GrafNav GPS-IMU to begin the 
program. 
 
Step 2: Convert and Process GPS Data 
Refer to Section 2.1.1  How to Start Processing Baseline from Step 2 to Step 8 to obtain 
processed GPS data.  Chapter 7  Convert contains details on how to extract inertial data 
from the Convert utility into a binary .imu file.  Once GPS processing is complete, a .cmb 
file should be created automatically by Inertial Explorer, as it is needed as a source of 
GPS updates during the inertial processing.   
 
Step 3: Determine Static Time using Velocity Plot Profile 
After processing the GPS data, static time is needed to determine the coarse and fine 
alignment parameters.  Under the Output Menu, choose Plot GPS Data.  From this list of 
options, click on ‘intermediate’ and scroll down to the bottom and click on “Velocity 
Profile”.  This plot shows the speed of the vehicle or aircraft in terms of North, East, and 
Height directions (based on the GPS data).  To process the inertial data in forward and 
reverse, there needs to be periods of static alignment at the beginning and the end of the 
dataset.  Static periods have zero velocity and should be clearly visible at the beginning 
and the end of the velocity plot, see Figure 5.4.  Zooming in may help (right-click on the 
plot for options – See section 2.6.1  Plot GPS Data for details).  Decide on a start time for 
static alignment at the beginning of the data (where velocity is near zero) and how long it 
will last.  You can right-click on a point on the plot and ‘Set IMU Processing Time’, 
preferably during a time of static data at the beginning for forward processing.  The same 
is required at the end of the dataset if you wish to process in reverse.  Note that any 
significant movement will result in an error during static alignment. 
 

 
Figure 5.4 Velocity Profile Plot – Used to Retrieve static alignment periods 
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Step 4: Process Inertial Data 
If necessary the IMU data may need to be converted into generic Waypoint format (*.imr 
file) using the ConvertIMU utility.  See Section 5.7.4  for more details.  From the Process 
Menu, click Process IMU.  A dialogue box will appear prompting you for more 
information.  Under the ‘General’ tab, the path of the IMU data file should be in the Raw 
Measurement Data File box.  If not, click the browse button to locate the path of the 
binary IMU measurement file.  The data format should also be selected from the Data 
Format box.  GENERIC_IMU is Waypoint format (*.imr file).  For this tutorial, we will 
process in the forward direction only.  All IMU data will be processed unless it conflicts 
with the static time that was determined in Step 3 above.  Change the begin and end times 
if necessary.  Under the ‘Alignment’ Tab, select Static Coarse Alignment Only for simple 
purposes of this tutorial.  Under the Initial Alignment Period, set the Coarse time (in 
seconds) of the static alignment time that was determined in Step 3 above.  For Figure 5.4 
above, as an example, we can use 500 seconds in the forward direction for coarse 
alignment, although 120 seconds is sufficent.  Note that the ‘bump’ around the 531000 
time does not qualify as a static alignment period, so it is best to use the time before it.  
Next, click on the ‘GPS Updates’ tab, and under the Source of GPS Updates box, select 
Project CMB file as the Update File and the path should be displayed below.  If the .cmb 
file is not in the local directory, select Browse External to locate it. 
 
Upon selecting OK, the program will begin post-processing your inertial data.  You will 
notice a window that displays various numbers which shows that your inertial data is 
processing. 
 
Step 5: Plotting and Quality Control 
Under the Output Menu, choose Plot GPS Data.  From the list of options you can show 
the following IMU plots: 
 
 
 Attitude (Roll and Pitch) This plot shows the roll and pitch profile of the 

processed IMU data. 
 Attitude(Azimuth/Heading) This plot shows the Heading/Azimuth of the 

IMU, as well as the GPS COG (Course-over-
Ground). 

 Attitude Separation If the inertial data was processed in forward and 
reverse, they need to be combined for this plot.  
Under the Process Menu, select Combine 
Solutions, then IMU Forward and Reverse.  Plot 
the Attitude Separation, which will show the 
difference between forward and reverse inertial 
processing.  Ideally, they should agree very 
well. 

 IMU GPS Position Misclosure This plot shows the misclosure between the 
GPS solution and the IMU solution. 
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Step 6: Export Final Coordinates 
From the Output Menu, select Export Wizard.  Select the source for the solution.  Epochs 
will output the trajectory, while features will export any loaded features.  For 
photogrammetry users wishing to export interpolated camera positions, event marks must 
be first loaded (see Section 2.2.10  Loading Camera Event Marks).  After selecting a 
source, a profile must be selected.  For Inertial Explorer users, select IMU data as the 
profile to export coordinates.  Click Next.  For the Datum screen just use the processing 
datum.  Users may also be prompted for the geoid undulation file.  The distribution CD 
contains a number of Geoids in the Geoids directory. 
 
See Section 2.7.1  Creating Files and Profiles with Export Wizard for more information. 
 
This was a brief overview on how to load a file and process the data.  The following 
sections deal with the additional menus and options that are associated with the inertial 
software. 

Section 4   Processing Options 

5.4.1   General Options 
Process | Process IMU | General 

 

 
Figure 5.5 General IMU Processing Options 
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Data Source 
Raw Measurement Data File 
Contains the path\\filename of the binary IMU measurement file which has been 
collected from the mission and stored to disk.  If not already filled in previously, the 
Browse button can be used to search for the correct IMU measurement file. 
 
Data Format 
Indicates which type of IMU measurement data has been collected.  It is important to 
choose the correct IMU as each inertial unit has different scaling for the delta v and delta 
theta rate values, as well as different measurement collection intervals.  Available data 
formats include: 
 
LTN90 
LASERREF3 
LN200 
HG1700 (NovAtel BDS) 
AG1700 
GENERIC_IMU 
 
See page 204 for a general discussion on data formats. 
 
Processing Direction 
Forward/Reverse IMU processing is possible in Inertial Explorer.  The default mode of 
processing is forward in time.  Reverse processing (in time) is possible with most types of 
IMU data formats.  As with GPS processing the forward/reverse separation of selected 
quantities can be plotted for analysis purposes. 
 
Processing Time 
Process All IMU Data 
If this is checked, the software attempts to find the beginning and end times in the raw 
binary IMU file.  These times will be GPS seconds of the week for typical GPS time-
tagged applications. 
 
There are some important things to note here: 
 
For forward processing, Begin Time may not correspond to some GPS time in the 
GrafNav FWD/REV/CMB files.  If it does correspond, Inertial Explorer will 
automatically use the GrafNav derived position at the time to seed the inertial processing 
in the forward direction.  For alignment purposes, you may or may not wish to use the 
Begin Time that is automatically detected.  There may be a more optimal GPS time at 
which to begin alignment.  In such a case, this time should be entered.  This will be 
mission-dependent and you will wish to choose your time to begin alignment with some 
care.  A poor alignment will result in poor attitude and coordinate information for all or 
part of the survey. 
 
For reverse processing, End Time will have the same considerations as above. 
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Data Rate 
This is a critical value.  This is the number of IMU epochs per second collected and time-
tagged in your binary IMU measurement file.  Inertial Explorer has built-in data rates for 
most IMU's, but this value should be checked.  The integration interval for IMU 
processing will be 1.0/Data Rate.  You will not obtain optimal or even correct results 
unless the Data Rate is correct.  Therefore, it must be known. 
 
IMU -> GPS Offset 
It is a requirement to measure the distance in metres from the centre of the IMU sensor 
array to the centre of the GPS antenna for each mission, if you wish to correctly update 
GPS and IMU position and attitude information. 
 

IMU 
(0,0,0)

z-b

x-b

y-b 
Front Rear 

GPS 

 
Figure 5.6 IMU - GPS in Body Frame Offsets in Vehicle Body Frame 

 
Figure 5.6 illustrates the relationship Inertial Explorer uses to lever-arm coordinates from 
the IMU to the GPS antenna.  Note the IMU is the local origin of the system. 
 
X (+ve right) 
This is the measured lateral distance in the vehicle body frame from the IMU to the GPS 
antenna out the ride side of the vehicle. 
 
Y (+ve forward) 
This is the measured distance along the longitudinal axis of the vehicle from the IMU to 
the GPS antenna. 
 
Z (+ve up) 
This is the measured height change from the IMU to the GPS antenna. 
 
Initial Angular o/s (Usually Zero) 
This set of values represents an additional "lever-arm" to the more general one described 
above.  Many typical IMU installations have the surface of the IMU directly attached to 
for instance the floor of the vehicle, such that the roll, pitch and yaw of the vehicle are 
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directly experienced by the IMU (i.e. the sensor frame of the IMU) and the body frame of 
the vehicle are more or less aligned.  Some IMU's may be installed in a tilted position 
with respect to the body frame of the vehicle.  If you know these tilts in terms of roll, 
pitch and yaw, Inertial Explorer will compensate so that the attitude information 
produced is with respect to vehicle body frame, not the IMU sensor frame. 

5.4.2   Alignment Options 
Process | Process IMU | Alignment 
 

 
Figure 5.7 Alignment Options 

 
Initial Alignment Setting -> FORWARD or REVERSE 
Initial alignment, whether processing forward or reverse, is used to determine the initial 
roll, pitch and yaw of the IMU sensor axes.  These values are used as integration 
constants in continuously updating the attitude information throughout the mission.  
These initial values should be determined as carefully as possible in order to insure 
optimal attitude information for the remainder of the survey.  Inertial Explorer provides 
you with 3 choices, largely depending on how much static IMU data is present at the 
beginning or end of the survey. 
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Static Coarse Alignment Only 
As this implies, this data must be static in nature.  If sufficient motion is detected, a 
warning will be given the user about it, but it is the responsibility of the user to choose a 
Begin Time (General Options) which is in a static data period.  One of the simplest ways 
to do this is to plot the Velocity Profile from GrafNav and check where the GPS velocity 
components are very near zero.  Coarse alignment is normally performed for the first 30 – 
120 seconds of static IMU data collection and is used to provide a seed value for attitude 
information for either fine alignment or navigation.  Coarse alignment uses the sensed 
gravity vector components to estimate roll and pitch.  It uses sensed earth rate to provide 
an initial estimate of the yaw of the IMU sensor array.  Note that most low accuracy (e.g. 
MEMS) sensors can more or less measure gravity components, but earth rate (which is 15 
arc seconds/second at the equator) may be buried in gyro noise.  For inexpensive sensors, 
Inertial Explorer may consider any sensed gyro rate during coarse alignment to be a bias 
and uses the data for a coarse calibration. 
 
Note that for many applications involving constant GPS updates, coarse alignment may 
be sufficient to start kinematic IMU navigation.  Coarse alignment only is the default 
mode for Inertial Explorer. 
 
Static Coarse + Fine Alignment 
This may invoke if the IMU is in static mode for any period significantly longer than 120 
seconds.  Note that 120 seconds is a guideline value only, but many high precision IMU 
applications recommend about 2 minutes of coarse alignment followed by 8 or 10 
minutes of fine alignment.  Given constant GPS updates, fine alignment may or may not 
be necessary.  Within say 5 to 10 minutes the GPS updates should provide enough 
information for the IMU to provide attitude information consistent with the accuracy 
level achievable by the accelerometer / gyro triad – with or without fine alignment.  This 
will depend on the type of IMU and the user's experience and requirements in their 
application.  After the roll, pitch and yaw are roughly estimated for coarse alignment 
attitude information to a better level of precision.  Again, it is a large mistake to invoke 
fine alignment if kinematic data is present during the alignment period. 
 
Transfer Alignment (Use GPS or Transfer Known Values Below) 
This should be checked if insufficent static data is present in the IMU measurement data.  
If constant GPS updates are available and the IMU data is of reasonable quality, the 
attitude information should be determined through GPS updates, even if the initial roll, 
pitch and yaw are completely unknown (i.e. roll, pitch and yaw are entered as zeroes).  It 
will take longer to converge to highest attitude accuracy, however.  How much longer 
will be a function of the mission type, GPS accuracy and IMU type.  If roll, pitch and 
yaw are known apriori, these values can be entered as initial integration constants and 
navigation can proceed from these known quantities.  Click ‘Enter / Read initial values 
for Kinematic Alignment’, see Figure 5.8.  If a user processed in the forward direction, 
and needs attitude values for reverse kinematic alignment processing, clicking this button 
will scan to the ‘End Time’ (General options) in the .fim file.  It will enter the attitude 
and velocity and their standard deviations automatically from the ‘End Time’ epoch.  If 
the time is not available, the user needs to enter the attitude values manually or set the 
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‘End Time’ to an epoch that exists in the .fim file.  The same idea applies to forward 
processing, if a .rim file exists.  If attitude is unknown for kinematic initialization, leave 
roll, pitch and yaw as zero and expect sub-optimal results for your survey, especially for 
the first n minutes of data processing. 
 

 
Figure 5.8 Input values for transfer alignment 

 
In-Motion Kinematic Alignment 
If no static data is available and no a-priori attitude information is available, the user may 
try to align the vehicle while in motion.  The user must choose a short period of time 
while the vehicle is relatively level and moving in a more or less straight line.  The time 
period can be anywhere from 4 to 40 seconds, depending on the dynamics at the chosen 
start time.  This feature can be useful if large data gaps have been experienced during a 
mission for some reason.  To data, Inertial Explorer has been successful at aligning 
tactical grade systems in this mode.  There is no guarantee that less grade IMU’s can be 
used in this way.  It might even be necessary to pick a different Error Model in order to 
prevent instabilities arising in the Kalman filter.  We do continue to recommend a static 
alignment if possible. 
 
Initial Alignment Period / Static Alignment Time 
Coarse and Total Alignment Time must be entered in seconds.  Begin Time and End 
Time from General Options must be chosen to correspond to the starting GPS time of the 
static alignment session.  The user must have some knowledge of how many seconds the 
IMU remained stationary following the begin and end time.  Plotting the GrafNav 
Velocity Profile (see Section 2.6.1  Plot GPS Data) may help here. 
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The number of seconds of coarse versus Fine alignment time depends on what is entered 
for seconds of coarse align time and total align time.  The program subtracts total – 
coarse to obtain Fine align time, should Static Coarse + Fine Alignment be checked.  If 
Kinematic Alignment is checked, the times will simply be zeroed.  If Coarse-only is 
checked the Coarse Time can range from zero to any value up to several hundred 
seconds.  A suitable default mode of operation for Inertial Explorer is Static Coarse 
Alignment Only with 120 seconds of Coarse Time.  Please note that this is somewhat 
arbitrary.  It is the responsibility of the user to determine optimal alignment procedure for 
their system and task. 
 
Initial Attitude Values (Transfer Alignment) 
By clicking ‘Enter / Read initial values for Kinematic Alignment’ the user can enter the 
known attitude values for the beginning (forward processing) and/or the end (reverse 
processing).  If the user has already processed in one direction and needs to use kinematic 
alignment in another direction, this option will scan the epoch output file and 
automatically fill in the attitude, velocities and standard deviations.based on the start or 
end times in the General tab.  Sometimes the user may need to change the start/end times 
if they do not exist in the .fim or .rim files. 
 
Estimate Gyro Biases During Coarse Static Alignment 
If static mode, any medium or lower accuracy gyro outputs a signal which consists of 
earth rate plus the bias error for that gyro axis.  This can be used by Inertial Explorer to 
perform a rough calibration of the gyros. 
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5.4.3   GPS Updates Options 
Process | Process IMU | GPS Updates 
 

 
Figure 5.9 Options for GPS Updates 

 
Source of GPS Updates 
Inertial Explorer uses previously processed GPS data to update the IMU information.  
The format must be GrafNav's ASCII epoch output (e.g. .FWD, .REV and .CMB format). 
The default file used to update the IMU is the combined trajectory (GrafNav .CMB file) 
for the current GPS/IMU project.  This filename is automatically inserted in the Update 
Data and File name box. 
 
Update Data 
This indicates which GrafNav FWD/REV/CMB file the user wishes to update the IMU 
with.  Data can come from the current project or an external FWD/REV/CMB file from a 
different project.  The drop down list provides choices for this.  If External is chosen, the 
BROWSE button is un-grayed and the FWD/REV/CMB file can be found through the 
standard file dialogue box. 
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File name 
This shows the path\\filename of the FWD/REV/CMB file used to provide IMU 
coordinate, velocity or azimuth updates. 
 
GPS Update Interval 
This is the interval that the GPS updates will take place.  The default update interval is 
1.00 second but if the GPS data was collected at a higher rate (e.g. 10Hz) then this value 
can be set to a lower value (e.g. 0.10 seconds) to have more frequent GPS updates. 
 
GPS Position Updates 
Use GPS position update 
This is checked by default.  To process IMU information alone, this box should be 
unchecked.  It should be noted that low accuracy (MEMS type) sensors are not usually 
reliable unless constant GPS position updates are employed. 
 
Required fixed ambiguities 
This should be checked if the user wishes to use only GPS information where KAR has 
produced Fixed Ambiguities.  In general, the IMU has an internal weighting scheme for 
updates such that low quality GPS updates get correspondingly low weights in the update 
process.  Hence this box can be left unchecked, in principle. 
 
Minimum acceptable quality 
This uses the GrafNav quality number to filter out unacceptable GPS update information.  
The default setting is a 5, which typically indicates GPS coordinate information at the 
one metre level.  Any GPS information with a quality number of 5 or lower is used to 
update the IMU at any given time match.  The quality number used is application 
dependent and should be determined by the user based on requirement and precision of 
the IMU.  For MEMS sensors, 5 make some sense whereas for navigation grade IMU's a 
better quality number should most likely be chosen. 
 
StdDev tolerance 
This reflects the standard deviation of the GPS coordinates as determined by GrafNav.  
GPS determined coordinates with a standard deviation (trace of the covariance matrix) 
above the given value will not be used for IMU updates.  Tolerances used will depend on 
mission and grade of IMU. 
 
Scale variances by 
Allows the user to increase or reduce the variances determined by GrafNav.  This 
variance information is used by the IMU filter in is Kalman update routines to weight the 
GPS position update.  It is recognized that the covariance information produced by the 
GPS filter is generally optimistic and this is a simple way of providing the IMU filter 
with a more realistic update variance for the input position information from GrafNav. 
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GPS Velocity Updates 
Use GPS velocity update 
This is checked by default.  If you do not wish to have the IMU filter use GPS velocity 
information as update information, uncheck this box.  GPS velocity updates are optional. 
 
GrafNav uses Doppler information to compute GPS-derived velocity components.  It 
should be pointed out that Doppler accuracies vary significantly from receiver to 
receiver.  The Doppler RMS can be viewed (after processing GPS) via the Advance 
Plotting Screen.  In addition, the Doppler Measurement Std. Dev. used by the GPS 
Kalman filter can be controlled from the standard deviation tab of the different GPS 
processing options.  The default value may not be optimal.  Doppler meas. tolerance is 
set by default to 0.25 m/sec.  Any GPS velocity information with an RMS residual value 
of less than 0.25 m/sec is used as velocity update quantities in the IMU filter.  The IMU 
filter will not use GPS derived velocities from data with RMS values above this value. 
 
Scale vel. variances by 
This is used to reduce or increase the covariance information related to GPS velocity.  
See the explanation for Position Updates. 
 
Continuous GPS Heading Update  
Use GPS track for heading update 
GPS course over ground (COG) can be computed from the GPS velocity components.  If 
the forward pointing axis of the IMU is more or less aligned in some known orientation 
with the longitudinal axis of the vehicle, GPS COG can be used as a direct azimuth 
update.  Care should be taken when using direct azimuth updates, as it may be difficult to 
guarantee the IMU is aligned with the vehicle body axis.  Aircraft crab angles are one 
example of errors which can produce significant differences.  On the other hand, some 
low accuracy (MEMS) sensors may not produce meaningful heading information in any 
case and this may be a useful update. 
 
Offset (deg) 
This option allows the user to enter a known constant offset between the forward axis of 
the IMU sensor triad and the forward axis of the carrier. 
 
Std Dev (deg) 
This is the estimated error in the constant value given in the Offset box. 
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5.4.4   Advanced Options 
Process | Process IMU | Advanced 

 

 
Figure 5.10 Advanced IMU Options 

 
Zero Velocity Updates (ZUPTs) 
Inertial Explorer can take advantage of zero velocity updates as long as the user marks 
the start time of the ZUPT while in the field, along with the duration of the ZUPT.  As 
illustrated in Figure 5.11, the start time of the ZUPT must be in GPS seconds of the week 
(presuming that you have time-tagged the IMU to GPS time), while the duration of the 
ZUPT is simply the number of seconds of static occupation.  10 seconds is the minimum 
recommended time for a ZUPT. 
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Figure 5.11 Adding a ZUPT in Advanced Options 

 
When Inertial Explorer reaches the 'ZUPT Start (GPS tow)', it will assume static data is 
present for at least 'ZUPT length' seconds and will use zero velocity as an update.  ZUPTs 
are probably redundant for data sets with constant GPS updates of good quality.  For GPS 
data sets in tree cover or urban canyons, ZUPTs can still be a valuable way of bounding 
inertial error. 
 
Initial Acceleration / Gyro Drift Biases 
Inertial sensors tend to have biases in their sensors which can be defined as a long-term 
constant.  These values may be calibrated by manufacturers especially for tactical or 
navigation grade units and can be subtracted during processing from each delta v and 
delta theta measurement.  The user may or may not have access to these values.  If so, 
they may be entered here.  Users may also wish to perform their own calibration on one 
mission, and use the values for subsequent ones. 
 
Inertial Explorer does not expect the user to have any knowledge of constant biases.  
Instead, it attempts to calibrate the sensors through the alignment and update process 
throughout the mission.  Hence these values will usually be zero for most applications. 
 
It should be noted that highest accuracy would be achieved for inertial units with 
predictable and known turn-on to turn-on biases.  However, the procedures for rigorously 
calibrating inertial sensors with off-line procedures involving rate tables and so on are 
outside the scope of the Inertial Explorer software. 
 
If you do have knowledge of the accelerometer and/or gyro drift biases they may be 
entered in metres/sec2 and decimal degrees/sec.  It is important to note the definition of 
the axes here.  Inertial Explorer defines: 
 
The X-axis is positive out the right side of the vehicle (facing the rear) and defines pitch 
rate. 
The Y-axis is positive out the nose of the vehicle and defines the roll rate. 
The Z-axis is positive up and defines yaw rate. 
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Yaw 

Roll 

Pitch 

 
Figure 5.12 XYZ-axis Definition 

 
If your IMU has a different X, Y, Z sensor frame definition, this should not represent a 
problem.  Just note which of your axes measure pitch rate and enter this in our X-slot, 
with the appropriate sign – and similar for roll and yaw. 
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5.4.5   Error Model Options 
Process | Process IMU | Error Model 

 

 
Figure 5.13 Building and Saving Error Models for Different IMU Types 

 
Set IMU Kalman Filter Error Model Values 
This is one of the most important aspects in IMU processing.  In general, the more 
inexpensive the sensor package, the more "tuning" will have to be performed to find 
initial variances and spectral densities that work optimally for your particular IMU.  For 
some MEMS sensors, it is critical that you choose spectral densities that match the sensor 
noise of your system.  In some cases, IMU processing will not work at all without a 
properly chosen error model.  You can choose one of the error models provided they can 
build an error model of their own and save it under Add IMU Type and Set Values.  
Building an error model can be a trial and error process and may be required for custom 
IMU packages.  More expensive tactical or navigation grade systems will need much less 
tuning and for many applications the error models provided are sufficent. 
 
In general, the poorer the sensor the larger the spectral density required for the 
misalignment, gyro, and accelerometer noise process.  Recall that spectral densities add 
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noise to the covariance propagation process prior to filtering.  The higher the density, the 
more emphasis is placed on the update measurement during filtering.  The less precise the 
sensor, the more we will rely on GPS updates to carry the IMU process. 
 
IMU Type 
This drop down-list box shows the list of error models that come with Inertial Explorer.  
These models really consist of an identifying name together with lists of variances and 
spectral densities.   
 
Navigation (High Precision) Contains Kalman filter parameters suitable for 

systems such as the Honeywell LaserRef.  IMU's 
such as this have gyro dirft rates at the level of 0.01 
degreee/hr or better. 

Tactical (Medium Precision) It stores values corresponding to medium grade 
systems such as the LN200 from Litton or the 
HG1700 from Honeywell with drift rates listed at 1 
– 10 degrees/hr. 

Automotive (Low Precision) Relates to lower grade units than Tactical.  This 
error model may also be useful for situations where 
alignment is poor or non-existent and the user 
wishes to allow the filtering process to "loosen-up" 
to compensate for poor field conditions. 

 
Custom error models may be added and stored for later use, as explained in the following 
sections. 
 
Add IMU Type 
User-defined error models may be added by clicking the Add IMU Type button.  The 
dialogue box shown in Figure 5.14 will appear. 
 

 
Figure 5.14 Adding a Custom Error Model Name to the IMU Types List 

 
Type in a name which suits the particular IMU or application.  This name will be stored 
in the IMU Type list in the file called User.imu, provided the user click Set Values button 
after filling in the Initial Standard Deviation and Spectral Density values. 
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Initial Standard Deviation 
Misalignment 
In general this relates to the difference between the computed direction cosine matrix 
relating the IMU body frame to the computation frame (ECEF in the case of Inertial 
Explorer) and an error free idealized direction cosine matrix or attitude matrix.  The 
initial Misalignment Standard Deviation in arc seconds represents the best estimate on the 
ability of the user's sensor package to estimate roll, pitch and yaw during the coarse 
alignment period (if any).  Roll and pitch are estimated from the sensed gravity 
components in the horizontal axes of the accelerometer triad, while yaw is computed 
from the sensed earth rate around the leveled gyro axes.  Typically, even MEMS sensors 
can make some estimation of roll and pitch.  Earth rate is buried in noise on any IMU's 
lower than tactical grade.  In any case, the initial misalignments in x and y (the horizontal 
axes corresponding to pitch and roll) may be an order or magnitude less than in z 
(corresponding to yaw).  If in doubt, simply make these large values in the order of 
thousands of arc seconds.  The IMU Kalman filter will eventually estimate some 
reasonable values for misalignment uncertainty (i.e. error in the computation of the 
"attitude matrix"). 
 
Accel Bias 
Represents an initial uncertainty in your knowledge of the constant bias errors in the 
accelerometer triad.  This value is in metre/second2 and will be dependent on the 
precision of each sensor array.  Recall that we often enter the accelerometer bias as zero 
(i.e. unknown and the initial uncertainty should reflect this). 
 
Gyro Drift 
In arc seconds per second pertains to knowledge of initial uncertainty in sensor drift in 
the gyros.  Again, the assumption that the gyro drift is unknown and large values are 
acceptable here to reflect this.  The IMU filter will attempt to resolve accelerometer and 
gyro biases on-the-fly. 
 
Spectral Densities 
Misalignment 
A Misalignment noise density in arc seconds squared per second becomes a covariance 
when multiplied by some time interval δt.  If the  sensor triad has problematical ability to 
provide you with an accurate attitude matrix or you have poor alignment capabilities for 
whatever reason, you may have to introduce large spectral density values for 
misalignment.  These spectral components will add noise to the computed Kalman 
covariances for misalignment.  This in turn will force the update computations to rely 
more heavily on the GPS coordinate and velocity information at each update epoch.  This 
in turn will hopefully help compensate for large errors in the direction cosine matrix. 
 
Accel Bias 
Accel Bias densities when multiplied by the prediction time interval act as additive noise 
to the accelerometer bias states.  Larger accelerometer noise densities may aid in 
compensation of large biases in these sensors. 
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Gyro Drift 
Gyro Drift densities similarly act as additives to the covariances computed for the gyro 
drift states.  In many cases, larger gyros densities are necessary for inexpensive gyro 
sensor blocks. 
 
Tuning a Kalman filter with correct noise values is extremely important especially for 
MEMS sensors.  It may be necessary for custom IMU packages to experiment with 
widely varying values for the spectral quantities.  Once, you have determined optimal 
values for your sensor package, name, and store the Error Model. 
 
Remember – to store a custom model, user must click the Set Values button, after filling 
in the specific entries for variances and densities. 

5.4.6   Initial Coords Options 
Process | Process IMU | Initial Coords 

 

 
Figure 5.15 Initial Coords Options 
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Initial IMU Position (Forward/Reverse) 
The initial position of the IMU sensor array must be known for the inertial integration 
process to begin.  Inertial Explorer will automatically lever arm derived GPS coordinates 
from the GrafNav fwd/rev/cmb file, provided the IMU Begin or End Time specified 
under General Options can be found in the GrafNav file.  Alternatively, user can enter the 
initial coordinates manually or change the Begin and End time.  Be careful when entering 
custom coordinates in kinematic applications.  If the start/end time is changed, the 
coordinate will beed to be altered as well. 
 
Dynamic Error Model 
This value can be left at Low Dynamics for most applications.  High or Extreme 
Dynamics really provide a higher spectral density for the coordinate and velocity states.  
These would not be invoked unless the user is unsure about the coordinate updates for 
timing or other reasons. 

5.4.7   User Commands 
Process | Process IMU | User Commands 
 

 
Figure 5.16 User Entered Commands 
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Some Inertial Explorer options may not be available from the dialogue boxes provided.  
A full list of configurable options is available under User Commands and may be invoked 
by users whos wish to try special features or overwrite defaults. 
 
For an explanation of all Inertial Explorer commands, please see the Appendix. 
 

Section 5   IMU Processing Display 
 
After choosing the OK button on the Ins Project File wizard described in detail above, the 
following screen will appear with processing output displayed. 
 

 
Figure 5.17 IMU Processing Display 

 
Time / Position Atttitude 
GpsTime shows the current GPS seconds of the week for the IMU record being 
processed. 
 
Latitude, longitude and height are shown in degrees, minutes and seconds in the first 3 
columns.  The next 3 columns show the associated standard deviation of the processed 
IMU coordinates respective to latitude, longitude and height in metres. 
 
Ve, Vn and Vu represent the inertially derived velocity components in east, north and up 
directions in m/s.  The next 3 columns are the current local level accelerations with 
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gravity and Coriolis effects removed.  These are then the vehicle accelerations in the east, 
north and up directions along with residual bias effects not removed by the Kalman filter.  
Units are m/s2. 
 
Roll, Pitch and Yaw are presented in degrees, along with standard deviation in the same 
units.  The roll and pitch values should be assessed as you process.   If your IMU has 
been placed on a level surface, these should reflect reasonable values relative to the 
motion of the vehicle.  Invalid roll and pitch values, especially for inexpensive IMU’s can 
be the result of an incorrectly chosen Error Model.  Incorrectly decoded binary data files 
can also cause inappropriate values to appear here. 
 
PosMisc in metres and VelMisc in metres/second display the current difference between 
the GPS derived coordinates and  velocity  and the corresponding mechanized IMU  
quantities.  These misclosures between GPS and IMU represent a good idea of the stand-
alone capability of your inertial system over the time interval between GPS updates. 
 
Messages can be watched for events or errors in the IMU processing DLL. 
 
Status provides an idea of whether you are in alignment or navigation mode or have 
completed processing.  
 

Section 6   List of Available IMU Plots 
Attitude (Roll and Pitch)         Novice 
Plots the Roll and Pitch values from GPS/INS processing. 
 

 
Figure 5.18 Roll and Pitch Plot 

 
In airborne data, it is common to see roll values between ± 30 degrees and pitch values of 
around ± 10 degrees, depending on the flight pattern of the aircraft itself. 
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Attitude (Azimuth/Heading)       Novice 
Plots the heading and GPS COG (Course-over-Ground) that was computed from the 
GPS/INS processing.  Effects of crabbing will be visible in this plot if the GPS COG is 
constantly offset from INS heading.  The IMU Heading COG Difference Plot shows the 
difference between these two heading values. 
 

 
Figure 5.19 Heading/Azimuth Plot 

 
Any transitions between a heading/azimuth of 359 degrees and 0 degrees will show up as 
a vertical bar in this plot. 
 
Attitude Separation         Novice 
This plot requires forward and reverse IMU solutions to be combined.  To combine 
forward and reverse IMU solutions, select the Process | Combine Solutions | IMU 
Forward and Reverse.  Basically, this plot shows the difference between the combined 
solutions in terms of Roll, Pitch, and Heading. 
 

 
Figure 5.20 Attitude Separation Plot 

 
Ideally, a zero separation means a match in solutions in the forward and reverse IMU 
processing.  It is common to see spikes at the beginning and the end of the data, as the 
ambiguities are being resolved into integers at those times. 
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Estimated Attitude Accuracy       Novice 
This plot shows the estimated accuracy (standard deviation) computed in the GPS/INS 
Kalman filter in terms of Roll, Pitch, and Heading. 
 

 
Figure 5.21 Estimate Attitude Accuracy Plot 

 
Estimated Gyro Drift Accuracy      Intermediate 
This plot shows the estimated standard deviation of the gyro drift rate.  This plot 
generally decreases with time.  It is plotted in terms of the X (right direction), Y (forward 
direction), and Z (up direction) of the INS body. 
 

 
Figure 5.22 Estimated Gyro Drift Accuracy Plot 

 
 
 
 
 
 
 
 
 
 

229 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

Estimated Accelerometer Bias Accuracy      Intermediate 
This shows the estimated standard deviation of the accelerometer bias.  It is plotted in 
terms of the X (right direction), Y (forward direction), and Z (up direction) of the INS 
body. 
 

 
Figure 5.23 Accelerometer Bias Accuracy Plot 

 
IMU Accelerometer Bias        Intermediate 
This is the apparent output in acceleration when there is no input acceleration present.  It 
is computed by the GPS/INS Kalman filter and the effects may be sinusoidal or random. 
It is plotted in terms of the X (right direction), Y (forward direction), and Z (up direction) 
of the INS body. Generally they should stabilize after the alignment period and agree 
when processed in both directions. 
 
 

 
Figure 5.24 Accelerometer Bias Plot 

 

 

 
 
 

 

230 



Chapter 5  Inertial Explorer 

IMU Angular Rates         Advanced 
This plot shows the gyroscope rate of change of attitude in the X, Y, and Z axes of the 
IMU body with the drift removed.  This plot is used to check the gyros. 
 

 
Figure 5.25 Angular Rates Plot 

 
IMU GPS Position Misclosure       Intermediate 
This plot shows the difference between the GPS solution and the mechanized INS 
positions obtained from the GPS/INS processing.  This is a good analysis tool used to 
check the GPS/INS solution as well as checking INS stability.  Large jumps or spikes 
may indicate a bad INS solution. 
 

 
Figure 5.26 IMU/GPS Position Difference Plot 

 
A near zero separation will confirm the GPS solution. 
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IMU GPS Velocity Misclosure       Intermediate 
This plot shows the difference between the GPS calculated velocity and the mechanized 
INS velocity obtained from the GPS/INS processing.  Another good analysis tool used to 
check INS stability. 
 

 
Figure 5.27 IMU/GPS Velocity Difference Plot 

 
IMU Gyro Drift Rate        Intermediate 
This is the apparent change in angular rate over a period of time.  It is computed by the 
GPS/INS Kalman filter and the effects are usually random. It is plotted in terms of the X 
(right direction), Y (forward direction), and Z (up direction) of the INS body.  Generally 
they should stabilize after the alignment period and agree when processed in both 
directions. 
 

 
Figure 5.28 IMU Gyro Drift Plot 
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IMU Heading COG Difference       Advanced 
This plot is the difference between the IMU heading and the GPS Course-over-Ground 
values. The absolute IMU heading/GPS COG can be seen in the Attitude 
(Azimuth/Heading) Plot.   Effects of crabbing will show up as a direct bias in this plot. 
 

 
Figure 5.29 IMU Heading/COG Difference Plot 

 

Section 7   IMU File Format 

5.7.1   .FIL or .RIL file 
The message log file simply echoes all error and warning messages sent to the message 
window during INS processing.  Some example messages are shown here: 
 
Coarse Alignment Succeeded on attempt #1 
Coarse alignment was successful. 
 
Reading GrafNav Record: 1000 
Scanning the GPS/IMU data before processing. 
Warning: Coarse Alignment has used up all of the Align Time. Will Continue 
Processing anyway... 
INS processor used all the coarse alignment time entered. 
 
Warning - GUPT Missing in GPS data -> DT: 0.200 
Gap in GPS data of time DT seconds – the processor cannot use this time as a GPS 
update. 
 
Warning: Trace of Body-Earth matrix < 0 after update 
Check on Fix: 1-tr{C} of transform matrix (0.056389) 
Mathematical computation warning. 

233 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 

5.7.2   .FIM or .RIM or .CIM file 

Tim: InsGpsTime InsGpsTime GpsWeek#       ; Gps_seconds_of_week 

Var: Cee Cnn Cup Cve Cvn Cvup TraceCpos      ; m

Drf: GyroX(deg/sec) GyroY(deg/sec) GyroZ(deg/sec) GX_sd(deg/sec) GY_sd(deg/sec) 
GZ_sd(deg/sec) 

Rat: Gx(deg/sec) Gy(deg/sec) Gz(deg/sec) Ax(m/s 2) 
Ecf: ECEF_X(m) ECEF_Y(m) ECEF_Z(m) 

} 

 

Ecf: 108.816 245.212 215.669 

Acc: 0.077 0.265 0.242 
Ang: 0.1364 0.2175 0.0864 

} 

 

 

This is the output format common to other Waypoint output files.  Note that the first line 
of the output file always begins with $OUTREC, and is followed by the version number, 
the processing engine, and the type of output.  An example is given below as the first 
line: 
 
$OUTREC Ver1.00 INSDLL Forward InsOutput 
An example of the output format is shown below.  A description of the variables and the 
units are also shown, followed by a numerical example. 
 
$OUTREC Ver1.00 INSDLL Forward InsOutput 
Eg { 

Geo: latitude(dms) longitude_ins(dms) ht_ins(m) 
Loc: d_east(m) d_north(m) d_ht(m) vel_east(m/s) vel_north(m/s) vel_up(m/s) 

2  m2/sec2  
Att: Roll(deg) Pitch(deg) Azimuth(deg) Roll_sd(deg) Pitch_sd(deg) Azimuth_sd(deg) 

Bia: AccelX(m/s2) AccelX(m/s2) AccelX(m/s2) AX_sd(m/s2) AY_sd(m/s2) AZ_sd(m/s2) 
2) Ay(m/s2) Az(m/s

Kal: MisalignX(arcsec) MisalignY(arcsec) MisalignZ(arcsec) dX(m) dY(m) dZ(m) dVx(m/s) 
dVy(m/s) dVz(m/s) 
Mis: GPS-IMU_east(m) GPS_IMU_north(m) GPS-IMU_up(m) GPS-IMU_ve(m/s) GPS-IMU_vn(m/s) GPS-
IMU_vu(m/s) GPS_Course_over_ground Acc: AccelEast(m/s2) AccelNorth(m/s2) AccelUp(m/s2) 
Ang: RollRate(deg/s) PitchRate(deg/s) YawRate(deg/s) 
 

 
 
Out { 

Tim: 594669.000 594669.000000 1135 
Geo: 51 06 01.50907 -114 01 16.90259 1065.3495 0.000 
Loc: -0.428 344.213 -0.620 0.084 37.222 -0.121 
Var: 4.23411e-004 3.88634e-004 2.95252e-004 8.91871e-001 -4.08521e-008 -1.32678e-005 
1.10730e-003 
Att: -1.5958 2.6190 0.3802 1.89049e-002 2.52198e-002 7.65137e-002 
Drf: 1.14593e-006 -1.36657e-007 -1.76144e-008 2.68329e-005 2.68407e-005 2.68488e-005 
Bia: -1.29293e-002 -2.65716e-003 3.38231e-003 3.23914e-003 2.83102e-003 1.17864e-003 

Kal: 15.2 -22.9 9.2 -0.023 -0.021 -0.013 -0.007 -0.006 -0.004 
Mis: -0.028 -0.068 0.017 -0.037 0.020 -0.008 0.180 

 

5.7.3   Generic Binary Input Structure 

GENERIC RAW DATA FORMAT 
 
Waypoint puts all custom IMU raw binary formats into a generic format which is read 
from Inertial Explorer following the decoding process in CONVERTIMU (see Section 
5.7.4  for further details).  The first 512 bytes of the Generic IMU Data Format is a 
header which must be filled in and must be read and interpreted as it contains vital 
information for reading and decoding the data. 
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In a C/C++ structure definition, the generic format header has the following fields: 
 
typedef struct 
{ 
  char   szHeader[8];        // $IMURAW[0] -> NULL terminated string 
  char   bIsIntelOrMotorola; // 0 - Intel (little endian) - default 
                             // 1 - Motorola (bit Endian) - swap bytes for IExplorer 
                             // This can be set for any user who directly writes in our  
                             // format with a big endian processor. IExplorer will swap  

  int    bDeltaTheta;        // Default 1 which indicates the data to follow 

                             // as scaled angular rates 

                             // If the flag is set to 0, then the data will be read directly 

                             // Our default is to store the gyro data in 0.01 arcsec increments 

                             // ACCEL_SCALE = 1000000 

                             // the bytes 
  double dVersionNumber;     // ie 2.00  

                             // will be delta theta's meaning angular increments 
                             // ie scale and divide by fDataRateHz to get degrees/second 
                             // If the flag is set to 0, then the data will be read directly 

  int    bDeltaVelocity;     // Default 1 which indicates the data to follow 
                             // will be delta V's meaning velocity increments 
                             // ie scale and then divide by fDataRateHz to get metres/second**2 

                             // as scaled accelerations 
  double dDataRateHz;        // ie 100.0 records for second 
                             // if you do not know it, set this to zero 
                             // then fill it in from the interface dialogue boxes 
  double dGyroScaleFactor;   // Scale (multiply) the gyro measurements by this to get 
degrees, if iDeltasOrRates=0 
                             // Scale the gyros by this to get degrees/sec, if iDeltasOrRates=1 
                             // if you do not know it, then the data can not be processed !! 

                             // or 0.01 arcsec/sec, so that 
                             // GYRO_SCALE = 360000 
  double dAccelScaleFactor;  // Scale (multiply) the accel measurements by this to get 
metres/second, if iDeltasOrRates=0 
                             // Scale the accels by this to get metres/second/second, if 
iDeltasOrRates=1 
                             // if you do not know it, the data can not be processed 
                             // Our default is to store the accel data in 1e-6 m/s increments 
                             // or 1e-6 m/s/s, so that 

 
  // defines in INSDLL.DLL 
  // IMU_TIMEFRAME_GPS    0  -> raw data file uses GPS sow 
  // IMU_TIMEFRAME_UTC    1  -> raw data file uses UTC - convert to GPS 
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  int    iUtcOrGpsTime;      // are the time-tags in UTC or GPS seconds of week 

 

                             // millisec level bias in your GPS->INS time tags 
                             // enter it here 

  char Reserved[447];        // total header size is 512 bytes 

 

                               // 0 - do not know (our default is GPS) 
                                // 1 - UTC 
                                // 2 - GPS 
 
  // defines in INSDLL.DLL 
  //  IMU_GPS_TIME_FRAME  0 -> GPS timetags are corr_time 
  //  IMU_RCVR_TIME_FRAME 1 -> GPS timetags are rcv_time 

  int    iRcvTimeOrCorrTime; // are the GPS time tags in the nominal top of the second 
                             // or are they corrected for receiver time bias 
                             // 0 - do not know (our default is corrected time) 
                             // 1 - receive time on the nominal top of the epoch 
                             // 2 - corrected time ie corr_time = rcv_time - rcvr_clock_bias 
 
  double dTimeTagBias;       // default is 0.0, but if you have a known  

 
  // space reserved 

                                  
} ImuGenericHeaderType; 
 
where 
 
szHeader[] is a NULL terminated ASCII C string - $IMURAW[0].  This must be present. 
 
bIsIntelOrMotorola – 0 indicates Intel format.  If a 1 is filled in, all bytes will be swapped 
in both the header and data records. 

dVersionNumber – ie 1.00. 
 
bDeltaTheta – if 1, then Inertial Explorer will expect the gx, gy, and gz  
gyro.measurements to be delta theta’s ie angular increments not angular rates. If 0, 
Inertial Explorer will assume all gyro measurements are given as angular rates. 
 
bDeltaVelocity– if 1, then Inertial Explorer will expect the ax, ay, and az accelerometer 
measurements to be delta v’s ie velcocity increments not accelerations. If 0, Inertial 
Explorer will assume all accel measurements are given as accelerations. 
dDataRateHz – this is the data rate at which the inertial measurements have been stored 
ie 100.00 
 
dGyroScaleFactor – when Inertial Explorer reads the 4 byte gx, gy, and gz gyro 
measurement values it will scale by this number to go from long integer to either a gyro 
increment in degrees or an angular rate in degrees/second. 
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dAccelScaleFactor – when Inertial Explorer reads the 4 byte ax, ay, and az accelerometer 
measurement values it will scale by this number to go from long integer to either a 
velocity increment in metres/second for the given time period or an acceleration value in 
metres/second/second. 

iRcvTimeOrCorrTime – the GPS receiver time frame – if 0, unknown and Inertial 
Explorer assumes the GPS time tags have been corrected for receiver clock bias, if 1, it is 
assumed the GPS time tags are at the nominal top of the GPS epoch (uncorrected), if 2 
Inertial Explorer assumes the GPS time tags have been corrected for receiver clock bias. 

Reserved[] bytes for future use.  It is suggested that these bytes be zeroed. 

typedef struct 

  long   ax,ay,az;   // delta v, or acceleration depending on flag in the header 

Time is given in GPS seconds of the week.  The angular increments or rates gx, gy, and 
gz are scaled long integers.  The scale factor to obtain a double precision word must be 
supplied in the header.  Similarly, the accelerations or velocity increments are signed 4 
byte words and must be scaled by a double precision variable given in the header. 

 
iUtcOrGpsTime – time frame for the IMU time tags - if 0, unknown and Inertial Explorer 
assumes GPS time frame, if 1 UTC time frame is used in processing the data, if 2 then 
0Inertial Explorer assumes GPS time frame for the binary IMU measurement tags. 
 

 
dTimeTagBias – if there is a known offset in the GPS->IMU time tagging system, it can 
be entered here.  This would be typically at the millisecond level.  Inertial Explorer will 
SUBTRACT this value from all time tags in the measurement structures.  Note that the 
default is 0.0000 and should be filled in as such. 
 

 
The single header is followed by a structure of the following type for each IMU 
measurement epoch. 
 

{ 
  double Time;       // gps time frame – seconds of the week 
  long   gx,gy,gz;   // delta theta or angular rate depending on flag in the header 

 
} INS_type;          // this is the binary structure type expected in GPSIMU 
 

5.7.4   Waypoint IMU Data Conversion 
wconvertimu.exe is a Win32 application program that converts custom formats into a 
GENERIC raw IMU data format.  The generic format that we use is described in Section 
5.7.3  .  To convert IMU data to Waypoint’s GENERIC raw IMU data format, click the 

 icon in Inertial Explorer or click File > Convert > Raw IMU data to Waypoint 
Generic (IMR).  See Figure 5.30 below. 
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Figure 5.30 wConvertIMU interface 

 
Click Browse to locate the path of the input IMU file to be converted to Waypoint’s 
GENERIC format.  The binary output file will be in the generic format and will have an 
.imr extension.  An ASCII output file (.out) can be generated if the Output ASCII option 
is enabled.  This will output the first 10000 epochs showing the GPS time, XYZ Gyros 
and XYZ acceleration.  It is useful to check after converting to observe if there are any 
errors while converting or if the correct scale factor was used.  Select a profile that 
applies to the input IMU data and click convert to begin converting the data.  If the 
profile of the IMU type is not in the list, a new profile will need to be created. 

5.7.4.1   Creating a new profile in wConvertIMU 
For users who have their own scale factors, data rates, and orientations in their raw data 
files can create a profile to convert their unique format to Waypoint’s Generic format.  
Open wConvertIMU and click ‘New’.  See Figure 5.31 below. 
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Figure 5.31 Creating a new profile in wConvertIMU 

The data rate of the IMU can be entered as well as any time tag offsets between the GPS 
and the IMU.  It is important that the correct byte order is set as either Intel or Motorola 
otherwise the decoding phase will report errors.  The time tag format can either be GPS 
seconds of the week or UTC seconds of the week.  The time tag source can be the GPS 
corrected time or the GPS received time. 

 
The scale factors can be entered at this point.  Note that the INVERSE value of the scale 
factors must be entered (e.g. if the scale factor is 0.0004 = 1/2500, so enter 2500).  The 
format of the gyros can be delta theta (angular increments) or the angular rate. The 
accelerometer can be delta velocity (velocity increments) or acceleration. 
 

 
To define the orientation of the IMU, click on the sensor orientation tab, as shown in 
Figure 5.32. 
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Figure 5.32 IMU Sensor Orientation Dialogue Box 

 
The current sensor orientation is shown at the top of the window.  To define a new sensor 
orientation, follow these steps (note that the orientation will always be right handed): 
 

• The X direction will be selected first.  Pick the direction that corresponds to the 
X-axis of the sensor frame.  Click ‘Select’ to set that direction to the X-axis. 

• The Y direction will be selected next.  Pick the direction that corresponds to the 
Y-axis of the sensor frame.  Click ‘Select’ to set that direction to the Y-axis. 

• The right handed frame will complete itself automatically at this point.  Click 
‘Update’ to apply the new sensor orientation.  If a mistake was made, click clear 
to start over. 

 
Click OK to set the new profile.  It should now be in the list of profiles to convert the 
IMU data. 
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5.7.5   Binary INS Data Files .BIF, .BIR (Output) 
A .imu file is the raw binary measurement data file that contains the INS data.  For more 
information, see Table 5.1 IMU Data Formats. 
 
The following is the data structure for a binary .bif and .bir files: 
 
typedef struct                   // holds latitude, longitude and height  
{ 

}    xyz_type; 

     float x,y,z; 

{ 

 

 

 

 

     double  phi,lamda;            // degrees  
     float  ht;                   // metres  
}    plh_type; 
 
typedef struct 
{ 
     double x,y,z; 

 
typedef struct 
{ 

}    fxyz_type; 
 
typedef struct 

     signed long iRoll, iPitch, iYaw;      // sf=1.0e-6 
}    iatt_type 
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typedef struct  

     long      IsExtended;        // true if exended format used (use later) 

     char      ProgramName[32];   // program name that created this file 

 

// normal record defininition 

     fxyz_type LLVel;       // local level velocity (m/s) 

{ 
     char      Str[16];           // $IMUOUT (see IMU_HDR_STR above) 
 
     long      HdrSize;            // size of this header 

     long      RecSize;            // size of this record 
     long      Reserved1;          // for later, zero 
     double    Interval;          // data interval (s) 

     char      VersionName[32];   // version that produced file 
     char      Direction[16];    // “Forward","Reverse" or "Combined" 
     char      Reserved2[392];     // reserved space for additional information (zero at 
creation of new file) 

}    imu_hdr_type; 
 

typedef struct                // 80? bytes 
{ 
     double    GpsTime;      // GpsTime of this record (0-604800) 
     short     WeekNum;    // week number 
     short     Reserved;     // reserved for future flags 
 
     plh_type  GeoPos;      // geographic position of this record (deg/m) 

     fxyz_type LLAcc;      // local level acceleration (m/s^2) 
 
     iatt_type LLAtt;        // local level attitude (deg) (scaled) 
      
     //fxyz_type LLPosSd;   // Position standard deviation 
     //fxyz_type LLVelSd;   // velocity standard deviation 
     //iatt_type LLAttSd;     // standard deviation of attitude values 
 
     float     fPosTrace;   // trace of position covariance (m) 
     float     fVelTrace;   // trace of velocity covariance (m/s) 
     float     fAttTrace;   // trace of attitude covariance (deg) 
 
}    imu_outrec_type; 
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Chapter 6   Utilities 
 

Section 1   COMPARE 
The ‘Compare’ utility is a Windows command line utility that compares multiple .LAT 
files.  It is located in the GrafNav distribution directory, which is usually “C:\Program 
Files\WayptGPS”.  ‘Compare’ can also be found in the ‘DosUtils’ directory on the 
GrafNav\GrafNet CD-ROM.  It is useful for comparing solutions from different base 
stations or solutions using different processing options.  The easiest way to use the utility 
is to write the coordinates using geographic and decimal degrees.  It will only compare 
epochs, and it will not compare stations (features). 
 
Compare.exe can be used as follows: 
 
Usage: compare file1 file2 outfile [-i interval] [-ecef] [-xyz] [-d] 
 
Where, 

-i interval  force comparison on this interval [default=use all] 
-neh  read north east height instead of decimal degrees 
-ecef  read in XYZ ecef and do comparison by rotating using the 
  coordinates from file1 using WGS84 ellipsoid 
-d  Compute slope distances 

Section 2   DUMP 

Usage:  dump [Fname] [-h] [-a fname] [-l fname] [-b baud] [-p port] [-n] 

-l fname log to file named fname  

-s  N,E on one file, E,N on the other, switch the first one 
-c  Contain decimal degrees to -180 - 180 

 

DUMP is a command line utility that can be used to log data from any serial source in a 
dumb fashion.  That is, it will log byte for byte any data originating from the source.  
DUMP is called as follows.  DUMP is located in “DosUtils” directory on the 
GrafNav/GrafNet CD-ROM. 
 

   [-nmea] [-r str interval] [-u ioaddr irq] [-f seconds] 
 
DUMP will NOT log to file unless a logfile is specified on the command line.  DUMP 
will prompt for the baud rate and COM port.  Parity is assumed to be none.  Data bits is 
8.  Stop bits is 1.  The following commands can be issued within DUMP. 
 
where, 

fname  same as -l option 
-h  this help screen 

-a fname append to file named fname 
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-n do not ask for port parameters use [com1: 9600-n-8-1] 
-b baud overwrite -n baud rate to baud 
-p port overwrite -n comport number to this number (1-4) 

GPB files are in a binary format, and thus cannot be viewed with a normal text editor.  
GPBView allows you to both view your data, and edit it in limited ways.  A picture of the 
program is shown below. 

-r str interval request nmea record (e.g. GGA) at specified  interval 
-u ioaddr irq com6: user port assignments (-n option) 
-w start watchdog timer 
-e echo_port echo GGA out receiver port n (usually 2) 
-c echo_baud echoed data goes out at this baud rate 
-f  seconds re-open the files every n seconds [default =300.0] 

 

Section 3   GPBView 

 

 
Figure 6.1 GPB Viewer 

6.3.1   Why Use GPBView? 
If you were unable to switch the remote data from KINEMATIC to STATIC or vice-
versa while collecting data, you can change the kinematic marker in the binary file.  This 
is also useful if you did not use the real-time logging software provided.  This is 
important if you wish to process kinematic data.  Go to the epoch where the 
kinematic/static is to start.  To change the process mode, go to the Edit Menu and choose 
Switch Static/Kinematic, select From Current Location, Specified Epochs, and enter the 
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number of epochs that you wish switched.  Choose whether the data will be switched to 
Static or Kinematic.  If you know the start and end time, just select Specified Time Range 
and enter the start and end times.  Note that if you want to convert the entire file, simply 
select All Epochs and From Start. 
 

• If you have cycle slip problems, you can go to the epoch with the problem by 
using the Search option under the Move menu, which allows you to search by 
Second, Epoch or H.M.S.  By examining the phase and phase rate (Doppler 
measurement) at the previous epoch, you can compute what the phase 
measurement at the present epoch should be. 
Phaset  = phaset-1 + phase_ratet-1 * time_interval + ∆ + clockcorrection 

 
• If a data record is corrupt, simply because the serial data was bad or the receiver 

clock jumped for one epoch, you can eliminate this record.  From the edit menu, 
choose Disable Satellite(s).  This will zero pseudoranges for one or more epoch(s) 
for a given satellite and will remove this/these epoch(s) from processing.   

 
• Add and remove cycle slips on the receiver.  These cycle slips can be edited using 

the Add/Remove Cycle Slips from the Edit Menu.  Cycle slips can be removed by 
selecting Remove Cycle Slip.  The cycle slip can be added by selecting Add 
Cycle Slip. 

 
• Recompute position and clock correction records.  This option can be found under 

the Edit menu, Recalculate Position.  This is useful for: 
• Computing a position where one did not exist, or 
• Correcting erroneous or bad clock shift data causing processing data errors.  

NOTE that ephemerides must exist - use the file/ephemeris option to specify 
another file containing the proper ephemeris. 

 
• Recompute Doppler can be found under the edit menu.  If the velocity during or 

after processing seems flawed (e.g. extremely high values), the Doppler may be 
corrupted.  To fix this is to recalculate the Doppler values in GPB Viewer.  Select 
to recompute by C/A if the data is kinematic or by the ephemeris if the data is 
static. 

 
• Edit Meteorological Values.  This feature will allow the user to edit the GPB file 

pertaining to the environmental conditions for better troposphere modeling.  A 
.trp file will be created that the processor will look for when processing GPS data.  
Information regarding the new troposphere parameters will appear in the 
forward/reverse message log after processing. Meteorological values should be 
entered for both stations (i.e. master and remote).  If not, the post-processor will 
utilize the entered values of one of the stations for both.  Only the effect of height 
difference will be accounted for.  It is suspected whether this is better than using 
the internal estimated values. 
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6.3.2   How to Use GPB View? 
The File Menu allows you to open or close a .GPB file.  The Load Alternate Ephemeris 
command is useful to print proper GMT H:M:S times or to recalculate position and clock 
shift.  Also, the ephemeris file must be loaded in order to search for H:M:S. 
 
The Move Menu is used to move through the list of epochs.  The choices are Forward 1 
epoch, Forward 10 epochs, Backward 1 epoch, Backward 10 epochs, Home (start of file) 
or End of File.  Search is useful when searching for a specific Second, Epoch or H.M.S. 
 
The Edit Menu edits the .GPB file.  This includes switching from static to kinematic and 
vice-versa.  Add or remove cycle slip.  Disable Satellite(s), zeroes pseudoranges for one 
or more epochs for a given satellite.  Recalculate Position recalculates receiver position 
values using a single point GPS solution.  Recalculate Doppler will fix bad Doppler 
values.  Edit Meteorological values edits a .trp file for troposphere modeling. 
 
Before any changes are made to the .GPB file, GPBView will confirm that you want to 
make the changes.  These changes are PERMANENT, so it is advisable to keep a backup 
copy of the observation file. 

6.3.3   How To Move Through a GPB File 
There are two ways to move through a .GPB file.  The first is to use the tool bar.  The 
second is the use the arrow keys, and the paging keys (Page Up, Page Down, Home, and 
End keys). 

6.3.4   Fix Corrupted GPB File 
GPBView will automatically fix up corrupted GPB files, simply open the file with 
GPBView. 

6.3.5   Convert to Old or New GPB Format 
 In GPBView, user can convert to the old format by selecting Save As under the File 
menu.  Old format can also be converted to the new format by selecting the same option. 
 

Section 4   Concatenate, Slice, Resample Utility 
This utility can be called from the GPB Utilities sub-menu under the File menu in either 
GrafNav or GrafNet.  As its name suggests, this utility can be used to concatenate 
multiple files into one new file, take a small portion of one file and make a new file with 
that portion, or create a new file from data sampled at a lower data rate from an original 
file.  The program also allows you to interpolate from a lower data rate to a higher data 
rate. 
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Figure 6.2 Concatenate, Splice and Resample GPB Utility 

 
Use the Add and Remove buttons to select the files that you wish to use as original files.  
Note that multiple files can be selected during Add.  From the “Time Interval Options” 
box, select the “Copy each epoch” radio button to simply splice a file, or select the “Only 
keep epochs on interval” to resample the file.  If you wish to concatenate two or more 
files, either radio button may be selected depending on whether you want to resample the 
data as well as concatenating it.  Use the “Time Range Options” to set the times that will 
be used to create the new file. 
 
This utility also allows GPB data to be resampled to a higher data interval.  This is best 
performed on static data because in the kinematic case it will also attempt to interpolate 
vehicle motion, which is not very well characterized by the polynomials used.  Note that 
this functionality is available directly within GrafNav too. 
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Figure 6.3 Resample to Higher Interval 

 
An additional dialogue box appears with the following options: 

• The data mode defines what measurement quantities are to be interpolated.  It 
is important to set this properly. 

• For kinematic data, results will be unreliable.  However, if the user wishes to 
try it, make sure that the kinematic box is selected. 

• Window size in epochs is the range of data used for interpolation. The 
window size should normally be set between 4 and 6.  Very large windows 
will have problems, especially with data files that have large data intervals. 

• The data interval is the interval that will be resampled to.  It should be finer 
than the original input interval. 

• The number of polynomial coefficients is the number of Chebychev 
polynomial coefficients used for the interpolation.  Normally a value close to 
the Window size is acceptable.  This value cannot be larger than the window 
size. 

• The maximum time span prevents the interpolator from using data across too 
high of an interval.  Currently, 3 minutes is the default.  However, larger 
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values are required for large interpolation windows with coarse input data 
rates. 

• Cycle slips can cause the interpolation to have problems.  Therefore, a coarse 
detector is implemented.  This value cannot be lowered too much, since then 
pseudorange noise will be mixed up with carrier phase errors (a minimum 
value of 50 cycles should be used). 

• The GPB resampling utility needs GPS ephemeris data.  Normally, the 
ephemeris from the input files is used.  If these ephemerides either do not 
exist, or they are incomplete, then use the alternate ephemeris option. 

 
This utility can also be used to resample the times of one GPB file onto those of another.  
This has application when the remote file is not on the whole epoch (e.g. Sirf, Parthus 
GSU-II). 
 
Interpolation adds 1 to 2 cm of noise for 30 second data.  Five second or higher data has 
almost no added error.  When processing 30 second interpolated data, KAR may not 
work.  In addition, for the Advanced KAR Option 'Exact Interval (for interpol. data)’, a 
value of 30 seconds should be used. 
 

Section 5   GPB to RINEX (Windows) 
This program will convert a .GPB file into a standard format RINEX version 2.0 or 2.10 
file.  You can convert multiple files in succession by simply adding them all to “Files to 
Convert” list.  Each time you add a file, you will be prompted for a station name, an 
antenna height, and whether an alternate ephemeris should be used. 
 
The type of data that will be written to the RINEX files can be selected with the radio 
buttons in the “Data Types to Export” box.  If Auto-Detect from this box is selected, then 
the program will export all available data.  Regardless of what button you press, only data 
that exists will be exported (columns of zeroes will not be created for missing data). 
 
The GPB to RINEX converter allows you to set the week number the observations were 
made on.  If the Auto-Detect button in the “GPS Week” box is chosen, then the week the 
observations were made will stay the same.  You can also set the week by choosing the 
Set Week button.  Occasionally, de-code data is given an incorrect week when it is 
converted from a receiver format to a .GPB file.  These errors can be corrected by 
converting the .GPB data into RINEX data with the correct week, and then back to .GPB 
data. 
 

Section 6   Insert Static/Kinematic Markers 
This utility can be called from the GPB Utilities sub-menu under the File menu in 
GrafNav.  This utility can be use to convert data to static or kinematic. 
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Figure 6.4 Insert Kinematic/Static Markers Utility 

 
Selecting the option “Make all epochs static” will change all the epochs in the selected 
GPB file into static mode.  “Make all epochs kinematic” will change all the epochs into 
kinematic. 
 
Selecting the option “Use user generated file to define static periods” will allow the user 
to change particular areas to static.  The file has to follow the following format: 
StaID  StartTime  EndTime  Description 

:  :   :  : 
 
The diagram in Figure 6.5 describes some of the options. 

 
Begin time offset End time offset 

Actual static periodStartTime EndTime 
 

Figure 6.5 Time Offset 

 
If “Create station file” is selected, all the static periods will be listed in the STA file. 
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Section 7   MAKEGEOID (Command Prompt) 
This utility can be used to convert ASCII geoid file to Waypoint Geoid Format (WPG).  
A bitmap file (BMP) file is also created to give a visual of the geoid.  The input file is as 
follows: 
 
LatVal  LonVal UndulationVal 
   :              :           : 
 
Note that Latitude and Longitude is in decimal degrees and Undulation is in meters.  Be 
sure to use at least 12 decimals for latitude and longitude values.  In addition, positive 
latitude is northern hemisphere while negative is southern.  For longitude, positive is 
eastern while negative is western hemisphere. 
 
Usage:  MakeGeoid InFile [-o OutFile[.wpg/bmp]] [-rlt] [-rln] [-d datum]  

[-g "Geoid name"] [-r "Region name"] [-h] 
Where, 
  InFile - Input file name, Format: 
  -o  - output file [default=InFile.wpg/bmp] 
  -rlt  - Reverse sign on latitude values [default=off] 
  -rlm  - Reverse sign on longitude values [default=off] 
  -d  - Datum name [default=WGS84] 
  -g  - Geoid name [default=Unknown] 
  -r  - region name [default=Unknown] 
  -h - help screen 
 

Section 8   Mission Planner 

6.8.1   What is the Mission Planner? 
Tools | Mission Planner 
The Mission Planner is a feature that was added to GrafNav/GrafNet version 6.02.  This 
tool allows the user to investigate satellite geometry, satellite count, and dilution of 
precision values for the GPS constellation.  Mission planning is normally performed prior 
to the mission, but it can also be used to compare the theoretical constellation to that 
observed during processing.  The Mission Planner requires an almanac file.  Two formats 
are supported: 

• YUMA almanac which can be downloaded from the NAVCEN web site (see 
below) 

• .EPP file that contains almanac records.  Currently, only a few decoders (e.g. 
NovAtel) support the decoding of almanacs.  .EPP files that do not contain 
an almanac cannot be used. 
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Figure 6.6 Mission Planner – Settings Tab 

 
The Mission Planner relies on almanac files for information on the orbital parameters for 
each satellite PRN and the geographical coordinates of cities (point of operation) in 
mission planner city (.mpf) files to estimate the number of satellites, satellite geometry 
(satellites in view), double difference DOP, PDOP, HDOP, and VDOP.  A base station 
must be defined for differential computations. YUMA almanac files (.txt) or Waypoint 
ephemeris files (.epp) can both be used with the Mission Planner.  The only requirement 
for the ephemeris files is that the almanac record be included in the .epp format.  At 
present, only the NovAtel almanac format is supported in the ephemeris files.  YUMA 
almanac files can be downloaded from 
http://www.navcen.uscg.gov/ftp/GPS/almanacs/yuma/ 

6.8.2   Getting Started 
The following section will guide a new user in how to use the Mission Planner and obtain 
output for flight mission. 
 
1) Open up GrafNav and select Mission Planner from the Tools Menu. 
2) Select either Single Point or Differential Mode. 
3) Choose a Point of Operation.  If the menu is blank, click on Define and then on 

Change List File and select a mission planner city list (i.e. world.mpf or 
north_am.mpf for cities with coordinates already defined).  If the city is not in either 
of the predefined lists, custom entries can be added to the MissPlan.mpf which is the 
default list upon installation.  When adding custom cities, an .mpf file other than 
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world.mpf or north_am.mpf should be used to prevent entries from getting lost upon 
re-installation. 

4) Choose a Base Station in the same manner as choosing a Point of Operation if 
differential mode was selected.  The closest base station to the Point of Operation can 
be found by using the Find Closest button; however, this function works best when 
the cities are chosen from two different city files, otherwise it will just find the point 
of operation city. 

5) Next, either browse through (or type the path name) and select the almanac file in 
your directories, or download a YUMA almanac file from one of the URLs in Section 
6.8.1  What is the Mission Planner?.  The following dialogue box will appear once the 
default web browser for GrafNav has been selected.  Follow the instructions on how 
to download the YUMA almanac, and then select it using Browse. 

 

 
Figure 6.7 Download Almanac Instructions Dialogue Box 

 
6) Leave the elevation mask at 15° to ensure that low satellites, which can have a poor 

signal, will not degrade the solution.  If there are not enough satellites to find the 
geometry of the position, lower the elevation mask to 10°. 

7) Enter in the start time, date, and length of the flight mission in H:M:S. 
8) Decide upon which plots are necessary for predicting and planning the flight, and 

click on each tab and change the option from None to either Line Graph or Bar Chart.  
If you wish to place all the DOP charts being plotted on one graph, select line graph 
and then change the option in the Advanced tab.  The default charts that are plotted 
are the Number of Satellites and PDOP bar charts. 

9) If you would like to see the elevation of all the satellites in view, select the option 
Satellite Lock Plot in the Sats in View tab. 

10) An output file containing a log of the mission planner output in ASCII can be saved 
by selecting the option from the Advanced tab of the Mission Planner. 

11) Press OK and all the graphs and/or mission planner log file will open in GrafNav. 
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6.8.3   Options for Mission Planner 
Settings 
 
Mode 

The mission planner will provide results for the area surrounding the single 
point chosen.  Differential mode should be used for long baselines or to closely 
match values computed during post-processing. 

Single Point 

The mission planner results will be for an area between the base station and 
point of operation 

Differential 

Point of Operation 
Define allows the user to select the city file containing geographic coordinates 
for their point of operation.  GrafNav comes with 2 default city coordinate files 
called north_am.mpf, and world.mpf (i.e. North America and the World).  The 
default .mpf file used is MissPlan.mpf which is blank upon installation.  
Coordinates for other cities should be added to MissPlan.mpf to prevent 
overwriting the north_am and world mpf files during re-installation. 

Define 

 

 
Figure 6.8 List of Point of Operations window 

 
Select will choose the highlighted city as the Point of Operation in the Settings 
Tab, while the Change List File allows the user to select a different .mpf file.  
The commands Add, Edit and Remove will edit and change the current .mpf file 
loaded.  Add and Edit will launch a dialogue box to change the name, latitude, 
and longitude of a selected point. 
 

 
Figure 6.9 Define (Add and Edit) Point Dialogue Box 
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Base Station 
See Point of Operation: Define Define 
Find Closest will find the closest city defined in the Base Station .mpf file 
compared to the city selected in the Point of Operation .mpf file.  This option 
works best when there are two different files used for Base Station and Point of 
Operation. 

Find Closest 

Source of Almanac (YUMA or .EPP) 
The user can browse the directory structures on their hard drive(s) to find 
existing YUMA or .EPP almanac files.  Note that .EPP file must contain an 
almanac record to work.  For most decoders this record will not be 
included. 

Browse 

This will open up a new browser window and the URL site for downloading 
YUMA almanac files.  If this option has never been used, a dialogue box will 
prompt the user to select a web browser (i.e. Netscape or Internet Explorer) to 
open.  Once the proper YUMA almanac is found, save the file as a text file by 
selecting File > Save As… 

Download 

Settings 
This option sets the cut-off elevation for the mission planner.  The default value 
for the mission planner is 15 degrees.  However, users may wish to use larger 
values to simulate conditions of satellite blockage lower on the horizon (e.g. 
aircraft turns, buildings, or trees). 

Elevation Mask (°) 

The start time of your mission in h:m:s GMT time. Start Time (h:m:s) 
The length of your mission in hours. Length (hours) 
The date of your mission in m/d/y format. Date (m/d/y) 

 
Number of Satellites, PDOP, HDOP, VDOP, and DD-DOP 
 

 
Figure 6.10 Mission Planner: Number of Satellites tab 
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Chart Type (for each one) 
No chart/graph will be plotted onto the display when this option is selected. None 
A line graph will be displayed with when this option is selected.  The line 
graphs are very similar to the ones plotted in the Plot GPS Data tool. 

Line Graph 

Bar Chart The bar graph allows for more interpretation of the results since the values of 
the Number of Satellites, Satellites in View, and DOP values are categorized in 
to Excellent, Adequate, Questionable, and Unacceptable categories where each 
graph has default maximum and minimum values.  A maximum of six bar 
colours are allowed for each bar chart. 

Bar Colours(only applicable for bar charts) 
The Add option will add a bar colour to the selected bar chart at the end of the 
list of colours. 

Add, Insert, Edit, 
Remove 

 
Insert will add a bar colour to the bar chart ahead of the highlighted bar colour 
in the colour list. 
 
Edit allows the user to modify the Name, and Maximum and Minimum values 
defining the chosen colour category. 
 
Remove will automatically delete the colour from the list.  If a colour is 
accidentally deleted, press Cancel so that the changes are not saved to the 
WPMissPlan.ini file. 
 

 
Figure 6.11 Bar Definition (Add, Insert, Edit) window 

 
Y-axis Range 

This option allows the Mission Planner to automatically scale the Y-axis for the 
line graph or bar chart. 

Automatic 

The maximum and minimum values in the Manual setting allow the user to 
customize all the graphs to a user-defined value regardless to the chart values. 

Manual (max, min) 

 
Satellites in View 
 
Chart Type 

No chart/graph will be plotted onto the display when this option is selected. None 
Satellite Lock Plot The graph displayed on the screen is a satellite lock plot showing each SV 

tracked with its elevation.  This graph is similar to the Lock Plots for the Master 
and Remote station in GrafNav. 
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Figure 6.12 Mission Planner Satellites in View tab 
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Advanced 
 

 
Figure 6.13 Mission Planner: Advanced Options tab 

 
Log File 

Users can either directly type in a directory path for where they would to save 
the mission planner output, or they can use the Browse button to define a path. 

Save mission 
planning output to 

ASCII file, Browse 
If you would like to view the mission planner output immediately after 
processing, select this option and the ASCII viewer will open the log. 

View .LOG file after 
processing 

Data Interval 
Automatic This option will automatically compute a data interval suitable for the most 

recent plot window size. 
Users can manually define a data interval to improve the resolution. Manual 

Options 
The Mission Planner will check the almanac file for any sick satellites if this 
option is selected.  If certain satellites that are causing problems and are not 
labeled as sick in the almanac file, the Mission Planner can be manually set 
using Ignore these Satellites to ignore specific PRNs. 

Ignore satellites with 
bad health/ Ignore 

these satellites 

This option will plot all the DOP plots that have line graph mode selected 
(except for DD-DOP) onto one line graph plot.  Note that each of the DOP 
charts must be set to line type. 

Plot all DOPs on  one 
graph (line graph 

only) 
Display seconds of 

the GPS week instead 
of H:M:S 

Users can change the format of the X-axis labeling between GPS seconds of the 
week or H:M:S.  This is used for comparing to post-processing data plots. 
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Note that if there are changes in the options that are unknowingly saved, default options 
and settings for the Mission Planner can be reset by deleting the WPMissPlan.ini file in 
your Windows directory. 
 

Section 9   Download Service Data 

6.9.1   About the Download Program 
The Download Service Data utility allows you to automatically download RINEX data 
from different services and convert the data into Waypoint’s .GPB format.  Optionally, 
GPS data can be resampled to a higher interval.  Services are internet web and ftp sites 
which continually store data from a number of GPS sites.  This data can be downloaded 
for free.  The services currently supported are CORS, IGS, AUSLIG, IGN, GSI, BKGI 
(EUREF), ASI, CDDIS, and OLG.  Users can also add their own services (see Section 
6.9.3  Adding Stations and Services). 

6.9.2   Downloading Service Data 

 

Tools | Download Service Data 
Figure 6.14 shows the main download screen.  This feature can be accessed from 
GrafNav, GrafNav Batch and GrafNet via “Tools > Download Service Data”.  The ‘List 
of Stations’ shows the stations you have selected to download and their associated 
service.  Distance is only present if the ‘Add Closest Stations’ option was used, which is 
described later.  The ‘Path’ is the path where the final GPB files will be placed.  ‘Date 
and Time Range’ is the date and time of the data in GMT time.  Note that the date is in 
month/day/year.  ‘Output data interval’ lets you either leave the data as found or select a 
new interval.  Note that interpolation to a higher interval will add roughly 1-2 cm of 
additional error in the measurements depending on the original data and the interval to 
which you are interpolating. 
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Figure 6.14 Main Download Service Data Screen 

 
Figure 6.15 shows the ‘Add from List’ feature.  ‘Add from List’ allows you to add a 
station from the list of pre-defined stations, and is useful if you know exactly which 
station you would like to download.  Highlighting the station and selecting the ‘Add’ 
button will add the station to the list of stations to be downloaded (on the main screen).  
Station information can be obtained by highlighting the station and selecting the ‘Info’ 
button.   
 
It should be noted that this list of stations may not be complete due to the continual 
addition and removal of CORS stations.  Additionally, every so often a service will 
change its directory structure, thereby making the download program useless for that 
service.  Both of these problems can often be solved by selecting the “Download Latest 
List” option from the “Add From List” tab.  This will download Waypoints latest list and 
station list and will also update the service directory paths that the Download Program 
searches for.  In the event that our list (which is updated every few months) does not 
contain some very recently added CORS, IGS, AUSLIG, IGN, GSI,  BKGI (EUREF), 
ASI, CDDIS, or OLG stations and you would like to add these yourself, consult the 
Adding Stations and Services section. 
 
It should also be noted that the coordinates provided are not guaranteed.  Every 
effort has been made to maintain correctness; however it is recommended that you look 
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up the coordinates on the services web page.  The coordinates you will usually want are 
for the L1 Phase centre (those stored in the favourites manager are ARP’s).  The services 
web pages are provided below.   
 

Service Name Web Address 
IGS http://sopac.ucsd.edu/ 

http://www.ngs.noaa.gov/CORS/cors-data.html 
http://www.ga.gov.au/ 
http://lareg.ensg.ign.fr/RGP/index.html 
http://www.gsi.go.jp/ 
http://www.epncb.oma.be/ 
http://geodaf.mt.asi.it/ 
http://cddisa.gsfc.nasa.gov/ 
http://gps.iwf.oeaw.ac.at/olgdc1.htm 

CORS 
AUSLIG 
IGN 
GSI 
BKGI (EUREF) 
ASI 
CDDIS 
OLG 

 

 
Figure 6.15 Add From List 

 
Figure 6.16 shows the ‘Add Closest’ feature.  This feature shows a list of all the closest 
stations based on the latitude and longitude position entered.  Two settings that can be 
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controlled are the ‘Maximum Distance’ and ‘Maximum Number’ of stations.  ‘Maximum 
Distance’ prevents stations further than this constraint from being added to the list.  
Maximum number of stations sets the maximum size of the list.  If no stations appear in a 
search then you’ll have to increase the maximum distance. 
 

 
Figure 6.16 Find Closest Station 

 
‘Download’ first places all files in a temporary directory.  Where the files are 
uncompressed and converted from RINEX to GPB.  If the program quits unexpectedly 
you can check the temporary directory for the files.  To change the temporary directory 
you can go to the options tab as shown in Figure 6.17.  It is important to note that the 
temporary directory cannot be the same as the final directory. 
 
If a file exists in the destination directory with the same name as the file being 
downloaded the file will be overwritten if the option “Overwrite existing files with newer 
ones” is enabled.  However, if the ‘Append’ option is enabled the new file will have an 
A,B,C etc appended to the file name.  If you would like to use the Doppler value from the 
RINEX file enable 'Use D1 in observation file if available'.  If you would like to keep the 
RINEX files enable the option ‘Leave raw RINEX files in TEMP directory’.  The files 
will then be available in the temporary directory for other packages to use.  By default the 
RINEX file will be converted into the new GPB format.  To convert to the old GPB 
format, disable 'Use New GPB format'.  Some of the FTP sites require the user to input a 
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valid email address before giving permission to download GPS data.  Note that your 
email address is not used for any other purpose than a password.   
 
If you would like to download the precise ephemeris, enable 'Download SP3 files'.  Final 
precise orbit ephemeris will be downloaded if available.  If it is not available, rapid orbit 
would be next.  The final precise orbits are available at 12 days latency and the rapid 
orbits are available with approximately 17 hours latency.  Precise orbits are located at: 
Final: ftp://igscb.jpl.nasa.gov/igscb/product/<week>/igs<week><d>.sp3.Z 
Rapid:  ftp://igscb.jpl.nasa.gov/igscb/product/<week>/igr<week><d>.sp3.Z 
Where <week> is the gps week and <d> is day of the week. 
 

 
Figure 6.17 Download Options 

 
IONEX (Ionosphere Map Exchange) files contain information relating to the Total 
Electron Count (TEC) of the ionosphere on a given day.  They can be used in single 
frequency or single point processing to aide in the ionosphere modeling process.  These 
files can be downloaded from various producers: 
 
CODE – Center for Orbit Determination (http://www.aiub.unibe.ch/igs.html) 
NRCan – Geodetic Survey Division of Canada (http://www.geod.nrcan.gc.ca) 
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ESA – European Space Agency (http://www.esa.int) 
JPL – Jet Propulsion Laboratory (http://www.jpl.nasa.gov) 
UPC – Technical University of Catalonia (http://gage1.upc.es) 
 
Precise clock files (.clk files) contain information of clock biases in a particular GPS 
satellite.  These files are also used to support single point positioning.  They are obtained 
from the NGS/NOAA producer (http://sopac.ucsd.edu).  For details on how to implement 
them in GrafNav, see Section 2.2.6  . 

6.9.3   Adding Stations and Services 
Download lets you add new stations and services for downloading.   To add either a 
station or service you need to open users.dn1 found in your Waypoint directory.  If the 
file does not exist, you might have to create it using the format is listed below.  To add a 
station record, copy the last station record in the file and paste it at the end.  Then edit the 
fields of the new record as explained below.  Note that you will also find a file, 
manufact.dn1, in the directory as well.  This is the file that gets updated when “Download 
Latest List” button is clicked. 
 
sName:  The station name on the ftp server. Max 4 characters (case sensitive). 
lat:    Station Latitude in DMS.  N – North  and S – South. 
lon:    Station Longitude in DMS. W – West and E – East. 
ht:    Station Height.  
serv:    Service name of the service that the station belongs to.  You will have to look at 
the service records to find the Service name  (“ServId:”).  Note that this is case sensitive. 
 
An example station record is shown below: 
 
Station { sName: prds 
lat: 50 52 16.8672 N 
lon: 114 17 36.5856 W 
ht: 1247.94 
serv: IGS 
} 
 
Adding a service requires you know the services ftp address, directory structure and file 
type (i.e. Z, gz, or zip).  To add a service, copy and paste one of the service records at the 
beginning of manufact.dn1.  Then edit the fields of the new record as explained below. 
 
ServId:      The name of the service.  This can be whatever you choose maximum 8 
characters  
 
ftpAd:       Address of the ftp server. 
 
oFile:      The directory structure and name of observation data files.  The directory 
structure is how the folders are organized to find a certain file.  For example, to find one 
file, you might have the path:  /pub/obs/1998/128/prds1280.98n.Z.  Then another file for 
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the same service may have the path:  /pub/obs/1999/032/alic0320.99n.Z.  On this 
example service, the files are organized by year and Julian day.  The directory structure 
would look like the following:  /pub/obs/<YYYY>/<JJJ>/<XXXX><JJJ>0.<yy>n.Z, 
where <YYYY>,  <JJJ>, <XXXX> etc are directory structure commands. 
 
The following is a list of these commands: 
 

<YYYY>  *   Year eg 2000 or 1999 

<week>        gps week eg 1075 

 

Datum:  This is the datum of station record coordinate. 

   ftpAd: lox.ucsd.edu 

<JJJ>           Julian Day eg 006 or 365 

<XXXX>       Station id   eg prds 

<wkrl>          gps week - 1024  eg 1075 would be 0051 
<yy>        *   last two digits of the year  eg 99 or 01 
<d>              Day of the week  eg 3 
<MN>          Month Number eg 11 
<DM>          Day of the month eg 31 

Note that commands with an * are case sensitive.  All the directory commands are inside 
the brackets < >.  For more information, look at some of the ftp services in manufact.dn1 
and examine their directory structure for examples. 
 
nFile: This is the directory structure of the navigation file.  Same commands as for oFile. 
 
dFile:  This is the directory for compressed RINEX files.    This field does not need to be 
present if the service does not have any compressed RINEX files. 
 
Ftype:  This is the type of compression on the file.  The file types include Z, gz  and zip. 
 

 
color:  This is the colour of the symbol in download for the service.  This option also 
does not need to be present but allows you to select a unique colour for the service and 
station symbols.  The following colours are available: red, green, blue, magenta, cyan, 
gray, wine, black, gold, darkgray, darkgreen, darkblue, lightcyan, and darkmagenta. 
 
An example service record is shown below. 
 
Service { ServId: igs 

   oFile: /pub/rinex/<YYYY>/<JJJ>/<XXXX><JJJ>0.<yy>o.Z 
   nFile: /pub/nav/<YYYY>/<JJJ>/<XXXX><JJJ>0.<yy>n.Z 
   dFile: /pub/rinex/<YYYY>/<JJJ>/<XXXX><JJJ>0.<yy>d.Z    
   Ftype: Z 
              Datum: WGS84 
           color: red 
} 
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The data conversion utility included with GrafNav/GrafNet 7.50 decodes raw GPS data 
from over twenty different GPS receivers by choice or auto-detect.  CONVERT is located 
in the distribution directory (i.e. C:\Program Files\WayptGPS750), and it can also be 
accessed from the Start Menu in Windows 95/98/2000/XP/NT 4.0.  The conversion 
utility can also be called from within GrafNav, GrafNav Batch or GrafNet in the menu 
File -> Convert -> Raw GPS to GPB. 
 
Similar conversion utilities for DOS can be found in the \DosUtils directory on the 
GrafNav/GrafNet CD-ROM.  Older style Windows utilities can be accessed from the 
GrafNav and GrafNet interfaces.  It is suggested to use the conversion capabilities within 
CONVERT over the others as they are the most up-to-date. 

Section 1   CONVERT Interface/Functionality 

7.1.1   How to Use Convert 
After opening CONVERT from GrafNav or the Start Menu, raw GPS data files can be 
easily converted to Waypoint’s custom GPB format using the following procedure. 
 

 
Figure 7.1 Convert’s receiver type options 
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For example, How to Convert your NovAtel data: 

• Under the File Menu choose File -> Convert -> Raw GPS to GPB 
• A dialogue box will appear as follows: 
• Choose the NovAtel receiver type from the pull down menu. 
• Select the appropriate path name for the folder containing the Raw GPS files or 

use the Browse button. 
• You can either add files individually using “Add” or add all files using the “Auto 

Add All” button or the “Auto Add Recursively” button which searches all 
subfolders in the directory as well. 

• Set global options required. 
• Press the Convert button. 

7.1.2   CONVERT Interface Options 
Receiver Type 

• If you know which receiver you used to collect the data, choose it from the drop 
box menu.  Otherwise, leave the selection at Unknown/AutoDetect. 

 
Global Options 

• Gives specific options for each receiver listed and allows the user to define data 
conversion 

• Modifying the global options for a given receiver will alter the options for all of 
the selected convert files.  These changes will also be saved for the future. 

• There are no options for unknown or auto-detect 
 
Info 

• Provides information on the status and version of the receiver’s DLL file and 
whether it is loaded and allows auto-detection 

 
Folder 

• The user can type in a folder path name into a dialogue bar if it is known 
 
Get Folder 

• A browsing feature that allows the user to look through the directories on the 
system and select the desired folder 

 
Source Files 

• The Source Files window lists all the files with filtered extensions from the folder 
path given 

 
Filter 

• Lists the associated file extensions for the selected receiver, separated by a 
semicolon.  Use *.* to view all files. 
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Add 

• Adds the highlighted file in the Source Files window to a list of files to be 
converted 

• If a receiver type is not selected, add will try to auto-detect the highlighted file 
 
Add All 

• Tries to add all files in selected folder to be converted 
 
Auto Add All Files 

• Adds all the files in the Source Files window to the list of files that will be 
converted 

• This function will always attempt an auto-detect on each file 
• Only files with a detected receiver type will be added 

 
Auto Detect 

• Allows CONVERT to automatically detect the receiver type of the file 
highlighted 

 
Note, not all receiver formats have auto detection available; Auto detection may not work 
on all variations of a receiver format 
 
Auto Add Recursively 

• Will automatically detect and add files to be converted in the immediate folder as 
well as all subfolders.  This will continue to add files up to a maximum of 128. 

 
Convert Files 

• The Convert Files windows lists the selected convert files 
 
Remove 

• Removes a highlighted file from the list of files waiting for conversion 
 
Clear 

• Removes all files from the Convert Files window 
 
Options 

• Displays the options dialogue box for the selected receiver.  Options will not be 
saved – use global options if changes are to be permanent. 

 
Info 

• Provides information on the file name, receiver type, and status of conversion 
 
View 

• After converting the raw GPS file to GPB format, pressing View will open the 
converted file in ViewGPB 
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Convert 

• Starts converting all of the selected files 
 
About 

• Provides copyright information and information relating to the .dlls used in the 
utility.  See Section 2.10.3  for more details. 

 
Close 

• Exits CONVERT 
 

Section 2   Messaging Options 
While a binary GPS data file is being decoded, a message dialogue box will appear to 
display the status and progress of the conversion. 
 

 
Figure 7.2 Message Log Dialogue Box 

 
Save Messages 

• Prompts the user with a dialogue box to save the message log to a file 
 
Clear Messages 

• Clears the message log from the dialogue box; once the button is pressed, the 
message log cannot be recovered if it has not been saved 
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Message Options 
 Maximum number of messages 

 Use FAST message addition (less flickering) 
o Maximum number of messages allowed to appear in the message log 

o Causes less flickering in the dialogue box window and updates the 
window every # of milliseconds 

 Automatically log messages to file 
o Automatically saves the message log to a user defined file name in 
the same directory as the converted data files 

 

 
Figure 7.3 Messaging Options Dialogue Box 

 

Section 3   Receivers 

7.3.1   Allen Osborne Associates (AOA version only) 
Turbo Binary (.TB) files can be converted to .GPB using CONVERT.  This decoder is 
only available for AOA versions.  Normally, one .TB file will contain data from many 
sessions (or even days).  Therefore, this decoder must split the files up to be compatible 
with GrafNav/GrafNet.  This decoder looks at the Begin and End session marks within 
the .TB file.  The user creates these when they mark the beginning and end of a session.  
The session name entered in the receiver will be the name of the file, except that the 
Julian day number will be appended. 
 
Data Required 
File Type Comments 
*.TB Measurement/Ephemeris/ 

Station 
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Options 
 

 
Figure 7.4 Allen Osborne Associates Options Dialogue Box 

 
Decode by Session Name Decodes the TB file based on session marks inputted into 

the receiver 
Decode Whole TB File 
(Ignore Sessions) 

Decodes the entire TB file with the assumption that all the 
data collected was from one session 

Make All Epochs 
Kinematic 

Use this to make every epoch kinematic, otherwise, will be 
static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Verbose Message Mode Alerts the user of additional warnings and errors that have 
occurred  
 

Re-compute position and 
clock offset 

GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 

Factory Defaults Restores the original settings for AOA format processing 
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7.3.2   Conexant Jupiter 
Because of timing issues, the carrier phase on this receiver is not usable.  Hence, this is 
basically a code-only receiver.  Ephemeris measurements are contained in record #1102, 
while record #1000 can be used for position measurements. 
 
Options 
 

 
Figure 7.5 Conexant Jupiter Dialogue Box 

 
General Options  

Use this to make every epoch kinematic, 
otherwise, will be static; use ViewGPB to switch 
individual or groups of epochs between static and 
kinematic 

 Make all epochs 
Kinematic 
 

 
 Recalculate Position 

and Receiver Clock 
GrafNav requires clock shift to perform data 
processing, while GrafNet needs the position 
record.  If the position record is not available, 
choose this option to use the decoder algorithms 
 

 Keep epochs where 
recalculation failed 

If time recalculation failed, measurement may 
cause problem.  Use this to ignore these records 
 

 Do not check data 
record checksum 

Use this setting to ignore record integrity checks 
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Time Skewing  
 Leave measurements 

raw 
Leave time 'as is' 

 Skew to whole second 
using linear 
interpolation 

Shift to integer second 

 Skew to whole second 
using polynomial 
(static only) 

Shift to integer second 

Ephemeris Options  
 Use alternate 

ephemeris file 
Utilize ephemeris records from another source 

 Ignore Jupiter 
ephemeris records 

If many corrupted records exist, the ephemeris in 
record #1102 may be unuseable 
 

Factory Defaults Restores the original settings for Conexant Jupiter

7.3.3   Conexant NAVCOR 
 

 
Figure 7.6 Conexant NAVCOR Dialogue Box 

 
Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Skew measurements to 
whole second 

Shift to whole second 
 

Ignore data from secondary 
(alternating) channel 

5th channel on this receiver alternates between remaining 
satellites. Enable this to ignore 
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Correct measurements for 
satellite clock 

Should be off 
 

Use alternate ephemeris Use if ephemeris is missing 
 

Corrected ranges for dual 
antenna window placement 

For CSSI users only 

Factory Defaults Restores original settings for conversion process 

7.3.4   CSI SLX/DGPS-MAX 
Convert data from DGPS-MAX receiver to GPB 
 
Data Required 
Record Type Comments 
96 Measurements  
1 Position  
95 Ephemeris  
 
Options 
 

 
Figure 7.7 CSI SLX/DGPS-MAX Dialogue Box 

 
Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Factory Defaults Restores original settings for conversion process 

7.3.5   Javad/Topcon 
The Javad decoder in CONVERT will decode the binary data from any Javad receiver 
into .gpb format.  This includes both the GPS and GPS/GLONASS receivers. 
 
Data Required 
Record Type Comments 
RC, rc C/A Code Measurement Block RC suggested 
R2, r2, 2R, 2r L2 P Code Measurement Block 2R suggested 
PC, pc, CP, cp L1 Phase Measurement Block CP suggested 
P2, p2, 2P, 2p L2 Phase Measurement Block 2P suggested 
DC L1 Doppler Measurements suggested 
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GE GPS Ephemeris  
NE GLONASS Ephemeris  
TO Clock Offset  
TC Locktime  
PO Position  
SI PRN List  
RD Receiver date  
OEM Measurement Compressed record which 

is more robust 
 
Options 
 

 
Figure 7.8 Javad Options Dialogue Box 

 
Decode GPS only (i.e. no 
GLONASS) 

This option causes the decoder to ignore all GLONASS 
data (i.e. GPS only) 
 

Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 
static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Use code and carrier from 
P1 instead of C/A 

P1 code is currently encrypted with Y code , but once SA is 
off, it is expected that L1 phase from P1 code will be more 
accurate 
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Use JPS locktimes for 
cycle slip detection 

Locktimes from the Javad receiver will be used instead of 
the ones computed by the decoder; currently, the Javad has 
a problem with the locktime counter, however, this may 
change with future firmware versions 
 

Ignore entire epoch if 
check failed on element 

If enabled, GPS data for the entire epoch is ignored if a 
checksum error is reported for any of the incoming records.  
Otherwise, only the affected data is ignored. 
 

Use SAVE marker to store 
sites to .sta file 

Markers will be saved to .sta file 
 

Reject entire record if L2 
phase is missing (may be 
needed for high data rates) 

  

Verbose messaging mode Allows the user to see additional warning messages 
 

If GRIL and OEM Formats are Mixed 
 Ignore GRIL 

Measurement Data 
Ignore GRIL record information and only utilize 
OEM 
 

 Ignore OEM 
Measurement Data 

Ignore OEM and only use GRIL 

Factory Defaults Restores original settings for conversion process 
 
Notes 
Current JPS default messages are: RC, CP, 2P, DC, and 2R or some set of equivalent 
records. 

7.3.6   Leica SR and MX 
Leica raw GPS measurement data can come in two types of formats.  The MX series data 
files are produced by the MX 4200 and 9200 receivers while the SR series data formats 
are produced by the SR-299, 399, 9400, 9500 sensors.  The SR files usually start with 
DS.  The decoder in CONVERT will automatically detect if the files are from the SR or 
MX series. 
 
Data Required 
SR series 
File  Type Comments 
DS*.OBS Measurements  
DS*.EPH Ephemeris  
 
or 
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MX series 
Record Type Comments 

Measurements 
3 Measurements Raw data for 12 channels 
8 Position  
200 Ephemeris  
201 Ephemeris  
202 Ephemeris  
203 Ephemeris  

2 Raw data for 6 channels 

 
Supported Files (SR only) 
File Type Comments 
DS*.CMP Position SR series 
DS*.TTP Station SR series 
DS*.EVT Event Mark Produced by SR-9400 & 

9500 sensors -> MRK file 
DS*.INT Station SR series 
DS*.CHN Static Chains SR series 

Event Mark ASCII files produced by 
ASCOT system with MX 
series; read by GrafNav 
directly 

.EV0 

.TDU Event Mark ASCII files produced by 
TDU units running in 
conjunction with SR sensor 
series (SR-299,399); read 
by GrafNav directly 

 
Options 
 

 
Figure 7.9 Leica SR and MX Options Dialogue Box 

 
Make all epochs kinematic 
(MX format only) 

 

Use this to make every epoch kinematic, otherwise, will be 
static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic; only works for MX 
format 
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Reject measurements that 
Leica declares bad (SR 
only) 

The Leica rejection flags are very sensitive; better results 
can often be obtained by ignoring them; however, if bad 
measurements are a problem, try this option 
 

Breakup chains into 
separate files (will ask for 
IDEX file name for version 
3.0 and later) 

For SR files that contain more that one static session 
(chain) per file, enable this option to split the chains up into 
separate .gpb files; see note below 
 

Factory Defaults 
 
Tips/Notes 
One current limitation of the SR decoder is that it does not copy alphanumeric station 
names properly since only the numeric index is retained.  This occurs in the newer 
firmware versions (i.e. versions 3.0 and later).  The value retained is in an index of a list 
of station names that are contained in the Leica file system.  To circumvent this, an IDEX 
file can be loaded into GrafNav (for kinematic processing) or into the decoder directly 
(for static chains).  See Section 2.2.11  for instructions on creating an IDEX file. 

7.3.7   Leica System 500 

 
Data Required 

Restores original settings for conversion process 

Use this decoder for Leica files from the newer System 500 or SR530 series receivers. 

Record Type Comments 
19, or Measurements Compacted observation data
20 Measurements Full observation data; not 

fully tested as of June 
4,1999; Use this record if 
Doppler measurements are 
desired 

15 Ephemeris  
 
Additional Files 
Record Type Comments 
10 Position  
13 Station/Event Mark  
9 Antenna Height  
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Options 
 

 
Figure 7.10 Leica System 500 Options Dialogue Box 

 
Recompute position and 
receiver clock 

GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 
 

Combine multiple 
(.o00,.o01…) files into 
single GPB file 

The Leica SR530 receiver writes all of its data into separate 
files from one session with different extensions; this option 
allows the user to combine files from one session into one 
.gpb file 
 

Use P1 carrier instead of 
CA carrier for L1 phase 
(rec #20 only) 

P1 code is currently encrypted with Y code, but once SA is 
off, it is expected that L1 phase from P1 code will be more 
accurate 
 

Verbose message 
information output 

Alerts the user of additional warnings and errors that have 
occurred  
 

Scale L1 Doppler to L1 
cycles  

Recalculates Doppler, corrects for early Leica firmware 
bug 
 

Insert kinematic markers 
after gaps and stations 

Ensures that static sessions are properly created 
 

Use new station format for 
output 

Utilizes new more detailed format 
 
Converts data into the new GPB format 
 

Factory Defaults Restores the original settings of the decoder for processing 
 

Use new GPB format 
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7.3.8   Magellan ProMark 
Decodes ProMark data format. 
 
Options 
 

 
Figure 7.11 Magellan Dialogue Box 

General Options  
 Output data interval Resample to this data interval 

 
 Resampling window 

size 
 

 

Use this to make every epoch kinematic, 
otherwise, will be static; use ViewGPB to switch 
individual or groups of epochs between static and 
kinematic 

 

 
Number of epochs used for resampling operator 

Make all epochs 
kinematic 

 
 

 
 

Use values from 
MOB/CAR file 

Utilize position computed by receiver 

Do not resample data 
to whole interval 
(leave raw) 

If data is kinematic, it is better to resample to 
base station using GPBCat 

Reject measurements 
with signal strength 

Reject very poor measurements (see ProMark 
documentation) 

GPB Position Record 
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 Recalculate position 

using ephemeris 
Recompute position by decoder 

Insert average position 
computed over entire 
file 

Ephemeris  
 Use alternate 

ephemeris file (.EPP) 
Use if ephemeris missing or imcomplete 

Factory Defaults Restores the original settings for Magellan 
ProMark 

 Use average of values compiled by receiver 

7.3.9   Motorola Oncore 
CONVERT will decode 6 and 8 channel data from the Motorola VP Oncore to .gpb and 
.epp format from the binary Motorola files. 
 
Data Required 
Record/File Type 
@@Ea or Position 8 channel 

Position 6 channel 
@@Eg or Measurements 8 channel 
@@Bg 6 channel 

Ephemeris  
 
Options 

 
Figure 7.12 Motorola Oncore Options Dialogue Box 

Comments 

@@Ba 

Measurements 
@@Bf 

 

 
6 channel Motorola 
Receiver (default=8) 

Select the receiver type that was used to collect the data 
 
Use this to make every epoch kinematic, otherwise, will be 
static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 

Only decode C/A code 
data (i.e. no carrier phase) 
Factory defaults 

Convert all epochs to 
kinematic 

 
Perform a code only extraction, thereby ignoring carrier 
lock information 
Restores the default settings for processing 
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Tips/ Notes 

Record/File Type 

The VP Oncore has been discontinued.  The GT Plus is its replacement and does not have 
raw data output capabilities.  Its data can only be corrected via position correction 
methods. 

7.3.10   NavCom 

 
Data Required 

Comments 
0xB0 Measurement 

Will decode binary data from all of NavCom's receivers. 

 
0xB1 Position  
0x81 Ephemeris  
0xB4 Event Marker  
 
Options 
 

 
Figure 7.13 NavCom Dialogue Box 

 
Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will 

be static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Re-compute position and 
clock offset 

GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 
 

Report L2 cycle slips Print message if L2 cycle slip encountered 
Verbose messaging mode Allows the user to see additional warning messages 
Use new GPB format Converts data into the new GPB format 
Factory Defaults Restores original settings for conversion process 
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7.3.11   NovAtel CMC 
Raw data from the NovAtel CMC All Star and Super Star can be converted to .gpb using 
this receiver type in CONVERT.  Waypoint also has logging software available that will 
log directly from the CMC All Star receiver. 
 
Data Required 
Record Type Comments 
ID#20 Position Should be last record 

requested 
ID#22 Ephemeris  
ID#23 Measurements This measurement record is 

recommended for better 
results 

ID#13 Measurements Old style measurement 
record (not suggested) 

Measurements Old style measurement 
record (not suggested) 

ID#15 Measurements Old style measurement 
record (not suggested) 

ID#16 Measurements Old style measurement 
record (not suggested) 

ID#14 

 
Options 
 

 
Figure 7.14 CMC All Star Options Dialogue Box 

 
Make all epochs Kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Verbose messaging mode 
Reject satellites with low 
CNO 

Satellites with low CNO will not be decoded 

Write new GPB format Converts data into the new GPB format 
Factory Defaults Restores original settings for conversion process 

Allows the user to see additional warning messages 
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7.3.12   NovAtel OEM2/3/SoftSurv 
This utility converts raw binary NovAtel data to a .gpb file.  The real-time data is formed 
when data logged externally from the receiver using a utility such as DUMP, WINSAT, 
or another simple logger.  If you wish to convert NovAtel ASCII data, then use 
NovAtel’s convert utility. 
Note:  There are two decoders: 

a) NovAtel OEM2/SoftSurv decoder 
b) NovAtel OEM3 decoder supporting new GPB format 

 
Data Required 
Record Type Comments 
RNGB (use one 
of the following 
measurement 
records), or 

Measurements 2100 Series; Ontime; outdated 

RGED, or Measurements 3100 Series; Ontime (suggested) 
RGEC, or Measurements 3100 Series; Ontime 
RGEB Measurements 3100 Series; Ontime 
REPB Ephemeris 2100, 3100 Series; Onchanged or Ontime 600 
 
Additional Records Supported 
Record Type Comments 
POSB Position To see your position when GrafNav starts, 

either log POSB or use position computed 
algorithms 

MKTB Event Mark CONVERT will automatically decode this 
record into a *.MRK file 

MKPB Event Mark CONVERT will automatically decode this 
record into a *.MRK file 

CLKB Clock Info Standard correlator receivers should log the 
CLKB record or recompute the position and 
clock correction; the clock correction (offset) 
is needed; this record is also suggested if you 
log data right from power up 

 
File Type Comments 
*.orb Ephemeris SoftSurv Ephemeris file for processing 
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Options 
 

 
Figure 7.15 NovAtel Options Dialogue Box 

 
Make all epochs Kinematic Use this to make every epoch kinematic, otherwise, will 

be static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic; SoftSurv files may 
have static / kinematic detected automatically 
 

Re-calculate position and 
clock offset.  Otherwise use 
CLKB and POSB 

If no POSB record is present, use this option to 
recalculate the position and time; REPB ephemeris 
record must be present; epochs collected before REPB 
will not be recompiled and may cause problems, use 
ViewGPB to check 
 

POSB marks the end of 
record.  Otherwise 
RGEB/C/D or RNGB 

If POSB record is requested after the RGEB/C/D or 
RNGB record, select this option to ensure that the POSB 
time record matches the RGEB; otherwise, request 
RGEB/C/D or RNGB first; this would ONLY be used if 
an RTK or DGPS position is to be preserved 
 

Print L1 and L2 loss of 
lock warnings 

Alerts the user of phase loss of lock problems in the 
status window 
 

Check NovAtel C/A code 
lock bit 

Prevents measurements that the NovAtel receiver has 
detected as having bad C/A code from entering the GPB 
file 
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Reject bad C/A code meas. 
(RGED only), tol(m) 

In the RGED format, the PRN range record has 4 bits 
that determine the pseudorange standard deviation.  Each 
possible code (out of a possible 16) represents a range of 
standard deviation.  The user can use the code in the 
record as a tolerance for which C/A code measurements 
to reject. 
 

Beeline Receiver Data  
(will make 2 GPB Files) 

Split Beeline data into two files for primary and 
secondary antennas 
 

Write new GPB format Converts data into the new GPB format 
 

Factory Defaults Restores original settings for conversion process 
 
Tips/Notes 

• Ask for the ephemeris once, then ask for onchanged later on 
• Use RGEC or RGED since they are much smaller records 
• Make sure your baud rate is high enough to log 12 channels and the records 

requested; note that GPS and GPS/GLONASS MiLLennium has 24 channels 
• Use either MKTB or MKPB, but not both 
• If logging CLKB, request for it before RGEB/RGEC/RGED 
• If no static data was collected, remember to enable the Make all epochs Kinematic 

option since it is important to make the epochs where the vehicle is moving 
kinematic 

• User may need to recompute position and time in GPBView if clock adjustment 
not available at start 

7.3.13   NovAtel OEM4 
Decode data from NovAtel's OEM4 product line. 
 
Data Required 
Record Type Comments 
43 Measurement RangeB Expanded format 
140 Measurement RangeCmpB Compressed 
64000 Measurement Waypoint Ultra Compressed * 
* Please obtain OEM4 on-board program from Waypoint. 

 
Additional Records Supported 
Record Type Comments 
73  AlmanacB 
42  BestPosB Position info 
8  IonUtcB Iono correction and UTC offset 
181  MarkedPosB Position of event (no time) 
71  PRPCLKMODELB clock info 
41  RAWEPEMB Ephemeris 
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231  MARKTIMEB Event time 
74  RAWALM Raw almanac data 
 
Options 

 

 
Figure 7.16 NovAtel OEM4 Dialogue Box 

 
Make all epochs Kinematic Use this to make every epoch kinematic, otherwise, will 

be static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Re-compute position and 
clock offset 

GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 
 

Report L2 cycle slips Alerts the user of phase loss of lock problems in the 
status window 
 

Verbose messaging mode Allows the user to see additional warning messages 
 

Ignore measurement 
validity check 

Utilizes more measurements by ignoring NovAtel data 
validity checks 
 

Write new GPB format Converts data into the new GPB format 
 

Extract BDS data to .imu 
file 

Extracts inertial data if available 
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Time tolerance for 
synchronizing BESTPOS 
and RANGE records 

Assigns position to GPB record if time difference 
between measurement and position record less than 
tolerance.  Note, decoder uses measurement record to 
compute record and save to disk 
 

Factory Defaults Restores original settings for conversion process 

7.3.14   RINEX 
The CONVERT utility will change the RINEX format into the .gpb format.  RINEX 
(Receiver INdependent EXchange) is a format that uses ASCII in two files for 
measurement and ephemeris data.  The .nav/.yyn file contains the ephemeris data while 
the .obs/.yyo contains the GPS measurement data for each epoch.   
 
RINEX is a very flexible format and it has been sometimes interpreted differently by 
various receiver manufacturers, software developers and government agencies, which 
produce RINEX files.  Due to this reason, RINEX has occasionally caused problems, and 
sometimes the altering of options is necessary to get the RINEX files to convert properly. 
 
The RINEX decoder also supports Hatanaka/Compressed RINEX observation files. 
 
Data Required 
File Type Comments 
.yyo (i.e.*.99o), *.obs, .0?o, 
*.rxo, *.0?d 

Measurements  

.yyn (i.e.*.99n), *.nav, 
*.rxn 

Ephemeris  
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Options 
 

 
Figure 7.17 RINEX Options Dialogue Box 

 
General Options  
 Make all epochs Kinematic Use this to make every epoch 

kinematic, otherwise, will be static; use 
ViewGPB to switch individual or 
groups of epochs between static and 
kinematic 
 

 Use new GPB format Converts data into the new GPB format 
 

 Write OBS file header 
information to message log 
and .sta file 

Saves content of observation file header 
to message log and station file.  Can be 
useful for determining receiver and 
antenna type 
 

 Show cycle slip messages Prints L1 and L2 cycle slip messages to 
message log 
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 Use APPROX_POS in 
header for each position 

Uses approximate position in 
observation header for each epoch's 
position 
 

Advanced Options  
 GLONASS PRN offset Shifts PRN number of GLONASS 

satellites by this number (>32) 
 

 Shift time to user interval 
 

If data interval determination (from 
header or file scanning) fails, use this to 
correct data interval 
 

Doppler Source  
 Automatic/use D1 value 

 
Uses D1 value for Doppler or auto-
detect if missing; auto-detection will 
use Calculate from CA code for < 10 
second intervals, or otherwise Use 
ephemeris (static) 
 

 Calculate from L1 phase If the Doppler signal is missing or 
unstable, use L1 phase to calculate 
Doppler 
 

 Calculate from CA code If the Doppler signal is missing or 
unstable, use CA code to calculate 
Doppler; this will create fewer 
problems than the L1 phase method but 
velocity accuracies may be worse 
 

 Use ephemeris (static) 
 

Assume still site and compute Doppler 
from satellite velocities; Doppler will 
have SA effects (0.5 m/s) 
 

Receiver Specific  
 Reverse sign on phase 

(Trimble) 
Some RINEX older Trimble formats 
have the incorrect sign on the phase 
 

 Reverse Doppler sign 
(Trimble) 

Some RINEX older Trimble formats 
have the incorrect sign on the Doppler 
signal 
 

 Data has SV Clock applied 
(GRAMS) 

 

 Data has earth rotation 
applied (GRAMS) 
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 Receive time is GPS time 

(GRAMS) 
 

Ephemeris  
 Prompt user if RINEX Nav 

file is missing 
If a nav file is missing or has a different 
name than the obs file, the user will be 
prompted to select a different broadcast 
ephemeris 

 Use alternative ephemeris 
file 

User defines ephemeris path name 
manually; this will override the 
prompting for a missing nav file 

Factory Defaults Restores the original defaults for 
RINEX data processing 

 
Tips/Notes 
• Be sure that data interval is determined properly 
• Watch out for incorrect sign on carrier phase and Doppler 

7.3.15   Rockwell PLGR/MPE12 (Rockwell version only) 
CONVERT also decodes Rockwell Jupiter binary data into the .gpb files.  Older versions 
of Jupiter firmware did not make measurements on the even second; therefore to enable 
GrafNav to use the data, the measurements need to be skewed to the even second by 
using Doppler measurements.  Newer versions of the firmware can make the 
measurements on the even second if enabled so that skewing is no longer necessary. 
 
Data Required 
Record Type Comments 
1102 Measurement/Ephemeris To extract the ephemeris 

from the 1102 file, a record 
for each second is needed 

1000 Position Contains position and clock 
offset 

 
Options 
 

 
Figure 7.18 Rockwell Jupiter Options Dialogue Box 
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General Options  
 Make all epochs Kinematic Use this to make every epoch 

kinematic, otherwise, will be static; 
use ViewGPB to switch individual 
or groups of epochs between static 
and kinematic 
 

 Re-compute position and 
clock offset 

GrafNav requires clock shift for 
processing; if these are incorrect, 
unstable or missing from the original 
data file (i.e. no record row), use this 
option for the decoder algorithms to 
re-calculate 
 

Advanced  
 Reject measurements with 

SNR below tolerance 
Satellites with low CNO will not be 
decoded 
 

Factory Defaults  Restores the original settings to 
allow for processing 

7.3.16   Septentrio SBF 
Data from the Septentrio SBF format can be converted into GPB format. 
 
Required Records 
Record Type 
5889 * Measurement record 
5890 * Compressed measurement record 
5891 GPS Nav (Ephemeris) 
* Either record 5889 or 5890 is required. 
 
Supported Records 
Record Type 
5904 PVT Geodetic 
 

293 



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 
 
Options 

 

 
Figure 7.19 Septentrio Dialogue Box 

 
Make all epochs Kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 

Recompute position and 
clock 

GrafNav requires clock shift for processing; if these are 
incorrect, unstable or missing from the original data file 
(i.e. no record row), use this option for the decoder 
algorithms to re-calculate 

Use new GPB format Converts data into NEW GPB format 
Verbose messaging mode Allows the user to see additional warning messages 
Extract multi-antenna data Should only be used for multi-antenna applications 

7.3.17   Sirf Binary 
Converts binary data from Sirf GPS receivers or receivers using Sirf chipset. 
 
Data Required 
Record Type Comments 
28 Measurement Navlib measurement record 
2 Position  
15 Ephemeris  
7 Clock offset  
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Options 

 

 
Figure 7.20 Sirf Dialogue Box 

 
General Options  
 Make epochs Kinematic Use this to make every epoch 

kinematic, otherwise, will be static; 
use ViewGPB to switch individual 
or groups of epochs between static 
and kinematic 
 

 Verbose messaging mode Allows the user to see additional 
warning messages 
 

 Reject satellite 
measurements with low 
C/No 

Satellites with low C/No will not be 
decoded 
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 Re-compute receiver 

position and clock offset 
GrafNav requires clock shift for 
processing; if these are incorrect, 
unstable or missing from the original 
data file (i.e. no record row), use this 
option for the decoder algorithms to 
re-calculate 
 

 Reject epoch if receiver 
clock offset is missing 

Data is unusable if clock offset is 
missing.  However, clock offset can 
be re-computed using GPBView 
 

 New firmware version with 
different representation of 
double precision 

 

Time Alignment  
 Leave time raw Use for kinematic or single point.  

Master data can be interpolated on to 
remote using GPBCat 
 

 Adjust time to nearest 
interval 

Kinematic/code-only shift to a 
interval equal to base data interval 
 

 Interpolate to data interval 
(static only) 

Static only, interpolate Sirf data onto 
regular data interval 
 

Advanced Options  
 Move Point/Attribute to 

start and end of static  
Links Point only 

 Use alternate ephemeris file Use if ephemeris is missing but 
recompute or interpolation selected 
 

Factory Defaults  Restores the original settings to 
allow for processing 

 
Tips/Notes 
• Sirf does not measure on whole epoch; either master or remote must be interpolated 

to make work.  Contact Waypoint for help. 

7.3.18   Thales Download (B-File Format) 
CONVERT will decode Thales data downloaded using their receiver download utility.  
This data will have been logged into internal receiver memory.  Thales receivers such as 
the Super C/A, Sensor or G12 must use the Thales Real-Time format type in CONVERT 
(described in 7.3.19). 
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Data Required 
File Type  Comments 
Bssssayy.jjj Measurements  Measurement file where 

ssss = site name, a = 
session, yy = year, jjj = 
Julian day 

 
Additional Records Supported 
File Type Comments 
Essssayy.jjj Ephemeris GPS+GLONASS ephemeris
Sssssayy.jjj Station Static site info (antenna 

height) 
Dssssayy.jjj Station Kinematic station 

information 
PHOTO.DAT Event Mark Camera events; must be 

loaded by GrafNav directly 
 
Options 
 

 
Figure 7.21 Thales Download Options Dialogue Box 
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Ashtech Receiver Type Select the Thales receiver used to collect the data; 

if auto-detect does not work, try selecting your 
receiver type manually 
 

General Options  
 Re-calculate 

position and 
receiver clock 

Used to correct incompatible clock correction 
sometimes computed by a Thales receiver; it is 
suggested that this option be used since GrafNav 
requires clock shift for post-processing; GrafNet 
requires both position and clock shift 
 

 Detect 
static/kinematic 
from site name 
 

Looks in Thales B-File for data tagged as static or 
kinematic using (????) site ID 

 Make all epochs 
kinematic 

Use this to make every epoch kinematic, 
otherwise, will be static; use ViewGPB to switch 
individual or groups of epochs between static and 
kinematic 
 

 Ignore questionable 
L2 phase 
 

Allows for processing of highest quality L2 data 
only; enable this if KAR is having difficulties 

 Verbose messaging 
mode 
 

Allows the user to see additional warning 
messages 

 Write new GPB 
format 

Converts data into the new GPB format 

 Extract stations 
information from 
Ashtech 'D-File' 

Various Thales handheld controllers can output a 
D-File which contains information regarding 
features and antenna heights.  Enable this 
checkbox to utilize this information. 
 

UTC Options  
 Use the following 

UTC time 
(otherwise 
automatic) 
 

Changes the GPS to UTC time offset from the 
current nominal value to user defined value; this is 
normally used for GLONASS processing if no 
UTC is contained in the data 

 Correct GPS time 
in D-FILE for UTC 
offset 
 

Thales D-files can have GPS or UTC time; 
changes time to GPS if in UTC 
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Dfile Options  
 Chain Repeated 

Station Marks into 
1 Static Session 
 

Enabling this setting causes sessions repeated in 
the Seismark software to be combined into one 
session 

 Do NOT Chain 
Marks that are more 
than # seconds 
apart 

This value controls the time tolerance used in the 
previous setting.  Basically, if two static periods 
marked less than this time amount apart, they will 
be combined 
 

Factory Defaults Restores the original decoding options for Thales 
Download 

 
Tips/Notes 
• Antenna heights may need to be altered within the feature editor if not kept constant 

as the Thales format only allows one value 
• Re-calculate position and time may need to be used if many cycle slips exist 
• User may need to select receiver type manually 

7.3.19   Thales Real-Time 
This receiver type converts Thales Real-Time (DG16, G12 and Super C/A) data to a .gpb 
file.  The real-time data is formed when data is logged externally from the receiver using 
a utility such as WLOG (raw format) or another simple or custom data logger.  The DLL 
for this decoder forms two files: .gpb and .epp. 
 
Data Required 
Record Type Comments 
MBN (use one of the 
following measurement 
records) or 

Measurements Preferable record for G12 

MCA or Measurements  
MPC or Measurements Dual frequencies (i.e. Z12) 
MCL or Measurements L2 codeless 
MACM or Measurements Preferable record for G12; can 

facilitate high data rate 
applications of 10 or 20 Hz w/o 
bandwidth limitations 

ITA Measurements  G8 measurement record, code 
only 

CT1 Measurements C/A code 
CT2 Measurements C/A code, L1 carrier 
CT3 Measurements C/A code, L1 carrier, L1 doppler 
SNV Ephemeris  
PBN Position Marks end of record 
SNG Ephemeris GLONASS ephemeris 
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Options 
 

 
Figure 7.22 Thales Real-Time Options Dialogue Box 

 
General Options  
 Make all epochs 

Kinematic 
 

Use this to make every epoch kinematic, 
otherwise, will be static; use ViewGPB to switch 
individual or groups of epochs between static and 
kinematic 
 

 Recompute position 
and time 

GrafNav requires clock shift to perform data 
processing, while GrafNet needs the position 
record.  If the position record is not available, 
choose this option to use the decoder algorithms 
 

 Write new GPB 
format 

Converts data into the new GPB format 

 Decode MACM 
messages and ignore 
others 
 

New Ashtech measurement record; ignore other 
measurement records if both MBN/MCA and 
MACM records exist. 
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 Decode old-style 
MBN locktime 
(increments by one) 

Some older units (e.g. Sensor II) output the 
locktime with a different resolution.  Use this 
option to properly output the locktime value. 
 

Parthus MACM Settings 
 

 

 Decode Parthus style 
MACM record 
(NS100/GSU-#) 

Parthus units (NS100, GSU-1 and GSU-2) utilize 
the MACM record.  However, due to timing 
differences, its implementation is not compatible.  
Therefore this checkbox should be selected. 
 

 Interval The GSU-1 benefits greatly by having the correct 
data interval entered, while the GSU-2 is best 
processed with the raw time and having the base 
interpolated onto these times (see GPBCat) 
 

UTC Offset for GLONASS 
decoding 

 

 Use the following 
UTC offset for 
decoding 
 

Allows the user to define their own UTC offset 
rather than using the nominal or detected value; 
needed for GLONASS processing 

Alternate Ephemeris (.EPP 
format) 
 

 

 Use alternate 
ephemeris 

Utilize this option if recompute is selected but 
there are ephemeride missing (e.g. Parthus, GSU-
2) 
 

Factory Defaults Restores the original settings for Thales Real-
Time 

7.3.20   Thales DNSP 
 
Data Required 
Record Type Comments 
Measurement Q (hex 51) Measurements Receiver time record 

(recommended) 
Measurement R (hex 52) Measurements Satellite time record 
Measurement E (hex 45) Ephemeris  
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Options 
 

 
Figure 7.23 Thales DNSP Options 

 
Make all epochs Kinematic 
 

Use this to make every epoch kinematic, otherwise, will be 
static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Recompute position and 
time 

GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 
 

7.3.21   Trimble DAT 
This utility converts Trimble 4000 – 5800 data to Waypoint’s custom format by forming 
a .gpb and .epp file.  The Trimble data files (.DAT) are formed when data  is logged 
internally in the receiver.  CONVERT should be able to handle most variations in the 
Trimble 4000 – 5800 series including event marks. 
 
Data Required 
File  Type Comments 
*.DAT Measurement/Ephemeris/ 

Station 
 

 
Options 
 

 
Figure 7.24 Trimble DAT Options Dialogue Box 
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Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Write new GPB format Converts data into the new GPB format 
 

Recompute position and 
clock offset 

GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 

Factory Defaults Restores the original settings of the decoder for processing 
 
Tips/Notes 
The antenna height extracted by the converter may be the slant distance which needs to 
be corrected to get the vertical distance.  Trimble SSF files must be converted to either 
.DAT or RINEX to be processed with GrafNav or GrafNet. 

7.3.22   Trimble Real-Time 
Data captured directly from a Trimble 4000-5800 receiver can also be converted to GPB 
using this decoder. 
 
Data Required 
Record Type Comments 
0x0 Measurement Concise and expanded 
0x1 Position  
0x2 Ephemeris  
 
Options 
 

 
Figure 7.25 Trimble Real-Time Dialogue Box 

 
Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
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Verbose messaging mode Allows the user to see additional warning messages 

 
Use new GPB format Converts data into the new GPB format 

 
Factory Defaults Restores the original settings of the decoder for processing 

7.3.23   Trimble TSIP 
Data in Trimble's TSIP format can be converted using this decoder.  Receivers include 
Ag20, MS-750 and MD-950. 
 
Data Required 
Record Type Comments 
0x9A Measurement  

Measurement With carrier 
0x5A Measurement Not suggested 

Position Single precision 
Position Double precision 
Ephemeris  

0x6t 

0x4A 
0x8A 
0x58 
 
Options 
 

 
Figure 7.26 Trimble TSIP Dialogue Box 

 

 
Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 

Verbose messaging Allows the user to see additional warning messages 
 

Reverse sign on receiver 
clock bias 

Opposite sign will be aplied to receiver clock bias 

Factory Defaults Restores the original settings of the decoder for processing 
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7.3.24   Trimble TIPY 
Used by Force 5 receiver. 
 

Record Type Comments 
Data Required 

0xAE Measurement  
0x84 Position LLA 
0x99 Ephemeris  
0x44 DOPS May not be used in post 

processing 
 
Options 
 

 
Figure 7.27 Trimble TIPY Dialogue Box 

 
Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Skew measurements to top 
of second 

Shift times to whole second to make differential possible * 
 
GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 
 

Verbose messaging mode Allows the user to see additional warning messages 
 
If ephemeris missing or imcomplete, use this setting to 
specify another ephemeris source file 
 

Re-compute position and 
clock offset 

Input alternate ephemeris 
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Shift (corrected) 
measurement time 

Apply time correction to measurements (used to correct old 
firmware bug) 
 
Restores the original settings of the decoder for processing Factory Defaults 

* consider also leaving raw and using GPBCat to interpolate Master to Remote times. 
Tips/Notes 
• Force 5 carrier phase may not be usable. 

7.3.25   U-Blox 
 
Data Required 
Record Type 
ID# 02 Position 
ID# 22 Clock 
ID# 10 Measurement 
ID# 31 Ephemeris 
 
Options 
 

 
Figure 7.28 U-Blox Options 

 
Make all epochs kinematic Use this to make every epoch kinematic, otherwise, will be 

static; use ViewGPB to switch individual or groups of 
epochs between static and kinematic 
 

Re-compute position and 
clock offset 

GrafNav requires clock shift to perform data processing, 
while GrafNet needs the position record.  If the position 
record is not available, choose this option to use the 
decoder algorithms 
 

Use New GPB Format Converts data into NEW GPB format 
 

Verbose messaging mode Allows the user to see additional warning messages 
 

Factory Defaults Restores the original settings of the decoder for processing 
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Chapter 8   Data Logging Utilities 
 
Section 1 discusses the Windows data logger, and Section 2 covers the new Windows CE 
data logger. 

 

 

 

Section 1   GPS Data Logger (Windows) 
Waypoint provides a WIN95/98/2000/XP/NT data logger, which currently supports 
NovAtel, Ashtech, Trimble, Marconi, Rockwell Jupiter, Javad (Topcon), Parthus CSI, 
Navcom, and Garmin receivers.  The data logger configures the GPS receivers, logs the 
measurement data and converts it into Waypoint’s GPB / EPP, measurement / ephemeris 
format.  Adjunct features include waypoint navigation, satellite and scatter plot 
capabilities.  In addition, stations and events can be marked and written to .STA files 
compatible for post-processing by GrafNav/GrafNet. 

The data logger is shipped with its own device driver for WIN95/98 users.  This driver is 
called WPCOMM.VXD and should be placed in your WIN95 System Directory or in the 
current directory from which the data logger runs.  On Windows 2000/XP/NT machines, 
the data logger uses the 2000/NT device driver. 

8.1.1   Getting Started 
To start using WLOG you simply follow the New Project Wizard to begin logging data.  
The New Project Wizard can be started either from the menu options or “quick started” 
from the toolbar by selecting NEW.  Setting up a new project with the Wizard consists of 
the following steps: 

Step 1 of 10 
1. Choose File > New Project to start the wizard 
2. Type in a Project Name, if you wish to store data to disk. The Project File stores the 

various settings used for logging data.  Click Next once a project name has been 
selected. 
 

Step 2 of 10 
3. Select the appropriate receiver type. 
4. Select a data interval at which data will be recorded.  Note that this number is in units 

of data interval / second, thus a data interval of 0.5 means 2Hz. 
5. Select the appropriate Receiver Com Port. 
6. Check the “Request Camera Marks” box if you want camera marks.  Note this option 

is only available for certain NovAtel, Ashtech and Javad receivers, and will be 
disabled otherwise. 

7. The most common usage of the option “re-compute position” is to force your data 
logger to output position at the data interval that you specified.  Some receivers may 
log data at 10 Hz, but only output position at 1Hz. 
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Figure 8.1 Selecting Receiver Options 

 

9. If you are using network for receiving data from the GPS receiver, choose TCP/IP in 
the “Receive Data by” box.  Otherwise, select “Serial Port”. 

 

Step 3 of 10 
8. NovAtel and Ashtech receiver users have the option to send ASCII commands to the 

receiver.  This can be used to shut off commands or over-ride various receiver 
commands.  Refer to your receiver manual for information on these commands. 
 

Step 4 of 10 

10. If using serial communication to obtain data from the GPS receiver to your computer- 
select the computer com port that the receiver is connected to. 

11. Choose a baud rate from the list. 
12. Select the parity, which for most receivers is none. 
13. Select the bits for the receiver, which for most receivers is 8. 

 
Note:  Refer to your receiver manual if you are not sure about the baud rate, parity or 
the bits for the receiver. 

14. Choose the network protocol, and the port number.  If using MultiCast protocol, type 
in the Multicast group IP address.  UDP and Multicast protocols can be used for 
communication over local networks (i.e. within the same office), while TCP is used 
for wide area communication in the same manner as internet.  You must choose a port 
number which does not conflict with those reserved for standard network purposes.  
Numbers starting at 1024 are usually considered safe.  Ports can range to values of 
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65536.  For Multicast groups, both the sender i.e. the GPS receiver and the receiver 
i.e. the computer must have the same IP address.  For Win32, Multicast IP addresses 
range from 224.00.00.00 to 240.00.00.00.  Select Next to proceed to the next step. 

 

 
Figure 8.2 Computer/Receiver Configuration 

 
Step 5 of 10 
15. Select the radio button indicating how you would like the data to be saved.  Data can 

be saved directly in Waypoint format i.e. GPB files or the data can be saved to disk 
byte by byte and decoded later with Waypoint’s Convert utility.  

16. If you want the data to be saved to disk then enter an appropriate file name.  All data 
files will adopt the file prefix given in the Edit box seen above. 

17. Select if you want all the data to be logged or if you want data within a certain time to 
be logged.  Note if you are using defined start or end times then you will have to enter 
the GMT offset.  Select Next to proceed to the next step in the wizard. 
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Figure 8.3 Generating RTCM Corrections (Optional) 

 
Step 6 of 10 
18. RTCM-104 corrections are the updated differential corrections.  Check the “Output 

RTCM–104 Corrections” box if you want RTCM corrections to be displayed.  If you 
are not displaying RTCM corrections then you are finished the setup. 

19. Select the type of RTCM output you would like and the interval for each. 
Type 1: includes time, PRN, δρ and δρ rate. 
Type 2: has the last IODE (issue of data ephemeris). 
Type 3: gives position. 

20. Select the comport you would like to use for the RTCM output. 
21. Enter the base station coordinates for the Antenna. 

 

 

22. Select the baud rate. 
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Step 7 of 10 
 

 
Figure 8.4 Re-broadcast GPS data over a Network (Optional) 

 

24. Another optional feature of WLOG is the ability to send a GPGGA NMEA string out 
a secondary serial port of the computer – assuming another serial port is available.  
This would be useful in the case where some external device such as an echo sounder 
may require position input from GPS on its serial port. 

23. GPS data collected by direct link to the GPS receiver can be rebroadcast over a local 
or wide area network.  An example of this is as follows.  Computer #1 collects GPS 
data on a serial port from the GPS receiver.  It rebroadcasts this GPS data on 
Multicast port #5001, group IP 234.5.6.7 (see above).  Computer #2 is in a different 
section of the building and of course is not directly linked to the GPS unit.  Referring 
to Figure 8.4, Computer #2 elects to receive the re-broadcast data through TCP/IP on 
Multicast port #5001, IP address 234.5.6.7.  Thus 2 different computers in different 
locations can collect data from one GPS receiver and view that data in real-time, even 
though only one computer is directly linked to the receiver.  In principle, this 
technique can be used to re-broadcast data using TCP protocol over existing internet 
connections. 

 
Step 8 of 10 
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Figure 8.5 Output GPGGA NMEA strings (Optional) 

 

25. In the case of a base station occupation it is unlikely that waypoint navigation will be 
a useful feature.  If navigating with a roving receiver, inputting a list of waypoints to 
navigate to may be very useful indeed, as ROCKLOG will provide a text and 
graphical display of the distance and bearing from the current GPS location to the 
selected waypoint.  ROCKLOG will also display across and along-track information 
for navigation between any 2 selected waypoints. 

Currently only GPGGA is supported.  NMEA string descriptions can be found in the 
main PLGR manual. 
 
Step 9 of 10 
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Figure 8.6 Adding a Waypoint List 

 
Waypoints can be added in two ways.  Firstly, an ASCII file can be loaded with the 
format shown below.  The first element is a station descriptor of up to 7 characters, 
followed by latitude in degrees minutes seconds and longitude in degrees minutes 
seconds. 
 
NW  51 05 47.1005  -114 22 24.0872  0.000  
100  51 01 56.0795  -113 54 21.3452  0.000  
101  51 05 45.4863  -113 54 43.2827  0.000  

Alternately, waypoints can be added from the dialogue launched by the ADD button.  
These waypoints can be edited, removed and/or saved to a file of their own for later use. 

102A  50 57  1.6482  -113 53 12.8852  0.000  
 

 
Step 10 of 10 
26. The user can make requests for position, ephemeris, and satellite visibility records 

while logging.  They will be displayed on the main window. The user can also display 
the time in HMS in GPS time, UTC time, or Local time.  UTC and Local time require 
the number of leap seconds to be entered as UTC time is a non-linear time system, 
unlike GPS time.  For more information on leap seconds, please see  
http://tycho.usno.navy.mil/leapsec.html  
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Figure 8.7 Optional Records and Display Time 

8.1.2   Logging data 
Once a project has been opened and the COM port has been initialized, the GPS receiver 
will send binary data to your computer to be logged. The following screen as seen in 
Figure 8.8 should appear. 

 

8.1.3   Basic Logging Display 
The text appearing in the figure below should be fairly self-explanatory.  It should be 
noted that GPS time is not synched to UTC, currently by 13 seconds.  The Mode item 
appears as Static by default.  This can be changed to Kinematic by hitting the F3 key or 
using the Events Menu option.  This is important if the data is meant to be post-processed 
by our GrafNav/GrafNet modules. 
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Figure 8.8 WLOG Logging Data 

 
An extended logging display including waypoint navigation features can be invoked from 
the Plot menu option or from the Plot Tool button. 

8.1.4   Extended Logging Display 
The extended display has two functions.  The first is to display the azimuth and elevation 
of the satellites being tracked by the receiver and the second is to plot the current track of 
the static or kinematic antenna.  The scatter plot of a static antenna will basically be an 
indication of selective availability.  A more useful feature of the Scatter Plot window is 
that it allows the user to follow the track of a vehicle to waypoints read from a simple text 
file.  In Figure 8.9 below, the waypoints are indicated by triangles while the current 
position of the GPS receiver is shown as a dot.  The Zoom menu option or tool buttons 
allow you to set a scale, which is congruent with the situation that you are in.  The 
Waypoint Information box is invoked from the Display menu option. 

8.1.5   Using Waypoints  
An ASCII “waypoint file” must be loaded in order to plot waypoints on the screen.  To 
load an ASCII waypoint file, you must first build the file with a text editor.  Each line in 
the waypoint file must look like: 
 
Station_name  latitude(deg min sec)  longitude (deg min sec) 
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For instance, part of the file read in for the figure below is simply: 
 
NW   51 05 47.1005   -114 22 24.0872   
100  51 01 56.07954  -113 54 21.34525  
101  51 05 45.48627  -113 54 43.28268  
and so on……. 
 
To actually load the waypoint file, look under the file menu option or click on the Load 
Waypoints tool button. 
 

 
Figure 8.9 Loading Waypoints 

 
It can be seen from the Waypoint Information Box that the current To Waypoint is station 
100, while the current From Waypoint is station 101.  The distance and bearing that must 
be traveled from the current receiver position to station 100 is 9533 m at an azimuth of 
50.9 degrees.  If one was to attempt to drive in a straight line from station 100 to 101, it 
can be seen that the current dot on the screen is 7746 m left of line.  The along track 
distance indicates that there are 12656 m left to travel along the line. 
 
To dynamically choose To and From Waypoints from the ASCII waypoint file, choose 
the Events / Next Waypoint menu option or click on the Choose Waypoints toolbutton or 
hit the F6 key. 
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8.1.6   Marking Events 
Currently, two kinds of events can be marked.  The first event is the Static/Kinematic 
mode sequence, which indicates that the antenna is either motionless or static.  The 
second is the Station Mark Event, which allows the user to mark the GPS time at which 
the antenna was over some significant point.  The static/kinematic marks are placed both 
in an ASCII .STA file, and in the binary GPB measurement file.  The data logger creates 
these files for each project you have.  The station marks are placed in the ASCII .STA 
file.  GrafNav/GrafNet will read the station marks in the .STA file and plot these in the 
GrafNav environment. 
 

 
Figure 8.10 Station Marks 

 
The information in the dialogue box shown above is stored in the ASCII .STA file.  Note 
that the GPS time in the status bar of the dialogue box is the GPS time current at the time 
that the dialogue box has been invoked by hitting the F5 key or using the Events menu 
option.  The Mode has been toggled to Kinematic by hitting the F3 key or using the 
Events / Static/Kinematic menu option. 

8.1.7   Output Files 
If a project name has been entered into the Log Data? dialogue box, the data logger will 
output measurement files in Waypoint’s binary .GPB format, ephemeris files in an ASCII 
.EPP format and .STA files which are ASCII files associated with event marks. 
 

Section 2   GPS Data Logger (Windows CE) 

8.2.1   The CE Data Logging Software 
There are 3 components to the WinCE data logger.  CELOG.EXE which is the graphics 
interface, SIOGPS.DLL which performs serial/network communications and data 
decoding and VARDISP.WPD.  VARDISP.WPD is a script file which can be built or 
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modified with a text editor to enable the user to build or change their own text display 
windows. 

To install the CE data logging software, you must simply copy three files to the root 
directory of your CE device using Active Sync or whatever generic file transfer service is 
provided to you by the CE manufacturer.  The three files required are CELOG.EXE, 
SIOGPS.DLL, and VARDISP.WPD.  For those users who wish to display State Plane 
coordinates, STPLN83.BIN will also be required in the root directory. 

 

 
CE data logging devices come in a variety of flavours.  They have different CPU’s and 
form factors.  This makes a generic data logger very difficult to write.  CELOG has been 
developed on the TDS Ranger - a CE unit which has a 320x200 screen pixel size and an 
ARM processor.  CELOG and SIOGPS can be compiled for other CPU’s.  The 
VARDISP script file allows the user to define text display windows with an ordinary text 
editor.  This will allow each user to custom build text screen output windows to fit their 
display size.  The VARDISP file and script format are described Section 8.2.6  Building 
or Modifying the VARDISP Script File to Display Data, which will focus on getting 
started with the features of the CE data logging software. 

8.2.2   Installing the CELOG Logger 

8.2.3   Getting Started with CELOG 
1. Following installation of the three files mentioned above, click on CELOG.EXE.  
You should see the following display (more or less depending on the CE device): 

 
Figure 8.11 Initial CE Logger Display 

 
2. Choose New Project (the first toolbutton) to start and build a new project file.  
The project file will be stored as a .IN file.  If you have an existing project, use the 
Existing Project toolbutton (the second toolbutton). 
 
The New Project toolbutton launches a Wizard which guides you step-by-step through 
the process of creating a project.  The Wizard becomes a Property Sheet when choosing 
the Existing Project mode.  For the sake of simplicity, the pages of the New Project / 
Existing Project are presented below in Property Page mode.  The explanation of each 
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page is valid whether you are choosing a New Project or Editing an Existing Project.  
Note that you can Edit an Existing Project while logging data by hitting the Existing 
Project toolbutton.  To start another new project, you must quit CELOG and start it up 
again. 
 

2a)  Type in a name for this project.  The given name will end with a .IN suffix.  All 
of your chosen parameters will be stored in this file.  You can bring the Project file up 
for quick starting another GPS data collection session.  If choosing Existing Project, 
you may want to change the Log File Name to make sure that you do not overwrite 
existing files. 

 

 
Figure 8.12 Enter a Name for this Project File 

 
2b)  Choose one of the supported receiver types.  Make sure to enter the data interval 
that you wish to log at.  Also, you are given a choice of whether to utilize one of two 
serial ports on the GPS receiver (provided the unit has multiple ports). 

 
CELOG will send the necessary configuration commands in order to force any of the 
given receivers to send measurement and position data out the chosen port.  This binary 
data will be decoded by CELOG into Waypoint’s GPB format or can be stored as is byte 
for byte to disk.  The byte for byte data can be decoded later from the GrafNav/GrafNet 
environment. 
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Figure 8.13 Choose a Receiver Type 

 
2c)  The third step in starting or editing a project may be skipped for any receiver 
type that does not support an ASCII command set.  However, NovAtel and Ashtech 
receivers support ASCII commands.  Any extra commands which CELOG does not 
send the receiver may be entered here.  CELOG will send its normal configuration for 
that command set and then transmit any extra commands typed here.  Below is an 
example for the Ashtech G12 receiver. 

 

 
Figure 8.14 Adding an ASCII Command to Send to an Ashtech Receiver 

 

320 



Chapter 8  Data Logging Utilities 

2d)  Setting up the serial or network communication parameters for logging data from 
the GPS unit is an important step.  In most cases, data transfer will be via serial cable.  
8 bits, no parity is assumed.  Baud rates up to 115200 baud are supported. 

 

 
Figure 8.15 Setting the COMM Parameters 

 
Note that TCP network protocol is also supported in the event that GPS data is input via a 
standard network connection. 
 

2e)  The fifth step in starting or modifying a project is to enter a name for the data 
files that you wish to store for post-processing. 

 

 
Figure 8.16 Choose a Prefix for the GPB,LOG,STA,EPP Files 
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Note that you may wish to “quick start” CELOG by using existing project with the same 
project file, but it is likely that you will need a different name for your data files as saved 
to disk.  CELOG saves three different files. 
 
Either a GPB or a LOG (Raw) file will be saved containing the measurement and position 
information generated by the receiver.  This depends on your choice in the above wizard 
page.  LOG files contain simply whatever comes across the serial or network port.  These 
have to be decoded later from the GrafNav environment.  GPB files are files decoded in 
real-time into Waypoint’s proprietary binary format. 
 
STA files are ASCII files generated from the CELOG environment by marking stations.  
Station marks contain the GPS time that a station was occupied and information 
regarding that point. 
 
EPP files are ASCII files containing ephemeris information as transmitted by the 
receiver. 
 

2f)  CELOG supports a number of different coordinate grids.  Please note that 
currently these are only supported in the WGS84 datum. 

 

 
Figure 8.17 Choosing a Framework for Coordinate Output 

 
Geographic coordinates are always available from the GPS receiver, however depending 
on the gird chosen, geographic coordinates can be converted in real-time to UTM, TM or 
the State Plane coordinate systems.  Please notify CELOG whether you are in the 
northern or southern hemisphere prior to reading in a waypoint file. 
 
If you are reading in a waypoint file or entering waypoints manually, CELOG assumes 
that the grid chosen above will also be the coordinate framework associated with your 
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waypoint file.  For the example shown in Figure 8.17, CELOG will assume that any 
waypoint file will be in UTM north and east. 
 
The VARDISP.WPD file allows display of a “north” and “east” variable.  These values 
will be associated with the grid coordinate frame chosen in this dialogue box. 
 

2g)  If a coordinate frame is defined as anything other than simple geographic, that 
grid must be defined with relevant parameters.  This is accomplished through 
invoking the Units Property Page and the property page corresponding to the chosen 
coordinate reference: 

 

 
Figure 8.18 Gird North / East Can be displayed as Meters, Feet or US Feet 

 
If UTM grid coordinates are desired, just enter your zone number.  To calculate a UTM 
zone number from a Central Meridian use: 
 
Zone_number = (CM +183) / 6 
 
For instance, for CM –117, the zone number is 11. 
 
For specific TM or Transverse Mercator grids such the 3TM grid, a number of 
parameters must be known, as shown in Figure 8.19. 
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Figure 8.19 UTM only Requires a Zone Number 

 
NAD83 State Plane coordinates can be converted from geographic or read in from a 
waypoint list simply by choosing the State Plane zone that you are concerned with. 
 

 
Figure 8.20 Choose a State Plane Zone 

 
Please note: STPLN83.BIN must be in the root directory of the CE device.  NAD27 
is NOT currently supported. 
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2h) Waypoint lists can be entered manually at the window shown in Figure 8.21, and/or 
read in from ASCII files created by a text editor.  Any waypoints so entered can be 
removed or edited.  The modified file can be saved to disk. 

 

 
Figure 8.21 The Waypoint Property Page 

 
Waypoint File Formats: 
Waypoint files are simple ASCII files.  Geographic coordinates can be entered as 
degrees, minute, seconds or decimal degrees.  UTM, TM or State Plane coordinates can 
be entered in meters, feet or US Survey Feet.  Examples are given below: 
 

a) Example Waypoint File – Geographic, degrees, minutes seconds 
 
$WAY GEO 
NW  51 05 47.1005  -114 22 24.0872   
100  51 01 56.0795  -113 54 21.3452  
101  51 05 45.4863  -113 54 43.2827  
 

b) Example Waypoint File – Geographic, decimal degrees 
 
$WAY GEO 
       ant-a     51.00000000  -114.00000000 
       ant-b     50.97861111  -114.01166667 
 

c) Example Waypoint File – UTM Coordinate Input 
 
$WAY UTM 
          NW   5663828.559   683914.631 
          100   5657966.778   716937.210 
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Note that the UTM Zone is defined in the corresponding project (.IN) file. 
 

d) Example Waypoint File – State Plane Coordinate Input 
 
$WAY ST 
          NW    462374.437  3211340.969 
         100    475344.388  3245597.245 
 
Again, the State Plane zone is defined in the associated project file. 
 
Waypoints can also be entered manually using the ADD button.  Any list of waypoints 
can be saved using the SAVE item. 
 

2i)  The final page of the start-up wizard allows the user to define a static 
occupation period.  This feature would typically be used for a tree cover survey where 
you would like to place some static occupations in a kinematic survey.  Static 
occupations of at least 2 minutes are recommended for surveys under tree canopy.  The 
static occupation feature displays a dialogue box during data logging which indicates a 
“count-down” until the session is finished. 
 

 
Figure 8.22 Survey Modes 

 
Continuous static/kinematic is the normal mode of operation where the surveyor would 
perform a static occupation to start and then go to kinematic status for the remainder of 
the mission.  Any marked points would be marked while in kinematic mode and typically 
occupied for only a few seconds.  Occupation mode allows the user to set up at a station 
for some given length of time.  At the end of the n minute period, CELOG shows the user 
a dialogue box which prompts the user to quit the static session and go directly back to 
kinematic mode. 
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8.2.4   The Variable Display File (WPD File) 
There are 3 components to the WinCE data logger: 
 

• CELOG.EXE: the graphics interface 
• SIOGPS.DLL: performs serial/network communications and data decoding 
• VARDISP.WPD: a script file which can be built or modified with a text editor to 

enable the user to build or change their own text display windows. 
 
The reason for allowing users to build or modify display windows is that a number of 
different screen sizes are used by various manufacturers of CE products.  Hand-held CE 
units tend to be 320x200 pixels or alternately 200x320 pixels.  Palm-top CE devices are 
usually in the order of 640x200 pixels.  Other variations may exist. 
 
The VARDISP script file not only defines the text display for CELOG, but can be 
modified by the user to display a given list of variables in any position on any defined 
window.  By definition CELOG only allows the user to display one window at a time.  
The window size is the default window size given by the CE device being used. For 
instance, those owning CE units with 200x320 displays may wish to output variables 
which are ordered in long columns and short rows.  Alternately, users with 320x200 
displays may wish to build windows which display items as long rows with relatively 
short columns.  Users can modify VARDISP.WPD with a text editor to accomplish this. 
 
The list of variables which you are allowed to display is set at the bottom of the 
VARDISP file.  Do not change this variable list.  Variable which are allowed in the text 
display window are listed below with a short definition of each. 

8.2.5   Variables Given in the VARDISP File 
The following variables can be invoked by the user for use in any text window that they 
wish to define.  Note that the variables below are NOT case sensitive in the context of 
CELOG.  For instance, the user can type in the Gpstime variable as “GPSTIME”, 
“gpstime”, or “GpsTime” in the VARDISP.WPD file.  CELOG will not care. 
 

• Gpstime -GPS seconds of the week 
• Latitude - Latitude in degrees, minutes, seconds 
• Longitude - Longitude in degrees, minutes, seconds 
• Height -  Elevation as output by the GPS receiver 
• Epochs – Number of measurement epochs since data collection started 
• Diskspace – Number of free mgbytes remaining on your device 
• Elev – Elevation of the satellite in degrees above the local horizon 
• Prn – PRN number of the given satellite 
• Az – azimuth of the satellite in degrees with respect to local north 
• Locktime – number of seconds of valid phase lock for a particular PRN – resets to 

0 on loss of lock 
• East – Easting as given by the defined grid.  Grids can be UTM, TM or State 

Plane 
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• North – Northing as given by the chosen grid 
• Tosta – If waypoints have been entered or read in from a file, this is the chosen 

waypoint ID which you are navigating to 
• Fromsta – If a waypoint list is present, this is the waypoint you are navigating 

from.  The line between the Tosta and the Fromsta defines an along track / across 
track reference frame 

• Acrosstrack – the distance left or right of a line joining the current Tosta and 
Fromsta waypoints 

• Alongtrack – the distance along a line given by the Tosta and Fromsta 
• Todist – the current distance from your position to the chosen Tosta waypoint 
• Toaz - – the current azimuth from your position to the chosen Tosta waypoint 
• Surveymode – static or kinematic.  You must define this from the CELOG menu 

or toolbar if you are performing kinematic surveys 
• Station – If marking a point for static or kinematic occupation, this will be the 

name that you give to that marked point 
• Static_epoch – If using Occupation Mode for marking a station, this is the number 

of measurement epochs that the user has occupied that station 
 
Once again, please do not edit the variable list in the VARDISP.WPD file. 

8.2.6   Building or Modifying the VARDISP Script File to 
Display Data 
CELOG is meant to present one text window at a time to the viewer.  The text windows 
are defined completely by the window elements in the VARDISP.WPD script.  If the file 
is not present or corrupted, you will not get a display.  These text windows can be 
changed during operation of CELOG by pressing the side arrow keys on the keyboard or 
the toolbar.  The content of the windows is defined by the user through the script file both 
in terms of which variables are displayed and where those variables are placed within the 
window region.  All of the following rules must be followed exactly, if you wish to build 
or modify your VARDISP file with a text editor.  Modifying the VARDISP file may be 
useful or even necessary depending on the Win CE device screen size that you have. 
 
1. Defining a New Window 
 
Up to 12 text windows can be created in VARDISP.WPD.  Each new window is built by 
using the following form: 
 
DISPWINDOW { 
 
} 
 
Remember these are text windows only.  They are designed to display the variables listed 
above in any particular format as designed by the writer. 
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2. To Define a Window Title 
 
Each window may have some theme as given in the title.  To add a title to a new window 
use: 
 
DISPWINDOW { 
Title:  “My Position Information Window” 
} 
 
3. To define a line of text, add the Line command: 
 
DISPWINDOW { 
Title:  “My Position Information Window” 
Line:  $”Latitude:” 
} 
where the $ indicates text to follow.  The text must be enclosed in double quotation 
marks.  The $“  “ format allows the use of spaces with text.  Spaces may be interpreted as 
delimiters by some basic C programming functions.  In this case, we would like to use the 
spaces as part of the text string to be displayed. 
 
4. To Embed a Variable or Variables in a Line of Text 
 
DISPWINDOW { 
Title:  “My Position Information Window” 
Line:  $”Latitude:”  &latitude 
} 
 
where the & sign MUST be followed by one of the variable names given in the list above.  
Variable names are NOT case sensitive.  &latitude and &LATITUDE are equally valid. 
 
5. To Separate Variables or Text Strings by Spaces 
 
DISPWINDOW { 
Title:  “My Position Information Window” 
Line:  $”Position:”  &latitude $”       “ &longitude #s#s#s#s#s &height 
} 
 
Spaces can be defined as text strings by using a line of text as $”      “ or spaces can be 
given by type in #s#s#s, where each “#s” represents one space.  In the example above the 
text word “Position:” will be displayed in the My Position” window followed by the 
current latitude, longitude and height i.e.: 
 
Position 51 00 43.652      -114 00 42.234     1015.45 
Is output by the CELOG program. 
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6. Separating Variables or Text by Tabs 
 
Using spaces as delimiters is not as exact as using TABS.  Single tabs can be used in the 
VARDISP script by simply inserting a TAB of 4 spaces using a “%t” format: 
 
DISPWINDOW { 

Line:  $”Latitude:”  &latitude  %50t &prn[0] %t &locktime[0] 

 

Title:  “My Position Information Window” 
Line:  $”Position:”  &latitude %t &longitude %t &height 
} 
 
Once again, 
 
Position 51 00 43.652    -114 00 42.234    1015.45 
 
Is output by the CELOG program in the “My Position Information” window. 
 
7. Separating Variables or Text by Percent Screen Sizes 
 
One of the most exact ways of delimiting text is to organize text and associated variables 
in columns which start at certain percent values ACROSS the screen.  For example you 
may wish to start displaying a certain column of variables exactly ½ way across the 
current window i.e. 50% of the way across the screen.  For example: 
 
DISPWINDOW { 
Title:  “My Position Information Window” 
Line:  

Line:  $”Longitude:”  &longitude  %50t &prn[1] %t &locktime[1] 
Line:  $”Height:”  &height  %50t &prn[2] %t &locktime[2] 
Line: $”” %50t &prn[3] %t &locktime[3] 
Line: $”” %50t &prn[4] %t &locktime[4] 
Line: $”” %50t &prn[5] %t &locktime[5] 
Line: $”” %50t &prn[6] %t &locktime[6] 
} 
 
In the example window above, the first column of values are single variables such as 
longitude and height.  These variables are displayed in the first column of the window.  
The PRN numbers are output half way across the window in a column and their 
corresponding LOCKTIME values, one tab from the PRN numbers. 
 
Note that the second column that is the %50t column must be preceded by any value 
including a space in the first column. 
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8. Displaying Array (Channel) Variables versus Single Item Variables 

DISPWINDOW { 

 
Variable such as latitude, longitude and height are defined here as single item variables.  
On the other hand, values given to prn numbers, locktimes, azimuth and elevation and so 
on are per channel variables.  These are given in arrays – up to 12 values corresponding 
to each channel of a 12 channel GPS receiver. 
 
Array or channel variables can be output in two ways.  The first method is to simply 
define the channel variable by its name with no index.  For example let us add another 
window to the VARDISP file. 
 
DISPWINDOW { 
Title:  “My Channel Information Window” 
Line:  $”Prn     Azimuth    Elev    Locktime “ 
Line: &prn %t &az %t &elev %t &locktime 
} 
 
The above window will automatically display all n channels at each epoch.  CELOG will 
recognize the variable prn, az, elev and locktime as array variable requiring n channel 
rows to be displayed. 
 
Note that you can not put %t’s in the sub-title string,(Prn  Azimuth..etc) but must 
space this header “manually”. 
 
The second method of outputting per channel variables to a text window is to define each 
element of the channel array variable explicitly with a zero-based index.  An example of 
this is seen in one of the previous Position Information windows.  
 

Title:  “My Position Information Window” 
Line:  
Line:  $”Latitude:”  &latitude  %50t &prn[0] %t &locktime[0] 
Line:  $”Longitude:”  &longitude  %50t &prn[1] %t &locktime[1] 
Line:  $”Height:”  &height  %50t &prn[2] %t &locktime[2] 
Line: $”” %50t &prn[3] %t &locktime[3] 
Line: $”” %50t &prn[4] %t &locktime[4] 
Line: $”” %50t &prn[5] %t &locktime[5] 
Line: $”” %50t &prn[6] %t &locktime[6] 
} 
 
Of a possible 12 channels, only 7 (0 – 6 inclusive) are explicitly output to the text screen.  
For those users with CE screens which are wider than longer, you may wish to display 
array variables as: 
 
DISPWINDOW { 
Title:  “My Channel Information Window” 
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Line:  $”Prn” &prn[0] %t &prn[1] %t &prn[2] …… %t &prn[n]“ 
Line:  $”Locktime” &locktime[0] %t &locktime[1] %t &locktime[2]   %t  &locktime[n]“ 
} 
 
This will display at most n channel values across the page with one tab delimiting each 
variable.  Each line is prefaced in the first column with a text string indicating the nature 
of the variable.   
 

 
Figure 8.23 Typical Window Created from the VARDISP Script 

 
See Below for the Actual Script Used 
 
DISPWINDOW { 
Title: "Position Info " 
Line: $"GpsTime   :" %35t &GpsTime     %70t $"Prn"  %t $"Lock" 
Line: $"Latitude    :" %35t &latitude  %70t &prn[0] %t &Locktime[0] 
Line: $"Longitude :" %35t &longitude   %70t &prn[1] %t &Locktime[1] 

Line: $"DiskSpace  :" %35t &diskspace   %70t &prn[6] %t &Locktime[6] 

Line: $"Height       :" %35t &height   %70t &prn[2] %t &Locktime[2] 
Line: $"Grid North :" %35t &north       %70t &prn[3] %t &Locktime[3] 
Line: $"Grid East   :" %35t &east       %70t &prn[4] %t &Locktime[4] 
Line: $"SurveyMode :" %35t &surveymode %70t &prn[5] %t &Locktime[5] 

Line: $"" %70t &prn[7] %t &Locktime[7] 
Line: $"" %70t &prn[8] %t &Locktime[8] 
Line: $"" %70t &prn[9] %t &Locktime[9] 
} 
 
Note that lines in the window can be COMMENTED OUT, by prefacing the Line: with a 
semi-colon.  CELOG will ignore these lines.
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9.1.1   .FML or .RML File 

Section 1   Output Files 
This section discusses some of the different output files that are created by GrafNav. 

The message log file simply echoes all error and warning messages sent to the message 
window during processing.  Some common example messages are shown and explained 
here. 
 
Reading ephemeris files... 
Processing ephemeris file 'C:\GPSData\urk_.epp' 
Detected 40 GpsEph, 0 GlonassEph, 0 GpsIono and 0 GpsAlmanac records 
This message is shown at the start of the file.  It's a good message to check to see how 
many ephemerides were loaded. 
 
Best base on BL1 is PRN 17 with 4 points and elevation of 62.1 degrees 
Second best on BL1 is PRN 16 with 2 points and elevation of 51.7 degrees 
This message indicates the base satellite (and its elevation) selected after a base change or 
at outset.  The second best base is also shown.  Base satellite selection is based on a point 
system that includes a number of factors such as elevation above the horizon, whether it 
is rising or falling, and ambiguity determination accuracy. 
 
Prn 15 dropped out for 2.0 s on baseline BL1--ambiguity reset 
Prn 23 dropped out for 2.0 s on baseline BL1--will try to save ambiguity 
These message are displayed when an individual satellite drops out for a short period.  
Whether the first or second message is displayed depends on if the 'Save ambiguities on 
satellite drop-outs' check box is selected under the Advanced option.  For some data sets, 
this saving process may be folloed by data errors ($$$).  In such a case, try de-selecting 
this option. 
 
Detected bad Phase measurement. Rms is 2.091 m (Worst Prn is 10 on B/L BL1 with 
residual of 2.325) 
This is almost always caused by one or more undetected cycle slips.  In most cases, the 
software will be able to correct for the problem by removing the affected cycle slip.  If 
not, a cycle slip will be induced to all satellites. 
 
Skipped 83 epochs or 76.1 % due to long distance (used 26 epochs or 23.9 %) 
This message shows up if the KAR option 'Utilize all data whose distances are less than 
tolerances' is enabled.  It indicates what percentage of the data is shorter than distance 
tolerance – hence it is used. 
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Performing KAR search at 525 seconds on baseline BL1 
KAR used 525.0 s (PASS) with average of 7.1 sats over average distance of 21.9 km 

KAR failed on baseline BL1 after 30.1 minutes--too much time used and starting 
over 

 

RMS is 0.0809 cycles (FAIL), Reliability is 1.2 (FAIL), Float/fixed sep. is 0.47 m 
(PASS) 
KAR failed 2 out of 4 tests, will try again in 15.0 seconds 
Message printed for an unsuccessful KAR search.  Indicates various statistics. 
 

Printed if KAR went too long.  The tolerance is generally 30 min., and can be set from 
the KAR option. 

Note: KAR cannot be engaged at this distance (68.6 km) on baseline BL1 
Printed if distance too long for KAR to engage.  The software will wait until it gets 
closer. 
 
Epoch rejected due to poor satellite geometry--DD_DOP of 918.0 too large 
This message warns that an epoch has been rejected because of poor satellite geometry.  
The default DOP tolerance is 100.0.  This can be changed in the user defined options with 
the command DOP_TOL. 
 
Doppler L1 cycle slip on PRN 24 of 1575419.57 cycles on baseline BL1 
Indicates that a large change in carrier phase has been encountered which is interpolated 
as a cycle slip.  If this message appears continoually, the doppler may need to be 
recomputed (see Chapter 6  Section 3  GPBView). 
 
Locktime cycle slip on PRN 4 of -5.92 cycles on baseline BL1 
Cycle slip has been reported by base or remote receiver.  Size of cycle slip is on 
approximate. 
 
Inserted L1 cycle slip due to locktime reset for PRN 4 on baseline BL1 
Receiver cycle slip counter has reset at some time in the past but was not caught.  
Therefore, slip inserted now. 
 
Less that four satellites at startup--Will try next epoch(s) 
Software needs at least 4 satellites and good measurement quality at start.  It will 
continue until this goal has been achieved. 
 
Warning: Epoch with less than 4 good satellites (Cycle slips) 
This message warns about an epoch with less than 4 satellites.  Usually the result of cycle 
slips. 
 
Locktime cycle slip on PRN 26 of -41.31 cycles on baseline BL1 
Small L2 cycle slip on PRN 26 of 0.65 cycles on baseline BL1 
Both messages warn of cycle slips on L2.  The DPH is an indicator of the size of the 
cycle slip.  It shows the difference in phase.  If you have a lot of L2 cycle slips in your 
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data it will make for a bad ionospheric free solution.  If you have a lot of L2 cycle slips 
try using the relative ionospheric solution. 
 
Prn 15 is below mask angle of 10.0 degrees 
This message indicates that a satellite has gone below the elevation mask. 
 
Satellite 7 is rising or re-appearing 
This message is usually caused from a satellite on the horizon. 
 
*** KAR engaged due to total loss of lock 
*** KAR now engaged because distance became lower than tolerance 
'***' followed by a message indicates if and why KAR was engaged. 
 
Prn 27 disappeared for 33.0 seconds on baseline BL1 
Indicates that as satellite dropped out and is reappearing, a new ambiguity will be solved. 
 
Calculating fixed solution 
Calculating RMS values 
Continuous fixed solution reliability: 7.43 (PASSED), RMS: 0.0372 m (PASSED), 
STD: 0.0014 m 
Continous fixed solution position is: 39 01 23.54716, -84 36 21.25817, 259.7909 m 
Computing New Fixed solution 
This message shows the results from the multi satellite fixed solution.  The reliability is 
the ratio between the second best RMS and the best RMS.  The minimum reliability for a 
pass is 1.35.  The RMS is the RMS fit of the fixed solution.  This number is in meters and 
the maximum value to pass is 0.025 m + 1PPM for dual frequency and 0.015 + 1PPM for 
single frequency. 
 
Warning: No precise available for prn 21 
Message warns that precise ephemeris messing for a satellite.  You may want to try 
another precise ephemeris file (if available) to try and better the results. 
 
$$$ GPS data errors detected--will try and reject measurements, baselines or 
satellites 
Error messages starting with ‘$$$’ indicated bad carrier or code measurements 
encountered.  The above message should be following another message indicating what 
residuals are out-of-range and which satellite has the largest value.  This indicated 
satellite may not be the actual problem one because the Kalman filter distributes the 
errors around.  A number of tests will be performed to isolate the problem data and 
satellite.  Therefore, this message is followed by the messages shown below. 
 
C/A code tested OK (CaRms is 2.1 m)--The problem must be due to the carrier 
phase 
Indicates that the C/A-only tested OK and a problem is very unlikely to be a problem.  If 
the C/A was invalid then another message will be printed. 
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On code, worst PRN is 20, RMS is 1.46 m (PASS), reliability is 1.84 (FAIL) 
A further test on the combined code-carrier solution to ensure that the code is OK. 
 
On phase, worst PRN is 28, RMS is 0.0949 m (PASS), reliability is 1.19 (FAIL) 
This test will generally indicate if a missed cycle slip to other carrier phase problem was 
fixed by removing a particular satellite.  The above message indicates that the problem 
could not be fixed, and will generally be followed by a filter reset message.  See below.  
The reliability must be greater than 4.0 to be signaled as a pass.  You may wish to 
investigate the clock offset information (see GPBView) at this epoch to see if the 
problem epoch is due to an incorrectly computed clock shift. 
 
Could not fix Kalman filter by rejecting a satellite--Failed 2 out of 4 tests 
Unable to correct bad GPS data--issuing filter reset 
This message indicates that a data problem could not be repaired. 
 
$$$ Engaging filter reset--Accuracy is severily reduced 
This is printed when the filter reset is being engaged.  It should be preceded by a message 
indicating why the filter reset was issued.  A filter reset is when a cycle slip is issued to 
all satellites and the position is reset to startup values. 
 
*** KAR enaged due to occurance of filter reset 
Printed when a User-KAR record is being implemented and the ‘Engage Filter Reset’ 
flag has been enabled.   
 
Locktime and doppler cycle slip on PRN 30 of -307.64 cycles on baseline BL1 
Indicates that a cycle slip has occurred and it has been detected by both the locktime and 
a large changed in the carrier phase. 
 
%%% PRN 18 was omitted for time range 488400.0-488500.0 s on ALL baselines 
%%% ALL satellites were omitted for time range 8000.0-8100.0 s on baseline mast 
‘%%%’ followed by a message indicates when and how long a baseline and/or prn was 
omitted from processing. 
 
‘@@@’ followed by a message indicates if a position fix was processed.  Position fixes 
can originate from fixed static or from user entered remote initialization. 

9.1.2   .FSS or .RSS File 
The Static Session Summary file presents a summary of the float, fixed static and KAR 
processing.  The FSS file is created in the forward direction processing while the RSS file 
is created in the reverse direction.  You will find the project configuration and processing 
settings at the beginning of the file and return status at the end of the file.  The following 
is an example of the project configuration and processing settings. 
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------------------------------------------------------------------------- 
   Configuration and processing settings 

  Use Glonass    : No 

General Options: 

  Data Interval  : 30.00 s 

Advanced Options: 

    Static tol.  : 0.40 cycles 

  Write Sat Resid: Yes 

------------------------------------------------------------------------- 
 
Project settings: 
                   #  Antenna Type         AntHgt FileName........... 
  Master Info    : 01 Generic               0.008 C:\Temp\Test\carh1050.gpb 
  Remote Info    :    Generic               0.486 C:\Temp\Test\carr1050.gpb 
  Master Position: 01  35 53 18.17873 -120 25 50.94840  480.276  
  Broadcast Eph. : Automatic, (406 GPS and 0 Glonass ephemerides)  
  Precise Eph.   : (none) 
  Direction      : FORWARD 
  Process Mode   : Dual frequency carrier phase 
  Static Initial.: Fixed 
  Use KAR        : Yes 

 

  Elevation Mask : 10.0 degrees 

  Fixed Interval : 15.00 s 
  Time Range     : (use entire range) 
  Datum          : WGS84 using conversion 'WGS84 to WGS84 (Same)' 
  Split Static   : No 
 

  Base Satellite : (auto) 
  Model Tropo.   : Yes, using Saastamoinen model 
  Locktime Cutoff: 4.0 s 
  Use Doppler    : Yes 
  Dynamics Model : No 
  Cycle slip checking: 
    Doppler      : Yes, using 150.0 cycle tolerance 
    Locktime     : Yes 

    Save ambig.  : Yes, (on satellite drop-out) 
  Bad data control: 
    Filter Reset : Yes 
    Write Bad    : No, (Yes if epochs containing bad data to be written) 
    Skip Bad     : No, (Yes if epochs with bad statistics to be skipped) 
  Output Format  : Normal 

  Print Slip Warn: Yes 
 
Standard Deviation Options: 
  C/A StdDev     : 7.00 m 
  C/A Rej Tol    : 25.00 m 
  Carrier StdDev : 0.0200 m 
  Carrier Rej Tol: 0.1000 m 
  Doppler StdDev : 1.000 m/s 
  Doppler Rej Tol: 25.000 m/s 
  Additive PPM   : 1.0 ppm 
 
Dual Frequency Options: 
  Use P-Code     : No 
  Use L2 for Amb : Yes 
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  Iono Correction: No 
  Small L2 Slip  : 0.40 (tolerance) 
  Corr. Code Iono: No 
 
General KAR Options: 
  Minimum Time   : 1.00 minutes 
  Additive Time  : 1.50 minutes/10-km 
  Search Region  : Adaptive, using StdDev scale factor of 3.00 
  Maximum Time   : 30.00 minutes 
  Max. distance  : 30.00 km 
  Use More Data  : No, (if Yes, use all < max. distance) 
  Start in Static: No 
  Engage on Time : No 
 
Advanced KAR Options: 
  Strict Rel. Tol: Yes 
  Strict RMS Tol : No 
  Distance Weight: Yes 
  Fast KAR       : No 
  Fast KAR (5SV) : No 
  Refine L1/L2   : Yes 
  Maximum DOP    : 9.00  
  Engage Bad DOP : No 
  Data Filter    : 5.0 s 
  Exact Interval : No 
  Search Interval: 15.0 s 
  L2 Noise Model : AUTO, (iono. distance tolerance is 5.0 km) 
 
The processing settings will not be display if ‘Print input settings to static/KAR 
summary’ under the Advanced option is turn off.  The following is an example of the 
return status. 
------------------------------------------------------------------------- 
   Program finished, return status 
------------------------------------------------------------------------- 
Finish { 
        Status:    "SUCCESS" 
        RetValue:  -101 "Successful program completion--end time reached" 
        ErrMsg:    "Endtime Reached" 
        NumEpochs: 2781 
        UsageTime: 13.74 s 
} 
 
The file may look slightly different if static or kinematic processing is done.  In static 
output are the final coordinates and various statistics associated with those coordinates.  
In kinematic processing the KAR summary record is the only output.  If you’re doing 
kinematic processing without KAR you will not see these output in the .FSS or .RSS file.   
The following is the output satellite tracking list.  This output is only displayed on fixed 
static solutions.  It shows which satellites are tracked when, how long, and the status of 
the satellite.  The status is important because it will show if any satellites are rejected.  
This output can also be seen for all data types in the plot ‘Satellite Lock’. 
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PRN START END DT(SEC) BASE BESTRMS INDEX RMS
@0 

NUM
RMS 

NEP
OCH 

STATUS 

14 259220 273645 14425.0 21 0.012 0 0.012 2881 2881 OK 
20 271235 273645 2410.0 21 0.020 0 0.020 483 483 OK 
22 272315 273645 1330.0 21 0.020 0 0.020 267 267 OK 
29 259220 273645 14425.0 21 0.013 0.013 0 2881 2881 OK 
30 263495 273645 10150.0 21 0.013 0 0.013 2031 2031 OK 
7 298205 302400 4195.0 27 0.050 0 0.050 840 840 Rejected 
14 273660 279775 6115.0 0.018 25 0.018 0 1224 1224 OK 
28 279815 280650 835.0 25 0.047 0 0.047 168 168 OK 
 
------------------------------------------------------------------------- 
 Satelites used/rejected in New/multi-satellite fixed solution 
------------------------------------------------------------------------- 
 
PRN START END DT(SEC

) 
BAS
E 

BESTRM
S 

INDEX RMS@
0 

NUM
RMS 

NEPOCH
S 

STATUS 

14 259220 273645 14425.0 21 0.012 0 0.012 2881 2881 OK 
20 271235 273645 2410.0 21 0.020 0.020 483 OK 

1330.0 0.020 
0 

10150.0 
298205 0.050 Rejected 

279815 0.047 168 

        EndTime:     403315.00 1284  16:01:55.0 08/19/2004 

0 483 
22 272315 273645 21 0.020 0 267 267 OK 
29 259220 273645 14425.0 21 0.013 0.013 2881 2881 OK 
30 263495 273645 21 0.013 0 0.013 2064 2031 OK 
7 302400 4195.0 27 0.050 0 810 840 
14 273660 279775 6115.0 25 0.018 0 0.018 1224 1224 OK 
28 280650 835.0 25 0.047 0 168 OK 
 
Following are the final coordinates that are output in a static solution.  This is not seen for 
kinematic data.  The difference between the Fixed and Float output is the Fixed will have 
an RMS and Reliability output.  The RMS is the RMS fit of the fixed solution.  This 
number is in meters and the maximum value to pass is 0.025 m + 1PPM for dual 
frequency and 0.015 + 1PPM for single frequency.  The reliability is the ratio between 
the second best RMS and the best RMS.  The minimum reliability for a pass is 1.35. 
 
 ------------------------------------------------------------------------- 
    Final FIXED static position for Station STATIC_01, Base BL1 
 ------------------------------------------------------------------------- 
 
Static { 
        ToSta:       "STATIC_01" 
        FromSta:     "BL1" 
        IsBest:      Yes 
        AntHgt:      0.486 m 
 
        StartTime:   401050.00 1284  15:24:10.0 08/19/2004 

        TimeLen:     37 minutes, 45 seconds 
 
        Latitude:      51 08 19.52307 
        Longitude:   -113 32 25.26474 
        EllHeight:   965.8063 
        SolType:     L1-Fixed 
        IsFixed:     Yes 
        RMS:         0.0074 PASS    ; m 
        Reliability: 3.0    PASS    ; RMS ratio 
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        StdDev:      0.0005 0.0008 0.0009   ; m (e,n,h) 
        EcefVec:     5180.8939 -287.3737 1462.3952  ; m 
        EcefCov1:     2.47516461e-007 
        EcefCov2:     2.90900665e-008  3.64201228e-007 
        EcefCov3:     2.69447236e-008 -4.06613700e-008  9.45815104e-007 
        AvgDDDop:    3.39 

        SurfaceDist: 5390.183    ; m 

        AvgPDop:     1.70 
        AvgNumSats:  6.8 
        Quality:     1 
 
        SlopeDist:   5390.997    ; m 
        HorizDist:   5390.182    ; m 

        Azimuth12:    64 24 48.00207 
        Azimuth21:   244 28 02.69245 
}---------------------------------------------------------------------------------------- 
 
The only output from Kinematic processing is the KAR summary record as shown below.  
If kinematic processing is used without KAR no output will be shown in the fss/rss files.   
 
 ------------------------------------------------------------------------- 
    KAR summary records for succeeded solutions 
 ------------------------------------------------------------------------- 
Kar { 
        EngageTime:  343269.00 1272  23:21:09.0 05/26/2004 
        RestoreTime: 343270.00 1272  23:21:10.0 05/26/2004 
        SearchTime:  343329.00 1272  23:22:09.0 05/26/2004 
        TimeSkipped: 0.0    s   
        TimeUsed:    60.0   s   PASS 
        RMS:         0.010  cyc PASS 
        Reliability: 6.2        PASS 
        FloatFixSep: 1.42   m   PASS 
        SearchDist:  0.02   km  "HIGH L2 noise model" 
        AvgDist:     0.02   km  
        AvgSats:     7.0    
        SearchSats:  7          "13 3 19 1 28 27 31" 
        RestoreSats: 7          "13 3 19 1 28 27 31" 
        RestoreDop:  2.6    
        RestorePos:  -21 10 09.12638 149 11 00.32129 58.989 
        Message:     "KAR success!" 
} 

9.1.3   .FWD or .REV 
This section explains the trajectory output, which has entries for each epoch.  The first 
line of the output file always begins with $OUTREC, and is followed by the version 
number, the processing engine, and the type of output.  An example of the first line is 
given below. 
 
$OUTREC Ver7.50 NGPS32 Forward Extended 
 
The output format is shown below.  Text that has been italicized indicates a description of 
the variables, or the units that the variables are in.  A numerical example is also given.  
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Note that entries in the format marked as optional may not appear, depending on which 
processing options were used.  The default processing output is Normal; however, to get 
full output (the optional output) go to the ‘Advanced’ tab in the processing options and 
change the option ‘FWD/REV File Format’ from Normal to Extended.  Extended output 
is required for some output types in the Export Wizard and for some of the advanced 
plots. 
 
Out {  Tim: even_sec_time corrected_time WkNum     GPS seconds of the week, week number 
       Geo: latitude longitude height anthgt           Degrees minutes seconds, metres 
       Loc: d-east d-north d-height v-east v-north v-height   local level pos+vel, metres, m/s 
       Sta: quality amb_drift dd_dop pdop hdop vdop    1-6, cycles/sec, dops 
       Rms: L1Rms CARms P1Rms D1Rms L1Std CAStd D1Std            m, m/s Rms=RMS of resid, 
Std=meas std-dev 
       Var: cee cnn czz cve cvn cvz cpos            Position + velocity variance + trace with ppm, m^2, m^2/s^2 
       Flg: S/K L/F NumGps NumGlonass SolType        (S)tatic, (K)inematic, f(L)oat amb., (F)ixed amb. 
                                         SolType: (S)-SF carrier, (D)-DF carrier, (I)-IonoFree, (R)-RelIono, (C)-C/A Only 
       Cov: cne cze czn cvne cvze cvzn                 Position and velocity covariance 
       Ecf: dx dy dz                                    ECEF base->remote vector 
       Acc: ae an au                                    Local level accelerations (m/s^2) 
       Gln: TimeOffset ToffSd NGps NGln                m 
} 
 
Out {   Tim: 343277.000 343276.999962535 1272 
        Geo: -21 10 09.16196 149 11 00.34808 58.9045 0.000 
        Loc: -2.454 18.834 0.804 -0.002 0.022 0.045 
        Sta: 4 0.118066 2.59 1.55 1.19 1.00 
        Rms: 0.0060 0.545 0.000 0.028 0.0379 4.200 1.050 
        Var: 5.89495e-001 7.70540e-001 4.04788e+000 2.80134e-001 3.47242e-001 9.18255e-001 
5.40791e+000 
        Flg: K L 7 0 I 
        Cov: 3.91145e-002 3.03102e-001 5.10459e-002 1.38708e-002 5.89769e-002 6.98362e-004 
        Ecf: -5.228 5.976 17.272 

iv) DOP values 

        Acc: -0.020 0.037 0.038 
        Gln: 0.000 1000000.0000 0 0 
} 

9.1.4   .FBV or .RBV 
These are binary values (BV) that provide additional baseline and satellite output 
statistics mostly used for plotting.  A BV file will be proved under the following 
circumstances: 

a) Multi-Base processing 
b) User selects ‘Write MB binary values/satellite residuals’ under Advanced 

1 Settings. 
 
A BV file will contain the following: 
 a) For each baseline: 
  i) Code, carrier and Doppler RMS values 
  ii) Code, carrier and Doppler SD values 
  iii) Code and carrier phase separation values (see MB Plots) 

v) Ambiguity drift 
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vi) Effective weighting 
 b) For each satellite: 
  i) PRN  

ii) Baseline 
iii) Rejection + base satellite flags 

  iv) Code, carrier and Doppler residual values 
v) Code, carrier and Doppler SD values 

 
Please contact Waypoint if the file format is required.  In the future, an ASCII converter 
may become available. 
 

Section 2   .CFG file 
The .CFG file stores all the options in a project.  It is rare that you will need to edit a 
.CFG manually; however one situation in which you will need to do so is when using 
callgps (the command-line processor).  When editing a .CFG file you have to be careful 
to follow the exact syntax.  To learn the commands of .CFG files look at a few files 
created by GrafNav and refer to Appendix A for a list of all the commands and their 
meanings. 
 

Section 3   Binary GPS data files 
Binary measurement data is stored in our custom .GPB format.  This format is receiver 
independent and only stores necessary information to minimize disk space requirements.  
This format contains a position record and num_sats measurement record for each epoch.  
GPBVIEW is a useful utility to inspect and modify this file. 
 

i. Position record: contains the receiver computed latitude, longitude, height and 
clock offset.  It also contains the correct GPS time (seconds since Sunday), and 
status bits for position validity and process mode (STATIC or KINEMATIC).  
The process mode is used to switch the processing program from static to 
kinematic mode and vice/versa.  This record requires 68 bytes. 

 
ii. Measurement record: contains the measurements for each satellite.  It contains the 

PRN number, CA code range, L1 phase, L1 phase rate (Doppler), L2 phase, P 
code range and locktime.  For those fields that do not exist, zero is present. This 
record requires 44 bytes per satellite. 

 

Section 4   Station Files 

9.4.1   New Station File Format (.STA/.NST) 
In Version 6.03 Waypoint Consulting Inc. changed the format of the station files.  The 
old station file format is still compatible with Version 6.03, 7.00 and 7.50; however, any 
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changes to that station file will be saved in the new format.  The new format has two 
possible file extensions; .NST and .STA.  The new station file format is described here. 
 
Every station file must have the input at the top of the file. 
 
$STAINFO 
 
If this string is not present in the file it will not load.  The station file may have a header 
record.  The header is optional and will not be present in most cases.  The following is a 
description of the header format. 
 
Hdr { 
     Proj:     "Name of project"     field project name 
     User:     "User Name"            name of field operator 
     Time:     hh:mm:ss LOCAL/GMT     Start time 
     Date:     mm/dd/yyyy             start date 
     RxName:   Ashtech                receiver type 
     RxSub:    GG24                   receiver sub type 
     Hi:       Hi_m VERT/SLANT        start antenna vertical or slant 
     Ant:      V_Offset H_Offset "Name"   antenna info (V=offset to phase centre, H-to meas. point) 
      if position fixed 
     Pos:      phi lamda ht [ELL/ORTHO]   computed position (of antenna) 
     Mode:     SP/DGPS/RTFL/RTFX/RTK/FIX   Mode of solution (RTFL=float, RTFX=fixed, 
RTK=float/fixed not known)       SP-single point, DGPS-DGPS, FIX-KNOWN 
} 

    UTim:     SecOfWeek [WeekNo]         UTC Time could be used instead of GTim but this is not 
recommended and often not supported. 

     Mode:     SP/DGPS/RTFL/RTFX/RTK/FIX   Mode of solution (RTFL=float, RTFX=fixed, 
RTK=float/fixed not known) 

     Att:      roll pitch heading      attitude in degrees 

} 

 
The following is the format for the stationary station marks.  Many options are available 
in this output; however, only the options with an * are required. 
 
Sta { 
*    ID:       "Station ID" 
*    GTim:     SecOfWeek [WeekNo]       GPS Time 

     Pos:      phi lamda ht [ELL/ORTHO]   computed position (of antenna) 

                                          SP-single point, DGPS-DGPS, FIX-KNOWN (user entered) 
     Std:      SdE SdN SdH            standard deviation in meters 
     Hi:       Hi_m VERT/SLANT       ; start antenna vertical or slant (vertical offset to ground) 
     Ant:      V_Offset H_Offset "Name"   antenna info (V=offset to phase centre, H-to meas. point) 
     OffR:     Range(m) TrueAzimuth(deg) DH(m,+UP)   offset to actural point 
     OffL:     DE DN DH              ; offset in local level frame, meters (+UP) 
     OffB:     DX DY DZ              ; body frame offset X-RightWingPos, Y-FOrwardPos, Z-UPPos (m) 

     Desc:     "description" 
     Rem:      "remarks" 
     Nsv:      NumSats NumGPS NumGlonass 
     Dop:      PDOP HDOP VDOP 
     Rms:      L1Phase CACode 
     Age:      Sec                    age of last correction (or RTK receipt) 
     Enable:   1/0                    used in grafnav  
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The new station file format also handles event marks.  Saving a project with event marks 
loaded will bring the event marks into the station file.  Currently no decoders will load 
event marks into the station file, but future decoders will.  The following is the event 
mark format.  The required fields are marked with an *. 
 
Mrk { 
*    Event:    Number                  event number or name (no spaces) 

     Rem:      "remarks" 

    GTim:     SecOfWeek [WeekNo]        GPS Time 

     Hi:       Hi_m VERT/SLANT         start antenna vertical or slant 

     Desc:     \"Name\"                 roll name 
*    GTim:     SecOfWeek [WeekNo]       GPS Time 
*    UTim:     SecOfWeek [WeekNo] UTC Time could be used instead of GTim but this is not 
recommended and often not supported  
Pos:      phi lamda ht [ELL/ORTHO]   computed position 
Mode:     SP/DGPS/RTFL/RTFX/RTK/FIX ; Mode of solution (RTFL=float, RTFX=fixed, 
RTK=float/fixed not known) 
                                      SP-single point, DGPS-DGPS, FIX-KNOWN (user entered) 
     Std:      SdE SdN SdH            standard deviation in meters 
     Vel:      VE VN VH               m/s 
     Att:      roll pitch heading      attitude in degrees 
     Rem:      "remarks" 
     Nsv:      NumSats NumGPS NumGlonass 
     Dop:      PDOP HDOP VDOP 
     Rms:      L1Phase CACode 
     Age:      Sec                   age of last correction (or RTK receipt) 
     Enable:   1/0                   used in grafnav  
} 
 
GIS marks are also available in the new station file format.  GIS marks can only be 
created by using Waypoint’s logging software (WLOG). 
 
Gis { 
     Count:    counter 
    Feat:     "name" 
     Attrib1:   "name"      
     Value1:    "name"      
     Attrib2:   "name" 
     Value2:    "name" 
     Attrib3:   "name" 
     Value3:    "name" 

     Type:     featuretype position direction 
               POINT/LINE/POLYGON NONE/START/END/NODE NONE/CW/CCW 

    UTim:     SecOfWeek [WeekNo]        UTC Time 
     Pos:      phi lamda ht [ELL/ORTHO]   computed position 
     Mode:     SP/DGPS/RTFL/RTFX/RTK/FIX   Mode of solution (RTFL=float, RTFX=fixed, 
RTK=float/fixed not known) 
                                          SP-single point, DGPS-DGPS, FIX-KNOWN 
     Std:      SdE SdN SdH             standard deviation in meters 
     OffR:     Range(m) TrueAzimuth(deg) DH(m,+UP)   offset to actural point 
     OffL:     DE DN DH                offset in local level frame, meters (+UP) 
     OffB:     DX DY DZ                body frame offset X-RightWingPos, Y-FOrwardPos, Z-UPPos (m) 

     Ant:      V_Offset H_Offset "Name"   antenna info (V=offset to phase centre, H-to meas. point) 
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     Nsv:      NumSats NumGPS NumGlonass 
     Dop:      PDOP HDOP VDOP 
     Rms:      L1Phase CACode 
     Age:      Sec                   age of last correction (or RTK receipt) 
     Enable:   1/0                   used in grafnav  
} 
 
Another new data type handled in the station format is an RTK epoch, where every epoch 
can be recorded.  This is not currently implemented but is described here for future 
reference. 
 
RTK { 
*    GTim:     SecOfWeek [WeekNo]       GPS Time 
*    UTim:     SecOfWeek [WeekNo]       UTC Time 
*    Pos:      phi lamda ht [ELL/ORTHO]  computed position 
     Mode:     SP/DGPS/RTFL/RTFX/RTK/FIX  Mode of solution (RTFL=float, RTFX=fixed, 
RTK=float/fixed not known) 
                                         ; SP-single point, DGPS-DGPS, FIX-KNOWN (user entered) 
     Std:      SdE SdN SdH           ; standard deviation in metres 
     Vel:      VE VN VH              ; m/s 
     Att:      roll pitch heading    ; attitude in degrees 
     Nsv:      NumSats NumGPS NumGlonass 
     Dop:      PDOP HDOP VDOP 
     Rms:      L1Phase CACode 
     Age:      Sec                  ; age of last correction (or RTK receipt) 
     Enable:   1/0                  ; used in grafnav  
} 

9.4.2   Station Old Format 6.02 and older (.STA) 
Feature points can be loaded into GrafNav via a station file.  This station file is an ASCII 
file from which station names, GPS times, antenna heights and related information is 
read.  GrafNav will select the nearest epoch time to extract the position, and will not 
interpolate in this situation.  For interpolation the user should see the Load Camera Marks 
option.  The station file can contain two feature type as follows:   
 
1. A named station has the following format: 
 
 STA: * GPSTime * StaName * AntHeight * Description * Remarks    [CR][LF] 
 
Where, 

GPSTime Time of feature mark, defined in GPS seconds of the week 
StaName Alpha-numeric station identifier [16 chars max] 
AntHeight Height of the range pole or tripod in meters 
Description Description of station [32 chars max] 
Remarks Remarks for the station [32 chars max] 
[CR][LF]  Carriage return + line feed to end line 
‘*’ Field separator, there cannot be any ‘*’s in the text 

 
2. The second feature is called a GIS feature mark and has the following format: 
 GIS: * GPSTime * Counter * AntHeight * Attribute [CR][LF] 
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Where, 

GPSTime Time of feature mark, defined in GPS seconds of the week 
Counter Numeric counter which normally increments 
AntHeight Height of the range pole or tripod in meters 
Attribute Feature name + attribute string 
‘*’ Field separator, there cannot be any ‘*’s in the text 

 

Section 5   Ephemeris Files  
GrafNav/GrafNet use a custom ASCII file format for the ephemeris records.  These 
records are created in real time with the data logger or from the various conversion 
utilities.  Since this file format is ASCII, a simple text editor can be used to combine 
ephemeris records from multiple concurrently collecting receivers.  This is useful if some 
ephemeris records were missed from some stations.  Duplicate records will be 
automatically removed in GrafNav. 
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Section 1   Tips on Maximizing Accuracies 
This is a valuable section to pass on some of Waypoint’s processing knowledge to the 
user along with a few tricks that can vastly improve certain data sets.  It should be noted 
that as you have the ability to bring a static baseline from GrafNet into GrafNav, many of 
the tips listed in GrafNav can equally apply to baselines in GrafNet. 

10.1.1   Helpful GrafNav/GrafNet Tips 

10.1.1.1   Avoid Re-Typing Master Station Coordinates 
Every time a new project is created from New File or Auto Start, the user needs to input 
the Master Station Coordinates.  If certain base stations are being used repeatedly, it is 
easier to store the station coordinates by using ‘Add to favorites’ in the Master Position 
Coordinate Options, and loading the master station coordinates using ‘Load from 
favorites’ when needed.  This method is faster and less typing errors are induced. 
 
Stations from network or traverse solutions can also be added to the favorite stations list 
using GrafNet.  Once a network solution has been processed and the user right-clicks the 
mouse on the station (on the map), a pop-up menu appears with the ‘Add point to 
Favorites’ option.  Stations added from GrafNet will also be available for use in GrafNav.  
Note that if no network solution is loaded, the user will be prompted to see if a traverse 
solution should be used or not.  A list of coordinates can also be loaded from the 
Favourites Manager. 
 
It is worth noting here that CORS, IGS, AUSLIG, IGN, and GSI control points are pre-
loaded into the Favorites Manager.  It is important to note that these coordinates should 
only be used as guidelines, as they are subject to change.  Additionally, be careful to note 
the datum of the coordinates found in the Favourites Manager.  For instance, IGS 
coordinates are given in WGS84.   If high accuracies are desired, the exact coordinates 
should be read from the Internet. 
 
By selecting the datum prior to pressing  'Select from Favorites', coordinates in this 
datum will be favored.  This has application for stations that are part of two networks 
(e.g. CORS and IGS).  CORS coordinates will be NAD83 while IGS is ITRF/WGS84. 

10.1.1.2   Custom Output Formats 
The Export Coordinates Wizard  (see Chapter 2  Section 7) is present to allow the user 
more control over output format.  Export Profiles can now be customized and saved for 
reuse.  Along with more access to different variables for output, the Export Wizard can 
also vary in format with user defined header/footer files, strings, error/warning messages, 
and a processing summary. 
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10.1.1.3   Missing a Base Station? 
GrafNav now supports single point processing which is accurate to 1-3 (or worse) meters 
with precise ephemeris, dual frequency and good quality code measurements (on both 
frequencies). 
 
Generally, a more accurate solution is to use the download program that can be launch 
form GrafNav, GrafNet or GrafNav Batch via Tools | Download Service Data.  Currently 
there are 2400 stations from around the globe loaded into the software.  Download will: 

1. Go onto the Internet and download selected stations 
2. Decompress 

4. Concatenate files if time span covers two or more days 

See Chapter 6  Section 9  Download Service Data for more information. 

3. Convert from RINEX to GPB 

5. Optionally resample to a higher data interval 

10.1.1.4   Use Pre-configured Options Profiles 
Version 7.50 now comes with pre-loaded configuration combination (see Options | 
Default Settings | Load Settings From).  Users can also add their own.  Using these makes 
the life of choosing settings easier.  Selecting either these or Factory Defaults is 
especially important for processing projects from previous versions. 

10.1.2   General Tips for Kinematic (GrafNav) 

10.1.2.1   Use Pre-Loaded Options Profiles 
Before processing, consider selecting an options profile (e.g. ‘Airborne’, ‘Low Cost 
Receiver’, etc…).  This can be accomplished directly during ‘Auto-Start’ or after a 
project has been created or loaded by selecting Settings | Load Settings From | Profile. 

10.1.2.2   Combine Forward and Reverse Solution 
For carrier phase processing, accurate ambiguity determination is the most important 
goal.  The forward/reverse combination is a fast and easy check on this determination.  
Selecting ‘Combine Forward/Reverse’ from the process menu after both directions have 
been processed performs this.  Plotting the forward/reverse separation shows the 
difference, and gives an indication of the reliability of the solution.  This difference is not 
necessarily the errors and the weighting of these two solutions can be plotted as well. 
 
With version 7.50, problem periods such as incorrect integers determined in either the 
forward or reverse direction can be blocked.  See Process | Combine Solutions | Combine 
Settings. 

10.1.2.3   Use Static/Kinematic Flag 
GrafNav keeps track of Static and Kinematic processing, and accuracies are better in 
Static than Kinematic.  Therefore, if a user has longer period of static (i.e. more than 5 
minutes), then it is beneficial to make that data static.  It is even more important to set 
portions of the data where the antenna is moving to kinematic.  Even if the movement is 5 

348 



Chapter 10  Processing Techniques 

centimeters, that portion should be set to kinematic.  This is performed via the GPB 
Viewer (see Chapter 6  Section 3  GPBView). 
 

• Make entire remote data kinematic (see GPBView, Chapter 6  Section 3  or use 
File | GPB utilities | Insert Static/Kinematic markers). 

To make use of this flag, it is important to first properly identify which data is static and 
which is kinematic.  An easy way to separate the static from the kinematic is as follows: 
 

• Process with float solution (i.e. no KAR or fixed solution). 
• Plot the Velocity Profile from the Plot GPS Data function within the Output 

Menu. 
• Static data is normally where the velocity is very near zero (e.g. < 0.2 m/s).  

Always be cautious about slow movements which can be shrouded in the 
measurement noise. 

• Use Raw GPS Data Viewer to switch these periods from kinematic to static.  It is 
generally a good idea to start the static 10-20 seconds after movement stops, and 
stop the static a similar amount before movement begins (again Insert 
Static/Kinematic Markers feature can also be use). 

• GPS receivers that make an accurate Doppler measurement facilitate easier 
static/kinematic identification. 

10.1.2.4   Eliminate Problem Satellites 
Sometimes a single problem satellite will introduce considerable error in the solution.  
Two techniques to identify and eliminate problem satellites are briefly discussed here.  
One way is to examine the message logs after processing, and look for repeated warnings 
concerning specific satellites.  If one satellite has many warning, you may wish to either 
eliminate this satellite for the entire data set, or for specific time periods (as indicated in 
the message logs). 
 
A second method to identify problem satellites is to process in the forward direction only, 
with the option ‘Write MB binary values/satellite residuals’ on, which is located in the 
Advanced Options.  Enabling this setting will allow you to plot the C/A code and the L1 
phase satellite residuals (see 'Individual Satellite Statistics' under Section 2.6.1  Plot GPS 
Data).  Problem satellites will usually have large spikes or generally stand out from the 
other SV plots, and omitting these satellites will generally improve results. 
 
If large spikes appear in every SV plot, examining which satellite is the worst offender 
(that is, which has the largest satellite phase residuals) just prior to the filter reset, and 
omitting these satellites (up to just after the total loss of lock) will often not result in the 
total loss of lock induced by the filter reset option, and improve results considerably. 

10.1.2.5   Set the Proper Standard Deviation for Kinematic Convergence 
The standard deviation on the C/A code is set to 4 meters by default.  This is to satisfy the 
requirement of all GPS receivers.  However, many receivers produce more accurate C/A 
code measurements by using narrow correlation or smoothing technologies, while other 
low-cost units have much poorer C/A code accommodations.  Setting proper 
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measurement standard deviation values will improve float accuracies and also increase 
KAR reliability. 
 
To determine a new C/A code standard deviation, process once in float mode (i.e. no 
fixed solution or KAR).  After processing, plot the C/A Code RMS from the Plot GPS 
Data option from the Output menu (see Section 2.6.1  Plot GPS Data).  Note that the 
current standard deviation value should be plotted as well.  Pick a value that nicely 
represents a good overall RMS for the C/A.  Pessimistic values are better than optimistic 
ones.  Set the C/A code standard deviation to this new value from the Standard Deviation 
options from the Options menu, and reprocess. The C/A code RMS can also be obtained 
via the Processing Summary (select View Processing Summary from the Process Menu).  
When using this value as a standard deviation (see Measurement Processing Settings), a 
problem can be that it is too optimistic, and the methodology discussed previously in this 
paragraph is better. 
 
A similar methodology can be used for the carrier phase.  However, instead of lowering 
the value, it is often raised to account for increased error.  Note that the carrier phase 
standard deviation value may be higher than the entered value due to the checkbox 
‘Adjust for Iono’ being set. 
 
Setting proper standard deviation values is especially important for single frequency data 
sets, and can do more to help than just about anything else.  The L1 phase standard 
deviation may need to be raised (e.g. 0.05-0.10 m).  This is performed under the 
Measurement Options.  Setting proper standard deviations is also helpful for dual 
frequency processing. 

10.1.2.6   Bad Data Control 
When GrafNav sees very high residuals (i.e. code and/or carrier RMS), it tries to correct 
the problem by removing a measurement (i.e. doppler or P2 code), baseline (MB 
processing only), or satellite.  In some cases, if it cannot correct the problem, it will issue 
a cycle slip to all satellites.  This is known as a filter reset and can be observed by a sharp 
increase in estimated position accuracy (in forward or reverse direction), and a ‘$$$’ 
message will be printed to the message log. 
 
The user can control how GrafNav handles bad data in the ‘Outlier detection/rejection’ 
section of the Measurement processing settings.  Specifically, a looser carrier phase 
‘level’ will prevent fewer resets from happening, while a stricter carrier phase ‘level’ will 
be more energetic in finding errors at the risk of issuing more resets. 

10.1.2.7   Avoiding Missing Epochs 
After processing with GrafNav, epochs can be missing for a number of reasons: 
 

• Either the base or remote .GPB files are missing one or more epochs.  Use the 
GPBView (View Raw GPS Data) and check the epochs in question.  If this is the 
case on the remote, then there is nothing that can be done here.  However, master 
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gaps can be “filled in” by selecting View | GPS Observations | Master ___ | 
Resample.  See 2.2.7   

• By default, GrafNav ignores the first 4 seconds of data after a satellite rises.  This 
is to avoid any possible half-cycle problems in determining the carrier phase that 
are more likely during the first few seconds of lock.  The tolerance is known as 
the Locktime cut-off, and can be altered from the Advanced Options.  If missing 
epochs are a problem, try lowering this number. 
If an epoch has been determined to be “bad”, data is not written to the .FWD or 
.REV files and thereby not received by GrafNav.  This is to protect the user from 
receiving very bad data.  However, if data quantity is more important than quality, 
then these epochs can be written by setting the “Write epochs containing bad 
data” checkbox from within the Advanced 1 Options. 

• 

• There may also be less than 4 satellites in common between base and remote.  
GrafNav requires at least 4.  If there are no obstructions, then check for Missing 
ephemeris messages in the Message Log File (.FML/.RML).  If there are not 
enough ephemerides, then broadcast ephemeris files can be downloaded from the 
NGS-CORS (http://www.ngs.noaa.gov/CORS/cors-data.html) or obtained from a 
service provider.  Convert the RINEX ephemeris to .EPP using the provided 
RINEX Converter.   

 
Otherwise, coordinate interpolation is the only other option.  GrafNav can interpolate 
missing epochs from within the Export Wizard or the Write Coordinates feature, which 
can both be accessed via the Output Menu.  Interpolation is permitted in the Export 
Wizard from the screen titled “Select Epoch Sampling Mode”.  Likewise, interpolation is 
permitted in the Write Coordinates feature by selecting Epoch Format.  At the bottom of 
this dialogue box, enable missing epoch interpolation, and select the desired data interval. 

10.1.2.8   Avoid RINEX for Kinematic Data 
Most GPS receivers attempt to detect cycle slips at a data rate much higher than the 
recording rate, and their native formats indicate such slips.  Although RINEX has a loss 
of lock character, RINEX converters do not always use it.  Therefore, use the receiver 
specific converter if possible. 

Incorrect intersections are caused by KAR when it picks the wrong solution.  This error 
exhibits a near constant offset in the combined forward/reverse separation.   

10.1.3   Tips for Using KAR 

10.1.3.1   Detecting and Fixing Incorrect Integer Intersections 

 
Step 1—Confirm that the large forward/reverse separation is due to a bad KAR fix 
After plotting the combined separation, which will show the times when the 
forward/reverse separation is poor, also plot the ‘Float/Fixed Ambiguity Status’.  This 
will show when there is zero, one or two fixes available for an epoch.  Incorrect KAR 
intersections are most apparent when there are two fixes (i.e. for both forward and 
reverse).  These areas show up as green.  This does not mean that an incorrect fix cannot 
occur when there is just one fix.  In this situation, you are comparing a float solution to a 
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fixed.  The large bias is usually due to the float solution, but this is not always the case.  
In such a case, plotting the standard deviation of the float solution can be very helpful. 
 
Step 2—Determine processing direction of bad solution 
It is always a good idea to determine which processing direction is the cause since only 
that direction needs to be reprocessed.  This is significant because in Step 3, you will be 
changing many options.  It is important to only make these trails on the bad direction as 
you would not want to corrupt the good direction. 
 
The fastest way to determine which direction is bad is to load each individually.  After 
each is loaded, plot the L1 Phase RMS.  The incorrect fix normally exhibits a linear 
growth to the carrier phase RMS.  There may be jumps as GrafNav is trying to correct the 
problem by removing satellites.  After some time, it may stay low if a filter reset has been 
issued. 
 
Another way to determine the likelihood of a bad KAR fix is to view the Static/KAR 
summary file (.fss/rss).  There will be records for each KAR fix.  Look for fixes with 
poor RMS (>0.05 cycles), low reliabilities (<2-3) and/or large float-fixed separations (>1 
m). 
 
Step 3—Correcting the Problem 
A bad KAR fix is normally a very easy problem to correct.  It just requires one or more of 
the following settings to be changed.  The first ones are more likely to help then the last. 

a) Enable the ‘Stricter RMS tolerance’ and/or the ‘Stricter reliability 
tolerance’ checkboxes in the Advanced KAR options. 

b) Lengthen the minimum KAR time.  As KAR uses more time, it usually 
rejects bad fixes better 

c) Try disabling 'Refine L1/L2 KAR search' (Advanced KAR option). 

e) Consider re-engaging KAR manually after the bad fix.  Be sure the 
checkbox ‘Reset Kalman Filter’ is checked on the Manual KAR Engage 
record. 

If the Download Service Data function was used to download CORS or IGS data, you 
have the option of interpolating to a higher interval.  In such a case, the epochs not on the 

d) If the auto-reduce KAR search area is used for dual frequency, try 
increasing the scale factor, or switch to the constant search region size. 

f) Use the KAR_SEP_TOL command to force KAR to only accept 
intersections that are close to the float solution.  For instance, use a value 
of 1 m). 

g) Lower the Maximum Engage Distance for KAR.  Users may also wish to 
use the KAR_USE_DIST command and set the distance to a lower value 
as well. 

h) If poor geometry is a concern, try lowering the ‘Maximum allowed 
DD_DOP’ from the Advanced KAR Options. 

i) If all else fails, disable this time period during combination (see 10.1.2.1). 

10.1.3.2   Using KAR With Interpolated Data 
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original interval (usually 30s), has errors of ~1 cm.  If KAR uses this data, it will often 
fail.  Therefore, under the Advanced KAR options, set the ‘Use on interval:’ value to the 
original data interval of your data (e.g. 30 s).  In addition, enable the ‘Exact interval (for 
interpolated data) option.  This will cause KAR to only use the data on the exact ‘n’ 
second interval.  The minimum KAR time may need to be increased to compensate for 
less data being used by KAR. 

Most of these tips are available primarily to dual frequency users due to the ionospheric 
modeling. 

10.1.3.3   KAR Options – Could Not Find a Solution 
Resolving this problem is usually more difficult than resolving the problem of picking a 
wrong solution.  This is because the inability to pick a solution is most often related to 
noisy carrier data on L1 and/or L2.  Usually, playing with the KAR time and search 
region size is all that can be done.  Consider disabling the strict reliability tolerance as 
well.  For dual frequency, switching to other noise models can help if there is a problem 
with L1 or L2.  With single frequency KAR, the L1 phase needs to be very clean, and 
there has to be a period of at least 10 minutes without a loss of lock.  These conditions are 
not always possible in many environments. 
 
For dual frequency data on short baselines (< 8 km), try using Fast KAR (Advanced 
KAR option).  The '5 satellite' option is not suggested. 
 
For dual frequency GPS data with good C/A code, the following tricks can be used. 
 

• Set the C/A standard deviation to 2-3 meters.  This is done under the Standard 
Deviation Options. 

• Change the size of the KAR Dual Frequency Search Region size to 1.5 meters.  
Use KAR Options. 

• Raise the KAR Minimum Time for Dual Frequency to 3 or more minutes.  Use 
the KAR Options as well 

• From the Options Menu, select User Defined Options.  Enter the command: 
KAR_SEP_TOL=0.75 

 
Using this procedure will help in finding a solution but may increase the chance of a false 
intersection as well.  Therefore, it is important that FWD/REV solutions agree. 

10.1.3.4   Taking Advantage of GrafNav’s Improved KAR (for long 
baselines) 

 
Iono Noise model removes ionospheric error to improve reliabilities and also seeds the 
ionospheric correction (when engaged).  The Auto Noise model chooses between the 
High and Iono noise models based upon the distance when the search is performed.  The 
distance tolerance for choosing between the two noise models (i.e. High and Iono) can be 
specified in the Advanced KAR Options.  In most cases the Auto setting works best.  
However, forcing either the Iono or High models has its advantages.  For example, the 
High noise model is less reliant on L2, which can make it more reliable if L2 is noisy.  
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The iono model seeds the iono-free and relative ionospheric models, which can produce a 
more accurate final solution. 
 
KAR can also be engaged in static mode (see KAR Options – Engage Settings).  This 
means using the fixed static solutions can be avoided, which simplifies processing.  
Normally though, the fixed static solution is more reliable, and fixed solution fixes can be 
solved for each of the static periods in the data. 
 
Using the option 'Utilize all data whose distances are less than tolerances' (see KAR 
options) has a great effect on airborne long distance data where the aircraft is 
continuously flying within and outside KAR distance tolerances.  Enabling is generally a 
good thing as more data is used.  However, sometimes this can result in the incorrect 
integer being chosen if a carrier slip is missed while the aircraft was far away. 

10.1.3.5   KAR – Improving Upon a 20-30cm Combined Separation 
On long baseline airborne processing, 5-10 cm accuracies are sometimes needed (e.g. 
large photogrammetric scales or LIDAR).  However, after initial processing, the 
forward/reverse separation may only show 20-30 cm.  The forward/reverse separation is 
not an absolute indicator of accuracy, but a very tight separation provides for a very nice 
level of comfort.  This section describes how 20-30 cm separations can be improved.   If 
it took a great deal of effort just to achieve 20-30 cm, then your outlook for improving 
upon this can be bleak.  Otherwise, here are some tips: 
 

a) Make sure that a fixed integer (ambiguity) solution is obtained for as much of the 
mission as possible because fixed integers solutions (i.e. KAR or the fixed static 
solution) are usually necessary achieving 5-10 cm accuracies.  This can be 
observed by plotting the Float/Fixed Ambiguity Status plot for both the forward 
and reverse directions.  If there is a larger separation and only one of the solutions 
(i.e. forward or reverse) has the fixed ambiguity solution, then this is not a 
significant problem if you are sure that the fixed integer solution (i.e. KAR/fixed 
static) is correct. 

b) Use manual KAR engage at times where base or remote distance is small but 
forward-reverse separation is outside tolerance. 

c) Enable the ‘Engage on poor DOP’ option under the Advance KAR Options.  This 
will be helpful if large DOPs are observed (plot the DD_DOP variable where 
DD_DOPS over 15-25 can cause instabilities).  You may also need to check the 
message log file, as epochs with extremely poor DOPs are skipped and not visible 
on the data plots. 

d) In MB processing especially, try engaging when close to a base station (see KAR 
1 | Engage if distance < tol1, reset if distance > tol2). 

e) Increasing either the KAR time or the KAR add time (i.e. # min/10 km) can help 
as well, since KAR can sometimes pick the wrong L1 or L2 lane resulting in a 10-
20 cm error. 

f) Try enabling the stricter RMS tolerance check box in the Advanced KAR 
Options.  This will make KAR less likely to accept a bad solution. 
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g) Try forcing the use of the Iono L2 noise model (or lower the Auto distance) in the 
Advanced KAR options.  This causes ionospheric corrections to be more properly 
estimated. 

h) Try using a stricter carrier phase ‘level’ in the Outlier Detection/Rejection section 
of the Measurement Processing Settings. 

i) If static data is available, using the fixed static solution can be helpful. 
j) Try both the Iono-free, relative models and combinations for forward and reverse 

10.1.4   General Tips for Static (GrafNet) 
If there is a problem with a static baseline, it is a good idea to right-click on it and select 
“GrafNav”, which will bring the baseline into GrafNav.  This allows you to control many 
more processing options, and gives you access to plot options for a more detailed 
analysis.  Once inside GrafNav, many of the above techniques for GrafNav are equally as 
applicable here. 

10.1.4.1   Use GrafNet for Static Batch Processing 
If you have numerous static baselines even with a single base, use GrafNet as it is much 
faster to setup and process the project.  If problems develop with the receiver at your base 
station, try downloading the nearest CORS/IGS station, or even the nearest few 
CORS/IGS stations, and use the Batch processor to get a combined solution from 
multiple base stations (see Chapter 4  for more information on the Batch Processor). 

10.1.4.2   Use Kinematic Processing on Static Baselines 
If data has static sections defined, and there is even a small amount of movement, the L1 
carrier will suffer.  This may cause a fixed solution to fail or a float/quick to deliver poor 
results.  To compensate for the small movement, the user may want to process the data in 
kinematic mode, which will give better results if there was movement in the antenna.  
Changing the entire remote file to kinematic can be accomplished within the GPB viewer 
(see Chapter 6  Section 3  GPBView).  Alternatively, the user can process in static mode, 
but select the option “Engage KAR while in Static mode”.  KAR is very reliable for dual 
frequency data but can only be engaged in kinematic mode. 

10.1.4.3   Optimizing the Fixed Static Solution for GrafNet or GrafNav 
Like in KAR, an ionospheric L2 noise model is available.  This can greatly increase the 
range of fixed integer solutions—especially with longer observations.  With such longer 
occupations, enabling the iono-free solutions (under GrafNav) can further improve 
accuracies.  Under GrafNet this is performed by default for the iono noise model (use 
Fixed Static Options). 
 
For both GrafNav and GrafNet, the automatic noise model works very well.  However, 
on days with heavy ionosphere, switching to the iono L2 noise model can be helpful.  
Having longer static occupation times can be extremely helpful under these conditions. 
 
On longer baselines, fixed solutions usually fail as a result of RMS rejections.  
Conversely, reliability failures are usually the cause of failure on short baselines.  In 
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either situation, engaging the Auto-reduce feature can be helpful.  This is possible for 
both GrafNav and GrafNet using the Fixed Static Solution Options.  If the float or iono-
free float is fairly accurate (e.g. +/- 10 cm), then using a user search area site (see Fixed 
Static Solution Options) can be helpful as well.  Values as small as 20 cm can be used. 

10.1.4.4   Adjust Refine L1/L2 Option for Dual Frequency Data 
The setting 'Refine L1/L2' in the fixed solution option can be beneficial for obtaining the 
proper static fix.  However, sometimes it can actually result in the one or more satellite 
resolving the incorrect integer.  Try using with and without selected. 

10.1.4.5   Using a Larger Interval for Static Processing 
Users may have collected data at a high data rate such as 1 Hz.  Such high data rates, 
while necessary for kinematic positioning, are detrimental to static processing.  The 
reason is that carrier phase measurements are correlated over time periods of 10 or more 
seconds.  Since each epoch is considered an independent set of measurements in the static 
computation, time correlation is not modeled.  The gist of the previous text is twofold.  
Firstly, statistics are overly optimistic with the higher data rate.  This can be explained 
with the following abstract example. Ten independent measurements are more accurate 
than one.  However, if these 10 measurements have a systematic bias that is much larger 
than the random error (i.e. epoch-to-epoch white noise), which is possible on GPS signals 
over short periods, one measurement is essentially as good as 10.  The second 
repercussion is a result of the first.  The floating solution will converge too quickly, 
making it very sensitive to erroneous measurements at the start. 
 
The solution is very easy.  Just use an interval of 15 or 30 seconds.  This will give you 
essentially the same coordinate value as with a higher data interval, but with a much more 
accurate estimated standard deviation.  In GrafNet, the network adjustment’s variance 
factor will be much closer to unity.  Both GrafNav and GrafNet have options for setting 
the interval. 

10.1.5   Long Baseline/Dual Frequency Processing in 
GrafNav/GrafNet 

10.1.5.1   Processing Long Kinematic Baselines 
For dual frequency processing on long baselines, it is important to process with L2 
ionospheric processing.  This option is set under the Dual Frequency Options.  Enable the 
checkbox labeled “Use L2 for ionospheric processing”.  The checkbox “Use L2 for 
ambiguity resolution” should also be enabled. 
 
Once L2 ionospheric processing is enabled, there are two ionospheric processing 
methods: 
 

i. The iono-free method works well when the remote initializes far from the base.  
This method creates a carrier signal “free” of ionospheric error.  However, a cycle 
slip on L2 will induce a total loss of lock for that satellite.  In some cases, the 
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iono-free method may do better than the Relative even if initialization is close.  It 
is often good to try both.  Generally iono-free works better than the relative 
model. 

 

Although KAR can be used with both ionospheric methods, a KAR fix will have some 
ionospheric error if the iono noise model is not used (found in Advanced KAR Options).  
It may also have difficulties on longer baselines.  Therefore, setting the “Maximum 
Distance for Engaging KAR” dual frequency value from within the KAR Options is 
important.  Normally, values between 20 and 60 km are realistic. 

ii. The Relative model works by only applying an ionospheric correction to the L1 
signal.  If initialization is close, then an initial correction of zero is accumulated as 
the remote vehicle travels away from the base.  The relative model tends to have a 
higher L1 phase error (see Plot GPS Data) than the iono-free.  This is because the 
relative model is only an approximation.  However, cycle slips on L2 do not reset 
the ambiguity like the iono-free solution.  Hence, accuracies may be better if L2 
cycle slips are present in large quantities.  For days with high ionospheric activity, 
the “Engage Distance” may need to be lowered (found in the Dual Frequency 
Options tab in the processing options).  If a static initialization is performed close 
to the base, which is suggested, then it may be beneficial to make the Engage 
Distance longer than the initialization distance.  Raising the rejection tolerance 
and/or the PPM value in the standard deviation options will stop GrafNav from 
mixing up big ionospheric corrections with carrier phase errors.  This is 
performed within the Standard Deviation Options.  Using 0.2 m for the L1 
rejection tolerance is normally good. 

 

 
On very long baselines, the C/A code can be corrected if P2 code is available.  In many 
cases, this will simply add more noise, but the noise is very white, and overall 
improvements can be observed.  This is enabled from the Dual Frequency Options.  It is 
often good to try with and without. 
 
For single frequency, it is important that the standard deviations be set properly on the 
C/A code and L1 carrier phase signals (see Section 10.1.2  General Tips for Kinematic 
(GrafNav)).  This can do more to help than just about anything else.  The L1 phase 
standard deviation may need to be raised (e.g. 0.05-0.10 m) as well as the rejection 
tolerance (e.g. 0.2-0.5 m).  This is performed under the Standard Deviation Options.  
Setting proper standard deviations is also helpful for dual frequency processing. 

10.1.5.2   Processing Dual Frequency Data During Ionospheric Storms 
Ionospheric activity peaks in 1999-2000, and data over even 10-15 km can sometimes be 
hard to process if ionospheric activity is high.  Since the effect of the ionosphere on 
electromagnetic signals is frequency dependent, dual frequency data can be used to 
combat ionospheric problems very effectively.  By default, both GrafNav and GrafNet do 
not use L2 phase data to correct for the ionosphere because noise can be added to shorter 
baselines.  Ionospheric processing must be enabled from within the options.  A dual 
frequency receiver is required at both ends of the baseline to perform such processing. 
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In GrafNav, ionospheric processing is enabled from the Dual Frequency Options.  Make 
sure the checkbox labeled “Use L2 for ionospheric processing” is enabled.  There are two 
modes of ionospheric processing.  The relative model assumes that the remote starts very 
near to the base and that the initial ionospheric error is zero.  As the remote travels it 
transfers the ionospheric correction.  On the other hand, the iono-free model forms a 
phase measurement, which is a combination of L1 and L2 and free of ionospheric error.  
This method is more effective for static positioning or if the remote starts far from the 
base.  One of the disadvantages of the iono-free model is that a cycle slip on L2 will 
induce a cycle slip for that satellite.  This is not the case for the relative model.  
Regardless, for many kinematic data sets, both should be tried.  For the relative model, it 
may be advantageous to lower the “Engage distance” during high ionospheric activity.  It 
is 4.0 km by default. 
 
In GrafNet, only the iono-free model can be used.  It is enabled from the General Options 
by selecting the Ionospheric Free Solution  for the Static Process Mode.  This is a float 
solution, which means that non-integer ambiguities are solved.  The effect of this is that 
observation times of at least 30 minutes should be used.  On longer baselines, many hours 
are suggested.  It is also suggested that if short and long baselines are combined in a 
GrafNet network, a Fixed Solution can give better results on the shorter baselines. 
 
To detect if there is bad ionospheric data, process with a float static solution and use 
single frequency (this is best done from GrafNav).  Make sure KAR is turned OFF.  Once 
the data is processed, plot the L1 Phase RMS from Plot GPS Data under the Output 
Menu.  If the data looks like a cross-section of the Rocky Mountains with peaks over 0.05 
meters, then there may be ionospheric problems.  The ionosphere should not show up on 
baselines less than 5 km. 

10.1.5.3   Processing Long Static Baselines 
Fixed solutions may be susceptible to ionospheric errors that are produced on long 
baseline lengths.  This may result in a failed solution (e.g. high RMS value and/or low 
reliability) or an incorrect fix.  In such cases, the iono-free solution or float solution 
should be used for dual and single frequencies respectively. 
 
The maximum distance for fixed solutions varies from data set to data set.  For dual 
frequency, maximum fixed solution distances are usually 30-60 km, but may be less 
during ionospheric storms.  For single frequency, this distance is more like 10-20 km.  In 
both cases, longer fixed solution distances can be achieved but with varying degrees of 
success. 
 
For single frequency, the float solution is the only alternative.  It should be used if the 
fixed fails in both forward and reverse directions.  If not, then the solution must be 
manually re-processed from the Session Menu (right-click on the baseline).  The float 
solution is more accurate if the fixed solution has determined an incorrect integer 
ambiguity solution. 
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For dual frequency, the iono-free solution is normally superior to the float.  The only time 
that this is not the case on long baselines is if the L2 signal from the GPS receiver has 
either many slips or data errors.  In such a case, the float solution is better.  For long 
observation periods on very long baselines, the iono-free may in fact be more accurate 
than the passed L1/L2 fixed solution.  This is because the ionospheric error has been 
removed. On short baselines, the iono-free solution should not be used. 
 
For either frequency, the inclusion of the precise ephemeris is also important.  This can 
be downloaded at no charge from the web site http://www.ngs.noaa.gov/GPS/GPS.html.  
Make sure to select the .SP3 files, which can be imported into GrafNav by using the 
Select Alternate Ephemeris option from the File Menu.  Normal precise ephemeris files 
take approximately one week to become available, and are the most accurate.  However, 
slightly less accurate rapid orbits are also available in about 1½ day. 
 
The different modes of processing are selected in the General Options located from the 
Options menu item.  If long and short baselines are mixed, then it may be necessary to 
process the short baselines with a fixed solution and the long ones with the iono-free or 
float solution. 
 

Section 2   Multi-Base Processing 
Many GPS post-processing applications utilize multiple base stations, and processing can 
be handled in two ways: 

a) Sequential manner where baselines are processed separately and combined 
after-the-fact.  This requires GrafNav Batch, and is the pre-version 7.50 
manner of processing that is still supported. 

b) Process all bases simultaneously in a combined multi-base Kalman filter 
(MB-KF).  This is a new feature, and processing is possible from both 
GrafNav and GrafNav Batch. 

 
In this Section, the words ‘base’, ‘base station’ and ‘baseline’ are often interchangeable.  
This is because GrafNav only supports one remote file.  This means that each base station 
produces one corresponding baseline (which is a base-remote pair). 

10.2.1   Which mode of processing should I use? 
Generally, the user has several options: 

i) Use the older sequential method (a) exclusively 
ii) Use the newer combined MB-KF method (b) exclusively 
iii) Use both which is possible in GrafNav Batch 
iv) Use the Combined MB-KF (b) first, and follow up with the sequential 

method (a) if needed 
 
Generally, option (iv) is preferable.  In general, the sequential method, although requiring 
less CPU effort to compute a solution, does require more operator intervention—
especially in terms of analysis and the number of user iterations required to reach an 
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optimal solution.  Secondly, since the MB-KF uses all of the bases at once, KAR can be 
much more effective if lock is lost in the project area.  Finally, cycle slips on base 
receivers (although not that common) are much better handled by the MB-KF as well.  
For these three reasons, the older method (a) should only be used if necessary.   

10.2.2   How important are base station coordinates? 
 

 

VITAL! Incorrect base station coordinates is the most common error in MB 
processing.  The averaged coordinate values are not acceptable for processing.  

Latitude, longitude and height errors (especially for MB-KF processing) must not be 
larger than 5 cm, and accuracies should be much better than this.  In addition to correct 
coordinates, the correct antenna height must also be entered.  All values should be double 
checked.  The best approach is to utilize GrafNet to quickly run a network adjustment 
using the all the base station data.  Use the iono-free float if baseline separations are 
longer than 20 km.  Process at a longer interval (15 or 30 s) and check each of the 
coordinates given.  Be sure the antenna heights in GrafNet match those in GrafNav. 
 
The effect of incorrect coordinates depends on the method and is as follows: 

a) For the sequential method, one of two phenomenon will occur: 
i) smaller errors will show up as a bias in the separation plot for 

the combined baseline 
ii) If the error is larger, this the outlier rejection algorithm will 

reject one (but not necessary the same) baseline.  For this 
reason, it is important to check the number of outlier rejections 
after combining multiple baselines in GrafNav Batch. 

b) For the MB-KF, the effect is much more obscure, and it is most apparent 
in the MB carrier phase RMS plot.  A very obvious ramping or “saw-
tooth” effect is visible.  See Figure 10.1 for an example.  For this reason, it 
is very important to always view this plot in addition to the separation. 

 

 
Figure 10.1 MB Carrier Phase RMS using bad base station coordinates 
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10.2.3   How do I use the MB plots? 
When using the MB-KF methodology, a number of new plots are available.  These utilize 
the FBV/RBV files that are produced in addition to the regular ASCII outputs.  Binary 
Value (BV) files contain statistics for each baseline and satellite.  The Output|Plot MB 
menu selection shows the baseline values.  Some of the more common plots are (in order 
of usefulness): 

a) Carrier Phase RMS/SD – shows carrier residuals for each baseline along 
with measurement standard deviations.  This plot indicates how well the 
carrier phase fits with the overall solution.  It also shows errors in base 
position, and it can be used to determine if one baseline is worse than 
another. 

b) Number of Baselines – Shows how many baselines are used for 
processing.  This is important to check as it will indicate if any baselines 
are ignored or rejected during data line-up. 

c) Distance Separation – Shows distances from remote to each of the base 
stations. 

d) Effective Weighting – This number is computed after the fact as is an 
approximate indicator of how much weight each baseline has.  This value 
is not used to compute the solution, but it can be very helpful in indicating 
which baseline has the most weight.  It is most affected by proximity, but 
the number of satellites can have an effect as well. 

e) Carrier Separation – shows the difference between combined KF 
solution and individual baseline solutions using code+carrier.  It is not 
really a measure of accuracy, but it does indicate how well multiple 
baselines fit to each other. 

10.2.4   Do all of the masters need to utilize the same data 
interval? 
In theory, no, but practically, the answer is yes. The MB-KF methodology can handle 
data with varying data rates without problems.  The constant dropping in and out of base 
data will result in closer bases possibly not being used when they should.  In the 
sequential method, processing is not affected, but a jumpy trajectory can be produced 
after combining.   
 

f) Number of Satellites/DOP – The user can plot the number of satellites 
and/or DOP values.  This will show if one base is tracking fewer satellite 
than another.  For very large areas, it may also show the effect of different 
satellites being above the elevation mask. 

For these reasons, both GrafNav and GrafNav Batch can now resample data right within 
the interface.  See View | GPS Observations | Master ___ | Resample / Fill Gaps using | 
Processing Interval, and be sure to set the processing interval to the remote data interval 
before performing this operation (see Settings | Processing | General).  Users can also 
select View | GPS Observations | Master ___ | Resample/Fill Gaps using | Remote File 
Times, which will resample to each exact epoch in the remote file.  If only one remote file 

 361



GrafNav/GrafNet and Inertial Explorer v. 7.50 Manual 
 
is processed, this is works well.  If many remotes are present for the same time, then data 
gaps in the remote used for resampling will cause dropouts in the resampled master. 

10.2.5   How about data drop-outs at the master, will this affect 
processing? 

 

Isolated data gaps are not as severe as differences in the interval.  However, depending on 
the frequency, side effects can be present as well.  For this reason, GrafNav will prompt 
the user to resample the master data if small gaps are detected (while creating a new 
project).  This process will fill in these gaps if the user selects ‘Yes’.  Resampling can 
always be performed in the manner described in Section 10.2.4  .  This operation is 
suggested if a significant number of drop-outs are present. To determine how many data 
gaps there are, select View | GPS Observations | Master ___ | Show Time Gaps. 

10.2.6   Which base stations should be included? 

10.2.7   What do I do about problematic baselines? 
Poor baselines can be defined as following: 

a) One baseline continuously tracking fewer satellites than the others (see 
Plot MB, Number of Satellites) 

c) KAR regularly resolving incorrectly (or not resolving at all) on one 
baseline but not the others 

d) Numerous bad data messages (that start with $$$) are present in message 
log, and seem to stem only to one base station. 

e) Numerous cycle slips in the message log stemming only from one base 
(note that Slip warning must be enabled in the Advanced 1 Processing 
Settings). 

In general, only base stations that are within the project area should be included.  This is 
because farther away stations will hinder rather than help results as it just adds increased 
errors (due to tropospheric and ionospheric effects).  A general rule of thumb is if a base 
never becomes the closest station, it is too far.  In addition, using two stations very close 
together adds nothing over just using the one.  If they track different numbers of 
satellites, pick the one that tracks the best. 

b) Having a larger carrier phase or C/A code RMS plot (see Plot MB, 
phase/code RMS/SD) 

 
For cases (a), (c), and (e) eliminating the baseline only from KAR should be sufficient.  
This is performed from the General Processing Settings (press ‘Omit …’ button).  Reject 
all satellites, on the isolated baseline for the entire time, but just for KAR/Fixed Static. 

For case (b), there are two approaches.  The easiest is to disable it, and in most cases this 
works best.  Disabling can be performed a number of ways, but the easiest is to right-
click on the baseline, and select ‘Edit’.  Check the disable checkbox.  The baseline 
symbol should now have a red ‘X’ on it.  The other alternative is to de-weight it, which is 
done from the Measurement Processing Settings.  From the ‘Values are for’ list, select 
the problematic baseline.  Uncheck the ‘Use main settings’ checkbox.  Then enter code 
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and carrier phase standard deviations more representative of the data for this baseline.  
You may also wish to disable this baseline from KAR as well (see previous paragraph). 
 
For case (d), disabling is the best approach (see previous paragraph). 

10.2.8   How is KAR best used with MB-KF processing? 
In general, very little is different.  By default, KAR uses the closest baseline for resolving 
KAR (or all those < 8 km).  After the KAR fix, the other baselines will be fixed to the 
same location as well.  There are two KAR settings that relate to MB processing. 

a) The ‘Search only closest base’ setting under KAR 2, when checked, 
causes KAR to only use the base station that is nearest, or it use all base 
stations that are within 8 km.  In general, the user would leave this 
checked.  If a base station is causes bad fixes, it is better to disable it (see 
Section 10.2.6). 

b) A useful setting (for corridor work especially) is the ‘Engage KAR if 
distance < tol1, reset if distance > tol2’ checkbox.  It will engage KAR on 
the first occurrence the proximity to each base is less than tol1.  KAR 
engagement will be reset if distance is greater than tol2.  The values tol1 
and tol2 (in km) may need to be refined for a particular data set.   

 
This feature is a useful means to take advantage of close periods to base 
stations in order to improved fixed integer accuracies.  The only 
disadvantage of using this method is that KAR may engage in the middle 
of the flight line which can cause a position shift, which is not necessarily 
desirable during image, laser or SAR data capture.  The only alternative is 
to manually fix KAR during the turns, and this latter approach is more 
time consuming. 

10.2.9   How about using the fixed static solution? 
KAR is the most common way to resolve fixed integer ambiguities, but the fixed solution 
works well too and can often be more accurate.  It obviously needs a stationary (static) 
period of a few minutes for dual frequency.  Longer times are needed for longer baselines 
(see Section 10.1.5).  For MB-KF processing, this process becomes more complex 
because GrafNav attempts to compute a fixed solution to all baselines.  It will disable 
those where the distance or time is too long and short respectively (see Advanced 2 
Processing Settings).  
 
For each static period, only one fixed solution will be utilized for “fixing”.  A number of 
criteria are used to pick the best one, including distance, RMS, reliability and estimated 
standard deviation.  The fixed solution used, will be signaled as ‘BEST’ in the GrafNav 
interface.   To view the solutions, right-click on the static sessions (or select View | 
Objects | KAR/Static).  Select the ‘View’ button for the desired static session.  All of the 
static sessions will be shown.  For combined solutions both forward and reverse will be 
shown.  In addition, a ‘combined’ static solution may also be computed.  This is signaled 
as PRIMARY, and these solutions are only used for exporting and do not affect 
processing.  In summary, each static session has one BEST solution for each direction, 
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which is used to fix the kinematic trajectory.  Each session will then have one PRIMARY 
solution used for exporting.  In some cases, the BEST and PRIMARY will be the same. 
 
If the BEST fixed solution used is deemed in incorrect from the forward/reverse 
separation or other means, then it can be disabled from the fixed solution.  To do this, 
first note the start/end times of the static session by selecting Edit from the Object Menu.  
From the General Processing Settings, select ‘Omit …’.  After pressing ‘Add’, disable all 
satellites from the erroneous baseline for the noted time period.  Select be sure to 
KAR/Fixed static radio button. 

10.2.10   How can I speed up processing? 
MB-KF processing can be much slower due to the increased numbers of states and 
observations.  For example, 12 satellites on 4 bases will result in 50 states and 132 
observations on every epoch!  Therefore, here are some tips to cut down processing time 
(other than buying a faster computer): 

a) Disable any bases that are far outside of the project area, as they will add 
very little to final accuracies, and they may even hinder them. 

b) Consider disabling the Doppler measurement from processing.  This is 
performed from the Advanced 1 Processing Settings.  Under the 
Velocity/Doppler Group, uncheck Doppler from phase processing.  If 
accurate velocity is needed, enable it again in the final stage. 

c) Reduce the data interval for preliminary analysis to something like 2 
seconds.  One of the problems is that the 1, 2 (or more) Hz data can result 
in different effects and problems.  This can be helped by forcing KAR to 
use the same data, which is accomplished by entering an interval value 
common to 2 s and your final data rate (e.g. 4 s) in the KAR 2 settings.  
The value is entered in the ‘Search on data interval’ edit box.  Be sure also 
to check ‘Only search on exact interval’.  This will help to make 2 second 
and high data rate data produce similar results, but it is best not to 
continue on this low data rate too long. 

d) Utilize only the closest base for fixed solution.  Consider lowering the 
maximum distance (for using fixed static) in Advance 2 processing 
settings. 

 

Section 3   FAQ 
This section contains general information and instructions on how to perform some of the 
tasks that was not covered in previous sections. 

10.3.1   Determine the Quality of Final Solution 
The best method to check the quality of the final solution would be to analyze the plots. 

This can found under the 'Output' menu or press F7 or click . The following are some 
of plots that might be useful: 
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1. Combined Separation Plot 
This should be the one of the first plot to look at. It shows the difference between the 
forward and reverse solution. An ideal solution should have separation of zero as this 
indicates that the carrier phase ambiguities have been determined to be exactly the 
same value in both directions. This plot gives the user an idea of what kind of 
accuracy they are getting. Looking at Figure 10.2, the accuracy seems to be 
approximately 5 cm. For a combined baseline in GrafNav Batch, this plot will always 
be positive as it shows maximum minus minimum value, and the user may wish to 
also view the ‘Combined RMS’ plot. 

 

 
Figure 10.2 Combined Separation Plot 

 
 
 
 
 
 
2. Float or Fixed Ambiguity Status Plot 

This plot shows if the solution is float or fixed.  Fixed integer ambiguities generally 
have better accuracies (usually < 20 cm accuracy).  Ideally, the plot should show fixed 
(green) as this indicates a fix in both directions.  Furthermore, the separation plot 
shown in Figure 10.2 is the most meaningful.  A fix in just one direction (cyan) is 
generally okay too, but it cannot be verified via the combined separation plot as well.  
Sometimes, a trajectory will lose its fixed status because the DD_DOP became too 
poor (see FF_DOP_TOL).  In such a case, the separation may not be as badly affected 
as a loss of lock. 
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Figure 10.3 Float or Fixed Ambiguity Status Plot 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Quality Factor Plot 

This plot shows the quality of the solution.  There are five different quality factors: 
• Quality 1 – Fixed Integer (Green) 
• Quality 2 – Stable Float (Aqua) 
• Quality 3/4 – Converging Float (Blue) 
• Quality 5/6 – DGPS or worse or single point (Red) 

Increasing quality factors indicate a worse solution.  This is not a perfect indication, 
but it can be useful to isolate problem areas.  See Section 2.9.1  for a description of 
Quality Factor. 
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Figure 10.4 Quality Factor Plot 

 

10.3.2   Antenna Profiles 
For correction antenna errors, data made available by the NGS is used. Unfortunately, 
they generally do not use the same measuring point than marked on the equipment.  They 
normally use the base of the antenna. For this reason, users are best to create their own 
profile if they have knowledge about the antenna characteristics (see below). 
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Figure 10.5 Antenna Profile 

 
This software assumes that one of three measurements is made: 

a) Vertically directly to L1 phase center (select ‘Measurement directly to L1 phase 
centre’ or use simple antenna model) 

b) Vertically to measurement point (or origin). 
c) Slant measurement to some point offset perpendicular to measurement point. 
d) Vertical measures to L1 phase center but antenna profile to base.  In this case, a 

new profile can be created or select ‘Measurement directly to L1 phase centre’). 
For b and c the L1 and L2 offsets are use to compensating antenna height for separation 
between measurement point and phase center. For c, the antenna radius is further used to 
correct the slant measurement via Pythagoras. 
 
To create your own antenna profile you must have knowledge of three parameters: 

a) Vertical offset from measuring point to L1 phase center 
b) Vertical offset from measuring point to L2 phase center (see existing antenna 

profile for difference between L1 and L2 offsets) 
c) Horizontal radius of antenna from measuring point (used only for slant 

measurements). 
d) Elevation based antenna errors (optional) 
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Once you have these values, press the 'Define' button next to the Antenna profile name 
under 'Use advanced method'. Then select 'Add Empty', give the antenna a meaningful 
name and enter values for (a), (b) and (c) described above (note that order is different!). 
 
In addition, an antenna height model can be created using correction values from that of 
another.  Select the model to copy from and press ‘Add From’.  The vertical distance 
values may need to be modified.  Be sure that the relationship between the L1 and L2 
vertical offset is unchanged. 
 
To further answer your question, each antenna profile has its own origin and you may 
specify it wherever you would like. If you have multiple origins for one antenna, then 
you will need to create profile for each origin definition. 

10.3.3   Copy User Files 
User files such as Export Wizard profiles, favorite points, and antenna, datum and grid 
definitions can be copied or backup.  There are two ways to do this: 
1. Running Copy User Files program. 
2. Manually copy the files. 
 
The following are the list of files that are copied by the Copy User Files program or if the 
user chooses to manually copy.  Note that not all the files will be available. 
• User.prf – Export Wizard profiles 
• User.fvt – Favorite points (from Favorites Manager) 
• User.dtm – Datum definitions 
• User.grd – Grid definitions 
• Local.fav – Local Coordinate Favorites 
• Missplan.mpf – Cities defined in Mission planner 
• User.dn1 – Download user file 
• User.adf (**) – Antenna definitions (new format) 
• *.Defopt (**) – User defined project/option settings 
(**) These files are only available on v7.50. 
 
1. Running Copy User Files Program 

Copy User Files program will automatically run at the end of the installation.  You 
may also run the program yourself from the Windows Start button | Waypoint GPS | 
Utilities.  The program will let you set the path of the source directory.  The 
destination will automatically set for you.  If you would like to set your own 
destination, then go to method 2. Manually copy the files. 
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Figure 10.6 Copy User Files 

 
2. Manually Copy the Files 

To manually copy or backup the files, just simply copy the list of files above to your 
destination. 

10.3.4   Updating Manufacturer Files 
The preloaded datums, station coordinates (favorites), download stations, grid definitions 
and IMU definitions may change from time to time.  Waypoint periodically updates these 
values on its FTP site*.  The user can download these via the About Box in GrafNav, 
GrafNet, GrafNav Batch, Download or Convert.  Select Help | About.  Then select 
‘Download latest manufacturer files’ at the bottom.  Be sure to restart program so that 
changes will take effect. 
 
*Note that new manufacturer files may not be updated for older versions outside of 
support period.  This feature is only supported by version 7.01 and later. 

10.3.5   Shifting Coordinates to Local Plane (XYZ Translation) 
Our objective is to shift the coordinate (Northing, Easting) that is relative to the Master 
(Green) station to coordinate relative to the Known Point (pink). 
 

 
Figure 10.7 Master to Known Point 
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Step 1: Create and Define Transformation 
1) First we need to define the transformation. This can be done under the 'Tools' menu, 

select 'Grid/Map Projection' and then 'Define', refer to Figure 10.8. 
 

 
Figure 10.8 Tools Menu 

2) You will come to the following screen, click 'New': 
 

 
Figure 10.9 Define Grids 

 
3) You will be asked to provide a name; in our case we will call it "TM_Custom". Select 

'Local Cartesian (ECEF rotated to local level)' then click 'Next'. 
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Figure 10.10 Enter Grid Name and Type 

 
4) You will then come to the 'Transverse Cartesian Settings' dialogue box (Figure 

10.11). 
a. Enter Latitude of the known point 
b. Enter Longitude of the known point 
c. Enter the Ellipsoidal Height of the known point 

Click Finish. 
 

 

 

(a) 
(b) 
(c) 

Figure 10.11 Local Cartesian Settings 
 
Step 2: Export Wizard/Output 
You may output the shifted coordinates (easting, northing) using 'Export Wizard'. The 
coordinates can be found under the variables are named 'Selectable Grid-East' and 
'Selectable Grid-North'. 
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Figure 10.12 Export Wizard 

 
When you reach the 'Select Grid System and Settings', make sure you select the 
transformation grid that you created in Step 1. 
 

 
Figure 10.13 Select Grid System and Settings 

10.3.6   Epoch Sampling 
A. Interpolate to higher sampling rate 
GrafNav has an option that enables the user to output data at higher sampling rate. An 
example of this would be if the user would like to output data between the times 12:00:01 
and 12:00:02 that is 1 Hz (1 second interval). This can be done with the 'Export Wizard'. 
It can be found under the Output menu. 
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Figure 10.14 Select Epoch Sampling Mode 

 
Figure 10.14 shows the window that will be seen near the last step in the 'Export Wizard'. 
If the user would like two data point between two epochs that is 1 Hz (1 second interval), 
they would enter 0.33333 sec in the Interval box under the 'Interpolate to higher sampling 
rate'. 
 
B. Reduce to lower sampling rate 
To reduce the sampling rate, repeat the same steps as Interpolate to higher sampling rate 
except select 'Reduce to lower sampling rate'. For example if the user would like to 
output data that is 1 second interval, but needs only data every 10 second, they would 
enter 10 second in the Interval box under 'Reduce to lower sampling rate'. 
 
C. Use distance dependent sampling 
'Use distance dependent sampling' is an option under the 'Export Wizard' that enables the 
user to output data that is distance interval rather than time interval. For example if the 
user would like to output data that is every 10 m, they would simply just enter 10 m in the 
Distance box under 'Use distance dependent sampling'. 

10.3.7   Processing Aerial Survey with Camera Event Marks 
Camera Event Marks 
After adding the master and the remote, you'll have to load the Camera Event Marks for 
some GPS files.  For others, they will load automatically. To load event marks manually, 
select File | Load | Camera Event Marks.  See Section 2.2.10  for details. 
 
Settings 
Select Settings | Load Settings From | Airborne to utilize a parameter set well suited for 
airborne data.  In addition, if you interpolated your data, make sure the option ‘Exact 
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interval (for interpolated data)’ is checked, and enter the original interval (under KAR 2 
Processing Options).  See section 2.5.4  on page 83. 
 
Process 
You may now start processing. Look at the Combined Separation plot (under the Output 
menu, Plot GPS Data). Preferably we want the plot to be around zero. 
 
Output (Export Wizard) 
When processing is done the next step is to output the solution. This can be done using 
the Export Wizard (under the Output Menu). 
 
Select the option Features/Stations and the profile that you prefer. You will then be asked 
to enter the Camera-Antenna offset. GrafNav define xyz as forward, left-wing, and up 
respectively. This can be seen in the following figure: 
 

 
Figure 10.15 Forward, Left-wing, Up 

 

Section 4   Digital Elevation Models 
This section goes over the implementation of DEMs into GrafNav and how to obtain 
some over the Internet for the United States.  DEMs are optional when processing GPS 
data. 

10.4.1   What are Digital Elevation Models? 
A Digital Elevation Model (DEM) is a representation of the height of the ground.  There 
are two ways they can be stored: 
 

i) Regular grid with constant density (i.e. spacing).  The DEM is stored as an 
array to minimize memory usage.  Access is very fast, but flat areas require an 
unnecessarily high number of points. 
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ii) Irregular point distribution where density generally increases with increased 
relief.  This type is represented by a Triangulated Irregular Network (TIN). 

 
GrafNav uses type (ii). It can theoretically handle both types of DEMs (although type (i) 
will be handled much less efficiently). 

10.4.2   Why should I use a DEM? 
There are two main reasons for using GrafNav’s DEM capabilities: 
 

a) The vehicle is traveling over a surface (e.g. road, runway, etc…) and the 
ground height is to be used for quality control purposes.  GrafNav has two 
plotting tools that help.  The ‘Height Profile Plot’ shows the height of the 
ground as well as remote station height.  If the GPS antenna is a constant 
vertical offset above the ground, it should be entered as the remote antenna 
height.  The ‘Height Above Ground’ plot shows the difference between 
kinematic GPS and ground heights.  The ground surface height (at each GPS 
position) can be exported as well.  DEM precision and accuracy is very 
important here. 

 
b) In aerial photogrammetry, mapping is often performed on the map projection.  

This leads to an incompatible scale used for horizontal and vertical axes.  The 
vertical scale factor (VSF) correction compensates for this, but usually only 
accepts a constant ground height.  A more accurate compensation can be 
employed by using the height of the DEM under each image frame.  In high 
relief areas, the DEM can improve this correction significantly.  The amount 
of improvement depends on the size and variation of the scale factor in the 
project area and variation of the ground height.  DEM accuracy is not as 
important as a 25 m DEM error will result in a very small final error in VSF 
height for UTM and an insignificant error for most state plane zones. 

10.4.3   How can DEMs be obtained? 
There are many sources, but for VSF correction purposes, 1:250,000 (1-degree) DEMs  
are sufficient.  In the US, these can be obtained free of charge from the internet (See 
http://edc.usgs.gov/products/elevation/dem.html and then http://edc.usgs.gov/geodata/). 
 
For the US, you will need to determine the following: 

i) Go to http://edc.usgs.gov/geodata/ and click on the 1:250K button at the top.  
Select ‘FTP via Graphics’. 

ii) Determine map sheet(s) that cover your area.  You may need to enter latitude / 
longitude values into MapQuest (or a similar mapping program/site) if you do 
not have any information about the state and county of the GPS observations. 

iii) Download these map sheets from USGS ftp site. For each file, use the utility 
DEM2XYZN (which can be downloaded from 
http://data.geocomm.com/dem/dem2xyzn/) to convert these files to a listing of 
geographic points.  The output will be Longitude, Latitude, Height where 
Lat/Lon are in arc-seconds while height is expressed in metres. 
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iv) Concatenate files of desired size together (e.g. from the command prompt type 
copy file1.pts +file2.pts +file3.pts filecombine.pts 

v) Follow the steps in section 6 for importing the DEM 

10.4.4   How is the geoid handled and what formats are 
supported? 
DEMs (after loading) are expressed in ellipsoidal height.  Therefore, if the DEM is mean-
sea-level (which is usually the case), the geoid undulation must be subtracted from the 
elevation values.  This is performed automatically during the import process but it 
requires that a geoid be available (see Section 10.4.4). 
GrafNav only supports DEMs stored in ASCII where the each elevation point is a 
separate record in the file.  The full position must be made available for each point.  This 
means that many gridded files must be expanded before importing.  The following 
formats are supported: 
 
 i) [ID] Grid-East(m) Grid-North(m) Height(m) 
 ii) [ID] Grid-North(m) Grid-East(m) Height(m) 
 iii) [ID] Grid-East(usft) Grid-North(usft) Height(usft)  
 iv) [ID] Grid-North(usft) Grid-East(usft) Height(usft)  
 v) [ID] Lat(deg min sec) Lon(deg min sec) Height(m) 
 vi) [ID] Lat(deg min) Lon(deg min) Height(m) 
 vii) [ID] Lat(decimal-deg) Lon(decimal-deg) Height(m) 
 viii) [ID] Lon(arc-sec) Lat(arc-sec) Height(m) 
 ix) Specialized formats… 
 
The [ID] term is an optional identifier that may be present.  It is not necessary.  Format 
(viii) is created by the DEM2XYZN utility. 

10.4.5   Importing DEMs 
 
Importing a new DEM should be performed after processing the desired area of interest.  
For instance, if the airport is some distance away, it may be preferable to limit the scope 
of processing to just the mapping area by setting start/end processing times.  The purpose 
of doing this is to limit the scope of the DEM to just the observation area, which saves 
memory and improves speed. 
 
To import the DEM, select from the main menu File | Load | Digital Elevation Model | 
Import DEM Points. 
 
The following dialogue box will appear in Figure 10.16: 
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Figure 10.16 Importing DEMs 

 
File Enter the file name of your DEM points 
Format Enter if suitable format.  If none exits, then you will need to convert your 

DEM to one of these formats. 
 Select the following: 

i) ‘First field contains ID string’ if an point name leads each line 
ii) ‘Stop reading if incomplete line encountered’ if multiple data types are 

in the file and you wish to only extract the first type 
iii) ‘Skip N lines at start’ to skip past any header lines in the file 
iv) ‘Reject points outside DEM area’ to limit the size of the DEM to just 

the GPS observation area.  This is highly suggested.  It requires that 
valid GPS position data be available either from the GPS receiver or 
via processing. 

v) Select ‘Reduce DEM density using error tolerance’ if you have 
either a gridded DEM or a large high density DEM that will give 
GrafNav memory or speed troubles.  Points will be rejected if their 
height is estimated from nearby ones with the error tolerance defined.  
Tolerances of 5-10 m are acceptable for VSF purposes.  Larger error 
tolerances will reduce densities. 
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Grid If the DEM horizontal coordinates are in a map projection such as UTM or 
state plane, then GrafNav needs to know the details of this exact projection.  If 
the DEM is stored in geographic, then a working map projection (grid system) 
is required.  Any system will do, but UTM is normally the easiest. 

Datum This is the processing datum and should match the datum that the DEM values 
are stored in.  Only the ellipsoid component of the datum is used, so NAD83 
and WGS84 can be used in place of each other for most applications that do 
not require the utmost DEM accuracy. 

Geoid Generally, a geoid model should be selected, as DEMs are generally always 
stored in mean-sea-level.  This requires a waypoint WPG file, NRCAN or 
NGS geoid.  NGS geoids are also available in WPG on the distribution CD. 

 
Next, press the Import button.  Forming the TIN model can take some time, so be patient.  
Finally, once the geoid is formed, press Accept and a .tri file will be saved.  In addition, 
the DEM will be displayed in GrafNav.  If no contour lines are visible, then the DEM 
might be out of the area. 
 
After a DEM has been imported, the TIN model does not need to be re-formed.  Just load 
the .tri file as follows: File | Load | Digital Elevation Model | Load Triangulation 
(.tri).  This is a much faster operation than importing. 

10.4.6   Handling Large DEMs 
Digital elevation models can become very large.  GrafNav’s ability to handle them is 
very functional but is not designed for extremely dense data sets.  DEM’s greater than 
half a million points will become very slow within the software.  They also will require a 
significant amount of memory.  A half million point DEM will utilize an additional 157 
MB in GrafNav (not including contours).  This requires a fast computer with at least 512 
MB of memory.  For VSF applications, DEM accuracy is not paramount, so DEM 
thinning is highly suggested (which can be performed right within the import DEM step). 
 
Some helpful hints to speed up GrafNav with large DEMs: 

a) Select the ‘Reduce DEM density using error tolerance’ checkbox during the 
Import DEM procedure.  This will cause the TIN formation to take longer, but 
GrafNav will operate much quicker afterwards.  This is especially important 
for regular grids. 

b) Before importing, create a GPS trajectory composed of just the project area.  
Use the start/end processing times to achieve this.  Ensure that the checkbox 
labeled ‘Reject points outside DEM area’ is selected. 

c) Disable contouring from the Options > DEM Plotting/Display Options or 
select a very coarse contour interval (see Section 2.5.3  for plotting options.) 

d) Disable ground height plotting on height profile plot in Options > DEM 
Plotting/Display Options. 

 
In GrafNav Batch, care should be taken to only load the DEM into one baseline, as an 
instance will be created for each baseline. 
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Section 5   Datums, Projections and Geoids 
This section outlines how processing with GrafNav and GrafNet can be optimized with 
the various datums, projections and geoids available.  To start out, some definitions are in 
order.  For the novice user, this text can be read disregarding the formulae. 

10.5.1   Introduction and Definitions 
A datum defines where the absolute coordinate values are referenced.  For instance, 
WGS84, NAD83 and ED50 are datums.  A datum is composed of an ellipsoid and a 
reference frame.  The ellipsoid is a geometrical approximation of the earth’s sea level 
surface, and it is needed to compute geographic or map projection coordinates.  A semi-
major axis (a) and a semi-minor axis (b) define the size of the ellipsoid.  A flattening 
value (f) may also be used in conjunction with the (a) parameter for this definition as 
well.  The relationship between f, a and b is given by 
 
f = (a - b)/a. (2) 
 
The reference frame defines the location and orientation of the geocentric coordinate axes 
(i.e. the origin).  The absolute location of the reference frame for a given datum is not 
accurately known.  However, differences between datum reference frames are often 
known precisely.  These “datum conversions” can be represented as follows: 

• 3-parameter (Molodensky) - This includes shifts in the ECEF X, Y and Z axes. 
• 7-parameter (similarity) - Includes 3 shifts, 3 rotations and one scale. 
• 10-parameter (7-parameter + temporal rotational velocities) - Includes 3 shifts, 3 

rotations and one scale + rotational rates (referenced to a certain year).  This is 
useful for datums that move with respect to each other. 

• Horizontal grid based method (e.g. NADCON) - This methodology does not try to 
use an analytical formula.  Rather, it uses a grid of localized corrections to latitude 
and longitude to transform one horizontal datum to another.  Normally, does not 
include corrections to the ellipsoidal height. 

 
A map projection is the representation of the earth’s spherical surface on a flat surface.  
Map projections are also sometimes referred to as grids. UTM is one of the most common 
map projections.  GrafNav and GrafNet currently support two types of map projections: 
 

• Transverse Mercator - This employs a cylinder placed horizontally around the 
earth.  Transverse Mercator (TM) has little distortion in the north-south direction, 
but the scale factor deviation from unity grows along with the convergence with 
distance from the central meridian.  UTM starts a new zone every 6 degrees to 
circumvent this. 

• Lambert Conformal - This utilizes a cone placed over the north (or south) poles.  
Distortion is minimal in the east west direction, while the limitations are in the 
north south direction. 
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US State Plane uses either the Transverse Mercator or the Lambert Conformal.  The one 
exception is the Alaska Pan Handle, which uses Oblique Mercator (which is currently not 
supported). 
 
The geoid is the level of the sea surface (equipotential surface under landmasses).  For 
instance, a spirit level (surveyor’s level) would follow the geoid, and because of this, 
vertical datums are based upon the geoid.  Maps are also based on the geoid, as this 
prevents any contour lines from forming on level surfaces such as lakes.  GPS can only 
make measurements on the ellipsoid (ellipsoidal height), and GPS elevations must be 
corrected to reference the Geoid.  The height above the geoid is known as an orthometric 
or mean-sea-level height.  The difference between the geoid and the ellipsoid is the geoid 
height or undulation value, and it changes across the earth by 100 m.  Luckily, many 
government agencies put out geoid undulation grid files (i.e. Geoid99 in US) that can be 
used to convert ellipsoidal to orthometric heights.  The relationship between the 
orthometric, ellipsoidal, and geoid height is given by 
 
 h = H + U (3) 
 
where h is the ellipsoidal height, H is the orthometric height, and U is the undulation 
(geoid height). 

10.5.2   Datums 
See introduction from Section 10.5.1  Introduction and Definitions. 

10.5.2.1   What capabilities are available? 
The following capabilities are available: 
• Built-in support for most of the world’s datums using the NIMA (DMA) shift 

values. 
• Users may select between multiple conversions between the same datum. 
• Better support for 7 parameter transformations.  
• Support for 10 parameter transformations (7-param. + rotational velocity).  This is 

useful for datums that are shifting with respect to each other due to tectonic 
movement. 

• Support for the NADCON grid transformation (e.g. NAD27-NAD83 conversion) 
• Ability to combine two conversions (e.g. ITRF97->NAD83 = ITRF97->WGS84 

+ WGS84->NAD83) 
• Much improved ability for users to add their own transformations.  For instance, 

users can now add their own 7-parameter transformations. 
• Coordinate transformation tool. 
• Datum conversion computation tool (3- and 7-parameter conversion). 

10.5.2.2   How does GrafNav/GrafNet handle datums other than 
WGS84? 
WGS84 is the datum that GPS satellite orbits are referenced to.  GLONASS is in PZ-90, 
but GrafNav/GrafNet takes care of the difference. WGS84 has undergone a number of 
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changes over the last 10 years, and it is now referenced to ITRF96…ITRF2004.  ITRF## 
are global datums, which means that they are moving with respect to most of the world’s 
datums due to plate tectonics.  Such movements can be as large as several centimeters per 
year.  For these reasons, WGS84 is not a suitable datum for publishing coordinates in. 
 
GrafNav/GrafNet supports two methods for handling other datums: 
Transform satellite coordinates into local datum - This is a very seamless methodology 
for supporting local datums.  It requires only that the datum transformation be applied 
once, which minimizes the danger of mixing up conversions.  Users need only to select 
the correct datum during processing and enter the base station coordinates in the local 
datum.  For this reason, this method is highly suggested. 
 
Process in WGS84 - Input coordinates are transformed into WGS84, which is the same 
datum that processing is performed in.  This methodology allows users to use very 
localized or grid based datum conversions.  It is not possible (or not suggested) to 
transform the very distant satellite coordinates (like method (a) does) using such localized 
conversions.  Normally, final coordinates are also desired in the “input datum”.  
Therefore, care must be taken to convert the coordinates from WGS84 to the local datum 
using the same transformation. 

10.5.2.3   How do I make my datum visible in the list? 
GrafNav/GrafNet has over 100 built-in datums.  Most of the transformations from these 
datums to WGS84 are from the NIMA document: http://164.214.2.59/GandG/pubs.html 
(see also http://www.nima.mil).  For simplicity, only a few of these datums are initially 
displayed in the processing options and other datum selection tools.  Therefore, users 
may wish to enable the datums that are going to be used frequently and disable the rest.  
This is performed from the ‘Datum Manager’, which can be selected from the ‘Tools 
Menu’.  From the ‘Datums’ tab, the entire list of datums is displayed.  By ‘double 
clicking’ on datums, the enable/disable status will be toggled. 

10.5.2.4   How do I enter my own 7-parameter transformation? 
When using 7-parameter transformations, be careful of the rotation angles, as there is no 
standard definition for the sign.  The sign convention used by GrafNav/GrafNet is as 
follows: 
 

  (4) 
 
Recent analysis shows the opposite sign tends to be more frequent.  If your 
transformation uses the opposite sign (i.e. θx, θy, θz have the opposite sign in front of 
them) then check the ‘Use reverse sign for rotations’ box.  The best way to determine 
which sign should be used is to inquire with the agency producing the transformation.  
Matching the overall transformation to an existing datum conversion can also be a 
method (see step 13).  However, extreme caution should used here. 
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To ensure that datums to be converted between are available, use the following steps: 
1. From the ‘Tools Menu’, select ‘Datum Manager’.  Select the ‘Datums’ tab. 
2. Make sure that your FROM and TO datums exist.  In addition, both datums should be 

enabled (i.e. box is checked).  Double click on a datum to enable/disable it. 
3. Step 3:  If a datum is not enabled, select the ‘Add’ button.  Enter the datum’s name 

and select the ellipsoid used from the list.  Check the ‘Enable’ box. 
 
To add a datum conversion, do the following: 
4. Select the ‘Datum Conversions’ tab so that you can enter the transformation between 

two datums. 
5. Step 5:  In the box labeled ‘Show conversions between these datums’, select the 

FROM and TO datums for the conversion.  Normally but not necessarily, one of the 
two datums will be WGS84.  It does not matter which one is WGS84.  It is best to 
match the datums to the conversion values.  For example, if you have conversion 
parameters for ED50->WGS84, FROM should be ED50 and TO should be WGS84.   

6. Step 6:  Press the ‘Add’ button, the following screen will appear.  If the Add button is 
grayed, then the FROM and TO datums have not been selected properly. 

 

 
Figure 10.17 Add/Edit Conversion – NAD27 to WGS84 

 
7. In the ‘Info string’ field, type a meaningful reference name.  Only alphanumeric 

characters are allowed (i.e. a-z, A-Z and 0-9).  Dashes ‘-‘ and underscores ‘_’ are also 
allowed.  You may also wish to check the ‘Set as default transformation’ box to 
ensure that this transformation is used for transforming between these two datums. 
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8. In the Type box, select the ‘7 parameter (similarity/Helmert)’ radio button. 
9. Enter the shift values in meters. 
10. Enter rotations in arc-seconds and not milli-arc-seconds (mas) as they are sometimes 

expressed in.  If the opposite sign formula is used (see above), check the ‘Use reverse 
sign for rotations’ box.  Watch out that the proper sign definition is used. 

11. Enter scale in parts-per-million (i.e. ppm_value x 10-6). 
12. Check your transformation using the ‘Coordinate Transformation’ tool.  At this stage, 

you can also compare the overall transformation to that of another datum conversion. 
13. Press OK 

10.5.2.5   How can I use NADCON conversion files? 
NADCON are the datum conversion files produced by the National Geodetic Survey 
(NGS) in the United States.  This conversion is expressed as a grid of corrections to 
latitude and longitude.  For the most part, this correction is used for NAD27-NAD83.  
However, some other countries have also adopted this format.  In addition, the NGS has 
corrections between NAD83 and NAD83(HARNS). The NGS files can be obtained from 
http://www.ngs.noaa.gov/TOOLS/Nadcon/Nadcon.html.  The latitude correction is 
located in the .LAS file, while the .LOS file contains the longitude correction. 
 
To add a NADCON datum conversion, use the same procedure (steps 1-7) as defined 
previously.  After that: 
1. In the Type box, select the ‘Nadcon (NGS)’ radio button. 
2. Select the .LAS file for the region that you wish to use.  The .LOS file need not be 

defined as it is loaded automatically. 
3. Choose how the height is to be treated.   
4. ‘Leave As Is’ means that there will be no transformation to height.  Care must be 

taken when importing/exporting coordinates.  In the export wizard, choose the option 
‘Do not convert elevation (leave in processing datum)’ on the Datum page. In 
addition, Make sure that you combine the datum transformation with a geoid height 
correction since only the orthometric height may be valid in this datum. 

5. Using another 3 or 7 parameter transformation for height can be a safer alternative, 
but it can be more difficult to incorporate a geoid model as there may not be one for 
NAD27 (for example). 

6. Check your transformation using the ‘Coordinate Transformation’ tool. 
7. In the datum options, make sure that you use the option ‘Convert input coordinates to 

processing datum (for Nadcon and localized datums)’.  This means that the button 
labeled ‘More Datum Options …’ must be selected from the General Options, or the 
Datum Options must be referenced directly.  In addition, make sure that WGS84 or 
NAD83 is selected as the processing datum. 

8. Press OK 
 
 

384 

http://www.ngs.noaa.gov/TOOLS/Nadcon/Nadcon.html


Chapter 10  Processing Techniques 

10.5.2.6   How can I prevent datum conversion errors from corrupting 
my final coordinates? 
In many cases, datum transformations can have errors of several meters or more.  Users 
should be cautious about using any transformation in an absolute sense.  Transformations 
should only be used for relative corrections.  Care should also be taken that the same 
correction be used throughout.  Here are several tips on minimizing these effects: 

• Process in your local datum (e.g. NAD83, ED50, etc…) as much as possible.  
This methodology effectively uses a relative datum correction and minimizes the 
possibility of using multiple datum conversions.  Processing in your local datum 
is performed by selecting the processing datum from the list of datums in the 
General Options in GrafNav.  Selecting the Datum tab from the processing 
options in GrafNet or using the Datum Options from GrafNav, GrafNav Batch or 
GrafNet will bring up the Datum Options dialogue box.  Select the processing 
datum from this screen..  In addition, make sure that the radio button labeled ‘Use 
processing datum by setting processing datum to local datum’ is selected from the 
‘Input Coordinate Datum’ box. 

• For localized datums (i.e. datums with large rotations, scale or shifts) or for 
NADCON corrections, processing should use a more global datum (e.g. WGS84 
or NAD83).  It is very important that the same conversion be used in the 
coordinate input and for the Export Wizard.  This means checking the conversion 
used.  In addition, avoid using the Write Coordinates feature to export 
coordinates, as it does not support input datums different from the processing 
datum. 

• If using a newer version of GrafNav or GrafNet, or if examining an old project, be 
sure that the default conversion has not changed. 

• If you use an external program to transform coordinates to the processing datum 
(e.g. WGS84), then use the same program to convert your final coordinates back 
to the local datum. 

• Be cautious with geoids.  Geoids designed for one datum may not be compatible 
with another. 

10.5.2.7   How do I compute my own datum transformation? 
Some users may wish to determine their own 3 or 7-parameter transformation/conversion.  
In such a case, a list of points with geographic coordinates in both datums must be 
available.  The height values must be present and are ellipsoidal.   
 
GrafNav has the ability to solve for a 3-parameter and a 7-parameter transformation.  The 
7-parameter can also have the scale constrained to unity, which effectively results in a 6-
parameter transformation with 3 translations and 3 rotations.  7-parameter 
transformations should only be used for larger areas (i.e. >300 km across).  This is 
because solving such transformations over small areas can make the solved parameters 
very sensitive to coordinate errors.  In some cases, 7-parameter transformations are 
necessary due to a slope in the local datum.  This is considered a ‘very localized datum’.  
See the previous section for information on dealing with such datums. 
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To solve for a transformation or datum conversion, use the following steps: 
1. Isolate the ToDatum and the FromDatum to be used.  Normally, one of the two will 

be WGS84, while ITRF is also common.  However, this feature could be used to 
convert between any two datums.  It does not matter which datum is ‘from’ and 
which is ‘to’, as long as the coordinate files correspond.  The datum conversion will 
take care of properly applying the conversion. 

2. Create a text file that contains the geographic coordinates of the points in the 
FromDatum (e.g. NAD83, ED50, etc…).  Coordinate systems other than geographic 
(degrees minutes seconds) are not supported.  The format for the coordinate file is as 
follows: 

 
 PointID  Lat_deg Lat_min Lat_sec  Lon_deg Lon_min Lon_sec  EllHgt  Flag 
 
The PointID may not contain any spaces and must match the PointID in the ToDatum file 
that will be created in Step 3.  The Lat_deg (latitude) term is +ve for the northern 
hemisphere and –ve for the southern.  The Lon_deg (longitude) is +ve for the eastern 
hemisphere and –ve for the western.  This means that North America needs –ve terms for 
the longitude.  The EllHgt is in meters and is the height above the ellipsoid.  The Flag 
term is optional.  It indicates whether this point should be used for computing the 
transformation.  Valid values are either 1 or 0, and 1 is assigned if the Flag is not present.  
Users may wish to use the Flag to either prevent suspect points from corrupting the 
solution, or they may wish to use some points as an independent check. 
 
3. Create a text file corresponding to the ToDatum (e.g. WGS84, ITRF??, etc…).  

The format for this file is the same as for the FromDatum, except that the Flag term is 
ignored.  Be sure that the PointID’s match.  

4. From the Tools Menu, select the Datum Manager.  Click on the ‘Solve 
Conversion’ tab.  The following screen will appear: 
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Figure 10.18 Datum Manager 

 
5. Press Browse to select the coordinates file corresponding to the FromDatum.  

Select the FromDatum from the list.  If the datum does not exist, it will need to be 
enabled or added.  The procedure for doing this is described earlier on in this section. 

6. Browse for the file corresponding to the ToDatum.  Select that datum as well. 
7. Select the transformation type (i.e. 3 or 7 parameter).  Enter a meaningful Info 

string.  This will appear in the datum conversion (e.g. ‘FromDatum to ToDatum 
(Info)’). 

8. Select a meaningful output file name.  This is a report that is generated from the 
computation process.  It will contain the compute transformation parameters along 
with the residuals (i.e. fit). 

9. (Optional) Select the ‘Advanced Settings’ button.  The following screen will 
appear: 
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Figure 10.19 Advanced Solve Conversion 

 
‘Add computed conversion to Datum Conversion List’ will cause the computed 

conversion to be added to the list of conversions on the ‘Conversions’ tab in 
the Datum Manager and Datum Options.  This will allow the conversion to 
be used by the software. 

‘Force scale factor to 1.0’ will constrain the PPM scale to zero (scale factor=1.0).  This is 
only applicable for the 7-parameter transformation and effectively causes a 
6-parameter transformation to be solved. 

‘Compare against existing conversion’ This will compute residuals for an another 
existing conversion in the Datum Conversion list.  This is useful for 
determining if the newly computed conversion fits better than the existing 
one. 

10. Select the Compute ‘Transformation’ button.  A message proclaiming success 
should appear afterwards.  If not, act on the message.  For some failures, a partial 
report file may be created.  Press OK. 

11. Press the View button next to the Report file to use Windows Notepad to view the 
processing report.  This report will show the following: 

 
Parameters—This is a reflection of the options on this dialogue box 
 
Raw Differences—These are the raw differences between the ECEF coordinates of the 

matched points in the two files.  Only points that have a match found will 
be processed.  The USED column indicates if points are to be used in the 
solution or not and refers to the Flag in the FromDatum file. 

Transformation Parameters—This shows the parameters computed by the solve process.  
If a comparison is made, then this will show the parameters from the 
datum conversion.  If the transformation needs to be inverted due to 
opposite from and to datums, then the reversed values are shown. 

Residuals using …—Shows difference between raw FromDatum coordinates and the 
ToDatum coordinates transformed into the FromDatum.  Root-mean-
square values are shown at the bottom.  Note that the residual values are 
oriented to local level (east, north and up). 

 
For more information on this utility refer to Section 10.5.5.4  Creating your own datum 
transformation from ASCII files. 
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10.5.3   Map Projections/Grids 
See introduction from Section 10.5.1  Introduction and Definitions. 
 
GrafNav/GrafNet supports two manners of map projections: 
1. Direct selection (e.g. UTM, TM, Gauss Kruger, State Plane, Lambert, etc…) 
2. Pre-defined and user-defined grid definitions using the Grid Manager. 
 
For coordinate output, both methods can be used in the Export Wizard (use Selectable 
Grid-East and Selectable Grid-North variables in Export profile; see section 2.7.2).  For 
Write Coordinates, only direct selection is possible. 
 
For coordinate input (i.e. base station in GrafNav and control points in GrafNet), only 
grid definitions (#2) can be used.  Another advantage with using grid definitions is that 
users can manage multiple user definitions more easily (i.e. for each country or region). 

10.5.4   Geoids 
GrafNav and GrafNet support geoids in three different formats including the U.S. 
National Geodetic Survey’s .GEO format, the Geodetic Survey of Canada’s .BIN/.SLV 
format and Waypoint’s own Waypoint-Geoid (.WPG) format. 
 
The distribution CD contains geoids in the .WPG format for the world with EGM-96, for 
the U.S. (including Alaska) with Geoid96/Geoid99 and for Australia with AusGeoid93.  
For Mexico, Mexico97 is included.  Canadian Geoid03 files must be obtained from the 
GSC website, but a conversion program is also provided to convert to WPG.  Otherwise, 
the .BIN/SLV files can be used directly with GrafNav and GrafNet.  A geoid file is also 
provided for Japan.  To obtain the latest Japanese geoid, please notify Waypoint that the 
geoid has been purchased from the government agency.  More information about these 
geoids is found in ReadMe.txt in the \Geoid directory of the CD. 
 
The relationship between ellipsoidal and orhtometric (mean-sea-level/MSL) height is: 
 
h = H + U (5) 
 
When correcting ellipsoidal heights to produce orthometric heights, it is very important 
that the geoid and processing datums match.  For example, if EGM-96 is used, then the 
base station coordinates should be in WGS84, and this datum should also be used for 
processing.  Moreover, users should be cautious about using the same geoid model as 
used on the control sheets.  This lessens the likelihood of differential errors developing. 
 
For each of the geoids supported, the following datums are used.  A web site is also given 
if further information is required. 
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Geoid Datum Web Site 
Gsd95-Canada NAD83 http://www.geod.nrcan.gc.ca/products/html-

public/GSDinfo/English/factsheets/gpsht_fact.html 
Geoid99-ContUS NAD83 http://www.ngs.noaa.gov/GEOID/GEOID99/ 
Geoid99-Alaska NAD83 http://www.ngs.noaa.gov/GEOID/GEOID99/ 
AusGeo98-1M GDA94 http://www.auslig.gov.au/geodesy/ausgeoid/ 
EGM96-World WGS84 http://cddisa.gsfc.nasa.gov/926/egm96/egm96.html 
Mexico97 ITRF94 

(1996) 
see NGS site 

Geoid96-Japan WGS84 No known web site 
RAF98-France WGS84 http://www.esgt.cnam.fr/fr/recherche/geoide.htm 
Geoid99-
PuertoRico 

NAD83 http://www.ngs.noaa.gov/GEOID/GEOID99/ 

Geoid99-Hawaii NAD83 http://www.ngs.noaa.gov/GEOID/GEOID99/ 
Geoid03-ContUS NAD83 http://www.ngs.noaa.gov/GEOID/GEOID03/ 

 
In some cases, the user may wish to process in a datum different than the one the geoid 
uses (e.g. NAD27 in North America or AGD84 in Australia).  For this case, accurate 
results can still be obtained by using the geoid model in a relative fashion.  The slope 
should be roughly the same between ellipsoids.  With NAD27, there is up to 200-metre 
difference in geographic coordinates between it and NAD83.  In areas with very high 
relief, this may result in a few centimeters of orthometric height error.  The same can be 
said for other datums with large shifts (e.g. TOKYO and ED50). 
 
In GrafNav, conversion to ellipsoidal can be performed as the master coordinate is 
entered.  When exporting with the Export Wizard, the geoid undulation will be subtracted 
for. 
 
For GrafNet, the process is similar.  This is because users can convert orthometric heights 
to ellipsoidal as they enter the control/check point coordinates.  The 
ellipsoidal/orthometric height flag must be entered correctly!!!  Please note that 
elevations are always stored as ellipsoidal inside GrafNet.  Conversion to orthometric 
will only take place at coordinate output/export.  In many cases the default output is 
ellipsoidal height, so care should be taken when exporting elevation values 
 
For more information on converting geoid to WPG format, please refer to Chapter 6  
Section 7  MAKEGEOID (Command Prompt). 

10.5.5   Transforming Coordinates 
In GrafNav/GrafNet, there are several ways to transform coordinates.  What follows are 
procedures for: 
 

1. Performing a datum conversion between for a single coordinate 
2. Performing a grid transformation on a single coordinate 
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3. Applying datum, geoid and coordinate transformations to and ASCII file. 
4. Generate your own datum conversion from ASCII coordinate files. 

 

10.5.5.1   Single Point Datum Conversions 
Tools | Datum Manager | Transform Coordinates Tab 
This tool allows you to quickly transform a coordinate from one datum to another.  This 
is frequently used to transform base station coordinates of a project to another processing 
datum.  Note that you can directly select a point that is in your favorites to be converted, 
as well as save any transformed point to your favorites.  Specifying the week number of 
the coordinate will only have an effect on the final result if the selected conversion is a 10 
parameter conversion. 
 

10.5.5.2   Single point Grid Transformations 
Tools | Grid/Map Projection | Transform Coordinates 
This tool allows you to quickly transform a single coordinate from geographic to gird, or 
grid to geographic.  It is important that users note the option “point is in Southern 
Hemisphere” which by default is not selected.  It is also worth noting that once 
coordinates are converted from grid to geographic; they can be directly added to the user 
favorites. 
 

10.5.5.3   Datum, Geoid, and Coordinate Transformations from ASCII 
files 
Tools | Convert Coordinate File 
Although the above mentioned methods are convenient for single point conversions, it 
quickly becomes tedious if you have a large list of coordinates to convert.  Additionally, 
you may already have the list of coordinates in ASCII format.  In this case it is best to use 
this tool, as entire files can easily be converted.  This is a very flexible tool and can be 
used for converting between datums, changing the height system used (ellipsoidal, 
orthometric), and/or changing to grid or ECEF coordinates.  It could also be used to 
simply change a list of coordinates to another format, such as from decimal degrees to 
DMS.  The first step in this process is shown below. 
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Figure 10.20 Coordinate Transforms step 1 of 3 

 
The first step of the wizard requires the name of the input file, the datum and the format 
of the input file.  Each line of the input file should contain the station name followed (on 
the same line) by the coordinates.  This tool can handle station naming in two different 
ways.  If the name of each station is always one continuous word and there are never 
spaces in any of the names, you can use the “use first continuous word” option.  
Otherwise, if station names contain spaces, you can specify a width of “n” characters.  
This will read the first “n” characters as the station name and include any spaces in the 
name.  Geographic coordinates use +/- to indicate the hemisphere (i.e. latitude is positive 
in the northern hemisphere and negative in south, while longitude is positive for East and 
negative for West). 
 
The next step requires the name, datum and format you want for the output file.  The 
‘Naming’ box is disabled as it will copy the names in the output file exactly as they have 
been read in from the previous step. 
 
After pressing next, you may be prompted for grid definition settings if grid coordinates 
were selected.  Otherwise, the same page as above will re-appear for the Output 
Coordinate definition. 
 
The final page to appear is shown below.  It will allow you to specify the datum 
transformation to be used if the input and output datums are different.  In addition, a 
geoid file can be specified (if required). 
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Figure 10.21 Coordinate Transform step 3 of 3 

 
Finally, options are available for the following: 
 
Include column header: Selected by default, this will conserve the header information in 
the input file. 
View output file after conversion: Will automatically open the output file after you press 
“finish”. 
Input grid coordinates in southern hemisphere: Only necessary if your input data has grid 
coordinates and your project area is in the southern hemisphere 
Do not apply datum transformation to height: This option is useful if you are 
outputting orthometric heights, as no datum transformation should be applied in this case. 
 

10.5.5.4   Creating your own datum transformation from ASCII files 
Tools | Datum Manager | Solve Conversion Tab 
This feature allows you to solve your own datum transformation.  This can be used if you 
have a list of control points with coordinates in both datums.  From these point pairs, you 
can create a locally best fitting datum transformation for your region or project area.  This 
function is also described in Section 10.5.2.7  How do I compute my own datum 
transformation?.  The two lists must be in ASCII format and all points in each file must 
be common to both files and have identical point names.  The order the points appear in 
each file, however, is not important. 
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The required format of each coordinate file is as follows: 
 
ais1 55 4 8.66252  131 35 -58.3228  32.17 
amc2 38 48 11.2486  104 31 -28.5327  1911.4 
aml5 35 9 12.8258  101 52 -42.4693  1098.11 
anto 29 29 28.3605  98 34 -35.9089  263.841 
aoml 25 44 4.88865  80 9 -43.9141  0.1 
arl5 32 45 32.5197  97 3 -37.0182  142.825 
arp3 27 50 18.0664  97 3 -32.2452  -16.603 
 
That is, the coordinates must be in signed DMS format.  Latitudes in the southern 
hemisphere and longitudes in the western hemisphere must have negative values. 
 
Be careful to specify what type of transformation you want to compute (3 or 7 
parameter).  The 3 parameter transformations will only compute a 3-D shift in the ECEF 
coordinates, whereas 7 parameter transformations will compute a 3-D shift in origin, a 
rotational shift about each axis and a scale factor.  3 parameter transformations are useful 
for small areas or if point errors are large. 
 

 
Figure 10.22 Solve Conversion 

 
After specifying the path of the coordinate files and the corresponding datums, simply 
click “Compute Transformation”.  A message box will then appear either reporting that 
the transformation was successfully computed, or an error message. 
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Info 
This is a required field and the transformation will not be computed unless text is entered 
here.  Text that is put here will be appended to the type of transformation that will appear 
in the datum transformation list under the “Datum Conversions” tab.  It is helpful to put a 
comment such as “7PCONTUS”, which could mean a 7 parameter transformation of the 
continental US.  Providing you were converting between NAD83 and WGS84, the full 
name of the datum conversion would read: NAD83 to WGS84 (7PCONTUS).  It is 
important to note that the new transformation will only be added to the list if this option 
is enabled from the “Advanced Settings”. 
 
Advanced Settings 
By default, only the “Add computed conversion to Datum Conversion List” is selected.  
This will allow GrafNav to utilize this conversion.  The option “Force scale factor to 1.0” 
simply will not solve for a scale factor in a seven parameter transformation.  “Compare 
against existing conversion” acts as a check on your conversion.  If this option is 
selected, residuals are computed for each point using both the newly computed 
conversion and a conversion that already exists. 
 
For more information on this utility refer to Section 10.5.2.7  How do I compute my own 
datum transformation? 
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Appendix A Summary of Commands 
 
The following lists the available commands and a short description of their usage. Any 
subset of the following may be used for your particular input file.  Note that the required 
format, status, and a description of each command in given after selecting the desired 
command and clicking on the ‘values’ field.  User commands can also be observed via 
the User Defined Options dialogue box from the Options menu in GrafNav.  Note that 
any spaces in file names, datum names, etc..., are substituted with the ‘*’ character.  
Many of these commands are used by GrafNav’s options.  See User Defined Options to 
determine if this is the case. 
 
Command Description 
 
ALT_FILE = fname EPP/SP3/CLK/IONEX ENABLE/DISABLE 
  
 This specifies the alternate ephemeris file 

(.epp file), or precise ephemeris (.sp3), or 
IONEX file (.yyI), or Satellite Clock file 
(.clk). They are set to ENABLE once added 
to the project.  DISABLE will disable the 
processor from using the file. 

 
APPLY_ANT = ON/OFF Set to ON if elevation based antenna 

corrections are to be employed.  Note that an 
antenna profile must also be specified for 
master and/or remote receivers.  This is ON 
by default; use OFF to disable antenna 
correction. 

 
ATMOS_FILE = Filename[.atm] This will output atmospheric values 

computed by GrafNav into a .atm file. 
 
AZ_DETERM = ON/OFF Dist DistSD GrafMov only.  Used to enable azimuth 

computation using an antenna distance 
constraint.  Distance and standard deviation 
are in meters.  Typical standard deviations 
are 2-3 cm. 

 
BASE_SAT = sv_num Satellite PRN number of base satellite used 

for differenced computations.  Normally, 
this value should be left at 99, which will 
cause the program to automatically choose 
the best satellite using a number of criteria.  
The default value is 99. 
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CYCLE_TEST = mode This can be LOCKTIME, DOPPLER, or 

BOTH, and determines the manner in which 
cycle slips are detected in kinematic mode. 
In general, either BOTH or DOPPLER 
should be used. Basically, using DOPPLER 
will disable LOCKTIME check. 

 
CYCLE_TOL = tol Tolerance used to detect cycle slips on the 

L1 phase in kinematic mode.  These 
tolerances generally vary from 1 - 500 
cycles, and depend on receiver type, vehicle 
dynamics and type of Doppler.  Numerous 
cycle slips reported may indicate that 
CYCLE_TOL is too low.  A value of 0.0 
will cause cycle slip tolerance to be 
computed automatically from data interval.  
This value is also subsequently multiplied 
by 30 [default is 0.0]. 

 
DATUM = ProcDatum [Wgs84Conv] This is the datum that processing is to be 

performed in, and the satellite coordinates 
are transformed into this datum.  See 
GrafNav for a list of available datums.  
WGS84Conv is the conversion to be used.  
Use WGS84Conv=AUTO to allow 
NGPS32.DLL to select the best datum.  
Note that datums are read from 
manufact.dtm and user.dtm located in the 
same directory as the DLL. 

 
DETAILED_SUM = ON/OFF ON if detailed parameter info is to be 

printed at the start of the static/kar summary 
(.fss/rss) file. 

 
DOP_TOL = dd_dop_tol Epochs with DD_DOP above this value are 

not printed to .FWD/REV files as the 
geometry is deamed too poor.  Default value 
is 100.0. 

 
DOPPLER_TOL = tol No longer supported. 
 
DUAL_FREQUENCY = on/off on/off off/relative/free on/off/smoothed 

OFF/ON - Use P-code for long baseline 
processing.  No longer used; see 
USE_PCODE command. 
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 OFF/ON - Use L2 phase for ambiguity 
resolution (should be ON). 

 OFF/RELATIVE/FREE – Use relative 
ionospheric correction or long baseline L3 
iono-free baseline processing 

 ON/OFF/SMOOTHED – Apply ionospheric 
correction to C/A.  SMOOTHED applies a 
low pass filter to the raw ionospheric 
corrections before implementing them. 

 
DYNAMICS = EnableFlag DynFlag This parameter controls the vehicle 

dynamics model that can be employed in the 
Kalman filter.  
EnableFlag=ON/OFF/AUTO, while 
DynFlag=LOW/MEDIUM/HIGH.  
Generally AUTO should be used, which 
means that dynamics constraint is off if 
Doppler is employed or ON if no Doppler is 
used.  If ON, HIGH dynamics is used.  If 
ON, use DynFlag to set vehicle dynamics. 

 
ELEV_MASK = angle Cut-of elevation for excluding satellites 

from the computations.  This value is 
expressed in degrees.  This elevation mask 
value may have to be increased to 15 
degrees or more in high multi-path 
environments or during ionospheric storms.  
Some data tracked under 10 degrees may 
exhibit noise characteristics. Default value is 
10.0. 

 
FF_DOP_TOL = dop_tol DD_DOP Tolerance over which a fixed 

integer solution is deemed “float”.  Allows 
user to control how easily a fixed changes to 
a float solution.  Does not affect processing. 
Default is 25. 

 
FIX_AUTO = Min DtL2 MaxLenL2 MinDtL1 MaxDtL1 ON/OFF 
 Controls automatic fixed static solution 

usage on static sessions. Use ‘ON’ to enable, 
or “OFF’ to always use. Note that fixed 
static must also enabled in processing 
settings. MinDt is minimum ime length in 
seconds while MaxLen is maximum 
allowable distance in km. 
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FIX_CORRECT_SLIP = ON/OFF ON if whole cycle slips are to be corrected 

forming a continuous phase in fixed 
solution.  By default this option is ON. 

 
FIX_CUBE = mode L1User L2User mode is AUTOREDUCE, NORMAL, or 

USER.  Sets the search region size for fixed 
solution.  L1User and L2User are the sizes 
of the search are to be used for USER mode. 
Default is NORMAL. Although, 
AUTOREDUCE often works very well. 

 
FIX_INTERVAL = DataInterval Data interval in seconds to use for fixed 

static processing. Default is 15 seconds. 
 
FIX_IONO_DIST = dist Used in the AUTO fixed solution L2 model 

for deciding between IONO and NORMAL 
L2 noise models.  dist is in kilometers. 
Default is 5 km. 

 
FIX_L2_NOISE = IONO/NORMAL/AUTO  

Selects L2 noise model for processing fixed 
solution.  IONO performs iono correction, 
NORMAL does not, AUTO selects between 
the two based on the FIXED_IONO_DIST 
command.  

 
HGT_MODEL = EstFlg KalFlg KarFlg ZOff/USEHI HgtSd [KarTol] 
 Controls DEM height constraint 

(Sportvision version only!) 
EstFlag = NAV / ALL / OFF 
Kar/KalFlag = ON / OFF 

 
INITEX = type time snap dir windowsize stdev anthgt phi lamda ht  
[[staname or ss_index] anthgt ELL/ORTHO] 
 Used to set the remote position at a given 

location.  See GrafNav user interface. 
     

INTERVAL = DataInterval This specifies the processing interval in 
seconds.  It should be equal to or greater 
than the recording interval for proper time 
length computations.  If this value is larger 
than the recording interval, then this new 
value will be used for processing. Use 0.0 to 
process all epochs. The default value is 0.0. 
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IONO_DIST = dist_in_km Baseline distance in km at which relative 
iono-free processing will begin. Default is 5 
km. 

 
IONO_PPM_TOL = tol Reject KAR or fixed static solutions if 

computed ionospheric error is greater than 
tol in PPM.  Default value is 10 PPM.  This 
setting is not in GrafNav’s dialogue boxes. 

 
ISSUE_KAR_DIST = ON/OFF DistKm1 DistKm2 
 This will engage KAR on first occurrance of 

dist < dist1 and reset the distance check 
when dist > dist2. 

 
ISSUE_KAR_DOP = ON/OFF doptol Engage KAR every time DD_DOP goes 

above doptol. 
 
ISSUE_KAR_TIME = ON/OFF NumMin Engage KAR every ‘NumMin’ minutes. 
 
KAR_COV_L2 = ON/OFF sf offset Determines KAR search area using 

ambiguity variances.  Search area is 
computed to be SearchArea=+/- sf*AmbVar 
+ offset. This option only works for dual 
frequency processing. 

 
KAR_CUBE = cube_size_l1 cube_size_l2 Size of kinematic ambiguity resolution 

(KAR) search cube in meters. A cube +/- 
cube_size/2 will be searched from the initial 
approximate position, which is obtained 
from the program following the loss of lock. 
The default value is 2.0 m.  This value 
should be increased if it is suspected that the 
remote position is outside of the search 
cube.  However, larger values increase the 
possibility of an incorrect intersection found. 

 
KAR_DISTANCE = l1_dist l2_dist Do not engage KAR if distance is greater 

than value. Distances are defined in km. 
After KAR is engaged, it will search farther.  
Use KAR_USE_DIST to prevent KAR from 
utilizing data past a certain distance. 

 
KAR_ELEV_MODEL = ON/OFF Default is ON. KAR uses the 

KAR_TWOSTAGE_SAT highest satellites 
for its ambiguity search. 
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KAR_EPOCH_FILTER = epoch_size Interval between storing epochs for KAR.  

epoch_size specified in seconds.  This 
controls how much data KAR will use. 

 
KAR_EPOCH_SIZE = epochs_l1   epochs_l2 

Number of epochs between KAR ambiguity 
searches if L1 only or L1/L2.  This controls 
how often KAR will search. 

 
KAR_EXACT_INTERVAL = ON/OFF Only use epochs exactly on 

KAR_EPOCH_FILTER in KAR. 
 
KAR_FAST = ON/OFF ON to enable ‘Fast KAR’ 
 
KAR_IONO_DIST = dist_in_km Used in auto L2 noise model for choosing 

between HIGH and IONO. 
 
KAR_L2_NOISE = AUTO/HIGH/IONO/MEDIUM/LOW 

Model used for KAR L1/L2 ambiguity 
search. Default is AUTO. 

 
KAR_MAX_DOP = 7.0 Tolerance for allowable DOP during a KAR 

solution. Default is 9.0. 
 
KAR_MAX_TIME = 30 After this number of minutes, KAR will 

restart searching 
 
KAR_MB_NEAREST = ON/OFF If this option is turned ON, KAR will use 

the nearest base station to engage (Multi-
baseline processing only). 

 
KAR_MIN_ADD = NumMinutes Minutes added to the minimum KAR time 

for every 10 km in baseline length. Default 
is 1.5 minutes. 

 
KAR_MIN_TIME = L1time L2time Minimum number of minutes for single and 

dual frequency processing before KAR is 
searching begins. 

 
KAR_OUTPUT = ON/OFF TRUE if KAR is to output additional 

information for FWD/REV files. 
 
KAR_RELTOL = tol Reliability is calculated by dividing the 

lowest intersection RMS by that of the 
second lowest.  Reliable intersections should 
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have values of 1.5 or higher and preferably 
greater than 2.0.  Default is 1.5. 

 
KAR_RMS_TOL = 0.075 Tolerance for KAR statistical test on the 

RMS phase. Default is 0.065 cycles. 
 
KAR_RMSKEEPTOL = tol If the RMS from a KAR solution is higher 

than this tolerance (cycles), then a warning 
will result.  If there are still 4 good satellites 
(see KAR_MAXSV), this solution will not be 
used.  Default value is 0.06 cycles. 

 
KAR_RMSUSETOL = tol This is the tolerance (cycles) with which 

intersections will be kept in the list.  This 
value should be 0.20 or higher. The default 
is 0.20 cycles. 

 
KAR_SEP_TOL = 2.0 Tolerance for allowable separation between 

the float and fixed KAR solutions.  This 
option can be used to “kick out” solutions 
with large float/fixed separations.   

 
KAR_STATIC = ON/OFF Turn ON to engage KAR in static mode.  By 

default this option is OFF. 
 
KAR_STRICT_TOL = rmsflag relflag rmsflag=ON/OFF and enables stricter RMS 

tolerance for rejecting bad KAR solutions.  
relflag=ON/OFF and it enables stricter 
reliability tolerance. 

 
KAR_TWOSTAGE_SATS = 6 Use this maximum number of satellites in 

the KAR ambiguity search routines. 
 
KAR_USE_DIST = ON/OFF MaxL1Dist MaxL2Dist 
 ON to prevent KAR from using long 

baseline data.  Tolerances for single and 
dual frequency processing are in km. 
Normally computed automatically from 
KAR_DISTANCE. 

 
KAR_USE_FAR = ON/OFF ON if KAR to use all data less than distance 

tolerances. OFF will just use data until 
maximum distance exceeded. Default is off. 

 
L2_LOCKTIME = ON/OFF ON to use L2 locktime for cycle slip 

detection.  For some receivers (e.g. 
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Ashtech), this can lead to more cycle slips 
being detected than really do occur. 

 
L2_MAIN = ON/OFF If turned ON, GrafNav will only use P2/L2 

for single frequency processing (special 
applications only). 

 
L2_SLIP_TOL  = 0.20 Tolerance in L2 cycles at which an L2 cycle 

slip will be assumed. Default is 0.4 cycles. 
 
LOCKTIME_CUTOFF = 8 Phase data will be ignored for the first 8 

seconds after locking onto the satellite.  
Change this value to 0 to process all phase 
data or a large value to ignore the first n 
seconds of lock.  This gives the phase lock 
loop a chance to stabilize. 

 
MB_MASTER_ANT = L1VertHgt [L2Corr MeasDist SlantFlag(1/0) ProfileName] 

MeasToPC 
 This is the extended version of the antenna 

height for a multi-base master station. Only 
first two parameters and ProfileName used 
by processing engine. 

 
MB_MASTER_DISABLE = ON/OFF ON if the master station is to be disabled 

from processing. 
 
MB_MASTER_FILE = Filename The name of the multi-base master file 

(.GPB file). Use * as spaces. 
 
MB_MASTER_INDEX = iIndex Index of the master file in the project. Note 

that this starts at 0.  It must proceed 
MB_MASTER_??? commands which refer 
to this location. 

 
MB_MASTER_NAME = StaName This is the name of the master station used 

in multi-baseline processing for 
identification and baseline settings 
matching.  This name is also displayed on 
the map and used to refer to station/baseline 
specific settings. 

 
MB_MASTER_POS = LatDeg LatMin LatSec LonDeg LonMin LonSec Ht(m) 
 These are the coordinates of a master 

station.  The latitude and longitude must be 
entered in degrees minutes seconds with 
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spaces in between.  For those just interested 
in differential vectors between the stations, a 
rough pseudorange position is sufficient.  
This can be found using the VIEWGPB 
utility or selecting interactive input from the 
first menu and selecting an averaged 
position.  If the antenna height (meters) is 
not present, this value will be assumed to be 
zero.  Latitude is positive in the Northern 
Hemisphere and negative in the southern.  
Longitude is positive in the Eastern 
Hemisphere and negative in the western 
(Americas). 

 
 
MOVING_BASE = ON/OFF Moving Baseline Option Only.  If ON, this 

indicates to the GrafMov module that the 
base station is in dynamic mode as well as 
the remote.  If MOVING_BASE=OFF, 
conventional processing is performed. 

 
MOVING_BASE_FILE = Filename No longer supported. 
 
NAV_TOL = dist_in_m Distance before using DGPS based 

navigation approximation.  Affect Kalman 
filter convergence for slowly moving 
objects. 

 
NOWRITE_HIGH = ON/OFF Does not export epochs to the .FWD/.REV 

if statistics are too poor (if ON used). 
 
OMIT = KAR/PROC $name/ALL sv#/ALL RANGE/ALL [start end] 
 This controls omitted objects (such as 

baselines and satellites) from GrafNav 
processing. KAR = remove from KAR/fixed 
static; PROC = remove from all processing; 
$name is baseline name (or use ALL); use 
start end to define RANGE of times to omit. 

 
OUTPUT_MODE = NORMAL/EXTENDED 

Determines output format for the ASCII 
.FWD and .REV files.  EXTENDED 
includes velocity and ambiguity values. 

 
POS_DENSITY = 1.0 This is the spectral density of the position 

states. You may want to increase this value 
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to 10 or more under high dynamics. This 
value should be left at 1.0 (default). 

 
PROCESSDESC = Description This is the processing description.  By 

default it uses Run(1) and increments after 
each processing run.  The information is 
stored in the processing history. Use * for 
spaces. 

 
PROCTIME = Time Date Time (hh:mm:ss) and date (mm/dd/yy) of 

processing. 
 
PROCUSER = Name User’s name or intials stored before 

processing.  It is stored in the processing 
history (by GrafNav) and is outputted in 
ASCII and binary files. 

 
PROCESS_DIR = direction Processing direction is either FORWARD or 

REVERSE.  Reverse processing can be 
useful if there are a major series of (fatal) 
cycle slips during a kinematic run. All 
features supported under forward processing 
are supported under reverse processing. 

 
REMOTE_ANT = L1AntHgt [L2Offset … Vertical offset from ground location to L1 

phase centre.  Second value is offset from 
L1 to L2 phase centre.  Additional values 
used by GrafNav for internal use (see 
MB_MASTER_ANT). 

 
REMOTE_FILE = [path]file_prefix[.gpb] This is the name and location of the remote 

station binary GPS data file.  This data must 
be in the .GPB format.  If your data is not in 
this format, use one of the conversion 
utilities supplied.  If this value is not 
entered, the program will prompt for it.  
Make sure to replace all spaces with ‘*’ 
characters. 

 
REMOTE_POS = lat.  long.  ht These are the coordinates of the remote 

station.  The latitude and longitude must be 
entered in degrees minutes seconds with 
spaces between.  The processing engine now 
computes a differential pseudo-range 
solution at the start of the program if 
REMOTE_SD is greater than 1.0 meters.  
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This means that this position can be many 
kilometers out and still work. Entering the 
position is not necessary. Latitude is positive 
in the Northern Hemisphere and negative in 
the Southern.  Longitude is positive in the 
Eastern Hemisphere and negative in the 
Western Hemisphere (e.g. Americas).  See 
also INITEX command. 

 
RMS_MODE = NEW/OLD No longer supported. 
 
SAVE_AMB = ON/OFF ON if ambiguities are to be saved if a 

satellite drops out in the file but it’s locktime 
is not reset.  Disable if too many filter resets 
are occurring because of missed cycle slips. 

 
SF_IONO_MODE = OFF/ON/BROADCAST/IONEX 
 Turned ON for automatic selection between 

IONEX and ICD-200 broadcast ephemeris 
corrections to be applied when processing 
single frequency data, or select type of 
correction manually.  Such corrections will 
only help on very long baselines. 

 
SHOTGUN = ON/OFF No longer supported. 
 
SKIP_EPOCH = ON/OFF MASTER/REMOTE/BOTH NumSats 
 Currently, not supported in Version 7.01 
 
SKIP_NOREPAIR = CaVal L1Val Maximum number of seconds of skip if bad 

data observed and could not be corrected on 
either L1 or C/A.  Defaults are 10 s for C/A 
and 0.0 s for L1.  Values are in seconds. 

 
SPLIT_SS = ON/OFF dt Set ON to break up static sessions if a time 

gap of greater than dt is observed.  Dt is in 
seconds.  By default, this setting is OFF. 

 
SP_??? Single point processing settings.  Ignored by 

NGPS32.dll. 
 
STANAME = name Used by GrafNet to set the station name for 

display in output files. 
 
STATIC_SLIP_TOL = val Static cycle slips are declared if greater than 

val, which is in cycles. 
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STATICSESS = ID AntHgt StartTime EndTime IsSec80 UseFix 0 
 Define information about a static session.  

For instance, ID gives it’s name (use ‘*’ for 
spaces); AntHgt allows the antenna height to 
be changed (value in m); Start/EndTime 
define time range in TOW or seconds since 
1980 (see IsSec80 flag); IsSec80=on/off; 
UseFix indicates whether fixed static 
solution is to be used (0=off, 1=use, 
2=check distance and time, see FIX_AUTO 
command) 

 
STD_MODE = AUTO/ELEV/CN0/STANDARD 

This is the type of weighting mode that the 
measurements will use in terms of statistical 
handling. 

 
STD_REF = REFCN0 REFELEV CN0_V These are the reference values that the 

measurement standard deviation’s refer to.  
V in SD = V+10-cno/10 (note: scaled by 
REF_CN0) 

 
STD_DIST = LOW/MEDIUM/HIGH/OFF/MANUAL [ManHzPPM ManVPPM] 
 This is the magnitude of distance dependent 

errors.  The distance effect can be low, 
medium, high, or off.  The user can override 
these settings and enter their own horizontal 
and vertical PPM manually. 

 
STD_PPM = RejectPPM This is only used if the user command 

STD_DIST = OFF above. 
 
STD_REJECT = Type CedeRej PhaseRej DopRej CedeReset PhaseReset 
 TYPE=MANUAL/NORMAL/STRICTALL

/STRICTPHASE/STRICTCODE/LOOSEA
LL/LOOSECODE/LOOSEPHASE, values 
are nSD (i.e. number of standard 
deviations).  If type is MANUAL, the user 
needs to enter the rejection and reset 
tolerances. 

 
STD_SKIP = MaxRejSec nSkipCodeEpochs nSkipPhaseEpochs 

These are the advanced reset settings. 
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STD_PHASE = SD_m ON/OFF This is the standard deviation for the carrier 
phase.  ON/OFF refers to if the standard 
deviation will be adjusted for additional 
ionospheric noise. 

 
STD_CODE = SD_m This is the standard deviation for the C/A 

code and P code. 
 
STD_DOPPLER = SD_m/s ON/OFF This is the standard deviation for the 

Doppler.  ON/OFF refers to the auto-doppler 
flag (used in GrafNav only). 

 
STD_BL = Name UseMain(ON/OFF) [CodeSD phaseSD dopplerSD] 

These are baseline specific values. Name 
refers to master; values in m or m/s. 

 
STD_RELTOL = Value This is the reliability tolerance for rejecting 

outliers. 
 
TIME_CORR = 0.0    0.0 seconds.  Time correction to master and 

remote files.  This may be useful if a 
receiver has logged data in UTC time rather 
than GPS time.  It is not suggested that this 
command be used unless there are errors in 
your GPS data timing. 

 
TIMERANGE = ALL/RANGE StartSec EndSec Flag ShowHmsMdy Processing 

time range.  Replaces START_TIME and 
END_TIME commands.  ALL processes 
entire data set.  StartSec is time at beginning 
(regardless of forward or reverse 
processing).  EndSec is time at end of 
processing period.  Times can either be 
seconds of the GPS week or seconds since 
1980 (see Flag).  Flag is 0 for time not 
valid, 1 for seconds of the week, and 2 for 
seconds since 1980.  ShowHmsMdy is only 
used by GrafNav for display purposes 
(1=show H:M:S …). 

 
TROPO_MODEL = OFF/SAAS Default is SAAS, which is the Saastamoinen 

model. OFF can be used with GPS 
simulators that have troposheric correction 
disabled. 
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USE_DOPPLER = ForCarrier ForCode ForCarrier uses Doppler for carrier phase 

(ON/OFF);  ForCode uses Doppler for code 
only processing (ON/OFF). 

 
USE_PCODE = P1forCA(ON/OFF) P2(ON/OFF) 

This will enable P-code and requires dual 
frequency processing. 

 
USERKAR = gpstime FORWARD/REVERSE/BOTH 
 Engage KAR at this time for the direction(s) 

specified, may be multiple entries.  gpstime 
is in seconds of the GPS week. 

 

 

 

 

 

 

 

VEL_DENSITY = density Spectral density for velocity states (m2/s2). 

VERBOSE = ON/OFF ON prints additional information to 
FWD/REV/FML/RML files. 

VERSION = #.#.# Ignored by .dll.  It is used by GrafNav to 
indicate version number producing CFG file. 

 
WRITE_BAD_EPOCHS = OFF/ON Default is OFF.  Use ON to write bad data to 

the .FWD/.REV files.  This option is useful 
if the user wishes to view data at epochs 
where the RMS_TOL values are exceeded.  
Normally, data which is greater than 
RMS_TOL is not written to file. 

WRITE_RESIDUALS = ON/OFF default OFF.  If ON, then write out each L1 
phase and CA-code residual for each 
satellite to a .RL1 and .RCA file. 

 
WRITE_SLIP_MSG = ON/OFF ON if cycle slip and other satellite 

rising/falling warning messages to be 
written to message log. 

GPS-IMU User Commands 
 
ACCEL_BIASES = x y z x,y,z, accel biases in m/sec  

ACCEL_NOISE = sd1 sd2 sd3 spectral density of the accel bias states 
(m**2/s**5) 

 
ACCEL_SD = x y z a priori Kalman std dev for x,y,z accel biase 

states (metres/sec**2) 
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ALIGNMENT_MODE = mode 0-coarse+fine align, 1-coarse align only, 2-
no alignment (transfer or on-the-fly 
alignment) 

 
ASCII_OUTPUT_INTERVAL = Interval ASCII IMY Output to FIM or RIM files 

(default is 1 second) 
 
COARSE_ALIGNMENT_MODE = mode 0-static coarse align,1-enter the az,2-transfer 

alignment 
 
COARSE_ALIGNMENT_TIME = time1 time2 seconds of coarse align for fwd/rev 

processing (def 120 sec) 
 
CORRELATION_TIMES = gyro_time accel_time correlation time for Gauss-Markof 

gyro / accel bias states (seconds) 
 
DATA_RATE = rate data rate for IMU:  
                   64 Hz for LTN90 
                   50 Hz for LRF3 
                   50 Hz for LN200 
                      100 Hz for HG1700 
 
DYNAMICS_MODE = mode 0 - low, 1 - high, 2 - extreme  
 
ERROR_MODEL_IMU = Name Error model name from manufact or 

user.imu files. 
 

 

GPS_INS_UPDATE_TOL = FLOAT/FIXED  sdev Q D_rms only use GPS updates 
when these conditions 
are met: 

GPS_COVARIANCE_SCALE = pos vel Scale GPS Kalman co-variances for POS 
and VELOCITY by this amount (default 
1.0) 

 
GPS_HEADING_UPDATES = OFF/ON const StdDev ON/OFF - use GPS heading 

updates / Const offset in 
degrees / std dev of offset 
angle in degrees(default 
OFF) 

GPS_INS_OFFSETS = dx dy dz (m) Lever Arm measured in body axes 
system with the IMU considered as the 
origin 
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GPS_POSITION_UPDATES = ON/OFF ON/OFF - use or not use GPS velocity 

updates (default ON) 
 
GPS_TRAJECTORY_SOURCE = source GrafNav solution file -> 0-cmb, 1-fwd, 2-

rev, 3-external file 

                                    FIXED/FLOAT (ambiguities -> def 
FLOAT) std_dev_GPS_coord (def -> 2m)  
Qfactor (1-6 -> def 6)  DopplerRms(m/s) 

INS position for fwd / rev processing 
(D.M.S / metres) 

 
GPS_VELOCITY_UPDATES = ON/OFF ON/OFF - use or not use GPS velocity 

updates (default ON) 
 
GPS_UPDT_INT = n GPS updates every n seconds 

 
GRAFNAV_FILE = filename1 filename2 name of FWD, REV, CMB GrafNav file for 

GPS updates (fwd and rev processing) 
 
GYRO_BIASES = x y z x,y,z, gyro drifts in deg/sec  
 
GYRO_NOISE = sd1 sd2 sd3 spectral density of the gyro drift states 

(arcsec**2/sec**3) 
 
GYRO_SD = xsdev ysdev zsdev a priori Kalman std dev for x,y,z gyro drift 

states (arcsec/sec) 
 
INITIAL_ATTITUDE_KNOWN =   att ATTITUDE_KNOWN, 

HEADING_KNOWN, 
ATTITUDE_UNKNOWN - validity of the 
initial roll, pitch, yaw values   

 
INITIAL_ATTITUDES = rowfwd pitchfwd azfwd rowrev pitchrev azrev  

if known input Roll,Pitch,Azimuth (decimal 
degrees) for fwd/rev alignment 

 
INITIAL_INS_POSITION = latfwd lonfwd htfwd latrev lonrev htrev  

 
INITIAL_POSITION_SOURCE = source 0-cmb/fwd/rev file, 1-manual entrry of 

position 
 
INITIAL_VELOCITIES = vefwd vnfwd vhfwd verev vnrev vhrev  

if known input East,North,Up velocities 
(m/s) for fwd/rev alignment 
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INS_BODYFRAME_OFFSETS = roll pitch yaw (degrees) constant angular offsets 
from the IMU axes to vehicle body 
frame axes in roll,pitch,yaw (usually 
zero) 

 

INS_FILE_NAME = filename name of IMU binary measurement file  

INS_LOWPASS = 0/1   0 or 1 -> if 1, use low pass filter on raw data 
(def = 0) 

INS_PROCESS_MODE = mode GPS_INS (default) or INS_ONLY 

INS_TYPE = type LTN90, LRF-3, LN200, HG1700, 
JAMI_IMU, GENERIC_IMU (*.imr) 

 
MISALIGNMENT_NOISE = sd1 sd2 sd3 spectral density of misalignment states 

(arc_sec**2/s)  

NUM_STATES = number Kalman filter states (def=15) 

POSITION_NOISE = sd1 sd2 sd3 spectral density of the coord states (m**2/s)  

INS_DATAGAP_TOL = Num_consectutive_epochs_missing Exit on a single data 
gap that is larger than this number. 

 

 
INS_GPS_TIME_FRAME = GPS_TIME_FRAME/RCVR_TIME_FRAME 

default GPS_TIME_FRAME (rcv_time - 
rcvr_clock_bias) / RCVR_TIME_FRAME 
(nominal rcv_time)  

 

 
INS_PROCESS_DIR = FORWARD/REVERSE FORWARD/REVERSE direction 

INS processing 
 

 
INS_TIMERANGE = start end  start / end times for IMU processing and 

process ALL / PARTIAL data set 
 

 
INS_VERBOSE = ON/OFF   ON/OFF - write extra messages to FIL and 

RIL files (default OFF) 

 
MISALIGNMENT_SD = esddev nsddev hsddev a priori Kalman std dev for east, 

north, up misalignment states (arc 
seconds) 

 

 
POSITION_MEAS_VAR = cov variance (R-matrix) of Kalman CUPT 

observation (m**2) 
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POSITION_SD = esdev nsdev usdev a priori Kalman std dev for east, north, up 

coordinate states (metres) 
 
PREDICTION_RATE = n Kalman filter prediction every n sec 

(def=0.5) 

 

VELOCITY_SD = sdev1 sdev2 sdev3 a priori Kalman std dev for east, north, up 
velocity states (metres/sec) 

 

 

 

 

 
TIME_OFFSET = offset correction in seconds (if any) to GPS times 

in the IMU binary file (def -> 0.0) 
 
TOTAL_ALIGNMENT_TIME = time1 time2 seconds of coarse + fine alignment 

(def 600 sec) 
NOTE: if total_align_time = 
coarse_align_time, no fine alignment 
is performed 

 
VEL_MEAS_VAR = var    variance (R-matrix) of Kalman ZUPT 

observation (m**2/s**2) 

VELOCITY_NOISE = sd1 sd2 sd3 spectral density of the velocity states 
(m**2/s**3) 

 

WRITE_BINARY_OUTREC = ON/OFF   ON/OFF - write binary structure to disk at 
Mechanization Rate for fwd/rev 
combination 

ZUPT_ALIGN_INTERVAL = interv length of time for a ZUPT during fine 
alignment (def -> 10 seconds) 

ZUPT_AT = start end start_time(GPS sec)  end_time(GPS sec)  
incremental_number 

 
ZUPT_OPTION = num   type of ZUPT = 0 or 1 -> one epoch or best 

fit over zupt_length seconds (default 1) 

ZUPT_TIME = time minimum length of time for a ZUPT (def -> 
10 seconds) 

 
ZUPT_VEL_TOL = tol reject a ZUPT with velocity above this tol 

(m/s) 

414 



 

Appendix B Moving Baseline Upgrade (GrafMov)  
 
This appendix describes the moving baseline upgrade, which is an add-on to Waypoint’s 
GrafNav/GrafNet GPS post-processing software package.  The purpose of the moving 
baseline software is to facilitate relative processing between two moving antennae. 
 
To run the Moving Baseline version of GrafNav, select the Start button from Win95/NT.  
Then select Program and GrafMov from the Waypoint GPS folder.  Make sure not to use 
GrafNav from the Desktop in Windows 95 since it will not process moving baseline files. 
 
Important considerations when using GrafMov: 
 

 

 
For the GrafMov, it is important to ensure that

Make sure that the base and remote data are set to kinematic. 
 
With the regular version of GrafNav, it is very crucial that static (stationary) and 
kinematic (moving) periods are properly defined for the remote GPB file, while the base 
stays static.  This is important because GrafNav treats remote kinematic and static data 
differently, and if kinematic data is set to static, then large errors will develop.  Even 
small movements on the antenna can cause problems in static mode, and such data should 
be switched to kinematic.  On the other hand, static data that is incorrectly set to 
kinematic will cause a reduction in accuracies.  This is especially true for single 
frequency data.   

Most of the decoders make the entire data static or optionally kinematic.  Switching 
between static and kinematic can be performed epoch-wise2 within the GPB File Viewer 
(see Section 2.2.15).  If WLOG is used to log the raw data, switches between static and 
kinematic can be performed in real-time by pressing F3. 

 both the base and remote stations are also 
set correctly (i.e. static or kinematic).  Again, this is best performed from within the GPB 
File Viewer.  The GPB File Viewer can be accessed a number of ways: 

 

                                                

From the File menu, select View and View Raw GPS Data 
From the File menu, select GPB Utilities and View Raw GPS Data 
From the Process menu, select View Raw GPS Data, select either View Master or View 
Remote.  For these to work, a project must be loaded. 
From the Waypoint GPS programs, select GPB Viewer 
 
If the user is not sure when the data is static and when kinematic, then make the entire 
file kinematic.  It is much safer. 

Make sure that the master GPB file has position data. 

 
2 Multiple epochs can be changed between static/kinematic as well 
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For relative processing in kinematic mode, the movement of the base must be tracked, 
and GrafMov will extract this position from the Master GPB file.  Normally, the receiver 
computes this position in real-time, but some of the decoders re-compute position during 
conversion.  Examples are Ashtech Hose, Rockwell Jupiter and RINEX.  With the 
exception of DGPS method, coordinates will have the effects of S/A that can be up to 100 
m.  This will not cause a problem since only the relative information is desired, which is 
not effected by S/A.  However, it is important to ensure that the master GPB file has 
proper coordinates.  This is best performed from the GPB File Viewer (see Section 2.2.15   
Viewing Raw Binary GPS Data).  Ensure that there is a geographic position in the top-
right window. 
 
Extracting Local Level Coordinates 
Once processing is complete, the relative coordinates between the base and remote 
antennae are usually required.  The local level system is very compatible with geographic 
coordinates and is often used.  This system has the y-axis pointing north and the x-axis 
pointing east, while the z-axis is vertically oriented.   
 
However, due to a convergence of the meridians the north axis at the base is different 
from the remote.  The local level coordinates computed in GrafMov and GrafNav use the 
north axis of the base to define the y-axis.  The base position is also the origin of the 
coordinates system.  Although local level coordinates can be extracted from the .MOV 
file, they are better obtained using the Write Coordinates feature from within GrafMov.  
This allows forward and reverse solutions to be combined.  This is performed by 
selecting Local Level coordinates as the Output Format.  The local level velocities will 
also be written (units are m/s). 
 

3. Select Epochs as the Source 

Extracting Relative Earth Centred Earth Fixed (ECEF) Coordinates 
The local level coordinate system in not Cartesian, which is due to a different formation 
of the horizontal and vertical axes.  These coordinates should not be used in conjunction 
with rotation matrices.  For this purpose, the relative ECEF vector is better suited.  ECEF 
is a coordinate system with its origin at the centre of the earth.  The ECEF x-axis pierces 
the Greenwich Meridian, while the y-axis intersects longitude +90°.  The z-axis intersects 
the North Pole.  The relative ECEF coordinate system will have the same orientation, but 
the origin will be centred at the base antenna. 
 
ECEF output requires the following steps: 
 
1. Export the absolute ECEF coordinates for the remote.  This is performed from Write 

Coordinates within the Output Coordinates menu, as follows: 
2. Enter a meaningful file name (e.g. REMOTE) 

4. For the latest version, make sure that the Time Format is GPS seconds of the week 
and NONE of the Correction Values are selected.  Otherwise, make sure Corrected 
Time is NOT enabled. 

5. Select XYZ-ECEF as the Coordinate Type 
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Appendix B Moving Baseline Upgrade (GrafMov) 

6. Use the ASCII Output Format 
7. Horizontal and Vertical Units should be Meters 
8. Do NOT apply the Geoid correction 
9. Press the OK button 
 
Export the ECEF coordinates for the base station.  This is also performed from Write 
Coordinates.  These coordinates will have the effects of S/A but so will the REMOTE 
coordinates from (a).  They will cancel.  Use the following steps: 

7. Press the OK button 
8. Select Master .GPB File 

Files for both the base and remote ECEF coordinates are now available.  Each is given 
extensions of .XYZ.  However, the coordinates need to be differenced to generate the 
relative ECEF vector.  This is performed using the COMPARE.EXE program that is 
supplied with the Waypoint GPS Software.  It should be located in the following 
directory: 

 
1. Enter a meaningful file name (e.g.  MASTER) 
2. Select Single Point Solution (.gpb file) as the Source 
3. Select XYZ-ECEF as the Coordinate Type 
4. Use the ASCII Output Format 
5. Horizontal and Vertical Units should be Meters 
6. Do NOT apply the Geoid correction 

9. Press the OK button 
 

C:\Program Files\WayptGPS 
 
 

ECEF velocities are not available, and the local level values must be used. 

Compare is executed as follows: 
 Compare  MASTER  REMOTE  outfile.xyz  -neh 
 
Do not use the –ecef option as it will compute Cartesian local level coordinates. 
The file output.xyz will contain the ECEF coordinates for each GPS epoch. 
 

 
Moving Baseline Options 
GrafMov has only one option.  This is whether Moving Baseline Processing is enabled or 
disabled.  By default, this option is enabled.  Disabling it will allow GrafMov to process 
like GrafNav.  However, it is suggested that GrafNav be used for this purpose. 
This option can be found under Options > Moving Baseline Options.  If moving baseline 
is enabled, the azimuth determination feature must also be selected, see Figure B1 below. 
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Figure B 1 - Moving Baseline Options 

 
If the user knows the distance constraint between the two antennas, they can use the 
second option to ensure the stability while processing the data.  The tolerance value is 
used to engage KAR if the distance between the two antennas becomes too far or close 
together. It may be a good idea to process with the azimuth determination off first to see 
the quality of the solution.  If the quality is quite good then using the second or the fourth 
option will work.  Selecting a lower tolerance may cause GrafMov to engage KAR 
continuously, resulting in a possible infinite loop or very long processing time.  By 
default it is set at 2cm, but the user can change this after they have processed first without 
azimuth determination.  Generally if the user just needs straightforward azimuth, or if the 
quality of the data is not good for using KAR, the third option should be used (compute 
only).
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